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Keep this User's Guide handy for quick reference when necessary. 

SAFETY INDICATIONS 

To use NEC Express5800 Series safely, follow the instructions in this User's Guide. 
 
This guide explains components that pose a danger, types of dangers, and actions taken to prevent 
them; such components are labeled warning. 
 
 
 
This guide and warning labels use “WARNING” and “CAUTION” to indicate a danger depending on 
the degree. These terms are defined as follows: 
 

WARNING  
Indicates a danger that could lead to a death or serious injury. 

CAUTION  
Indicates a danger that could lead to a burn, other injuries or damage to 
physical assets. 

 
This guide uses the following three types of symbols to give indications and precautions against a 
danger. They are defined as follows: 
 

 
Indicates that there is a risk of danger. Each image symbolizes a particular type of 
danger. (Attention) 

 
Indicates what you must not do. Each image symbolizes a particular type of 
prohibition. (Prohibited actions) 

 
Indicates what you must do. Each image symbolizes a particular type of action 
necessary to avoid a danger. (Mandatory actions) 

 
(Example) 

Symbol to draw attention 
 Term indicating a degree of danger 

 

 

 CAUTION  
 

   
 High temperature. 

 
Immediately after the power-off, system components such as hard disk are 
very hot. Wait the server to cool down completely before adding/removing 
some component. 

   
   
Symbol indicating a prohibited 
action (may not always be 
indicated) 

  Description of a danger  

 



 

SYMBOLS USED IN THIS USER'S GUIDE AND WARNING LABELS 

Attention 

 
Indicates a risk of an electric shock. 

 
Indicates a risk of an injury due to heat. 

 
Indicates a risk of catching your fingers. 

 

 
Indicates a risk of a fire or smoke. 

 
Indicates a general precaution or warning that is not defined herein. 

 
Indicates a risk of losing eyesight due to laser beam. 

 
Indicates a risk of an injury or damage to physical assets due to a hazardous material. 

 
Prohibited actions 

 
Indicates a general prohibition that is not defined herein. 

 

Do not disassemble, repair, or modify the equipment. There is a risk of an electric 
shock or fire. 

 
Mandatory actions 

 
Unplug the server. There is a risk of an electric shock or fire. 

 

Indicates a general action to take that is not defined herein. Make sure to follow the 
instructions. 



 

NOTE:  This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference when the equipment is operated in a commercial 
environment. This equipment generates, uses, and can radiate radio frequency energy and, if not 
installed and used in accordance with the instruction manual, may cause harmful interference to 
radio communications. Operation of this equipment in a residential area is likely to cause harmful 
interference in which case the user will be required to correct the interference at his own expense. 

 

 

 
This class A digital apparatus meets all requirements of the Canadian Interference-Causing 
Equipment Regulations. 
Cet appareil numériqeu de la classe A respecte toutes les exigences du Règlement sur le matériel 
brouilleur du Canada. 

 

CE Statement 
Warning:  This is a Class A product. In residential environment, this product may cause radio 
interference, in which case the user may be required to take adequate measures (EN55022). 

 
NOTE: This product provides resistance against hardware faults with its redundant hardware 

modules. However, this does not mean complete fault-tolerance is assured. For example, 
there is a risk of system down when: 
– A fatal fault occurs in software. 
– Both modules within a redundant hardware pair break down. 
– A fatal fault occurs in a non-redundant component, such as the clock generator circuitry 

or the interconnect backplane.  
– The entire system is cut off from AC power. 

 
 



 

Trademarks 

NEC EXPRESSBUILDER, NEC ESMPRO, and NEC Express5800/ft series are trademarks of NEC 
Corporation. 

Stratus is a registered trademark of Stratus Technologies Bermuda Ltd. 

Microsoft, Windows, Windows Server, Windows NT, and MS-DOS are registered trademarks of 
Microsoft Corporation in the United States and other countries. 

Intel and Pentium are registered trademarks of Intel Corporation. 

AT is a registered trademark of International Business Machines Corporation in the United States 
and other countries. 

VERITAS is a registered trademark of VERITAS Software Corporation in the U.S. and other 
countries.  

The VERITAS logo and VERITAS Volume Manager are trademarks of VERITAS Software 
Corporation. 

Adobe, the Adobe logo, Acrobat, and the Acrobat logo are trademarks of Adobe Systems 
Incorporated. 

Datalight is a registered trademark of Datalight, Inc. ROM-DOS is a trademark of Datalight, Inc. 

Xeon is a trademark of Intel Corporation in the United States. DLT and DLTtape are trademarks of 
Quantum Corporation in the United States. QLogic and its logo are trademarks of QLogic 
Corporation in the United States. Fast!UTIL is a trademark of QLogic Corporation in the United 
States. 

All other product, brand, or trade names used in this publication are the trademarks or registered 
trademarks of their respective trademark owners. 

Microsoft Windows Server 2003 Standard Edition operating system and Microsoft Windows Server 
2003 Enterprise Edition operating system are called Windows Server for short. Microsoft Windows 
2000 Server operating system, Microsoft Windows 2000 Advanced Server operating system and 
Microsoft Windows 2000 Professional operating system are called Windows 2000 for short. 
Microsoft Windows NT Server network operating system version 3.51/4.0 and Microsoft Windows 
NT Workstation operating system version 3.51/4.0 are called Windows NT for short. Microsoft 
Windows Millennium Edition Operating System is called Windows Me for short. Microsoft 
Windows 98 operating system is called Windows 98 for short. Microsoft Windows 95 operating 
system is called Windows 95 for short. 

Names used with sample applications are all fictitious. They are unrelated to any existing product 
names, names of organizations, or individual names. 

 
 

 

To prevent voltage sag: 

This product may be affected by voltage sag caused due to lightning. To prevent voltage sag, you 
are recommended to use an AC uninterruptible power supply (UPS) unit. 
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Notes: 

(1) No part of this manual may be reproduced in any form without prior written permission of 
NEC Corporation. 

(2) The contents of this manual are subject to change without prior notice. 

(3) The contents of this manual shall not be copied or altered without prior written permission of 
NEC Corporation. 

(4) All efforts have been made to ensure the accuracy of all information in this manual. If you find 
any part unclear, incorrect, or omitted in this manual, contact the sales agent where you 
purchased this product. 

(5) NEC assumes no liability arising from the use of this product, nor any liability for incidental or 
consequential damage arising from the use of this manual regardless of (4) above. 

 
 
PREFACE 
Welcome to the NEC Express5800/ft series. 

NEC Express5800/ft series is a “fault-tolerant (ft)” server focusing on “high reliability” in terms of 
fault-tolerance, in addition to “high performance,” “scalability,” and “general versatility” provided 
by NEC Express5800 series. In the event of trouble, its dual configuration will allow the system to 
instantaneously isolate the failed parts to assure non-stop running; operation will be moved 
smoothly from one module to the other, minimizing damage to it. You can use this NEC 
Express5800/ft series in a mission-critical system where high availability is required. By the use of 
Windows2003 operating system, it also provides outstanding openness for general-purpose 
applications, etc. 

To make the best use of these features, read this User's Guide thoroughly to understand how to 
operate NEC Express5800/ft series. 
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ABOUT THIS USER'S GUIDE 
This User's Guide helps a user to properly setup and use the product. 

Consult this guide to ensure safety as well as to cope with trouble during a system setup and daily 
operation. 

Keep this manual handy. 

This User's Guide is intended for users who have a good knowledge on the basic use of 
Windows2003/NT operating systems and general I/O devices such as a keyboard and mouse. 

 
 
How to Use This User's Guide 
This guide consists of eight chapters and appendices. To help you find a solution quickly, the guide 
contains the following information: 

For descriptions on setting up this product, see the separate volume “User’s Guide (Setup).” 
Before going on to main chapters, be sure to read “Precautions for Use.” These precautions are very 
important for using the product safely. 

Chapter 1  Precautions for Use 
This chapter describes precautions necessary to use the product safely and properly. Be 
sure to read this chapter before using the product. It also provides information on user 
support. It will be helpful when you need maintenance service, support, etc. 

Chapter 2  General Description 
This chapter describes what you should know about the product: its component names, 
functions, operating procedures as well as handling of devices and other parts. 

Chapter 3  Windows Setup and Operation 
This chapter describes setup and operation specific to the product when it is on 
Windows. 

Chapter 4  System Configuration  
This chapter describes how to make settings of built-in basic input/output system. It also 
describes factory-shipped parameters. 

Chapter 5  Installing and Using Utilities 
This chapter describes features and operating procedures of a standard utility “NEC 
EXPRESSBUILDER.” It also describes procedures to install and operate various 
software programs contained in its CD-ROM. 

Chapter 6  Maintenance 
This chapter describes maintenance procedures and use of maintenance tools. If you 
need to move the product for maintenance purposes, follow the steps provided in this 
chapter. 

Chapter 7  Troubleshooting 
If the product does not work properly, see this chapter before deciding that it is a 
breakdown. 

Chapter 8  System Upgrade 
This chapter describes procedures to add options and precautions. See also this chapter 
when you replace failed components. 

Appendix A  Specifications 
This appendix lists specifications of the product. 

Appendix B  I/O Port Addresses 
This appendix lists factory-assigned I/O port addresses. 
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Additional symbols 

The following symbols are used throughout this User's Guide in addition to the caution symbols 
describe at the beginning.  

IMPORTANT:  Important points or instructions to keep in mind when using the 
server or software 

CHECK: Something you need to make sure when using the server of 
software 

TIPS:  Helpful information, something useful to know 

 
 

Accessories 

This product is shipped with various accessories. See the attached list to make sure everything is 
included and check the individual items. If some component is missing or damaged, contact your 
sales agent. 

� Keep the accessories in a safe place. You will need them when you perform setup, 
addition of options, or replacement of failed components. 

� To check NEC EXPRESSBUILDER components, see the attached list. 

� Be sure to fill out and mail the software registration card that is attached to your operating 
system. 

� Make backup copies of included floppy disks, if any. Keep the original disks as the master 
disks; use these copies in operation. 

� Improper use of an included floppy disk or CD-ROM may alter your system environment. 
If you find something unclear, stop using them and contact your sales agent. 



iv 

 

(This page is intentionally left blank.) 
 

 

 



v 

CONTENTS 

PREFACE......................................................................................................................................... i 
ABOUT THIS USER'S GUIDE ......................................................................................................ii 

Chapter 1  Precautions for Use..................................................................................... 1-1 

WARNING LABELS ...................................................................................................................1-2 
Tower Model ............................................................................................................................1-2 
Rack-mount Model...................................................................................................................1-4 
PCI/CPU Modules....................................................................................................................1-6 

PRECAUTIONS FOR SAFETY..................................................................................................1-7 
General .....................................................................................................................................1-7 
Use of Power Supply and Power Cord .....................................................................................1-8 
Installation, Relocation, Storage and Connection.....................................................................1-9 
Cleaning and Handling of Internal Devices ...........................................................................1-11 
During Operation ...................................................................................................................1-12 
Rack-mount Model.................................................................................................................1-13 
For Proper Operation..............................................................................................................1-14 

TRANSFER TO THIRD PARTY ...............................................................................................1-16 
DISPOSAL OF EQUIPMENT AND CONSUMABLES ...........................................................1-17 
IF SYSTEM TROUBLE IS SUSPECTED.................................................................................1-18 
ABOUT REPAIR PARTS...........................................................................................................1-18 

Chapter 2  General Description .................................................................................... 2-1 

STANDARD FEATURES ............................................................................................................2-2 
NOTES .........................................................................................................................................2-6 

Notes on System Environment and Settings.............................................................................2-6 
Notes on Operations and Manipulations ................................................................................2-10 

HOW THE OPERATING SYSTEM SEES THE CPU MODULES...........................................2-13 
How CPU modules appear on Device Manager.....................................................................2-13 
How CPU modules appear on Task Manager.........................................................................2-13 

NAMES AND FUNCTIONS OF COMPONENTS....................................................................2-14 
Front View..............................................................................................................................2-14 
Front View (inside).................................................................................................................2-16 
CD-ROM Drive......................................................................................................................2-17 
Rear View...............................................................................................................................2-18 
CPU Module...........................................................................................................................2-20 
PCI Module ............................................................................................................................2-22 
Chassis Board Layout.............................................................................................................2-23 
LEDs ......................................................................................................................................2-24 

BASIC OPERATION .................................................................................................................2-35 
Locking and Unlocking the Front Bezel ................................................................................2-35 
Power ON...............................................................................................................................2-37 
Power OFF .............................................................................................................................2-38 
POST Check...........................................................................................................................2-39 
Floppy Disk Drive..................................................................................................................2-42 
CD-ROM Drive......................................................................................................................2-45 

Chapter 3  Windows Setup and Operation .................................................................. 3-1 



vi 

DISK OPERATIONS................................................................................................................... 3-2 
Disks Operations Using Disk Management............................................................................. 3-3 
Disk Operations Using the RDR (Rapid Disk Resync) Function .......................................... 3-15 
Replacing Failed Hard Disk Drives....................................................................................... 3-29 

CHANGE DRIVE LETTER...................................................................................................... 3-39 
DUAL LAN CONFIGURATION .............................................................................................. 3-40 

Overview ............................................................................................................................... 3-40 
Configuring dual LAN........................................................................................................... 3-40 
Removing dual LAN ............................................................................................................. 3-43 

CHECK THE DUPLICATING OPERATION OF MODULES................................................. 3-46 
Evaluate Startup and Stop of PCI Modules ........................................................................... 3-46 
Evaluate Start and Stop of CPU Modules.............................................................................. 3-49 

NEC Express5800/ft series SERVICE PROGRAM CONFIGURATION ................................. 3-51 

Chapter 4  System Configuration ................................................................................. 4-1 

SYSTEM BIOS ~ SETUP ~ ........................................................................................................ 4-2 
Starting SETUP Utility ............................................................................................................ 4-3 
Description of On-Screen Items and Key Usage ..................................................................... 4-4 
Configuration Examples .......................................................................................................... 4-5 
Menu and Parameter Descriptions........................................................................................... 4-8 

SCSI BIOS ∼ Fast!UTIL ∼ ........................................................................................................ 4-29 
Start ....................................................................................................................................... 4-29 
Configuration Settings........................................................................................................... 4-32 
Scan SCSI Bus....................................................................................................................... 4-36 
SCSI Disk Utility................................................................................................................... 4-36 
Select Host Adapter ............................................................................................................... 4-36 
Exit Fast!UTIL ∼ Termination and Storage of Fast!UTIL ∼ ................................................. 4-37 
Setting List for Optional SCSI Device .................................................................................. 4-37 

FORCED SHUTDOWN AND CLEAR..................................................................................... 4-38 
Forced Shutdown................................................................................................................... 4-38 
Clear CMOS / Password (Configuring Motherboard Jumpers)............................................. 4-39 

Chapter 5  Installing and Using Utilities....................................................................... 5-1 

NEC EXPRESSBUILDER .......................................................................................................... 5-2 
Start Menu ............................................................................................................................... 5-2 
NEC EXPRESSBUILDER Top Menu .................................................................................... 5-4 
Consoleless Menu.................................................................................................................... 5-8 
Master Control Menu ............................................................................................................ 5-10 

NEC ESMPRO Agent and Manager ...........................................................................................5-11 
Overview ................................................................................................................................5-11 
NEC ESMPRO Agent............................................................................................................ 5-18 
NEC ESMPRO Manager ....................................................................................................... 5-28 
Maintenance of NEC Express5800/ft series .......................................................................... 5-45 

NEC MWA ∼ MANAGEMENT WORKSTATION APPLICATION ∼ ..................................... 5-75 
Servers to be remotely managed by NEC MWA ................................................................... 5-75 
Remote Management Configuration for the Server without Console.................................... 5-75 

 



vii 

Chapter 6  Maintenance................................................................................................. 6-1 

DAILY MAINTENANCE ............................................................................................................6-2 
Checking Alert .........................................................................................................................6-2 
Checking STATUS LEDs and LCD Display............................................................................6-2 
Making Backup Copies ............................................................................................................6-3 
Cleaning ...................................................................................................................................6-3 

SYSTEM DIAGNOSTICS...........................................................................................................6-7 
Test Items .................................................................................................................................6-7 
Startup and Exit of System Diagnosis ......................................................................................6-7 

OFF-LINE MAINTENANCE UTILITY......................................................................................6-9 
Starting the Off-line Maintenance Utility.................................................................................6-9 
Features of Off-line Maintenance Utility .................................................................................6-9 

RELOCATING/STORING THE NEC Express5800/ft series ....................................................6-11 

Chapter 7  Troubleshooting .......................................................................................... 7-1 

TO LOCATE THE ERRORS........................................................................................................7-2 
ERROR MESSAGES ...................................................................................................................7-3 

Error Messages by LED Indication ..........................................................................................7-3 
Error Messages on the Liquid Crystal Display (LCD) .............................................................7-3 
POST Error Messages ............................................................................................................7-14 
Error Notification by BEEP ...................................................................................................7-20 
Windows Server 2003, Enterprise Edition Error Messages....................................................7-21 
Server Management Application Error Message....................................................................7-22 

SOLVING PROBLEMS.............................................................................................................7-23 
Problems with NEC Express5800/ft series.............................................................................7-23 
Event Log...............................................................................................................................7-34 
Problems with NEC EXPRESSBUILDER ............................................................................7-37 
Problems with Master Control Menu .....................................................................................7-38 
Problems with NEC ESMPRO...............................................................................................7-39 

COLLECTION OF TROUBLE LOGS ......................................................................................7-40 
Collection of Event Logs........................................................................................................7-40 
Collection of Configuration Information................................................................................7-41 
Collection of Diagnostic Information by Dr. Watson .............................................................7-41 

COLLECTION OF THE MEMORY DUMP .............................................................................7-42 

Chapter 8  System Upgrade .......................................................................................... 8-1 

SAFETY PRECAUTIONS...........................................................................................................8-2 
ANTI-STATIC MEASURES........................................................................................................8-3 
PREPARING YOUR SYSTEM FOR UPGRADE .......................................................................8-4 
3.5-INCH HARD DISK DRIVE ..................................................................................................8-5 

Installing 3.5-inch Hard Disk Drive .........................................................................................8-7 
Removing 3.5-inch Hard Disk Drive........................................................................................8-9 
Replacing 3.5-inch Hard Disk Drive ......................................................................................8-10 

CPU MODULE ..........................................................................................................................8-11 
Removing CPU Module .........................................................................................................8-12 
Installing CPU Module...........................................................................................................8-14 

DIMM.........................................................................................................................................8-16 
Installing DIMM ....................................................................................................................8-18 
Removing DIMM...................................................................................................................8-19 



viii 

Replacing DIMM................................................................................................................... 8-20 
PROCESSOR (CPU) ................................................................................................................. 8-21 

Installation ............................................................................................................................. 8-22 
Removing CPU...................................................................................................................... 8-25 
Replacing CPU ...................................................................................................................... 8-26 

PCI MODULE ........................................................................................................................... 8-27 
Precautions ............................................................................................................................ 8-28 
Removing PCI Module.......................................................................................................... 8-29 
Installing PCI Module ........................................................................................................... 8-31 

PCI BOARD .............................................................................................................................. 8-33 
Installing PCI Board .............................................................................................................. 8-34 
Removing PCI Board ............................................................................................................ 8-39 
Replacing PCI Board............................................................................................................. 8-40 
Setup of Optional PCI Board................................................................................................. 8-41 

Appendix A  Specifications .......................................................................................... A-1 

Appendix B  I/O Port Addresses .................................................................................. B-1 

 
 



 

Chapter 1 

Precautions for Use 

This chapter includes information necessary for proper and safe operation of the server. 
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WARNING LABELS 
Warning labels are placed in certain parts of the system so that the user stays alert to possible risks 
(Do not remove or damage these labels). 

If some label is missing, about to peel off, or illegible, contact your sales agent. 

 

Tower Model  

The figures below show locations of the labels on the tower model server. 

Label A
Label B 

Label D Label E 

Label C 
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Rack-mount Model 

The figures below show locations of the labels on the rack-mount model server. 
 

  

Label C 

Label B Label B 

Label C 

Label E Label D 

Label A
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PCI/CPU Modules 

 
PCI Module 
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CPU Module 
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Label A 
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PRECAUTIONS FOR SAFETY 
This section provides precautions for using the server safely. Read this section carefully to ensure 
proper and safe use of the server. For symbol meanings, see "SAFETY INDICATIONS" described 
in the previous section. 

 

General 

WARNING  
  

 
Do not use the equipment in an operation where human lives are involved or 
high reliability is required. 

  
 This equipment is not intended for use in controlling or use with facilities or 

systems where human lives are involved or high reliability is required, including 
medical devices or nuclear, aerospace, transportation, and traffic control 
facilities. NEC assumes no liability for any accidents or damage to physical 
assets resulting from the use of this equipment in such systems or facilities. 

  
Do not continue to use the equipment if you detect smoke, odor, or noise. 
  If the equipment emits smoke, odor, or noise, immediately flip off the POWER 
switch, unplug the cord, and contact your sales agent. There is a risk of a fire. 

  
Do not insert a wire or metal object 
  Do not insert a wire or metal objects into a vent or disk drive slot. There is a risk 
of an electric shock. 

  
Do not use the equipment in an unsuitable place. 
  Do not install a server rack in an unsuitable environment. 
Other systems also may be affected, and the rack may fall over to cause a fire 
or injuries. For details about installation environment and quake-resistant 
engineering, see the attached manual or contact your sales agent. 

  
 

CAUTION  
  

Prevent water or foreign objects from getting into the equipment. 
  

 
Do not let water or foreign objects (e.g., pins or paper clips) enter the 
equipment. There is a risk of a fire, electric shock, and breakdown. When such 
things accidentally enter the equipment, immediately turn off the power and 
unplug the cord. Contact your sales agent instead of trying to disassemble it 
yourself. 
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Use of Power Supply and Power Cord 

WARNING  
  

Do not handle a power plug with a wet hand. 
  Do not plug/unplug a power cord with a wet hand. There is a risk of an electric 
shock. 

  
Do not connect the ground wire to a gas pipe. 
  Never connect the ground wire to a gas pipe. There is a risk of a gas explosion. 

  
 

CAUTION  
  

Do not plug the cord in a nonconforming outlet. 
  

 

 

Use a wall outlet with specified voltage and power type. There is a risk of a fire 
or current leakage. 
Avoid installing the equipment where you may need an extension cord. If the 
cord that does not meet the power specifications, there is a risk of overheating 
that could lead to a fire. 

  
Do not plug too many cords in a single outlet. 
  If the rated current is exceeded, there is a risk of overheating that could lead to 
a fire. 

  
Do not plug the cord insecurely. 
  Insert the plug firmly into an outlet. There is a risk of heat or fire due to poor 
contact. If dust settles on the slots and it absorbs moisture, there is also a risk 
f heat or fire.  o

  
Do not use nonconforming power cords. 
  

 

Use the power cords specified by NEC. If the rated current is exceeded, there is 
a risk of a fire. 
You also have to observe the following prohibitions to prevent an electric shock 
and a fire caused by damages of the cords. 
� Do not pull on the cord. 
� Do not pinch the cord. 
� Do not bend the cord. 
� Keep chemicals away from the cord. 
� Do not twist the cord. 
� Do not tread on the cord. 
� Do not place any object on the cord. 
� Do not use cords as bundled. 
� Do not alter, modify, or repair the cord. 
� Do not staple the cord. 
� Do not use any damaged cord. (Replace it with a new one of the same 

specifications. For replacement procedures, contact your sales agent.) 
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Installation, Relocation, Storage and Connection 

 
WARNING  

  
Disconnect the power cord(s) before installing or removing the equipment. 
  
Be sure to power off the equipment and unplug its power cords from the wall 
outlet before installation/relocation. All voltage is removed only when the power 
cords are unplugged. 

  
 

 CAUTION  
  

Do not hold the front bezel to lift the equipment. 
  
The equipment weighs around 70 kg (depending on its hardware configuration). 
Do not hold the front bezel, or it may become detached, causing an injury. For 
lifting and moving the equipment, remove the mounted modules from the main 
unit and carry them separately. It takes at least two people to carry it; hold the 
equipment firmly by its bottom.  

  
Do not install or store the equipment in an unsuitable place. 
  
Install or store the equipment in such a place as specified in this User's Guide. 
Avoid the following, or there is a risk of a fire. 
� a dusty place 
� a humid place located near a boiler, etc 
� a place exposed to direct sunlight 
� an unstable place 

  
Be careful not to hurt your fingers. 
 

 

Exercise great care not to hurt your fingers on the rail when you 
mount/dismount the equipment into/from the rack. 

  
Do not use or store this product in corrosive environment. 
  Avoid the usage or storage of this product in an environment which may be 
exposed to corrosive gases, such as those including but not limited to : 
sulfur dioxide, hydrogen sulfide, nitrogen dioxide, chlorine, ammonia and/or 
ozone. 
Avoid installing this product in a dusty environment or one that may be exposed 
to corrosive materials such as sodium chloride and/or sulfur. 
Avoid installing this product in an environment which may have excessive metal 
flakes or conductive particles in the air. 
Such environments may cause corrosion or short circuits within this product, 
resulting in not only damage to this product, but may even lead to be a fire 
hazard. 
If there are any concerns regarding the environment at the planned site of 
installation or storage, please contact your sales agent� 
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CAUTION  
  

Do not connect any interface cable with the power cord of the server plugged to 
a power source. 
 

 

 Make sure to power off the server and unplug the power cord from a power 
outlet before installing/removing any optional internal device or 
connecting/disconnecting any interface cable to/from the server. If the server is 
off-powered but its power cord is plugged to a power source, touching an 
internal device, cable, or connector may cause an electric shock or a fire 
resulted from a short circuit. 

  
Do not use any non-designated interface cable. 
  
Use only interface cables designated by NEC; identify which component or 
connector to attach beforehand. If you use a wrong cable or make a wrong 
connection, there is a risk of short-circuit that could lead to a fire. 
You also have to observe the following prohibitions about handling and 
connecting interface cables: 
� Do not use any damaged cable connector. 
� Do not step on the cable. 
� Do not place any object on the cable. 
� Do not use the equipment with loose cable connections. 
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Cleaning and Handling of Internal Devices 

WARNING  
  

Do not disassemble, repair, or alter the server. 
  

 

 

Unless described herein, never attempt to disassemble, repair, or alter the 
equipment. There is a risk of an electric shock or fire as well as malfunction. 

  
Do not look into the CD-ROM drive. 
  

 
The CD-ROM drive uses a laser beam. Do not look or insert a mirror inside 
while the system is on. A laser beam is invisible; if your eyes get exposed to it, 
there is a risk of losing eyesight. 

  
Do not detach a lithium battery yourself. 
 
This equipment has a lithium battery. Do not detach it yourself. If the battery is 
exposed to fire or water, it could explode. 
 

 

When the lithium battery is running down and the equipment does not work 
correctly, contact your sales agent instead of disassembling, replacing or 
recharging it yourself. 

  
Disconnect the power plug before cleaning the server.  
 
Make sure to power off the server and disconnect the power plug from a power 
outlet before cleaning or installing/removing internal optional devices. Touching 
any internal device of the server with its power cord connected to a power 
source may cause an electric shock even of the server is off-powered. 
 

 

Disconnect the power plug from the outlet occasionally and clean the plug with 
a dry cloth. Heat will be generated if condensation is formed on a dusty plug, 
which may cause a fire. 

  
 
 

CAUTION  
  

High temperature 
  
Immediately after powering off the system, system components such as hard 
disk may be very hot. Wait for the server to cool down completely before 
adding/removing components. 

  
Make sure to complete installation. 
  
Firmly install all power cords, interface cables and/or boards. An incompletely 
installed component may cause a contact failure, resulting in fire and/or smoke. 
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CAUTION  
  

Protect the unused connectors with the protective cap. 
 

 
The unused power cord connectors are covered with the protective cap to 
prevent short circuits and electrical hazards. When removing the power cord 
connector from the internal devices, attach the protective cap to the connector. 
Failure to follow this warning may cause a fire or an electric shock. 

  
 
 
During Operation 

CAUTION  
  

Do not pull out a device during operation. 
  
Do not pull out or remove a device while it works. There is a risk of malfunction 
and injuries. 

  
Do not touch the equipment when it thunders. 
  
Unplug the equipment when it threatens to thunder. If it starts to thunder before 
you unplug the equipment, do not touch the equipment and cables. There is a 
risk of a fire or electric shock. 

  
Keep animals away. 
  

 
Animal’s waste or hair may get inside the equipment to cause a fire or electric 
shock. 

  
Do not place any object on top of the server. 
  
The object may fall off to cause injuries, damage to hardware and/or a fire. 

  
Do not leave the CD tray ejected. 
  
Dust may get in the equipment to cause malfunction. The ejected tray may also 
become a cause of injuries. 

  
Do not use a cellular phone or pager around the equipment. 
  
Turn off your cellular phone or pager when you use the equipment. Their radio 
waves may cause the equipment to malfunction. 

  
 
 

 



Precautions for Use  1-13 

Rack-mount Model 

CAUTION  
  

Do not install the equipment on a nonconforming rack. 
  Install the equipment on a 19-inch rack confirming to the EIA standard. Do not 
use the equipment without a rack or install it on a nonconforming rack. The 
equipment may not function properly, and there is a risk of damage to physical 
assets or injuries. For suitable racks, contact your sales agent. 

  
Do not attempt to install the server yourself. 
  
To avoid a risk of injuries, users should not attempt to install the equipment into 
a rack. Installation should be performed by trained maintenance personnel. 

  
< For Maintenance Personnel Only > 

Do not remove and carry the equipment with modules mounted. 
  
When you remove this product from the rack and carry it, remove all modules 
that are mounted first.  

  
Do not install the equipment in such a manner that its weight is imposed on a 
single place. 
 

 

To distribute the weight, attach stabilizers or install two or more racks. It may 
fall down to cause injuries. 

  
Do not assemble parts alone. 
  
It takes at least two people to mount doors and trays to a rack. You may drop 
some parts to cause a breakage or injuries. 

  
Do not pull a device out of the rack if it is unstable. 
  
Before pulling out a device, make sure that the rack is fixed (by stabilizers or 
quake-resistant engineering). 

  
Do not leave two or more devices pulled out from the rack. 
  
If you pull out two or more devices the rack may fall down. You can only pull out 
one device at a time. 

  
Do not install excessive wiring. 
  
To prevent burns, fires, and damage to the equipment, make sure that the rated 
load of the power branch circuit is not exceeded. For more information on 
installation and wiring of power-related facilities, contact your electrician or local 
power company. 
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For Proper Operation 

Observe the following instructions for successful operation of the server. Failure to observe them 
could lead to malfunction or breakdown. 

� Perform installation in a place where the system can operate correctly. For details, see the 
separate volume “User’s Guide (Setup)”. 

� Before turning off the power or ejecting a disk, make sure that the access LED is off. 

� When you have just turned off the power, wait at least 30 seconds before turning it on again. 

� Once you have turned on the server, do not turn it off until the "NEC" logo appears on the 
screen. 

� Before you move the equipment, turn off the power and unplug the cord. 

� This server shall not assure reproduction of copy-protect CDs using reproduction equipment 
if such disks do not comply with CD standards. 

� Clean the equipment regularly. (For procedures, see Chapter 6.) Regular cleaning is effective 
in preventing various types of trouble. 

� Lightning may cause voltage sag. As a preventive measure, it is recommended to use UPS 
(uninterruptible power supply). 

This equipment does not support the connection through an UPS serial port (RS-232C) or the 
control using PowerChutePlus. 

� Check and adjust the system clock before operation in the following conditions:  

- After transporting the equipment 
- After storing the equipment 
- After the equipment halt under the conditions which is out of the guranteed 

environment conditions (Temperature: 10 to 35°C, Humidity: 20 to 80%). 
Check the system clock once in a month. It is recommended to operate the system clock using 
a time server (NTP server) if it is installed on the system which requires high level of time 
accuracy. If the system clock goes out of alignment remarkably as time goes by, though the 
system clock adjustment is performed, contact your sales agent. 

 
� When you store the equipment, keep it under storage environment conditions (Temperature: 

-10 to 55°C, Humidity: 20 to 80%, non-condensing). 

� If NEC Express5800/ft series, the built-in optional devices, and the media set for the backup 
devices (tape cartridges) are moved from a cold place to a warm place in a short time, 
condensation will occur and cause malfunctions and breakdown when these are used in such 
state. In order to protect important stored data and assets, make sure to wait for a sufficient 
period of time to use the server or components in the operating environment. 

       Reference: Length of the time effective at avoiding condensation in winter (more than 10°C 
differences between room temperature and atmospheric temperature)  

                          Disk devices: Approximately 2-3 hours 
                          Tape media: Approximately 1 day 

� Make sure that the optional devices are attachable and connectable to the equipment. There is 
a risk of malfunctions that could lead to a breakdown of the equipment even if you could 
attach and connect. 
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� Make sure that your options are compatible with the system. If you attach any incompatible 
option, there is a risk of malfunction that could lead to a breakdown. 

� It is recommended to use NEC's genuine option products. Some competitors’ products are 
compatible with this server. However, servicing for trouble or damage resulting from such a 
product will be charged even within the warranty period. 
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TRANSFER TO THIRD PARTY 
When you transfer (or sell) the product or its included items, you must observe the following: 

 

Server 

Attach this User's Guide to the server you are transferring (or selling) to a third party. 

IMPORTANT: Data remaining on hard disk: 

When you transfer your server, you are responsible for erasing important data stored on its hard 
disk (e.g., customer information, accounting information); you must be careful to prevent such 
data from leaking out to outsiders. 

Even if you perform “Empty trash” on Windows or Linux operating system or execute a “format” 
command to erase data superficially, the data actually remains on the hard disk. If data is not 
erased completely, it could be restored by certain software and be used for unexpected purposes. 

You are strongly recommended to buy a special type of software or service to avoid such trouble. 
For details, contact your sales agent. 

NEC shall not be accountable for such data leakage caused by your failure to take necessary 
measures. 

 

Included Software 

When you transfer or sell the included software to a third party, you must meet the following 
conditions: 

� Transfer all of the software included with the system. Do not retain any copies. 

� Meet the conditions of transfer described in each software license agreement. 

� Uninstall untransferable programs, if any, from the server before the transfer. 
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DISPOSAL OF EQUIPMENT AND CONSUMABLES 
� When you dispose of the main unit, hard disk drive, floppy disks, CD-ROMs, optional 

boards, etc., you need to observe your local disposal rules. For details, ask your municipal 
office. 

IMPORTANT: For disposal (or replacement) of batteries on the motherboard, consult 
with your sales agent. 

If data remains on the hard disk, backup data cartridges, floppy disks, or other writable 
media (such as CD-R and CD-RW), it could be restored and reused by outsiders. The 
customer is responsible for wiping out such data before disposal. You need to exercise 
sufficient care to protect privacy and confidential information. 

� Some of the system components have limited lifetime (e.g., cooling fans, built-in batteries, 
built-in CD-ROM drive, floppy disk drive and mouse). For stable operation, it is 
recommended to replace them regularly. For lifetime of individual components and 
replacing procedures, ask your sales agent. 

WARNING  
  

Do not detach a lithium battery yourself. 
  
This equipment has a lithium battery. Do not detach it yourself. If the battery is 
exposed to fire or water, it could explode. 

 RISK OF EXPLOSION IF BATTERY IS REPLACED WITH INCORRECT TYPE. 
DISPOSE OF USED BATTERIES ACCORDING TO THE INSTRUCTIONS. 

 When the lithium battery is running down and the equipment does not work 
correctly, contact your sales agent instead of disassembling, replacing or 
recharging it yourself. 

 

 
 PCI module board 
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IF SYSTEM TROUBLE IS SUSPECTED 
Before sending the equipment for repair, try the following: 

1. Check if its power cord and connection cables are attached correctly. 

2. See “Error Messages” in Chapter 7 to check if there is a relevant symptom. If yes, take 
measures as instructed. 

3. Certain software programs are required for operation of NEC Express5800/ft series. 
Check if these programs are properly installed. 

4. Use a commercially available anti-virus program to check the server. 

If the problem is not solved by the above actions, stop using the server and consult with your sales 
agent. In this case, check LED indications of the server and alarm indications on the display, which 
will serve as helpful information at the time of repair. 

 
ABOUT REPAIR PARTS 
The minimum duration of holding repair parts of this equipment may be different for each country, 
so contact the NEC sales representatives.   
If the period is not specified, the repair parts are kept for 5 years after discontinuance of the product.   
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Advice for Your Health 
 
Prolonged use of a computer may affect your health. Keep in mind the 
following to reduce stresses on your body: 

 

  
Sit in a good posture  
Sit on your chair with your back straight. If the desk height is appropriate, 
you will slightly look down at the screen and your forearms will be parallel to 
the floor. This “good” work posture can minimize muscle tension caused by 
sedentary work. 
If you sit in a “bad” posture—for example, sit round-shouldered or with you 
face too close to the display—you may easily suffer fatigue or have your 
eyesight affected. 

 

  
Adjust the installation angle of Display  
Most types of displays allow you to adjust the angle vertically and 
horizontally. This adjustment is very important to prevent the reflection of 
light as well as to make the screen more comfortable to see. Without this 
adjustment, it is difficult to maintain a “good” work posture and may get tired 
soon. Be sure to adjust the angle before using the display. 

 

  
Adjust Brightness and Contrast 
Displays allow you to adjust brightness and contrast. Optimum brightness 
and contrast vary depending on the individual, age, brightness of the room, 
etc; you need to make an adjustment accordingly. If the screen is too bright 
or too dark, it is bad for your eyes. 

 
  
Adjust the installation angle of Keyboard  
Some types of keyboards allow you to adjust the angle. If you adjust the 
angle to make the keyboard more comfortable to use, you can greatly 
reduce stresses on your shoulders, arms, and fingers. 

 
Clean the Equipment  
Cleanliness of the equipment is very important not only for reasons of 
appearance but also from the viewpoints of function and safety. Especially, 
you need to regularly clean the display, which gets unclear due to the 
accumulation of dirt. 

 

  
Take a break when you get tired 
If you feel tired, you are recommended to refresh yourself by taking a short 
break or doing a light exercise. 
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Chapter 2 

General Description 

This chapter describes what you need to know to use the NEC Express5800/ft series. Refer to this 
chapter when you want to know about certain components and how to operate them. 
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STANDARD FEATURES 
High performance  
� Intel® Xeon ™ Processor (2.4GHz/2.8 

GHz) 
� High-speed Ethernet interface 

(1000Mbps/100Mbps/10Mbps supported) 
� High-speed disk access (Ultra160 SCSI 

Wide) 

Expandability 
� Wide variety of optional I/O slots 

Four 64-bit/33 MHz, two 32-bit/33 MHz 
PCI slots 

� Large memory of up to 6GB 
� Remote power-on feature 
� USB interface 

 

  
High-reliability Various Features 

� Graphic accelerator "CT69000" 
supported 

� El Torito Bootable CD-ROM (no 
emulation mode) format supported 

� POWER switch mask 
� Remote power-on feature 
� AC-LINK feature 
� Consoleless feature 

 
Self-diagnosis 

� Memory monitoring feature (1-bit error 
correction/ 2-bit error detection) 

� Bus parity error detection 
� Temperature monitoring 
� Error notification 
� Built-in fan monitoring feature 
� Internal voltage monitoring feature 
� BIOS password feature 
� Security feature (security lock for front 

bezel) 
� Power On Self-Test (POST) 
� Test and Diagnosis (T&D) Utility 

  
Management Utilities Maintainability 
� NEC ESMPRO 
� NEC Management Workstation 

Application (NEC MWA) 

� Off-line Maintenance Utility 

Ready-to-use Easy and Fine Setup 
� Quick cableless connection: hard disk, 

CPU module, and PCI module (hot-swap 
supported) 
 

� NEC EXPRESSBUILDER (system setup 
utility) 

� SETUP (BIOS setup utility) 
� Fast!UTIL (SCSI device utility) 

Fault-tolerant Feature  
� Redundant modules achieved within a 

system 
� Higher hardware availability by isolation 

of failed module 
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The NEC Express5800/ft series achieves fault-tolerant high-availability in a space-saving form 
factor by incorporating redundant hardware module pairs in a single chassis. These modules work in 
synchronous tight lockstep while constantly making comparisons with each other and detecting 
anomalous diversions in operation. 

 

 

Mirrored 

Memory Compare/Sync
Memory

CPU Module #1 
CPU Module #2 

PCI Module #1  PCI Module #2 

Mirror 

Windows software programs 

New fault-tolerant technology Standard product 

Even if one hardware module stops, the server can continue operation with the other module. After the failed 
module is replaced, the new module will obtain information from the other and resume operation. 

 
NEC Express5800/ft series is a highly fault-tolerant Windows server that achieves continuous 
computing operations, data storage mirror, and continuous network connection. It allows you to run 
Windows Server 2003-based applications. 

NEC Express5800/ft series achieves continuous computing operations for the Windows server and 
server-based applications with its redundant CPU processing and redundant memory. It assures data 
redundancy through duplication of server data on an independent storage system. These features 
eliminate server downtime that is usually caused by network disconnection or trouble with the I/O 
controller, Ethernet adapter or disk drive, and support operation of the network and server 
applications continuously. While being transparent to application software, NEC Express5800/ft 
series achieves high fault-tolerance. 

NEC Express5800/ft series detects status changes, errors and other events and notifies the Windows 
Event Log of these events. If you use an alarm notification tool, you can configure NEC 
Express5800/ft series to notify you when certain events occur. 

NEC ESMPRO is installed on the system as a server management solution. NEC ESMPRO, a 
GUI-based management tool, allows you to monitor, view, and configure NEC Express5800/ft 
series. This tool also supports both local and remote management of NEC Express5800/ft series. 
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NEC Express5800/ft series mainly provides the following advantages: 

� Highly fault-tolerant processing and I/O subsystems 

NEC Express5800/ft series use redundant hardware and software to assure server 
operation even if one module suffers trouble with its processor, memory, I/O (including 
trouble related to the I/O controller), disk drive, or Ethernet adapter. 

� Continuous network connection 

NEC Express5800/ft series maintains continuous network connection by detecting any 
trouble with the network adapter, connection, etc. If trouble occurs, the standby network 
connection will take over all network traffic processing and thus securely maintain the 
network system connection of NEC Express5800/ft series without losing network traffic 
or client connection. 

� Support of multiple network connections 

Since NEC Express5800/ft series can support multiple Ethernet connections, you can add 
network redundant control or network traffic control. 

� Industry standard hardware platform 

NEC Express5800/ft series uses IA (Intel Architecture)-based system hardware. 

� No need to modify applications 

You can run Windows Server 2003-compliant applications on NEC Express5800/ft series. 
Thus, unlike other highly fault-tolerant products, special API or scripts are not necessary. 

� Automatic mirroring 

NEC Express5800/ft series automatically maintains data as the current data. 

� Automatic detection and notification of faults 

NEC Express5800/ft series detects and sorts out all events such as general status changes 
and faults, and notifies Windows Event Log of these events. 

� Transparent migration 

NEC Express5800/ft series constantly monitors events. If trouble occurs on NEC 
Express5800/ft series’ server module, it will transparently use a redundant module of the 
failed module. This feature maintains data and user access without losing application 
service.  

� Automatic reconfiguration 

When the failed module restarts after the trouble is corrected, NEC Express5800/ft series 
will perform reconfiguration automatically, and if necessary, resynchronize the affected 
modules. Reconfiguration can include CPU processing (e.g., CPU memory), server's 
operating system (and related applications), and system data stored on the hard disks. In 
most cases, NEC Express5800/ft series automatically restores redundancy of the server 
modules after recovery. 
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� Local and remote management 

NEC Express5800/ft series uses NEC ESMPRO as a server management tool. This tool 
uses a GUI that enables monitoring and setting of NEC Express5800/ft series. NEC 
ESMPRO can be used both locally and remotely on workstation PCs or server PCs.  

� Event notification function 

When trouble or other events are detected on NEC Express5800/ft series, they will be 
notified to Windows Event Log and saved. Therefore, you can view the log items locally 
or remotely by a usual Windows procedure. Since an NEC Express5800/ft series events 
use unique IDs, they are easy to distinguish.  

� In-service repairing 

You can repair or replace a failed module even if NEC Express5800/ft series is operating. 

� Partition structure 

On this product, the first logical drive will be in the following state when the setup by 
NEC EXPRESSBUILDER is complete:   

 

 

 

 

 

* The size varies depending on the specification at setup. 
 

CHECK: The partition for operating system is not mirrored at the time of NEC 
EXPRESSBUILDER setup completion. Mirror the partition separately.  

 

Partition for operating system (*)

Free area (*) 

� Windows OS and media 

The Windows OS media used on NEC Express5800/ft series are not specifically processed 
for it. The standard operating methods of Windows are same as general. 
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NOTES 

Notes on System Environment and Settings 

 
Do not use the “Auto Detect” function for the transfer rate setting of LAN controller 
on the OS.  

� Fix the transfer rate of the LAN controller to the transfer rate of hub. 

→ NEC Express5800/ft series is not recognized on the network. For details, see “The 
server is not found on the network:” of “Problems with NEC Express5800/ft 
series” in “SOLVING PROBLEMS” in Chapter 7 “Troubleshooting” of this 
User’s Guide. 

 
Load Balancing mode can not be selected on the on-board LAN (100Base). 

� Load Balancing mode cannot be selected on "Stratus emb-82559 10/100 Enet 
Adapter". 

→ Only Fault Tolerance mode can be selected. 

 
Do not remove “Stratus Fault Tolerant Virtual 69000 Video” displayed on the “Safely 
Remove Hardware” dialog box. 

� Do not remove “Stratus Fault Tolerant Virtual 69000 Video” which is displayed on 
the “Safely Remove Hardware” dialog box.  

→ There is a possibility that the system does not run normally. For details, see 
“Stratus Fault Tolerant Virtual 69000 Video” is displayed on “Remove Hardware” 
dialog box:” of “Problems with NEC Express5800/ft series” in Chapter 7 
“Troubleshooting”. 
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Change the setting of monitor hardware acceleration to “None”. 
� Do not use the hardware acceleration. 

→ If hardware acceleration is set to “Full”, the following error occurs.  
Be sure to set “None” for hardware acceleration.  

• The screen becomes dark and nothing is displayed when a PCI module failed over 
(either the primary PCI module was stopped with ft server utility or when the 
primary PCI module failed). 

• When a PCI module is mounted, the following error is displayed in the event log 
and the PCI module is not duplicated.  

Source: srabid 
ID: 16487 
Description: The reason IoBoard XX has gone broken is N2sDeadmanTimer. 

(XX is the device number of the PCI module) 

• The mouse is less responsive and it takes time to draw graphics. For details, see 
“Mouse Does Not Move Smoothly, And Drawing Graphics Takes Time:” of 
“Problems with NEC Express5800/ft series” in “SOLVING PROBLEMS” in 
Chapter 7 “Troubleshooting”. 

 
Caution about allocating a drive letter for the CD-ROM device 

� Specifying “D” to the drive letter for the CD-ROM device is recommended. 

→ The assigned drive letter may be changed after the system is restarted. 

 
Remove the USB-FDD which was shipped with the server after performing “Safely 
Remove Hardware”. 

� Do not remove USB FDD without performing “Safely Remove Hardware”. 

→ You may not be able to use the keyboard or mouse. In that case, disconnect the 
keyboard from the USB connector and then reconnect it. 

 
For PCI board, only use supported N-code products. 

� If a product which is not supported is used, it does not function properly. 

 
Peripheral devices cannot be connected to the serial port. 

� The serial port cannot be used. It is only used for certain maintenance operations. 

→ If a peripheral device such as UPS is connected, the system operation becomes 
unstable. 
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Unsupported USB device cannot be connected. 
� Do not connect peripheral devices other than NEC-specified keyboard, mouse, 

server switch unit, and USB-FDD which were shipped with the server to the USB 
connector.  

→ If unsupported USB device is connected, the system operation may become 
unstable. 

 
Disk Failure Prediction (S.M.A.R.T) is not supported. 

� NEC Express5800/ft series does not support Disk Failure Prediction (S.M.A.R.T). 

→ Do not enable Disk Failure Prediction (S.M.A.R.T.) on the window which appears 
when starting ft server utility of NEC ESMPRO Agent. 
If this setting is done, the setting seems to be made, but it does not actually work. 
Ignore the display. 

 
 
About applying Windows Service Pack 

� Do not apply Service Packs to NEC Express5800/ft series judging by yourself. 

→ For applying Windows Service Pack to NEC Express5800/ft series, a module 
other than the Windows Service Pack medium is required. If you need to apply 
Windows Service Pack, ask its application status to your sales agent. 
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About Windows Update function 
� The Automatic Updates service of Windows Update is disabled. 

→ The Automatic Updates service of Windows Update is disabled on NEC 
Express5800/ft series in the initial status after performing “ft series Setup”.  
To enable it, carefully read “About Windows Update (Applying Security Patches)” 
in Chapter 5 “Procedures after Completion of Installation” in User’s Guide 
(Setup), and change “Startup Type” of “Automatic Updates” from the Start menu - 
“Administrative Tools” - “Services” to Automatic or Manual, and then start the 
service. 

� When updating Windows modules using the Windows Update function, be sure to 
check the contents of update. 

→ Contact NEC sales company about the evaluation status of security patches or 
QFE. 
You must contact NEC sales company about updating the OS. 
For details, see “About Windows Update (Applying Security Patches)” in Chapter 
5 “Procedures after Completion of Installation” of User’s Guide (Setup). 

 
About Automatic System Recovery (ASR) of NtBackup 

� The ASR function cannot be used on NEC Express5800/ft series.  

 
Cautions about Windows Server 2003 Recovery Console 

� Windows Server 2003 Recovery Console cannot update files on the hard disk in the 
system where the system disk is a dynamic disk. 

→ To use Recovery Console in the system where the system disk is a dynamic disk, 
specify “Local Security Policy” on Windows Server 2003 in advance, and specify 
an environment variable “AllowRemovableMedia” on Recovery Console when 
using Recovery Console. For details, see “Cautions for using the Windows Server 
2003 Recovery Console” of “System Repair” in Chapter 6 
“TROUBLESHOOTING” of User’s Guide (Setup).  

� For using Windows Server 2003 Recovery Console in the system where disks are 
duplicated using RDR (Rapid Disk Resync) function, remove one of the PCI 
modules and then use Windows Server 2003 Recovery Console.  

→ If Windows Server 2003 Recovery Console is used with two PCI modules 
mounted, OS stop error may occur after using Recovery Console. For details, see 
“Starting up Recovery Console” of “System Repair” in Chapter 6 
“TROUBLESHOOTING” of User’s Guide (Setup). 
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Notes on Operations and Manipulations 

 
Do not power off the switch while starting the server. 

� After powering on the server, do not power it off during the startup. 

→ There is a possibility that it will not start up properly when you try to start the 
server next time. Do not shut it down until the OS is started and the duplication 
process is completed. 

 
Do not use the keyboard or mouse right after startup. 

� Do not use the keyboard or mouse right after startup. 

→ POST will not be completed. Details are described in “POST fails to complete:” of 
“Problems with NEC Express5800/ft series” of “SOLVING PROBLEMS” in 
Chapter 7 “Troubleshooting” in this User’s Guide. See “□ Did you perform any 
keyboard or mouse operation immediately after you started the server?”  

 
Do not start NEC Express5800/ft series while BMC status LED on the secondary side 
is blinking. 

� Do not start NEC Express5800/ft series while the BMC status LEDs are blinking. 

→ Mirror of the hard disk drives is cancelled when the server is started. For details, 
see “Primary PCI module’s status LED2 and DISK ACCESS LED illuminate 
amber after startup:” of “Problems with NEC Express5800/ft series” of 
“SOLVING PROBLEMS” in Chapter 7 “Troubleshooting” in this User’s Guide. 
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Do not shut down NEC Express5800/ft series during the duplication process of PCI 
modules 

� Do not perform shutdown while PCI modules are being duplicated (when starting 
the machine or when mounting a PCI module). 

→ The following phenomena occur when shutdown is performed: 

• The mirror of hard disk drives is cancelled. 
For details, see “Primary PCI module’s status LED2 and DISK ACCESS LED 
illuminate amber after startup:” of “Problems with NEC Express5800/ft series” of 
“SOLVING PROBLEMS” in Chapter 7 “Troubleshooting” in this User’s Guide. 

• Duplication of LANs is cancelled and communication cannot be established the 
next time the machine is started. 
[About recovery] 

• “!” is displayed on Device Manager. 
When “!” is displayed for a network adaptor (excluding “Intel(R) Advanced 
Network Services Virtual Adapter)” on Device Manager, reinstall the driver to 
that adapter (“Update Driver···”). 

• The “Intel(R) Advanced Network Services Virtual Adapter”, “Client for 
Microsoft Networks”, and “File and Printer Sharing for Microsoft Networks” 
checkboxes are cleared (they cannot be selected). 
On the [Network Connections] dialog box, select “Intel® Advanced Network 
Services Virtual Adapter”, display its properties, and check if the “Client for 
Microsoft Networks” and “File and Printer Sharing for Microsoft Networks” 
checkboxes are selected. 
If an error occurs when these checkboxes are selected and trying to exit, 
uninstall “Internet Protocol (TCP/IP)” and restart the system, and then, install 
“Internet Protocol (TCP/IP)” again. 

 

Do not shut down NEC Express5800/ft series during the duplication process of CPU 
modules. 

� Do not perform shutdown when CPU modules are being duplicated (while starting 
NEC Express5800/ft series or when mounting a CPU module) 
Check that the following event is recorded to the system event log and then perform 
shutdown: 

<Duplication completion event of CPU modules> 
Source: srabid 
ID: 4137 
Description: Memory consistency check has completed memory scan. 

→ If shutdown is performed during the duplication process, the duplication process 
of the CPU modules may fail at next startup. 
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Cautions about adding hard disk drives 
� After adding an unused (no signature) hard disk, PCI modules may not become 

duplicated on a rare occasion (the Status LED 2 of the PCI module where the hard 
disk is added may illuminate amber). 

→ When the Status LED 2 of the PCI module where a hard disk is added illuminates 
amber, use [Disk Management] to perform “Initialize Disk” to the added hard disk 
(without signature) (the image below). The color of the Status LED 2 of the PCI 
module changes to green, and the PCI module becomes duplicated. 

 
Note: 
The signature mentioned above indicates the signature written to the disk 
when making a disk usable on Windows. 

 
Connection timeout of LAN protocol 

� Immediately after NEC Express5800/ft series is booted or when CPU modules are 
remounted, there is a possibility that connection timeout of LAN protocol between 
NEC Express5800/ft series and clients occurs. 

→ There is a possibility that connection between NEC Express5800/ft series and 
computers connected by LAN protocol has no communication and times out 
immediately after booting NEC Express5800/ft series or while remounting 
(duplicating) CPU modules. For details and workaround, see “Setting up PCs on a 
Network” in Chapter 5 “Procedures after Completion of Installation” of the User’s 
Guide (Setup). 
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HOW THE OPERATING SYSTEM SEES THE CPU MODULES 
On NEC Express5800/ft series, the CPU modules are redundantly configured but only the 
processors installed on the primary side are shown.  
 

How CPU modules appear on Device Manager 

Device Manager shows as many CPUs as the number of physical CPUs. 
s

 
How C

Intel
techn
proce
Task
below

PU 
System with two CPU
System with one CPU System with two CPUs 

PU modules appear on Task Manager 

 Xeon processor introduces a new technology called Hyper-Threading Technology. It is a 
ology that makes the operating system see a single processor performing as two logical 
ssors.  

 Manager shows logical processors using the Hyper-Threading Technology. As shown 
, information for the processors of twice the number of physical processors is displayed.  

System with one CPU System with two CPUs 
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NAMES AND FUNCTIONS OF COMPONENTS 
Names and functions of components are shown below: 

 

Front View 

 

Tower model 

 

Rack-mount model
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1 Front bezel 
 A door that covers internal components. You can lock it with the included security key. 

2 Key slot 
 Insert the security key in this slot to unlock the front bezel. 

3 Stabilizers 
 Parts for stabilizing a tower-model unit. 

4 Casters 
 Wheels for moving a tower-model unit. 

5 BMC status LED 
 See “LEDs” in this chapter for details. 

6 PCI module status LED 1 
 See “LEDs” in this chapter for details. 

7 PCI module status LED 2 
 See “LEDs” in this chapter for details. 

8 DISK ACCESS LED 
 See “LEDs” in this chapter for details. 

9 CPU module status LED 1 
 See “LEDs” in this chapter for details. 

10 CPU module status LED 2 
 See “LEDs” in this chapter for details. 
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Front View (inside) 

Tower model 

Rack-mount model
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1 PCI module (for group 1) 
 A module that includes a PCI board and LAN controller. 

2 PCI module (for group 2) 
 A module that includes a PCI board and LAN controller. 

3 CPU module (for group 1) 
 A module that includes a CPU (processor) and memory (DIMM). 

4 CPU module (for group 2) 
 A module that includes a CPU (processor) and memory (DIMM). 

5 POWER switch 
 A switch for turning on/off power to the system. The POWER switch on the primary PCI 

module will be lit. Press it once to turn on power. Press it again to turn off power. Depress 
the switch for more than four seconds to force the system to power down. The POWER 
switch on the secondary PCI module will be unlit and will not respond until a failure in the 
primary PCI module causes the secondary PCI module to assume primary functionality. 

6 CD-ROM drive 
 Used for reading data from CD-ROMs. 

Although there are two CD-ROM drives, only the one on the active primary PCI module can 
be used (the module with the lit POWER Switch LED). 

7 3.5-inch hard disk drive bay 
 Slots for adding hard disks. On a tower model, they are called Slots 1, 2, and 3 from the 

bottom. On a rack-mount model, they are called Slots 1, 2, and 3 from the left. Slots of the 
same number are mirrored between the groups 1 and 2. 

8 DUMP switch 
 A switch for outputting a memory image from the kernel to a file. 

9 DISK LED (green/amber) 
 An LED on the hard disk. Blinks in green while the hard disk is accessed and turns amber 

when operating in simplex mode. If one of the mirrored hard disks fails, the failed disk’s LED 
turns green and the other disk’s LED turns amber. 

 

 

CD-ROM Drive 

 
1 Status LED 
 An LED that stays on while the loaded CD-ROM is accessed. 
2 CD tray eject button 
 A button for ejecting the CD tray. 
3 Manual release hole 
 When the eject button does not work, insert a metal pin into this hole to forcefully eject the CD 

tray. 
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Rear View 

 
 
 
 

 
 

CPU module (for Group1) PCI module (for Group2) 

PCI module (for Group1) CPU module (for Group2)

Rack-mount model

Tower model

PCI module (for Group2)

PCI module (for Group1)

CPU module (for Group2)

CPU module (for Group1)
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1 Serial port A connector 
 Connected to a device that has a serial interface. For maintenance use only. 

2 AC inlet B (for Group1) 
 PC socket for plugging a power cord (for Group1). If you desire to make the PCI module for 

Group1 primary, use this inlet to connect the power cord first.  
3 Serial port B connector 
 Connected to a device that has a serial interface. For maintenance use only. 

4 USB connectors  
 Tower model: from top: USB1, USB2 

Rack-mount model: from left: USB1, USB2 
Connected to devices that support the USB interface. 
Connect the keyboard (with mouse) to USB 1; connect the USB floppy disk drive to USB 2. 

5 AC inlet A (for Group2) 
 PC socket for plugging a power cord (for Group2). If you desire to make the PCI module for 

Group2 primary, use this inlet to connect the power cord first.  
6 Monitor connector 
 Connected to the display unit. 

7 SCSI connector 
 Used for connecting external SCSI devices. 

8 PCI module status LED 1 
 See “LEDs” in this chapter for details. 

9 PCI module status LED 2 
 See “LEDs” in this chapter for details. 

10 PCI board slot status LED (Slot1) 
 See “LEDs” in this chapter for details. 

11 PCI board slot status LED (Slot2) 
 See “LEDs” in this chapter for details. 

12 PCI board slot status LED (Slot3) 
 See “LEDs” in this chapter for details. 

13 LINK/ACT LED 
 See “LEDs” in this chapter for details. 

14 LAN connector 1 
 A connector for 1000BASE-T, 100BASE-TX, and 10BASE-T. Connected to the network 

system on LAN. 
15 1000/100/10 LED 
 See “LEDs” in this chapter for details. 

16 LINK/ACT LED 
 See “LEDs” in this chapter for details. 

17 100/10 LED 
 See “LEDs” in this chapter for details. 

18 LAN connector 2 
 A connector for 100BASE-TX and 10BASE-T. Connected to the network system on LAN. 
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CPU Module 

 
Group 1 and group 2 have the same configuration. 

1 Module handle 
2 Cooling fan  
3 CPU module board 
4 CPU socket #2 (additional) 
5 AC inlet (in the back) 
6 Back panel connector (in the back) 
7 CPU socket #1 (standard) 
8 DIMM 
9 Power unit 
10 Power backboard 
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CPU module board 

Group 1 and group 2 have the same configuration. 
 

1 Cooling fan connector  
2 LED connector 
3 Power connector 
4 CPU socket #2 
5 CPU socket #1 
6 DIMM sockets (Slots #1 to #6 from the top. Add memory modules in pairs: #1 and #2, #3 and 

#4, #5 and #6.) 
*This section only describes connectors that are used for replacing parts or upgrading. Other 
connectors have been setup before shipment. 

 

 

 

 

 

 

 

 

 

 

 

 



2-22  General Description 

 
PCI Module 

 
Group 1 and group 2 have the same configuration. 

 

1 Cooling fan 
2 Power unit 
3 AC inlet (in the back) 

The AC cable in the module which is connected to the AC inlet cannot be used for other 
purposes. 

4 Backpanel connector (in the back) 
5 PCI module board 
6 Video board 
7 PCI riser card 
8 PCI board retention bracket 
9 SCSI backboard 
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PCI module board 
Group 1 and group 2 have the same configuration. 

 
1 SCSI connector (external) 
2 Configuration jumper pin 
3 Battery (lithium battery) 
4 Cooling fan connector 
5 Power connector 
6 IDE connector 
7 Power switch connector 
8 
9 

LED connector 
SCSI connector (internal) 

 

 

 

Chassis Board Layout 

Rack-mount model 

 

 

Back panel 

Interface board 

Clock board 

Backplane 
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LEDs 

This section describes indications and meanings of the LEDs on NEC Express5800/ft series. 

See “NAMES AND FUNCTIONS OF COMPONENTS” (page 2-14) for the locations of each LED. 

 

POWER LED 

The POWER switch of the PCI module also functions as a POWER LED. When power is supplied 
to the modules, POWER LED on the primary side will illuminate (the switch also works on the 
primary side alone).  

 

BMC Status LED 

The BMC status LED indicates the status of the Baseboard Management Controller (BMC) installed 
on NEC Express5800/ft series. 

The LED stays green while the server is running normally. If the LED is not green, there is 
something wrong with the server. 

The table below shows indications of the BMC status LED and their meanings. 

TIPS:  
� If the server has the NEC ESMPRO or Off-line Maintenance Utility installed, you can view 

the error log to identify the cause of a trouble. 

� When you want to restart the server, perform a shutdown if the OS allows you to shut down 
the system. If not, perform a reset or forced shutdown, or you can restart the server by unplug 
and plugging the power cord. 

 
LED indications 
Primary Secondary Description Action 

Green Off BMC operates normally 
and CPU and PCI modules 
are in duplex mode. 

– 

Green 
(blinking 
every 1 
second) 

Off CPU or PCI modules are 
not in duplex mode during 
operation. 

Remount components whose status 
LED is red. If the problem persists, 
replace that module. 

AC power is all off. Turn on the AC power. 
Performing POST. Wait for a while; it will illuminate in 

green shortly after POST. 
CPU module error 
occurred. 

Off Off 

PCI module error occurred. 

After turning off the power, turn it on to 
restart the system. If some error 
message appears on the POST screen, 
write it down and contact your sales 
agent. 
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LED indications 
Primary Secondary Description Action 

Detected a fatal 
temperature error. 

If LCD displays some error message, 
refer to the error message list (see 
Chapter 7). 
Check if dust is accumulated on internal 
fans and confirm that the fan cables are 
connected firmly. If the message does 
not disappear, contact your sales agent. 

Amber Off 

Detected a fatal voltage 
error. 

Contact your sales agent. 

Detected a temperature 
error to be warned. 

If LCD displays some error message, 
refer to the error message list (see 
Chapter 7). 
Check if dust is accumulated on internal 
fans and confirm that the fan cables are 
connected firmly. If the message does 
not disappear, contact your sales agent. 

Detected a voltage error to 
be warned. 
Detected a device defect. 

Contact your sales agent. 

Amber 
(blinking 
every 1 
second) 

Off 

Detected a fan alarm. If LCD displays some error message, 
refer to the error message list (see 
Chapter 7). 
Check if dust is accumulated on internal 
fans, and confirm that the fan cables are 
connected firmly. If the message does 
not disappear, contact your sales agent. 

BMC is being dumped. Wait for a while; it will go off soon. 
PCI module may be 
connected incorrectly. 

Check if PCI module is connected 
correctly. Look for loose screws. 

Red Off 

BMC may be out of order. BMC firmware may need 
reprogramming. Contact your sales 
agent. 

BMC is being dumped. Wait for a while. After a while, the BMC 
status LED on the secondary will blink. 

PCI module may be 
connected incorrectly. 

Check if PCI module is connected 
correctly. Look for loose screws. 

ANY*1 Red 

BMC may be out of order. BMC firmware may need to be 
rewritten. Contact your sales agent. 

ANY*1 Red 
(blinking 
every 0.5 
second) 

Transfers data being 
synchronized after a PCI 
module is replaced (this is 
not an error). 

Do not remove either of the PCI 
modules or control the AC/DC power 
until the LED stops blinking. 

ANY*1 Red 
(blinking 
every 1 
second) 

The revision of BMC 
firmware does not match. 

Contact your sales agent. 
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LED indications 
Primary Secondary Description Action 

BMC is being dumped. Wait for a while. After a while, the BMC 
status LED on the primary will go off. 

Red Red 

Both BMCs are out of 
order. 

Check if both PCI modules are 
connected correctly. Confirm that 
screws are fixed firmly. If the indication 
does not change, contact your sales 
agent. 

*1  The status of green, green (blinking every second), amber, amber (blinking every second), or off. 
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PCI Module Status LEDs  1/2 

Disk Access LED 
The PCI module has three LEDs. 
Combined, the three LEDs show the status of the PCI modules and hard disks. 

See “NAMES AND FUNCTIONS OF COMPONENTS” (page 2-14) for the locations of LEDs. 

 

(1) Status LED 1 of both PCI modules are off 
PCI#1 PCI#2 

Status 
LED 2 

DISK 
Access 

LED 

Status 
LED 2 

DISK 
Access 

LED 

Description Action 

Green Green/
Off 
* 

Green Green/ 
Off 
* 

Both PCI modules 
operate normally in 
duplex mode. 

- 

Green Off Amber Amber Some trouble occurred 
on a hard disk of the 
PCI module 1. 

Amber Amber Green Off Some trouble occurred 
on a hard disk of the 
PCI module 2. 

Reconfigure the hard disk 
mirror.  
(See “DISK OPERATIONS” in 
Chapter 3, Windows Setup and 
Operation) 
If the problem persists, contact 
your sales agent. 

Off Off Amber Amber AC power is not 
supplied to the PCI 
module 1. 
The PCI module 2 
operates in simplex 
mode. 

Check if the power cord is 
connected correctly. 
Check the condition of breaker 
and UPS. 
Check if the power unit of the 
PCI module 1 is connected 
correctly. 
Remount the PCI module 1. 
If the problem persists, contact 
your sales agent. 

Amber Amber Off Off AC power is not 
supplied to the PCI 
module 2. 
The PCI module 1 
operates in simplex 
mode. 

Check if the power cord is 
connected correctly. 
Check the condition of breaker 
and UPS. 
Check if the power unit of the 
PCI module 2 is connected 
correctly. 
Remount the PCI module 2. 
If the problem persists, contact 
your sales agent. 
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PCI#1 PCI#2 

Status 
LED 2 

DISK 
Access 

LED 

Status 
LED 2 

DISK 
Access 

LED 

Description Action 

Green Green/
Off 
* 

Amber Green/
Off 
* 

i) There is an error in 
the option PCI board or 
the PCI module board 
connected or mounted 
on PCI module 1.  
ii) There is an error in 
the devices connected 
to the option PCI board 
connected or mounted 
on PCI module 1. 
(including the cable 
disconnection) 
iii) The LAN cable 
connected or mounted 
on PCI module 1 is 
disconnected. 

Make sure that the option PCI 
board is properly mounted and 
cables are properly connected 
to the connectors of the PCI 
module or the option PCI 
board. 
Remount the PCI module 1. 
If the problem persists, contact 
your sales agent. 

Amber Green/
Off 
* 

Green Green/
Off 
* 

i) There is an error in 
the option PCI board or 
the PCI module board 
connected or mounted 
on PCI module 2.  
ii) There is an error in 
the devices connected 
to the option PCI board 
connected or mounted 
on PCI module 2 
(including the cable 
disconnection) 
iii) The LAN cable 
connected or mounted 
on PCI module 2 is 
disconnected. 

Make sure that the option PCI 
board is properly mounted and 
cables are properly connected 
to the connectors of the PCI 
module or the option PCI 
board. 
Remount the PCI module 2. 
If the problem persists, contact 
your sales agent. 

Amber Amber Amber Amber DISKs are performing 
mirroring (when 
mirroring by Disk 
Management). 

Wait for the mirroring to be 
completed. 

Amber Amber Green Green/
Off 
* 

Green Green/
Off 
* 

Amber Amber

DISKs are performing 
mirroring. (when 
mirroring by the RDR 
function) 

Wait for the mirroring to be 
completed. 

* DISK ACCESS LED illuminates green when hard disk is accessed. 
 

Tips: When the status LED 1 is off, the colors of the status LED 2 indicate the following. You 
must be careful especially when detaching modules. 

- Green: Unmounting the module has no effect on the system operation. 
- Amber: Unmounting the module causes a system down.  
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(2) Status LED 1 of both PCI modules are red 

PCI#1 PCI#2 
Status 
LED 2 

DISK 
Access 

LED 

Status 
LED 2 

DISK 
Access 

LED 

Description Action 

Off Off Off Off On standby (AC power 
is supplied through the 
cord, but the system 
has not been powered 
on yet.) 

After turning on the power, 
wait for the OS to start. When 
the OS starts and duplex 
mode is established, the 
indications will return to 
normal. If they do not get 
back to normal, remount the 
PCI module.  
If the problem persists, 
contact your sales agent. 

Green Off Off Off The PCI module 1 is 
performing diagnosis 
(Diag). 

Wait for the OS to start. When 
the OS starts and duplex 
mode is established, the 
indications will return to 
normal. 

Off Off Green Off The PCI module 2 is 
performing diagnosis 
(Diag). 

Wait for the OS to start. When 
the OS starts and duplex 
mode is established, the 
indications will return to 
normal. 

 
 

(3) Status LED 1 of only PCI module 1 is red 
PCI#1 PCI#2 

Status 
LED 2 

DISK 
Access 

LED 

Status 
LED 2 

DISK 
Access 

LED 

Description Action 

Off Off Amber Amber The PCI module 1 is on 
standby (The PCI 
module 1 has not been 
powered on yet.)  
The PCI module 2 
operates in simplex 
mode. 

Start the PCI module 1 from ft 
server utility (See page 5-50). 
Remount the PCI module 1.  
If the problem persists, 
contact your sales agent. 

Green Off Amber Amber The PCI module 1 is 
performing diagnosis 
(Diag).  
The PCI module 2 
operates in simplex 
mode. 

Wait for the PCI module 1 to 
start. When the PCI module 1 
starts and duplex mode is 
established, the indications 
will return to normal. 

Off Off Off Off Only the PCI module 1 
is on standby (AC 
power is supplied 
through the cord, but 
the system has not 
been powered on yet.) 
AC power is not 
supplied to the PCI 
module 2. 

Check if the power cord is 
connected correctly. 
Check the condition of 
breaker and UPS. 
Check if the power unit is 
connected correctly. 
Remount the PCI module 2. 
If the problem persists, 
contact your sales agent. 
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PCI#1 PCI#2 

Status 
LED 2 

DISK 
Access 

LED 

Status 
LED 2 

DISK 
Access 

LED 

Description Action 

Green Off Off Off The PCI module 1 is 
performing diagnosis 
(Diag).  
AC power is not 
supplied to the PCI 
module 2. 

Wait for the OS to start. After 
the OS starts, check the 
status LEDs and then take the 
appropriate actions.  
If the problem persists, 
contact your sales agent. 
 

 
 
 

(4) Status LED 1 of only PCI module 2 is red 
PCI#1 PCI#2 

Status 
LED 2 

DISK 
Access 

LED 

Status 
LED 2 

DISK 
Access 

LED 

Description Action 

Amber Amber Off Off The PCI module 2 is on 
standby (The PCI 
module 2 has not been 
powered on yet.)  
The PCI module 1 
operates in simplex 
mode. 

Start the PCI module 2 from ft 
server utility (See page 5-50). 
Remount the PCI module 2.  
If the problem persists, 
contact your sales agent. 

Amber Amber Green Off The PCI module 2 is 
performing diagnosis 
(Diag).  
The PCI module 1 
operates in simplex 
mode. 

Wait for the PCI module 2 to 
start. When the PCI module 2 
starts and duplex mode is 
established, the indications 
will return to normal. 

Off Off Off Off Only the PCI module 2 
is on standby (AC 
power is supplied 
through the cord, but 
the system has not 
been powered on yet.) 
AC power is not 
supplied to the PCI 
module 1. 

Check if the power cord is 
connected correctly. 
Check the condition of 
breaker and UPS. 
Check if the power unit is 
connected correctly. 
Remount the PCI module 1. 
If the problem persists, 
contact your sales agent. 

Off Off Green Off The PCI module 2 is 
performing diagnosis 
(Diag). 
AC power is not 
supplied to the PCI 
module 1. 

Wait for the OS to start. After 
the OS starts, check the 
status LEDs and then take the 
appropriate actions. 
If the problem persists, 
contact your sales agent. 
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CPU Module Status LEDs 1/2 

The CPU module has two LEDs. 
Combined, the two LEDs show the status of CPU modules: 

See “NAMES AND FUNCTIONS OF COMPONENTS” (page 2-14) for the locations of LEDs. 

 
CPU#1 CPU#2 

Status 
LED1 

Status 
LED2

Status 
LED1 

Status 
LED2

Description Action 

Off Green Off Green The CPU module 
operates normally in 
duplex mode. 

- 

Off Amber Red Off The CPU module 2 is 
on standby (The CPU 
module 2 has not been 
powered on yet.)  
The CPU module 1 
operates in simplex 
mode. 

Start the CPU module 2 from ft 
server utility (See page 5-50). 
Remount the CPU module 2. 
If the problem persists, contact 
your sales agent. 

Red Off Off Amber The CPU module 1 is 
on standby (The CPU 
module 1 has not been 
powered on yet.)  
The CPU module 2 
operates in simplex 
mode. 

Start the CPU module 1 from ft 
server utility. (See page 5-50). 
Remount the CPU module 1.  
If the problem persists, contact 
your sales agent. 

Off Amber Red Green The CPU module 2 is 
performing diagnosis 
(Diag).  
The CPU module 1 
operates in simplex 
mode. 

Wait for the CPU module 2 to 
start. When the CPU module 2 
starts and duplex mode is 
established, the indications will 
return to normal. 

Red Green Off Amber The CPU module 1 is 
performing diagnosis 
(Diag).  
The CPU module 2 
operates in simplex 
mode. 

Wait for the CPU module 1 to 
start. When the CPU module 1 
starts and duplex mode is 
established, the indications will 
return to normal. 

Off Off Off Amber AC power is not 
supplied to the CPU 
module 1. The CPU 
module 2 operates in 
simplex mode. 

Check if the power cord is 
connected correctly. 
Check the condition of breaker 
and UPS. 
Check if the power unit is 
connected correctly. 
Remount the CPU module 1. 
If the problem persists, contact 
your sales agent. 
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CPU#1 CPU#2 

Status 
LED1 

Status 
LED2 

Status 
LED1 

Status 
LED2 

Description Action 

Off Amber Off Off AC power is not 
supplied to the CPU 
module 2.  
The CPU module 1 
operates in simplex 
mode. 

Check if the power cord is 
connected correctly. 
Check the condition of breaker 
and UPS. 
Check if the power unit is 
connected correctly. 
Remount the CPU module 2. 
If the problem persists, contact 
your sales agent. 

Off Off Red Green AC power is not 
supplied to the CPU 
module 1.  
The CPU module 2 is 
performing diagnosis 
(Diag). 

Red Green Off Off AC power is not 
supplied to the CPU 
module 2.  
The CPU module 1 is 
performing diagnosis 
(Diag). 

Wait for the OS to start. After the 
OS starts, check the status LEDs 
and then take the appropriate 
actions.  
If the problem persists, contact 
your sales agent. 
 

Red Off Red Off On standby (AC power 
is supplied through the 
cord, but the system 
has not been powered 
on yet.) 

Red Green Red Off The CPU module 1 is 
performing diagnosis 
(Diag). 

Red Off Red Green The CPU module 2 is 
performing diagnosis 
(Diag). 

After turning on the power, wait for 
the OS to start.  
When the OS starts and duplex 
mode is established, the 
indications will return to normal. If 
not, check the status LEDs and 
then take the appropriate actions.  
If the problem persists, contact 
your sales agent. 

Red Amber Off Amber 
Red Amber Off Off 

The CPU module 1 
memory is being 
dumped. (This occurs 
only when 
maintenance is being 
performed.) 

- 

Off Amber Red Amber 
Off Off Red Amber 

The CPU module 2 
memory is being 
dumped. (This occurs 
only when 
maintenance is being 
performed.) 

- 

 

Tips: When the status LED 1 is off, the colors of the status LED 2 indicate the following. You 
must be careful especially when detaching modules. 

- Green: Unmounting the module has no effect on the system operation. 
- Amber: Unmounting the module cause a system down.  
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PCI Board Slot Status LEDs (P1, P2, P3) 

To show the status of PCI board slots, each PCI module has three status LEDs. 

LED 
indications Description Action 

PCI board is mounted 
correctly and operates 
in duplex mode. 

The system operates normally. Off 

The PCI board is not 
mounted; is mounted 
incorrectly; or power 
is not supplied. 

If the PCI board is not mounted or is mounted 
incorrectly, just mount it correctly; there is no problem. 
Check the condition of power unit. 
If the problem persists, contact your sales agent. 

Amber PCI board is mounted 
correctly and operates 
in simplex mode. 

Simplex mode is not a problem. 
To make the server fault-tolerant, attach a PCI board 
to a slot of the same on the other PCI module. 

Red Although the PCI 
board is mounted, it 
may be offline or not 
be working. 

Remount the PCI board correctly. 
Remount the PCI module correctly. 
If the problem persists, contact your sales agent. 

For LED indications when option boards are attached, see “PCI Module” in Chapter 8.  

 

Disk LED 

A DISK LED shows the status of a hard disk that is mounted in a slot of the 3.5-inch hard disk drive 
bay. Combined, the disk LEDs on PCI modules 1 and 2 show the status of the hard disks. 

PCI 
module 1 

PCI 
module 2 Description Action 

Green/Off* Green/Off* The hard disk drives are mirrored 
and operating normally.  

- 

Green/Off* Amber Mirroring the DISKs by the RDR 
function. 

Wait for the mirroring to be 
completed.  

Green Amber Some trouble occurred on a hard 
disk of the PCI module 1. 
The hard disk drive in the PCI 
module 2 is running without 
mirror.  

Reconfigure the hard disk mirror.  
(See “DISK OPERATIONS” in 
Chapter 3, Windows Setup and 
Operation) 
If the problem persists, contact 
your sales agent. 

Amber Green/Off* Mirroring the DISKs by the RDR 
function. 

Wait for the mirroring to be 
completed. 

Amber Green Some trouble occurred on a hard 
disk of the PCI module 2. 
The hard disk drive in the PCI 
module 1 is running without 
mirror.  

Reconfigure the hard disk mirror.  
(See “DISK OPERATIONS” in 
Chapter 3, Windows Setup and 
Operation) 
If the problem persists, contact 
your sales agent. 

Amber Amber Mirroring DISK by Disk 
Management.  

Wait until the mirroring is finished. 

* The DISK LEDs becomes off (blinks) when the hard disk drive is accessed.  
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TIPS:  
� When there are many accesses, the access LED will blink frequently. Check if the LED blinks 

in green when the number of accesses decreases, or if it is green when there are no accesses 
anymore. 

� When you power on NEC Express5800/ft series and the access LEDs do not illuminate green, 
remount the hard disks. 

 
 
LAN Connector LEDs 

Two LAN ports (connectors) located in the back have two LEDs each. 

• 100/10 LED (LAN connector 2), 1000/100/10 LED (LAN connector 1)  

These LEDs show the transfer rate of the network that is being connected. 

LED indications LAN connector 1 
1000/100/10 

LAN connector 2 
100/10 

Amber Operating as 1000BASE-T. Operating as 100BASE-TX. 
Off Operating as 100BASE-TX or 

10BASE-T. 
Operating as 10BASE-T. 

 

• LINK/ACT LED 

The LINK/ACT LED shows the status of a standard network port. It is green if power is supplied 
to the main unit and hub, and they are connected correctly (“LINK”). It blinks green while the 
network port sends or receives data (ACT). 

When the LED does not illuminate during “LINK,” check the condition and connection of 
network cables. If there is nothing wrong with the cables, a defect is suspected in the network 
(LAN) controller. In this case, contact your sales agent. 
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BASIC OPERATION 
This section describes basic operation procedures of NEC Express5800/ft series. 

 

Locking and Unlocking the Front Bezel 

The front bezel covers built-in components of the server such as the POWER switch, CD-ROM 
drive, and hard disks. 

The tower model server has a door-type bezel (it can also be detached). The rack-mount model 
server has a cover-like detachable bezel. 

You need to open the front bezel when you access the POWER switch, CD-ROM drive or hard disk. 

IMPORTANT:  
� Without using the security key, you cannot open or detach the front bezel. 

� It is not recommended to use the server with its bezel detached. 

Tower Model 

Insert the security key into the slot and turn it to release the lock. Hold the handle on the left side of 
the bezel and pull it. After closing the front bezel, lock it with the key for security. 

 
 

 

Release Lock 

Release Lock 
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Rack-mount Model 

The rack-mount model server is equipped with a detachable front bezel. 

 

Detach 

Follow the steps below to detach the front bezel: 

1. Insert the security key into the slot and turn it with a little pressure to release the lock.  

 
Release Lock 

2. Hold the right side of the front bezel lightly and pull it open. 

3. Detach the bezel from the main unit by sliding it to the left a little to disengage the tabs 
from the frame. 

 
 

Attach 

To attach the front bezel, engage the tabs on the frame on the left side of the main unit. After 
attaching and closing the front bezel, lock it with the key for security. 

 

 

 

 

Tabs Frame 
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Power ON 

To power on NEC Express5800/ft series, press the POWER switch located on the front panel. 

Follow the steps below to turn on the power. (A rack-mount model is shown here for convenience of 
explanation. However, the steps are the same for a tower model except that the modules are 
mounted vertically.) 

1. Power on the display unit and other peripheral devices connected to the server. 

TIPS:  

� If the power cord is connected to a power controller like a UPS, make sure that it is 
powered on. 

� When NEC Express5800/ft series is powered on, BMCs between the two PCI 
modules are synchronized. (The BMC status LED on secondary module blinks.) See 
Chapter 2 “LEDs” for details of the BMC status LED.  

2. Detach the front bezel (or open it in the case of a tower model). 

3. Confirm that the BMC status LED on both PCI modules are off and press the POWER 
switch which illuminates green and located on the front panel. 

After a while, the "NEC" logo will appear on the screen. 

 
 
 

IMPORTANT: 

POWER switches* (LEDs) 
*You can only use a power 
switch whose LED is on. 

� Do not turn off the power before the "NEC" logo appears. 

� When powering on, make sure that the BMC status LED on the both PCI modules 
are off and then press the power switch.   

While the "NEC" logo is displayed on the screen, NEC Express5800/ft series is 
performing a power-on self test (POST) to check itself. For details, see "POST Check" 
described later in this chapter. Upon the completion of POST, the OS will start. 

TIPS: If the server finds errors during POST, it will interrupt POST and display the 
error message. See Chapter 7. 
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Power OFF 

Follow the steps below to turn off the power. If NEC Express5800/ft series is plugged to a UPS, see 
manuals included with the UPS or the application that controls the UPS. 

1. Perform a normal shutdown from Windows Server 2003. 

The system will be powered off automatically. (Note: the POWER LED on the primary 
side will remain illuminating when AC power is supplied.)  

2. Power off all peripheral devices. 
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POST Check 

POST (power-on self test) is a self-test function stored on the motherboard of NEC Express5800/ft 
series. 

When you power on the server, POST will start automatically to check the motherboard, ECC 
memory modules, CPU modules, keyboard, mouse, etc. It also shows startup messages for various 
BIOS setup utilities. 

 
 
According to the factory default settings, the “NEC” logo appears on the display while POST is 
being performed. (To view POST’s details, press Esc.) 

TIPS:  
� You can view POST details from the beginning without the need to press Esc when the    

BIOS menu is displayed: select [System Configuration] - [Advanced], and set [Boot-time 
Diagnostic Screen] to "Enabled" (see Chapter 4). 

� You can view the test items and details from a management PC where NEC ESMPRO 
Manager or NEC MWA is installed. 

You do not always need to check POST details. You will need to check messages when: 

� You install a new NEC Express5800/ft series. 

� A failure is suspected. 

� You hear several beeps between the time of the power-on and OS start-up.  

� The display unit or the LCD* shows an error message. 

*For details, see “Error Messages on the Liquid Crystal Display (LCD)” in Chapter 7. 

TIPS: Although there is no LCD on the front of NEC Express5800/ft series, you 
can check error messages using NEC MWA or NEC ESMPRO Manager. For details, 
see Chapter 7. 
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Flow of POST 

This section walks you through how POST is performed. 

1. When you power on the system, one selected CPU/PCI module will start up. 

POST will be performed on this selected CPU/PCI module. 

2. Memory check starts. 

A message appears at the upper left of the screen to show that the basic and expanded 
memories are being counted. The memory check may take a few minutes to complete 
depending on the server’s memory size. Likewise, it may take about one minute for the 
screen to appear when the server is rebooted. 

Note that if you have replaced the PCI module, the server will perform a reset of the MAC 
address, then reboot itself before the memory check. 

3. The server starts processor check, IO check, and initialization. 

Several messages appear: they show the ID of the selected CPU/PCI modules, information 
on the processor, detection of the keyboard and mouse, etc. 

4. A message appears at the lower left of the screen, prompting for startup of the BIOS setup 
utility “SETUP.” 

Press <F2> to enter SETUP
 

You will need to start it when you want to modify the configuration for using the server. 
Unless this message appears together with an error message, you do not need to start the 
utility to modify the configuration. (If you wait for a few seconds, POST will go on 
automatically.) 

To start the SETUP utility, press F2 while the above message is displayed. For setting and 
parameter functions, see the section of BIOS setup. 

When SETUP is completed, the server will reboot itself automatically and perform POST. 

5. A message appears prompting for startup of SCSI BIOS setup utility. 

When a built-in SCSI controller is detected, a message will appear prompting for startup 
of SCSI BIOS setup utility. (If you wait for a few seconds, POST will go on 
automatically.) 

If you press Ctrl + Q, the SCSI BIOS setup utility will start. For setting and parameter 
functions, see the section on SCSI setup. 

You will need to use this utility, for example, when you have changed the server’s internal 
SCSI device connections. However, you usually do not need to use it. 

When SETUP is complete, the server will reboot automatically and perform POST again. 

If multiple SCSI controller boards are mounted on the PCI bus, the SCSI BIOS startup 
message will appear for these boards in numerical order (PCI #1, PCI #2, PCI #3…). 

6. The screen shows SCSI ID numbers used by the connected SCSI devices. 
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7. Upon completion of POST, the password entry screen appears prior to OS startup. 

The password entry screen will appear after the normal termination of POST only if you 
have set a password in the BIOS setup utility “SETUP.” 

You can enter a password up to three times. If you enter an incorrect password three times, 
the startup will be unsuccessful. In this case, turn off the power and then turn it on again 
after waiting 30 seconds to boot the server. 

IMPORTANT: Do not set a password before installing the OS. 

8. Upon completion of POST, the OS will start up. 

 

Behavior at Occurrence of Error 

If POST or OS startup does not finish normally, the server will reboot itself automatically. 

At the time of reboot, it will select the other CPU/PCI module and run POST or OS startup. 

In this manner, the server retries POST or OS startup with different combinations of CPU/PCI 
modules. If POST does not finish normally with any combinations, the server will stop with the 
state of DC OFF. 

While performing retries, the server displays or registers the error types. 

For details of error messages, see Chapter 7 “Troubleshooting.” 

 

POST Error Messages 

When the server detects an error during POST, it will notify you of the occurrence in the following 
manners: 

� Displays an error message on the display unit. 

� Displays an error message on the LCD*. 

� Makes a beeping sound. 

*For details, see “Error Messages on the Liquid Crystal Display (LCD)” in Chapter 7. 

These notification methods are described in “POST Error Messages” in Chapter 7. 

IMPORTANT: Before you contact your sales agent, write down the error messages and 
patterns of the beeping sound. They will serve as helpful information at the time of 
maintenance. 
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Floppy Disk Drive 

A USB floppy disk drive is attached to the main unit. It allows you to read and write (save) data 
using floppy disks. 

The USB floppy disk drive accepts the following types of floppy disks: 

� 2HD floppy disk (1.44MB) 
� 2DD floppy disk (720KB) 

 

 
 

Drive letter of floppy disk drive 

The drive letter will change when the primary PCI module is switched to the standby PCI module 
while the Windows operating system is in operation. The drive letter of the floppy disk will be 
determined as follows: 

“A” will be assigned to the floppy disk drive for the PCI module that is operating as the primary 
PCI module during Windows operating system boot-up. “B” will be assigned to the floppy disk 
drive for the standby PCI module. 

Ex) If a floppy disk drive was connected for the first time while the primary PCI module is group 1. 

 Primary PCI module 

  PCI module (for group 1): A drive 

  PCI module (for group 2): B drive 

IMPORTANT: In the event that the active PCI module switches to the standby PCI module 
due to a failure while the system is in operation, the floppy disk drive letter will change at the 
point PCI module switches to the standby module. 
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Insert/Remove Floppy Disk 

Before inserting a floppy disk into the drive, make sure that NEC Express5800/ft series is on and 
that the drive’s USB cable is connected to the USB connector at the back of the server. 

Insert a floppy disk into the drive firmly with the label side up and its protective shutter facing the 
drive. 

TIPS: 
� If you insert an unformatted disk, you will see a message that the disk cannot be read or that 

needs formatting. To format a floppy disk, see your OS manual. 

� If you power on or restart NEC Express5800/ft series with a floppy disk left in the drive, the 
server will access the floppy disk to start the system. Unless a system exits on the FD, the 
server will be unable to start. 

To remove a floppy disk from the drive, press the eject button. 

TIPS: Before removing a floppy disk, make sure that the access LED is off. If you eject a floppy 
disk while the LED is on, the stored data could be damaged. 
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Use of Floppy Disk 

You may need to store important data on floppy disks. Since the floppy disk is a very delicate 
medium, you must handle it with extra care: 

� Push the floppy disk gently into place. 

� Attach the label on a proper position. 

� Do not use a pencil or ballpoint pen to write on the disk. 

� Do not open the protective shutter. 

� Do not use the floppy disk in a dusty place. 

� Do not place anything on the floppy disk. 

� Do not leave the floppy disk in a place that is subject to direct sunlight or high temperatures 
(e.g., near a heater). 

� Keep away from cigarette smoke. 

� Do not leave the floppy disk near water or chemicals. 

� Keep away from magnetic objects. 

� Do not clip disks. Be careful not to drop. 

� Store floppy disks in a protective case where they are kept away from magnetic waves or 
dust. 

� To prevent data from being erased accidentally, the floppy disk has a write-protect notch. 
When the disk is write-protected, you can read data, but you cannot write the data or format 
the disk. It is recommendable to write-protect floppy disks that contain important data. To 
write-protect a floppy disk, slide the write-protect notch located on its back. 

� The floppy disk is a very delicate storage medium. Dust or changes in temperature could 
cause data to be lost. Data loss could also be caused by faulty operation and computer trouble. 
To avoid such possible data loss, it is recommendable to back up important data regularly. (Be 
sure to make back-up copies of the disks that are included with NEC Express5800/ft series.) 

 



General Description  2-45 

 
CD-ROM Drive 

NEC Express5800/ft series has a CD-ROM drive on the front panel. It is a device used to read data 
from a CD-ROM (compact disc read-only memory). Compared to a floppy disk, a CD-ROM allows 
for larger volume and fast data readout. 

CAUTION  
  

Observe the following instructions to use the server safely. There are risks of a 
burn, injury, or damage to physical assets. For details, see PRECAUTIONS 

OR SAFETY in Chapter 1. F
 

 

 
� Do not leave the CD tray ejected.   

 

About the CD-ROM Drive of NEC Express5800/ft series 

Each PCI module contains a single CD-ROM drive in NEC Express5800/ft series, but only the 
CD-ROM drive on the primary side can be used.  

 

When you cannot eject a CD-ROM 

When you cannot eject the CD-ROM by pressing the eject button, follow the steps below to eject it: 

 
 Manual release hole 

1. Power off the server. 

2. Use a metal pin of about 1.2 mm in diameter and 100 mm long (alternatively, you can use 
a fairly large paper clip after straightening). Insert it gently into the manual release hole 
located to the right of the eject button until the tray is ejected. 

IMPORTANT: 
� Do not use a toothpick, plastic pin, or other breakable objects. 

� If you cannot eject the CD-ROM by following the steps above, contact your sales agent. 

3. Hold the tray and pull it out. 

4. Take out the CD-ROM. 

5. Push the tray back. 
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Use of CD-ROM 

Observe the following when you use a CD-ROM on NEC Express5800/ft series: 

� As for a disk such as a noncompliant “copy-protected CD,” we shall not guarantee that you 
can use a CD player to play it with this server. 

� Be careful not to drop the CD-ROM. 

� Do not bend or place anything on the CD-ROM. 

� Do not attach labels on the CD-ROM. 

� Do not touch the signal side (blank side). 

� Place the CD-ROM gently on the tray with the printed side up. 

� Do not scratch, or use a pencil or ballpoint pen to write on the CD-ROM. 

� Keep away from cigarette smoke. 

� Do not leave the CD-ROM in a place that is subject to direct sunlight or high temperatures 
(e.g., due to a heater). 

� If the CD-ROM gets dirty with dust or fingerprints, wipe it gently from its center to edge with 
a dry soft cloth. 

� When you clean the CD-ROM, use a CD cleaner. Do not use a record cleaner (spray), benzine, 
or thinner. 

� Store the CD-ROM in a protective case when not in use. 

 

 



 

Chapter 3 

Windows Setup and Operation 

This chapter describes setup procedures to make NEC Express5800/ft series ready for use. 
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DISK OPERATIONS 
 
NEC Express5800/ft series duplicates disks to secure data by using “Disk Management” or the 
“Rapid Disk Resync (RDR) function”. This section describes operations such as configuration of 
dual settings to disks and replacement of disks. 

IMPORTANT: 
On the disks containing the OS, it is recommended to create only the system partition. To create a 
partition other than a system partition on the disk with the OS, note the following: 

If you reinstall the OS, the entire disk will be cleared. If there is any data partition other than the 
system partition, the data must be backed up before reinstalling the OS. 

Operations differ depending on the model of NEC Express5800/ft series. Choose the suitable 
procedure:  

� Models that do not support the RDR (Rapid Disk Resync) function: 
Go to “Disks Operations Using Disk Management” (page 3-3).  

 

� Models that support the RDR (Rapid Disk Resync) function: 
Skip to “Disk Operations Using the RDR (Rapid Disk Resync) Function” (page 3-15).  
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Disks Operations Using Disk Management 
 
Disk Management 
NEC Express5800/ft series (which does not support the RDR function) ensures reliability by 
executing software mirroring to hard disk volumes using Windows. Use Windows’ “Disk 
Management” to manipulate volumes.  

Refer to the online help for the operating procedures of “Disk Management”. 

Steps to refer to the help of operating procedures: 

1. Click [Start] - [Help and Support]. 

2. Select [Disks and Data] from the topics on the help. 

3. Select [Managing Disks and Volumes] - [Disk Management] - [How To…], then check the 
operating procedures. 

 
Hard Disk Configurations that can be built on the NEC Express5800/ft 
series 
In the NEC Express5800/ft series, all volumes need creation of mirror disks. You can create mirror 
disks only on the dynamic simple volume as shown in the table below.     

Volume type Can/cannot be built 
Dynamic simple volume √ 
Dynamic span volume – 
Dynamic mirror volume – 
Dynamic stripe volume – 
Dynamic RAID5 volume – 

 
Create mirror disks by selecting disks that are in the same slot of the SCSI enclosure. For example, 
if the hard disks are positioned as shown in the table below, define hard disks 0 and 3, hard disks 1 
and 4, and hard disks 2 and 5 as mirrored pairs. 
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The pairs of mirror disks as shown above can be created by selecting hard disks whose target IDs 
are identical in the disk properties, which are displayed through [Disk View]. The following 
explains how to confirm the target ID: 

1. Click [Start] → [Administrative Tools] → [Computer Management]. The [Computer 
Management] window appears. 

2. Click [Disk Management] under [Storage] in 
the console tree. 

3. Right-click the disk and point to Properties to 
confirm the target ID. The target ID in the 
example shown here is “1”.   

 

 

 

 

 

 
4. Similarly, confirm the target IDs of the other 

disks.   

Disk No Target ID 
Hard disk 0 0 
Hard disk 1 1 
Hard disk 2 2 
Hard disk 3 0 
Hard disk 4 1 
Hard disk 5 2 

 
When disk numbers and target IDs are matched as shown above, define hard disks 0 and 3, 
hard disks 1 and 4, and hard disks 2 and 5 as mirrored pairs, and add mirror volumes. 
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Configuring and Breaking Mirror 
 
This section describes the procedures to configure and break the mirror of hard disk volumes using 
Disk Management. 
 
Configuring mirror 
Follow the procedures below to configure a volume mirror. 

IMPORTANT: 
Set mirror to the disks whose Target IDs are identical.  
For details, see “Hard Disk Configurations that can be built on the NEC Express5800/ft series 
(page 3-3).”  

 
1. Click [Start] - [Administrative Tools] then [Computer Management].  

The [Computer Management] dialog box will appear. 

2. Click [Disk Management] under [Storage] in the console tree.  
The [Disk Management] window will appear on the right panel.  

3. Insert a new disk. The disk will appear on the [Disk Management] window. 

 

IMPORTANT: 
� If the status of the disk is “Not Initialized”, right-click the disk and initialize it.  

� If [Foreign] appears, right-click the disk and execute [Convert to Basic Disk…].  
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4. Select and right-click a disk, and 
then execute [Convert to 
Dynamic Disk…].  
On the [Convert to Dynamic 
Disk] dialog box, select the disk 
and click [OK].  

 
 
 
 
 
 
 
 
 

5. Right-click the volume of the 
dynamic disk to mirror and click 
[Add Mirror…]. 

 
 
 
 
 
 
 
 
 
 
 
 
 

6. On the [Add Mirror] dialog box, select the disk 
to mirror and click [Add Mirror].  
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IMPORTANT: 
� Clicking [Add Mirror] displays the [Logical Disk Manager] dialog box, but there is no 

problem. Click [OK].  

� If the server is rebooted during mirror generation, mirroring will not be completed. Do 
not reboot the server until the mirroring process is completed.  

 
7. The volume status changes to 

“Resynching”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
8. The mirror configuration is 

completed if the volume status 
changes from “Resyching” to 
“Healthy”.  
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Confirming if Paired Disks are Mirrored Properly 
 

Check the following to confirm that the mirror is configured properly: 

• Is disk mirroring completed successfully? 
Disk mirroring is completed properly if the volume layout is [Mirror], and the status is 
[Healthy] on the [Disk Management] window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Is the mirror configured on the disks of the proper position?  

On the [Disk Management] window, right-click the mirrored disks and select [Properties].  
Click the [General] tab and check if the Target IDs are identical. (In the case below, the Target 
ID is “0”.)  
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Breaking mirror 

Follow the procedures below to break the mirror of volumes.  

The procedures to break a mirror on C drive are discribed here.  

1. Click [Start] - [Administrative 
Tools] - [Computer 
Management]. The [Computer 
Management] window will 
appear.  

 
2. Right-click the volume of the 

dynamic disk whose mirror is 
to be broken and click [Break 
Mirrored Volume…].  
 
 
 
 
 

3. Click [Yes] on the [Break Mirrored Volume] dialog box. 

 
4. Click [OK] on the [Logical Disk Manager] dialog box. (This dialog box is not displayed for 

data volume.) 

 
5. The mirror is broken and the 

volumes will be converted to 
simple volumes.  
In the figure on the right, the 
status of the volumes are as 
follows: 
 
[System Volume] 

Volume: OEM(C:), Status: 
Healthy (System) 

[Broken Volume]  
Volume: OEM, Status: 
Healthy 
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Importing Data Disks 
 
This section describes a procedure to import a data disk using Disk Management.  

IMPORTANT: If you import the disk used as a boot disk on another system, it becomes 
impossible to boot from the disk.  

 
1. Insert the disk to import. 
 
2. Foreign Dynamic Disk is 

displayed on [Disk 
Management]. 
In the figure on the right, Disk 2 
and Disk 3 are the inserted 
disks.  

 
 
 
 
 
 
 
 
 
 
 
3. Right-click the disk to import 

and select [Import Foreign 
Disks…]. 

 
 
 
 
 
 
 
 
 
 
 
 
 
4. In the [Import Foregn Disks] dialog box, select 

the disk group to import and click [OK]. 
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5. In the [Foreign Disk Volumes] dialog box, check 
the volumes to import, and click [OK].  

 
 
 
 
 
 
 
6. The disk import is completed if 

the disk status changes from 
“Foreign” to “Online”.  
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Extending Data Volume Size  
 
This section describes a procedure to extend a volume size using Disk Management.  

IMPORTANT: 
� It is not possible to extend boot volume. 

� As it is not possible to extend mirror volume, a mirror volume is extended in the following 
order: [Remove Mirror] - [Extend Volume] - [Add Mirror]. 

1. Remove the mirror of the volume you want to extend, and make it a simple volume. 
(In the case below, the mirror of the volume (E:) is removed to extend the volume (E:).)  

 
 
2. Right-click the volume to be extended and 

click [Extend Volume…].  
 

 
 
 
 
 
 
 
 
 
 
3. When the [Welcome to the Extend Volume 

Wizard] dialog box of the Extend Volume 
Wizard appears, click [Next].  
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4. On the [Select Disks] dialog box, enter the 
amount of space to extend and click [Next]. 
(In this case, 1500MB is added.)  

 
 
 
 
 
 
 
 
 

 
5. Check the settings on the [Completing the 

Extend Volume Wizard] dialog box and click 
[Finish]. 

 
 
 
 
 
 
 
 
 
 
 
6. The size of the volume is 

extended. 
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7. Configure the mirror of the extended volume.  
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Disk Operations Using the RDR (Rapid Disk Resync) 
Function 
 
RDR (Rapid Disk Resync) 
Models supporting the RDR function secure reliability by making disks duplexed per disk using the 
ft control software’s RDR function. Duplexing disks by the RDR function enables the disks to be 
resynchronized in a short period of time when their mirror has been broken due to causes such as 
PCI module replacement. 

Setting RDR to disks duplicates the disks of paired slots as shown in the figure below and Windows 
(ex. Disk Management and Device Manager) recognizes paired disks as a single virtual disk. 

 

[Paired slots] 

 
Corresponding slots  Virtual disk name given by the RDR 

Utility 
PCI module#1 Slot 1 Ù PCI module#2 Slot 1 
PCI module#1 Slot 2 Ù PCI module#2 Slot 2 
PCI module#1 Slot 3 Ù PCI module#2 Slot 3 

RDR Virtual Disk 1 
RDR Virtual Disk 2 
RDR Virtual Disk 3 

Note: In the above table, the PCI module names correspond to the following modules:  
PCI module (for Group1): PCI module#1 
PCI module (for Group2): PCI module#2 

 
[Cautions for using the RDR function] 

1. RDR can be set only to the disks inserted into the built-in slots of NEC Express5800/ft series.  

2. Be sure to specify RDR to all disks inserted to the built-in slots and make duplex settings.  

3. RDR can be set only to basic disks.  
If a span volume or stripe volume is needed, make settings of RDR to a basic disk and then 
change the disk to a dynamic disk from [Disk Management].  

4. The disks to set RDR must have the same capacity and must be new or physically formatted. 
(For physical format, refer to “SCSI BIOS ~ Fast!UTIL ~” in Chapter 4 “System 
Configuration” and perform Low-Level Format using SCSI Disk Utility.) 
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5. The disks which RDR has been set can only be used in the system with the ft control software 
ver.3.0 or later. 

6. If the system is shut down (or restarted) while the mirror is broken, or a long time (30 hours or 
longer) has passed after the mirror is broken, the mirror resynchronization target will be the 
entire disk.  
For example, if the mirroring has been broken due to a PCI module failure, when you shut 
down the system and replace the PCI module in such a state, the entire area of the disk needs 
to be resynchronized. 

7. You must insert a new disk or replace a disk while the server is powered on. 

8. Import of disk is not supported.  
When reinstalling the OS, if necessary, perform physical format on all disks after backing up 
data disk. 

After reinstalling the OS, restore data from the backup. 

 

Configuring and Removing Duplexed Setting of Disks by the RDR 
Function  
This section describes how to make disks duplex and how to remove the settings by using the RDR 
function. To use the RDR function, use [RDR Utility].  

 
About RDR Utility 

z Starting RDR Utility  
From [Start], select [All Programs] then [RDR] and click [RDR Utility] to start [RDR 
Utility]. 

 
z Screen 

 
Note: In RDR Utility, the PCI module names correspond to the following modules:  

PCI module 1: PCI module (for Group1) 
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PCI module 2: PCI module (for Group2) 
 
 
[Left pane] 
The tree shows disks inserted to the built-in slots and virtual disks (RDR Virtual Disks) 
created by RDR. On the models supporting RDR, right-click a disk on the tree to display the 
menu for setting RDR. By looking at the tree, you can know which disk corresponds to 
which disk of the Windows’ [Disk Management] and whether RDR is set to the disk.  
 
For example, in the case of the disk highlighted in the figure above:  
        Disk (Harddisk1�LUN2�PLEX1) 
               (1)        (2)     (3) 

(1) Corresponds to the number of Windows’ [Disk Management]. In this example, this 
disk is the Disk1 on [Disk Management].  

(2) Corresponds to the number of a virtual disk created by RDR setting. In this example, 
this disk is a disk which makes up the RDR Virtual Disk 2 (only appears for disks 
with RDR setting). 

(3) This section appears only for disks with RDR setting.  
 

[Right pane] 
The properties of the disk selected in the left pane is shown.  
In the figure above, the properties of the disk inserted to the PCI module for Group1’s Slot 2.  

IMPORTANT: 
The [RDR Utility] display is not updated automatically. Therefore, update it by clicking 
[Refresh] from [Action] on the menu or pressing F5 after performing operations to disk 
such as inserting/removing a disk, specifying/removing the RDR setting.  

 
Making disks duplex by RDR 

The following describes the procedure to set duplex configuration to disks by RDR.  
In this example, the disks of the Slot 2 of the PCI modules for Group1 and Group 2 are duplexed.  

 
1. Insert a new disk to a built-in slot.  

(In this example, a disk is inserted to the Slot 2 of the PCI module for Group1.)  
 

2. From [Start], select [Control Panel] then [Administrative Tools] and start [Computer 
Management]. On the tree in the left pane, click [Disk Management].  
If the inserted disk is indicated as [Not Initialized] in the right pane, right-click the disk and 
initialize it.  
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3. Start RDR Utility. 

IMPORTANT: 
� If the inserted disk does not appear on the tree, from the menu of RDR Utility, select 

[Action] and click [Refresh] or press F5 to update the display after awhile. 

� The display of RDR Utility is not updated automatically. Therefore, update it by clicking 
[Refresh] from [Action] or pressing F5 on the menu after performing operations 
described below. 

 
4. On the left tree of RDR Utility, right-click a disk to set RDR and click [Add RDR Virtual 

Disk]. 

IMPORTANT: 
Depending on the disk condition, RDR setting may take some time and RDR Utility may 
pause for a few minutes. There is no error, so wait until the process is completed. 
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IMPORTANT: 
If RDR is specified to a disk which contains the system partition or partition which cannot 
be unmounted, the following pop-up message appears. If you click [Yes], the system is 
restarted in two minutes automatically. Go on to 5. when the system is restarted.  
 

 
 
 

5. Insert a disk to set duplex configuration into the corresponding slot. 
(In this example, a disk is inserted into the Slot 2 of the PCI module for Group2.) 
After the disk is inserted, RDR is set automatically and synchronization starts. Then the 
status changes as described in 6. 

IMPORTANT: 
For a disk to be inserted, use a new or physically formatted disk which has the same 
capacity as the synchronization source. If such a disk is not used, disks are not 
duplicated successfully 
For physical format, see Chapter 4 “System Configuration” - “SCSI BIOS ~ 
Fast!UTIL ~” and perform Low - Level Format by SCSI Disk Utility. 

When performing Low - Level Format, disable “Advanced” - “Monitoring 
Configuration” - “Option ROM Scan Monitoring” of BIOS Setup Utility. For the setup 
method, see Chapter 4 “System Configuration” - “SYSTEM BIOS ~ SETUP ~”. 
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6. Confirm that the DISK LEDs and the display of RDR utility change as shown below: 
 

� Synchronizing 
RDR Utility  DISK LED Op State: State Status 

Source disk Amber Simplex  
Destination disk Green Syncing  
RDR Virtual Disk  Simplex Resync x percent 

(x=0, 10, 20, ..., 90) 
 

 

IMPORTANT: 
� The time required for synchronization varies depending on the partition size on the disk. 

For 18GB partition, it takes about 16 minutes. 
If there is no partition, synchronization may complete in a short period of time and the 
disk may become synchronized after RDR is set. 

� If the system is rebooted during synchronization, the process cannot be completed. Do 
not restart the system until the synchronization is completed. 
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� Synchronization completed 
RDR Utility  DISK LED Op State: State Status 

Source disk Green Duplex  
Destination disk Green Duplex  
RDR Virtual Disk  Duplex None 

 

 

IMPORTANT: 
� When a new partition is created on the disk where RDR is set, the created partition area 

is synchronized automatically. 

� When the disk where RDR is set is converted to a dynamic disk, the area which has not 
been synchronized (the area that no partition exists) will be synchronized. 

� When the system is shut down without shutting down Windows properly, for example, 
by pressing the power button, the entire area of the synchronized disks will be 
resynchronized after the system is restarted. 
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Removing duplex configuration of RDR disks 

This section describes how to remove duplex configuration from the disk with RDR setting.  
In the example below, the duplication setting of the disks in the Slot 2 of the PCI modules for Group 
1 and for Group 2 is removed. 

IMPORTANT: 
� After executing the command, RDR settings will be cancelled but other data will remain. 

� You cannot break the duplex setting of the following disks: 
� Disk containing the boot partition or volume 
� Disk containing page files 
� Dynamic disk 

� The display of RDR Utility is not updated automatically. Therefore, update it by clicking 
[Refresh] from [Action] or pressing F5 on the menu after performing operations described 
below. 
 

1. Start the RDR Utility, right-click a disk you 
want to cancel RDR from the tree in the left 
pane, and select [Delete RDR configuration 
on Physical Disk]. 

 
 
 
 
 
 
 
 
 
 
 
2. In the [Warning] dialog box, click [Yes]. 
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3. Confirm that RDR of the disk is cancelled. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4. Cancel the disk of the corresponding slot in the same manner. 
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IMPORTANT: 
� A partition on the disk where the RDR setting is removed is not assigned a drive letter. To 

use the partition, assign a drive letter using [Disk Management]. 

� If the disk contains a partition which cannot be unmounted, the OS needs to be restarted 
when canceling RDR. 
In that case, the following pop-up message appears. If you click [Yes], the OS is restarted in 
two minutes automatically: 
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Other functions of RDR Utility 

 
<Commands for physical disks> 
 
Remove Physical Disk from RDR Virtual Disk 
All data including RDR settings on a physical disk can be deleted. 

IMPORTANT: 
� After executing the command, the physical disk becomes an empty basic disk without RDR 

settings. 

� This command can only be executed to physical disks in Duplex/Syncing state. 
 

1. Start RDR Utility and right-click a target disk on the tree in the left pane, and click [Remove 
Physical Disk from RDR Virtual Disk]. 

2. In the [Warning] dialog box, click [Yes]. 

3. In the [Success] dialog box, click [OK]. 

 
Clear MTBF 

When a failure occurs to a disk, the mean time between failures (MTBF) is counted and the value is 
saved. In RDR Utility, the value is displayed at [MTBF: Current] and [MtbfThresholdStatus]. 

These MTBF values can be cleared by the [Clear MTBF] command. 

1. Start RDR Utility and right-click a target disk on the tree in the left pane, and click [Clear 
MTBF]. 

2. In the [Success] dialog box, click [OK]. 
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Resynchronize This Disk 

Disks whose synchronization by RDR is cancelled for reasons including a failure can be 
resynchronized. 

1. Start RDR Utility and right-click a target disk in the left pane and click [Resynchronize This 
Disk]. 

2. In the [Success] dialog box, click [OK]. 

3. Confirm that the resynchronization starts and the status of disks changes as shown below: 

� Synchronizing 
RDR Utility  DISK LED Op State: State Status 

Source disk  Amber Simplex  
Destination disk  
(disk where the 
command is run) 

Green Syncing  

RDR Virtual Disk  Simplex Resync x percent 
(x=0, 10, 20, ..., 90) 

 

� Synchronization completed 
RDR Utility  DISK LED Op State: State Status 

Source disk Green Duplex  
Destination disk Green Duplex  
RDR Virtual Disk  Duplex None 
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Set As Active RDR Disk 

A physical disk can be set as “Active RDR Disk”. 
Active RDR Disk is the disk on which data reading process is performed when Load Balancing of 
RDR Virtual Disk is off. 

 

1. Start RDR Utility and right-click a target disk in the left pane and click [Set As Active RDR 
Disk]. 

2. In the [Success] dialog box, click [OK]. 

 
Active RDR Disk can be viewed from [ActiveRDRDisk] of RDR Virtual Disk. 
(In the image below, the disk in the slot 2 of PCI module for Group1 is set to Active RDR Disk 
among physical disks constructing RDR Virtual Disk 2.) 
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<Commands for RDR Virtual Disk> 
 
Verify RDR Virtual Disk 

Whether the synchronization by RDR is performed normally can be checked. 

1. Start RDR Utility and right-click [RDR Virtual Disk x](x=1,2,3) in the left pane and click 
[Verify RDR Virtual Disk]. 

2. In the [Success] dialog box, click [OK]. 
The progress of verification can be viewed using RDR Utility. 

 Verifying Verification completed  
[Status] of RDR Virtual Disk x 

(x=1,2,3) 
Verify x percent 

(x=0, 10, 20, …, 90) None 

 

TIPS: 
� The verification process is automatically performed every 720 minutes (12 hours). 

� The time required for verification depends on the disk size and load. 

 
Set Resync Priority 

Priority of synchronization can be specified for disk mirroring by RDR. 

By changing the priority, I/O load during synchronization can be reduced. 

1. Start RDR Utility, right-click [RDR Virtual Disk x](x=1,2,3) in left pane to change the 
priority and click [Set Resync Priority]. 

2. When a dialog box appears, select Low, Normal or High (a default is Normal) and click 
[OK]. 

3. In the [Success] dialog box, click [OK]. 

 
Set RDR LUN Load Balancing 
On or off of load balancing can be specified. 
When the load balancing is on (default), the read process is performed alternately from two physical 
disks forming the RDR Virtual Disk to improve performance. When it is off, the read process is 
performed from the physical disk specified as Active RDR Disk. 

1. Start RDR Utility, right-click [RDR Virtual Disk x](x=1,2,3) in left pane to change the 
priority and click [Set RDR LUN Load Balancing]. 

2. When a dialog box appears, select On or Off (a default is On) and click [OK]. 

3. In the [Success] dialog box, click [OK]. 
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Replacing Failed Hard Disk Drives 
 
Follow the procedure below to locate and replace the failed hard disk. The failed hard disk 
should be replaced with new device with the server powered-on. 
 
How to Locate Failed Disks  

1. From [Start], select [All Programs] - [RDR] and click [RDR Utility] to start [RDR 
Utility].  

2. From the tree on the left pane of [RDR Utility], select each disk and check the values of 
[MTBF: Current] and [MtbfThresholdStatus] in the right pane.  
 
TIP: 
For RDR Utility, see “About RDR Utility” on page 3-16. 
 
[Description of each MTBF value] 

Property name Description  Normal value* 
MTBF: Current Mean time between failures.  Unknown 
MtbfThresholdStatus The status of comparing the MTBF value 

with the threshold level (1200 seconds). Normal 

* The normal value denotes the value of when no error has occurred.  
 
If either of the values is different from the normal value, the disk has an error.  
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Procedures to Replace Failed Disks 
 

Models that do not support the RDR function 

When a failure occurs on a disk mirrored by volume using [Disk Management], follow the steps 
below to replace the disk.  

IMPORTANT: 
� To remove a disk due to a failure, etc., compare [Disk Management] and [RDR Utility] to 

determine the disk to remove. (For RDR Utility, see “About RDR Utility” on page 3-16.) 

� To reconfigure a mirror, be sure to confirm the TargetID in the disk’s [Properties] and use the 
disks with the same number. Do not mirror disks using the disk number shown in [Disk 
Management]. 

� When the disk to be inserted into a slot for duplexed configuration of disk has been used as a 
disk which contains the boot volume (disk storing the OS), the disk cannot be used for 
duplexed configuration. Initialize the disk to use the disk.  

 
This section describes an example of determining failures of the disk in the Slot 2 of the PCI 
module for Group1 and the disk in the Slot 3 of the PCI module for Group2 using “How to Locate 
Failed Disks”.  

 
1. Click [Start] → [Administrative Tools] → 

[Computer Management]. The [Computer 
Management] window appears.   

2. Click [Disk Management] under [Storage] 
in the console tree. An example in this 
figure shows that one of the mirrored disks 
in which Drives E and F are included is 
broken. Some disks are indicated as 
“Unknown disk.” However, they may be 
indicated differently depending on the error 
type. Even in such cases, failed disks can be 
recovered by following the steps below: 

 

3. Remove the hard disks from Slot#2 of 
Group 1 and Slot#3 of Group 2. 
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4. Right-click a volume that has “!”, and 
remove mirror.  

 

 

 

 

 

 

 

 

 

5. After checking to see the “Missing” 
disk is selected, click [Remove 
mirror]. At Drive (F), [Mirror] and 
[Failed Redundant] will change to 
[Simple] and [Healthy].    

 

 

 

 

 

 

 

 

6. Right-click a disk with “x”, and select 
[Remove Disk]. 

 

 

 

 

 

 

 

 

 



3-32  Windows Setup and Operation 

7. Similarly, delete the other [Missing] disk. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. Insert new disks. They will appear on 
[Disk Management]. If any uninitialized 
disk is inserted, right-click the disk and 
initialize it. 
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9. Select and right-click a disk, and then 
select [Convert to Dynamic Disk]. 

 

 

IMPORTANT: If [Foreign] appears, execute [Convert to Dynamic Disk] after [Convert 
to Basic Disk] is executed.    
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10. Open the disk’s properties to check the target IDs. In the following figures, disks are 
configured as: 

Disk 1: Target ID 1 

Disk 2: Target ID 2 

Disk 4: Target ID 1 

Disk 5: Target ID 2 

Disks with the same target ID are mirrored.   

Disk 1                                   Disk 2 
    

 
 
 
 
 
 
 
 
 
 
 

Disk 4                                   Disk 5 
     
 
 
 
 
 
 
 
 
 
 
 

IMPORTANT: Hard disks are numbered from “0” at the OS startup according to the 
position they are inserted. When you increase a hard disk while the system is running, it 
will be given a number that is not used for any disks. However when you restart the 
system, the old disk numbers will not be retained and disks are re-numbered according 
to the hard disk position. Therefore, you need to determine which disks are mirrored 
based on target IDs, which are always fixed, but not on disk numbers because disk 
numbers may change.   
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11. Make a mirror setting of Disks 1 and 

4. Right-click volume (E) on the 
Disk 4 and select [Add Mirror].   

 

 

 

 

 

 

 

 

12. When the [Add mirror] dialog box 
appears, select Disk 1, and then click 
[Add Mirror].   

 

 

 

 

 

 

 

13. Similarly, make settings of Disk 2 
and Disk 5.  
Upon completion of synchronous 
processing, recovery is completed.   
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Models supporting the RDR function 

This section describes a procedure for replacing a disk when a failure occurs to a disk which is 
duplicated by the RDR function.  
Here, an example that a failure of the disk in slot 2 of the PCI module for Group 1 is determined as 
described in “How to Locate Failed Disks” is explained. 
 

IMPORTANT: 
� The display of RDR Utility is not updated automatically. Therefore, update it by clicking 

[Refresh] from [Action] or pressing F5 on the menu after performing operations described 
below. 

� Do not update RDR Utility frequently immediately after inserting a disk. 

 
1. From [Start], click [All Programs], point to [RDR], and select [RDR Utility] to start RDR 

Utility. 

2. Remove the disk in the slot 2 of the PCI module for Group 1. 

3. Insert a new disk to the slot 2 of the PCI module for Group 1. 
Then, RDR is automatically set to the inserted disk, synchronization starts and the status 
changes as described in 4. 

IMPORTANT: 
For a disk to be inserted, use a new or physically formatted disk which has the same 
capacity as the disk of the corresponding slot (in this example, the disk in slot 2 of the PCI 
module for Group 2). 
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4. Confirm that the DISK LEDs and the display of RDR Utility change as shown below: 

� Synchronizing 
RDR Utility  DISK LED Op State: State Status 

Source disk Amber Simplex  
Destination disk 
(Inserted disk) Green Syncing  

RDR Virtual Disk  Simplex Resync x percent 
(x=0, 10, 20, ..., 90) 

 

 

IMPORTANT: 
� The time required for synchronization varies depending on the partition size on the disk. 

For 18GB partition, it takes about 16 minutes. 
If there is no partition, synchronization may complete in a short period of time and the 
disk may become synchronized after RDR is set.  

� If the system is rebooted during synchronization, the process cannot be completed. Do 
not restart the system until the synchronization is completed. 
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� Synchronization completed 
RDR Utility  DISK LED Op State: State Status 

Source disk  Green Duplex  
Destination disk  
(Inserted disk)  Green Duplex  

RDR Virtual Disk  Duplex None 
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CHANGE DRIVE LETTER  
To add, change or delete drive letters, follow the steps below. Before making any changes, 
thoroughly read the NEC Express5800/ft series-specific precautions and general precautions for 
Windows.  
 

1. Select [Start] - [Control Panel] - [Administrative Tools] and open [Computer Management].  
2. In the console tree of [Computer Management], click [Disk Management].  
3. Right-click a target partition, logical drive or volume and click [Change Drive Letter and 

Paths…].  
4. Perform one of the following:  
z To assign a drive letter, click [Add…], a drive letter to use, then [OK].  
z To change a drive letter, click the drive letter to change, [Change…], a drive letter to use, 

then [OK].  
z To delete a drive letter, click the drive letter to delete then [Remove].  

 

IMPORTANT: 
<NEC Express5800/ft series-specific precautions>  
One CD-ROM drive for each PCI module (total of two CD-ROM drives) is installed in NEC 
Express5800/ft series. If those CD-ROM drives’ N-codes are different, the drive letter assigned to 
the CD-ROM drive may be changed (reassigned) when the secondary PCI module becomes the 
primary module at startup. In such case, follow the instruction above to change back the drive 
letter. It is recommended to specify “D” as the CD-ROM drive’s drive letter. (The change of drive 
letter due to the change of primary PCI module can be suppressed.)  
 
<General precautions for Windows>  
• Drive letter of system volume or boot volume cannot be changed.  
• Up to 26 drive letters can be used on a computer. “A” and “B” are drive letters for floppy disk 

drives. Generally, hard disk drives are assigned “C” to “Z”, but for network drives, drive 
letters are assigned in a reverse order (“Z” to “C”).  

• Because many of Windows programs refer to specific drive letters, cautions are required for 
assigning drive letters. For example, the Path environment variable specifies a program name 
and a specific drive letter.  

• For performing the procedure above, you need to be a member of Backup Operators group or 
Administrators group, or you need to have appropriate authorization.  
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DUAL LAN CONFIGURATION 
The NEC Express5800/ft series builds a dual LAN configuration by using "Stratus emb-82559 
10/100 Enet Adapter" (100Base) and "Stratus emb-82544GC Copper Gigabit Adapter" (1000Base) 
mounted as standard on the PCI module. 

 

Overview 
The dual LAN configuration is of two types. 

Adapter Fault Tolerance (AFT) is a feature that creates a group containing more than one adapter 
and automatically converts the process of the working adapter to the other adapter in the group 
when any trouble occurred on that adapter. 

Adaptive Load Balancing (ALB) is a feature that creates a group containing more than one adapter 
and enhances the throughput by operating packet transmission from the server by all the adapters. 
This feature includes AFT feature. 

 

Configuring dual LAN 
TIPS: To set dual LAN configuration, log on as "Administrator" or a member of the group 
"Administrators". 

1. Display the [Intel(R)PROSet II] dialog box by starting one of the start menu modes below:   
Standard start menu mode 

Click [Intel(R)PROSet II] in [Control Panel] from the [Start] menu. 

Classic start menu mode 

(1) Select [Control Panel] from [Settings] of the [Start] menu. 

(2) Double-click the [Intel(R)PROSet II] icon. 

2. Select [Network Components] from Network Component Tree. The pop-up menu appears. 
Select [Fault Tolerance] from [Create Team]. 
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[Team #1: Adaptive Fault Tolerance Mode] is added to Network Component Tree. 
 

 

 

 

 

3. Select [Stratus emb-82559 10/100 Enet Adapter] from Network Component Tree. The 
pop-up menu appears. Select [Team #1: Adaptive Fault Tolerance Mode] from [Add to 
Team], and add the adapters. 

You will see the warning message when you add the team. You can ignore this warning 
message by clicking [OK]. This warning message is to inform you that only one adapter is 
added to the team. 

4. Select [Stratus emb-82559 10/100 Enet Adapter #2] from Network Component Tree in the 
same manner as for 4. The pop-up menu appears. Select [Team #1: Adaptive Fault 
Tolerance Mode] from [Add to Team], and add the adapters. 

IMPORTANT: Do not set [Preferred Primary] or [Preferred Secondary] to each 
adapter. 

5. Make settings of dual configuration for "Stratus emb-82544GC Copper Gigabit Adapter" 
(1000Base) as well. 

Perform 3 to 5 in the same manner, replacing [Stratus emb-82559 10/100 Enet Adapter] with 
[Stratus emb-82544GC Copper Gigabit Adapter]. 

In 3, you can also select [Load Balancing]. In this case, [Team #X: Adaptive Load Balancing 
Mode] will be added. 

When the option boards are used, perform 3 to 5 in the same manner, replacing [Stratus 
emb-82559 10/100 Enet Adapter] with the following. 

N8804-001P1: [Stratus AA-U51500 10/100 Enet Adapter] 

N8104-84: [Stratus AA-U57000 Fiber Gigabit Adapter] 

N8104-103: [NEC 8490XT Copper Gigabit Adapter] 
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IMPORTANT: Load Balancing mode cannot be selected on "Stratus emb-82559 
10/100 Enet Adapter". Only Fault Tolerance mode can be selected. 

6. Click [OK]. 
The [Intel(R)PROSet II] dialog box closes after a while, and the settings become effective. 

 

IMPORTANT: 
� The [Digital signature not found] dialog box may appear (several times). If it 

appears, click [Yes]. 

� After the settings of dual configuration, “Intel(R) Advanced Network Services 
Virtual Adapter” will appear on the [Network and dialup connection] or [Device 
Manager] dialog box. Therefore 6 adapters that consist of two "Virtual", two 
"100Base", and two "1000Base" adapters will appear on the [Network and dialup 
connection] or [Device Manager] dialog box. Do not “disable” the status of this 
“Virtual Adapter”. If you enable it again, the system may become unstable and you 
may need to restart it. 

� Set IP address for "Virtual Adapter" after the settings of dual configuration. Do not 
set IP address for "100Base Adapter" or "1000Base Adapter". 

� Use a hub for dual configuration. Use a repeater hub or a switching hub for AFT 
function. Use a switching hub for ALB function. 

� Connect the network cables to the both primary and secondary PCI modules. After 
the settings of dual configuration, if one network cable is disconnected from a PCI 
module or a hub, the status of the PCI modules becomes simplex. In such case, if the 
network cable is connected to the PCI module or the hub again, the status of the PCI 
modules becomes duplex. 
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Removing dual LAN 
TIPS: To set dual LAN configuration, log on as "Administrator" or a member of the group 
"Administrators". 

1. Display the [Intel(R)PROSet II] dialog box. 

2. Start one of the start menu modes below:   

Standard start menu mode 

Click [Intel(R)PROSet II] in [Control Panel] from the [Start] menu. 

Classic start menu mode 

(1) Select [Control Panel] from [Settings] of the [Start] menu. 

(2) Double-click the [Intel(R)PROSet II] icon. 

3. Remove all adapters from Duplication. 

Right-click the following adapters on the control tree which is located on the left side 
of the [Intel(R)PROSet II] dialog box and select [Remove from Team].   

<For on-board > 
- Status emb-82559 10/100 Enet Adapter 
- Status emb-82544GC Copper Gigabit Adapter 

 
<For option board > 

- Status AA-U51500 10/100 Enet Adapter (100BASE-TX) 
- Status AA-U57000 Fiber Gigabit Adapter (1000 BASE-SX) 
- NEC 8490 XT Copper Gigabit Adapter (1000 BASE-T) 

 

You will then see the dialog box on the right of this paragraph. This is because one of 
two teamed adapters constituting dual configuration is removed. 

Click [Yes], to remove the adapter from Team. 
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Remove the other adapter in the same way. 

<For on-board > 
- Status emb-82559 10/100 Enet Adapter 
- Status emb-82544GC Copper Gigabit Adapter 

 
<For option board > 

- Status AA-U51500 10/100 Enet Adapter (100BASE-TX) 
- Status AA-U57000 Fiber Gigabit Adapter (1000 BASE-SX) 
- NEC 8490 XT Copper Gigabit Adapter (1000 BASE-T) 

 

4. Right click [Team #1: Adaptive Fault Tolerance Mode] and select [Remove]. 

At that time, the dialog box shown on the right is displayed. This is a message for 
confirmation, so click [Yes] button. 

Remove all teams displayed on the [Intel PRO Set II] dialog box in the same manner. 
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5. Click the [OK] button on the [Intel PROSet II] dialog box, close it, and make a setup 
effective. 

The dual LAN will be canceled.  
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CHECK THE DUPLICATING OPERATION OF 
MODULES 
This section describes how to check if the system runs properly after system installation or 
reinstallation.  
 

Evaluate Startup and Stop of PCI Modules 
This section describes how to confirm the continuous system operation by failover after stopping the 
primary PCI module.  

 
1. Check which is the primary PCI module.  

The PCI module with the POWER switch illuminated is the primary module.  
 

2. Check whether the PCI modules are duplicated.  
To check if the PCI modules are duplicated, see the PCI modules’ status LEDs.  
 

 
 
[Indications of the status LEDs when PCI modules are duplicated]  

LED Primary Secondary 
1 BMC status LED Green - 
2 PCI module status LED1 - - 
3 PCI module status LED2 Green Green 
4 DISK ACCESS LED Green or off Green or off  
DISK LED Green Green 

* The numbers in the table correspond to the numbers in the above figure.  
The DISK ACCESS LED (4) lights when the hard disk drive is accessed. 
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3. Stop the operation of a PCI module using the ft server utility.  
Select [Start] - [All Programs] - [NEC ESMPRO Agent] - [ft server utility] to start the 
ft server utility.  
Then, from the ft server utility, select [PCI Module] then the primary PCI module from 
the [FTSever] tree on the left pane, and click [Down] of [Bring Up/Bring Down]. When 
you stop the operation of the primary PCI module, a failover occurs and the secondary 
PCI module becomes the primary module.  
 

 
 
The following events or changes occur when stopping the primary PCI module and the 
module fails over: 
z The screen temporarily blacks out and then displayed again.  
z The following message will appear from the taskbar:  

Windows - FT Orphaning: A disk that is part of a fault-tolerant volume can no 
longer be accessed. 
* The message denotes that the mirror volumes of the hard disk stored in the 
disconnected PCI module are released.  
* The message will not appear if disks are duplicated by the RDR function.  

z Indications of PCI modules’ status LEDs change as follows:  
[Indications of status LEDs]  

LED Secondary* Primary* 
1 BMC status LED - Green and blinking  
2 PCI module status LED1 Red - 
3 PCI module status LED2 - Amber 
4 DISK ACCESS LED - Amber 
DISK LED - Amber 

* The primary and secondary modules after failover 
 

4. Restart the PCI module.  
From the ft server utility, click [Up] of [Bring Up/Bring Down] to the PCI module 
which was stopped in the step 3, and the PCI module will be started. Once the PCI 
module is started, PCI module diagnosis, mirror volume duplication and PCI module 
duplication are performed.  
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IMPORTANT: If BrightStor ARCserve 2000 or Backup Exec is installed, the tape will 
not be recognized due to the failover of the PCI module. Thus be sure to stop the 
services before starting the PCI module. 

1. Start [Services] from [Administrative Tools] of [Control Panel]. 

2. Select a service of backup software. 

3. Choose “Stop” from the “Action” menu. 

4. Repeat 2 and 3 for all services of the backup software. 
 
The PCI modules’ status LEDs changes as shown below:  
[Indications of the status LEDs]  
Immediately after the PCI module startup until the completion of diagnosis 

LED Secondary Primary 
1 BMC status LED - Green 
2 PCI module status LED1 Red - 
3 PCI module status LED2 Green Amber 
4 DISK ACCESS LED - Amber 
DISK LED Green Amber 

 
 
 
When duplication of disks is started after the completion of PCI module diagnosis 
* The status of LEDs varies depending on the method of disk duplication.  

Secondary 
LED Non-RDR 

model 
RDR 
model 

Primary 

1 BMC status LED - - Green 
2 PCI module status LED1 - - - 
3 PCI module status LED2 Amber Green Amber 
4 DISK ACCESS LED Amber Green Amber 
DISK LED Amber Green Amber 

 
 
 
After the completion of disk duplication and when the PCI modules are duplicated 

LED Secondary Primary 
1 BMC status LED - Green 
2 PCI module status LED1 - - 
3 PCI module status LED2 Green Green 
4 DISK ACCESS LED Green or off Green or off 
DISK LED Green Green 
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Evaluate Start and Stop of CPU Modules 
This section describes how to confirm the continuous system operation after stopping one of the 
CPU modules.  

 
1. Confirm that the CPU modules are duplicated.  

To check if the CPU modules are duplicated, see the status LEDs of the CPU modules.  
 

 
 
[Indications status LEDs when CPU modules are duplicated]  

LED CPU module#1 
(Operating) 

CPU module#2 
(Operating) 

1 CPU module status LED1 - - 
2 CPU module status LED2 Green Green 

 
2. Use the ft server utility to stop the operation of a CPU module to remove.  

From [Start], select [All Programs], [NEC ESMPRO Agent] then [ft server utility] to start the 
ft server utility. Then, from the ft server utility, select [CPU Module] then the CPU module to 
stop from the [FTSever] tree on the left pane, and click [Down] of [Bring Up/Bring Down].  
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When you stop the operation of a CPU module, the indications of the status LEDs change as 
follows. Below denotes that the only one CPU module is operating.  
 
[Indications of status LEDs]  

LED CPU module#1 
(Stopped)* 

CPU module#2 
(Operating) 

1 CPU module status LED1 Red - 
2 CPU module status LED2 - Amber 

* As an example, the indications of when CPU module#1 is stopped are shown.  
 

3. Press the start button of the CPU module stopped by ft server utility.  
In the ft server utility, select the stopped CPU module and click [Up] of [Bring Up/Bring 
Down].  
Once the CPU module is started, hardware diagnosis and then synchronization of memory 
(memory copy) are performed, and the duplication process is completed.  
Note that the system is paused temporarily for copying memory during memory 
synchronization.  
 
[Indications of status LEDs during diagnosis]  

LED CPU module#1 
(Started) 

CPU module#2 
(Operating) 

1 CPU module status LED1 Red - 
2 CPU module status LED2 Green Amber 

 
 
 

[Indications of status LEDs after completion of duplication]  

LED CPU module#1 
(Operating) 

CPU module#2 
(Operating) 

1 CPU module status LED1 - - 
2 CPU module status LED2 Green Green 

 
IMPORTANT: 
After duplication is completed, the status of memory will be checked. 

Wait until this process ends to perform the next step (evaluation of start and stop of PCI 
and CPU modules). When the process is complete, the following event log will be 
output: 

Source: srabid 

Type: Information 

Event ID: 4137 

Description: Memory consistency check has completed memory scan. 
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NEC Express5800/ft series SERVICE PROGRAM 
CONFIGURATION 
NEC Express5800/ft series achieves the duplex system using the following service programs, in 
addition to dedicated drivers. 
 

Service program names shown in [Services]:  
z Stratus ftServer Maintenance and Diagnostics (MAD) 
z Stratus ftServer Provider Manager 
z Stratus ftServer Storage Manager 
z BMC FW Update Service 
z Windows Management Instrumentation 
z SNMP Service 
z Alert Manager Main Service 
z ESM System Management Service 
z ESMFSService 
z ESMCommonService 
z ESRAS Utility Service 
z ESMPS 
z ftMofInit * 

 
The above programs are necessary for the NEC Express5800/ft series operation. Do not stop these 
services. 
 
When minimizing the number of operating service programs temporarily is required (for system 
disk backup using backup software, etc), the following service programs may be stopped:  
 

Services that can be stopped: 
z ESMFSService 
z ESRAS Utility Service 

 
Services required to keep operating 
z Stratus ftServer Maintenance and Diagnostics (MAD) 
z Stratus ftServer Provider Manager 
z Stratus ftServer Storage Manager 
z BMC FW Update Service 
z Windows Management Instrumentation 
z SNMP Service 
z Alert Manager Main Service 
z ESM System Management Service 
z ESMCommonService 
z ESMPS 
z Virtual Disk Service (when using Windows’ Disk Management) 
z ftMofInit * 

 
Make sure to restart the operations of stopped service programs immediately after the backup 
processes are completed. 
 
* This service is stopped normally. Because it starts as necessary, do not change its 
“Startup Type” to “Disabled”. 
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Chapter 4 

System Configuration 

This chapter describes Basic Input Output System (BIOS) configuration. 

When you install the server for the first time or install/remove optional devices, thoroughly read this 
chapter for better understanding and correct setups. 
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SYSTEM BIOS ~ SETUP ~ 
The SETUP utility is provided to make basic hardware configuration for the server. This utility is 
pre-installed in the flash memory of the server and ready to run. 

The server is configured with the correct parameters using the SETUP utility and shipped in the best 
conditions. Thus, you do not need to use the SETUP utility in most cases. However, you might wish 
to use the SETUP utility in the cases described below. 

IMPORTANT:  

� The SETUP utility is intended for system Administrator use only. 

� The SETUP utility allows you to set a password. The server is provided with two levels of 
password: Supervisor and User. With the Supervisor password, you can view and change all 
system parameters of the SETUP utility. With the User password, system parameters available 
for viewing and changing are limited. 

� Do not set any password before installing the OS. 

� The server contains the latest version of the SETUP utility. Dialog boxes appearing on your 
SETUP utility, thus, may differ from descriptions in this User's Guide. If you find anything 
unclear, see the online help or ask your sales agent. 
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Starting SETUP Utility 

Powering on the server starts POST (Power On Self-Test) and displays its check results. If the NEC 
logo is displayed, press Esc. 

After a few seconds, either of the following messages appears at bottom left on the screen 
depending on your system configuration. 

Press <F2> to enter SETUP
 

Press <F2> to enter SETUP, Press <F12> to Network
 

You may see either of the following messages at bottom left on the screen when POST terminates. 

 
 

Press <F1> to resume, <F2> to SETUP 
 

Press <F1> to resume, <F2> SETUP, <F12> Network
 

Press F2 to start the SETUP utility and display its Main menu. 

If you have previously set a password with the SETUP utility, the password entry screen appears. 
Enter the password. 

Enter password:[              ]
 

Up to three password entries will be accepted. If you fail to enter the password correctly for three 
consecutive times, the server halts. (You can no longer proceed.) Power off the server. 

TIPS: The server is provided with two levels of password: Supervisor and User. With the 
Supervisor password, you can view and change all system configurations. With the User password, 
the system configurations you can view or change are limited. 
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Description of On-Screen Items and Key Usage 

Use the following keyboard keys to work with the SETUP utility. (Key functions are also listed at 
the bottom of the screen.) 

Setup item 
menu 

Indicates there  
are submenus 

Explanation of key
function menu 

Online help 
window 

Parameter (high-lights upon selection) menu 

Indicates the current menu

 

Cursor (↑, ↓): Selects an item on the screen. The highlighted item is currently 
selected. 

Cursor (←, →): Selects the Main, Advanced, Security, System Hardware, Boot, or 
Exit menu. 

– and +: Changes the value (parameter) of the selected item. When a 
submenu option (an option preceded by " ") is selected, these 
keys are disabled. 

Enter Press Enter to choose the selected parameter. 
Esc Displays the previous screen. 
F1: Press F1 when you need help on SETUP operations. The help 

screen for SETUP operations appears. Press Esc to return to the 
previous screen. 

F9: Sets the default parameter to the parameter of the currently 
displayed item. (The default parameter may differ from the factory 
setting. 

F10: Save configuration values and exit. 
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Configuration Examples 

The following describes examples of configuration required to use software-link features or for 
system operations. 

 

Link with Management Software 

To control power supply of the server with NEC ESMPRO Manager via the network 

Select [System Hardware] → [AC-LINK] → [StayOff]. 

To use the management PC with "NEC MWA" installed for remote operations 

� Remote operation via LAN 

Select [Advanced] → [Advanced] → [RomPilot Support] → [Enabled]. 

� Remote operation via direct connection using cross cable 

Select [System Hardware] → [Console Redirection] → [Console Connection] → [Direct]. 

� Remote operation via WAN 

Select [System Hardware] → [Console Redirection] → [Console Connection] →  
[Via Modem]. 

 

UPS 

To link power supply with the UPS 

� To power on the server when power is supplied from the UPS 

Select [System Hardware] → [AC-LINK] → [Power On]. 

� To keep the server off-powered even when power is supplied from the UPS if the POWER 
switch was used to power off 

Select [System Hardware] → [AC-LINK] → [Last State]. 

� To keep the server off-powered even when power is supplied from the UPS 

Select [System Hardware] → [AC-LINK] → [StayOff]. 

 

Keyboard 

To set NumLock and key repeat 

Select [Advanced] → [Keyboard Features] and set each item. 
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Security 

To set passwords on the BIOS level 

Select [Security] → [Set Supervisor Password] and enter a password. 

Set Supervisor password first, then User password. 

To enable/disable the POWER switch 

Select [Security] → [Power Switch Mask] → [Unmasked]. 

Select [Security] → [Power Switch Mask] → [Masked]. 

IMPORTANT: Masking the POWER switch disables forced shutdown as well as power 
on/off using the POWER switch. 

 

Serial Devices 

To setup serial devices 

Select [Advanced] → [Peripheral Configuration] and setup each device. 

 

Optional PCI–related devices 

To install optional PCI boards, etc., 

Select [Advanced] → [Option ROM] → [PCI Slot n] → [Enabled]  

n: Slot number to install the board 

Boot 

To change the boot order of devices connected to the server 

Select [Boot] and specify the boot order. 

To display POST check results 

Select [Advanced] → [Advanced] → [Boot-time Diagnostic Screen] → [Enabled]. 

You can also press Esc while the NEC log is on the screen to display POST check results. 

To control from the HW console 

� Remote operation via LAN 

Select [Advanced] → [Advanced] → [RomPilot Support] → [Enabled]. 

� Remote operation via WAN 

Select [System Hardware] → [Console Redirection] and set each item. 
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Memory 

To check the installed memory (DIMM) status 

Select [Advanced] → [Memory Information] and check the status indications. 

 

Saving the Configuration Data 

To save the BIOS configuration data 

Select [Exit] → [Save Changes & Exit] or [Save Changes]. 

To discard changes to the BIOS configuration data 

Select [Exit] → [Exit Without Saving Changes] or [Load Previous Value]. 

To restore the default BIOS configuration (it may be different from the configuration at 
shipment) 

Select [Exit] → [Get Default Values]. 
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Menu and Parameter Descriptions 

The SETUP utility has the following six major menus: 

� Main 

� Advanced 

� Security 

� System Hardware 

� Boot 

� Exit 

To configure detailed settings of functions, select a submenu from the above menus. Below 
describes configurable functions and parameters and the factory settings displayed in the screen for 
each menu. 

 

Main 

Start the SETUP utility to display the Main menu. 

<Example> 

 Phoenix BIOS Setup Utility

Main Advanced Security System Hardware Boot

Processor Type: 
Processor Speed: 
Cache RAM: 
System Memory: 
Extended Memory: 

  BIOS Version: 
System Time: 
System Date: 
Language: 

  Primary Master: 

  
  

<Tab>, <Shift-Tab>, or 
<Enter> selects field.

Item Specific Help

Exit

Intel(R) Xeon(TM)processor 
2.80 GHz 
512KB 
584KB 
511MB 

 REL.6.0.8:M-1 
[18:54:08] 
[
[English(US)] 

 CD-ROM

F1   Help -/+      Change Values F9  Setup Defaults
F10 Save Changes & ExitSub-MenuEnter Select Esc Exit 

/ 12/ 2002] 11

Select Item 
Select Menu  
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Available options in the Main and descriptions are listed below. 

Option Parameter Description Your Setting 
Processor Type Intel®Xeon™Processor Indicates the type of the installed 

CPU (view only). 
 

Processor Speed 2.40GHz/2.80GHz Indicates the clock speed of the 
installed CPU (view only). 

 

Cache RAM 512KB Indicates the cache RAM size 
(view only). 

 

System Memory 584KB Indicates the total size of the 
basic memory (view only). 

 

Extended Memory (Extended memory size) Indicates the total size of the 
extended memory (view only). 

 

BIOS Version (Version of BIOS) Indicates the version of the 
system BIOS (view only). 

 

System Time HH:MM:SS Specify the current time.  
System Date MM/DD/YYYY Specify the current date.  
Language [English (US)] 

Français 
Deutsch 
Italiano 
Español 

Select a language in which the 
SETUP is displayed. 
Only English (US) is supported 
currently.  

 

Primary Master CD-ROM Indicates device type connected 
to IDE (Primary master). (View 
only) 

 

  [   ]: Factory-set 
 
IMPORTANT: Check and adjust the system clock before operation in the following conditions.  

- After transporting the equipment  
- After storing the equipment 
- After the equipment halt under the conditions which is out of the guranteed environment 

conditions (Temperature: 10 to 35°C, Humidity: 20 to 80%). 
Check the system clock once in a month. It is recommended to operate the system clock using a 
time server (NTP server) if it is installed on the system which requires high level of time accuracy. 
If the system clock goes out of alignment remarkably as time goes by, though the system clock 
adjustment is performed, contact your sales agent. 
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Advanced 

Move the cursor onto "Advanced" to display the Advanced menu. 

There is no configurable item on the Advanced menu screen below. Display each sub menu and 
make settings on the sub menu screen. Select an option with the " " mark and press Enter to 
display its submenu. 

 
Advanced 
Processor Information 
Memory Information 
Peripheral Configuration 
Monitoring Configuration 
Option ROM 
Keyboard Features

Select Advanced  
options.

Item Specific Help

Phoenix BIOS Setup Utility

Main Advanced Security System Hardware Boot Exit

F1   Help -/+      Change Values F9  Setup Defaults
F10 Save Changes & ExitSub-MenuEnter SelectEsc Exit

Select Item
Select Menu  
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Advanced 
Select "Advanced" on the Advanced menu to display the following screen. 

Select Item

Select Menu

 
 

upport: iagnostic 
 

enabled.

F9  Setup Defaults
F10 Save Changes & Exit 

F1   Help -/+      Change Values 
Enter SelectEsc Exit

Select Item 
Select Menu Sub-Menu

Phoenix BIOS Setup Utility

Advanced

[Enabled]

 
 

Advanced Item Specific Help

Display the diagnostic 
screen during POST 
instead of the Logo. 
The boot-time d
screen is redirection 
or rompilot is  r Pause:

Boot-time Diagnostic Screen: [Disabled]
[Disabled]RomPilot S

POST Erro

 
See the table below for setup options on the screen. 

Option Parameter Description Your Setting 
Boot-time 
Diagnostic Screen 

[Disabled] 
Enabled 

Specify whether to display the Power On 
Self-Test (POST) screen at start-up. If 
"Disabled" is selected, the NEC logo 
appears while POST is in progress. (To 
display POST check results, press Esc.) 
If "RomPilot Support" is set to "Enabled" or 
"Console Redirection" is set, this option is 
unconditionally set to "Enabled". 

 

RomPilot Support [Disabled] 
Enabled 

Enable or disable the RomPilot (the remote 
console and remote drive features during 
OS start-up). If this option is set to 
"Enabled", "Boot-time Diagnostic Screen" is 
unconditionally set to "Enabled". 

 

Post Error Pause [Enabled] 
Disabled 

Specify whether to stop POST at the end of 
POST when an error occurs during POST. 

 

  [   ]: Factory-set 

TIPS: "RomPilot" is a BIOS feature for communications with the NEC Management Workstation 
Application (NEC MWA). To use the NEC MWA for management of the server, select "Enabled" 
for "RomPilot Support.” Use of the RomPilot features requires setups for the NEC MWA. 
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Processor Information 
Select "Processor Information" on the Advanced menu to display the following screen. 

 
 

Processor 1 Type: 
Processor 2 Type:

 

Item Specific HelpProcessor Information
 
 

xxxxxxxx 
xxxxxxxx

Phoenix BIOS Setup Utility

Advanced

F1   Help -/+      Change Values F9  Setup Defaults
F10 Save Changes & ExitSub-MenuEnter SelectEsc Exit

Select Item
Select Menu  

See the table below for setup options on the screen. 

Option Parameter Description Your Setting 
Processor 1 Type 
Processor 2 Type 

– Indicates processor type installed on 
Processor 1 or Processor 2 (view 
only). 

 

  [   ]: Factory-set 
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Memory Information 
Select "Memory Information" on the Advanced menu to display the following screen. 

 
See the table below for setup options on the screen. 

Option Parameter Description Your Setting 
DIMM #1- #6 Size – Indicates the size of memory installed 

on DIMMs 1 (#1) to 6 (#6). "None" 
indicates no DIMM installed (view 
only). 

 

DIMM #1- #6 Speed – Indicates the type of DIMM 
(DDR200/DDR266) installed on 
DIMMs 1 (#0) to 6 (#6). "None" 
indicates no DIMM installed (view 
only). 

 

  [   ]: Factory-set 
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Peripheral Configuration 
Select "Peripheral Configuration" on the Advanced menu to display the following screen. 

 

Phoenix BIOS Setup Utility

Advanced

Peripheral C nfio guration
 

Item Specific Help
  
  
Serial Port A: 
Serial Port B:

 
[3F8, IRQ 4] 
[2F8, IRQ 3]

Disables serial port 1 
or sets the base  
address/IRQ of 
serial port 1.

F1   Help -/+      Change Values 
Enter Select Esc Exit

Select Item
enuSelect M Sub-Menu

F9  Setup Defaults
F10 Save Changes & Exit

See the table below for setup options on the screen. 

IMPORTANT: Make sure to avoid any conflict in the interrupt requests or the base I/O 
addresses. 

Option Parameter Description Your Setting 
Serial Port A 
Serial Port B 

Disabled 
3F8, IRQ 3 
[3F8, IRQ 4]*1
[2F8, IRQ 3]*2
2F8, IRQ 4 
3E8, IRQ 3 
3E8, IRQ 4 
2E8, IRQ 3 
2E8, IRQ4 
Auto 

Enable or disable the serial port A and 
B, or specify a base address and 
interrupt. 
 
*1  Factory setting for the serial port 
A 
*2  Factory setting for the serial port 
B 
 

 

  [   ]: Factory-set 
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Monitoring Configuration 
Select "Monitoring Configuration" on the Advanced menu to display the following screen. 

 

Option ROM Scan Monitoring:  
   Option ROM Monitoring 
Boot Monitoring:  
  Boot Monitoring Time-out Period:  

POST Pause Monitoring: 
  POST Pause Monitoring Time-out: 

Option ROM Scan  
Monitoring features

Item Specific HelpMonitoring Configuration

[Disabled] 
[5] 
[Enabled] 
[8] 
[Enabled] 
[3]

Phoenix BIOS Setup Utility

Advanced

F1   -/+      Change Values F9  Setup Defaults
F10 Save Changes & ExitSub-MenuEnter SelectEsc Exit

Select Item
Select Menu

Displayed only when "Enabled" is selected for "Option ROM Scan 
Monitoring", "Boot Monitoring" or "POST Pause Monitoring".  

See the table below for setup options on the screen. 

Option Parameter Description Your Setting 
Option ROM 
Scan Monitoring 

Disabled 
[Enabled] 

Enable or disable the Option ROM scan monitoring 
feature. 

 

Option ROM 
Monitoring 
Time-out 

1 - [5] - 20 Specify the Option ROM monitoring time-out 
period. This option is displayed only when 
"Enabled" is selected for "Option ROM Scan 
Monitoring". 

 

Boot Monitoring Disabled 
[Enabled] 

Enable or disable the boot monitoring feature. This 
function is unique to NEC Express5800/ft series: 
detects errors until the OS boots up, and 
immediately reboots the OS upon detection of an 
error. (For details, see “Behavior at Occurrence of 
Error” in Chapter 2.) Enable this function if NEC 
ESMPRO Agent is installed on the OS. Disable this 
function if NEC ESMPRO Agent is not installed or 
when you install the OS. Otherwise, the OS will 
boot up after “Specified boot timeout.” 

 

Boot Monitoring 
Time-out Period 

1 - [10] - 20 Specify the boot monitoring time-out period. This 
option is displayed only when "Enabled" is selected 
for "Boot Monitoring". If you specify a shorter period 
of time to “Boot Monitoring Time-out Period”, the 
time until rebooting can be reduced. When there is 
no external device connected, it is possible to set a 
shorter period of time, but 3 minutes or longer is 
recommended. Appropriate value for the setting 
varies depending on your environment. Therefore, 
when changing this setting, evaluate it thoroughly 
after constructing the environment.  

 

POST Pause 
Monitoring 

Disabled 
[Enabled] 

Enable or disable the POST monitoring feature 
during boot-up restriction.  
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Option Parameter Description Your Setting 
POST Pause 
Monitoring 
Time-out 

1 - [3] - 20 Specify the POST monitoring time period during 
boot-up restriction. 

 

  [   ]: Factory-set 

IMPORTANT: 
� When connecting a Fibre Channel disk array device, change the set value of "Boot 

Monitoring Time-out Period" depending on the wait time for the completion of the Fibre 
Channel disk array device initialization.  
Ex.: If the wait time for the completion of the Fibre Channel disk array device initialization 

is 4 minutes, change the value of "Boot Monitoring Time-out Period" from 10 (default) to 
14 minutes. 

� If you set a small value for "Boot Monitoring Time-out Period", you can shorten the waiting 
time to the rebooting. It is recommended to set a value of more than 3 minutes though smaller 
value setting is available when external devices are not used. As it depends on the user’s 
setting environment, make sure to execute enough evaluation after the configuration of the 
environment. 

 

Option ROM 

Select "Option ROM" on the Advanced menu to display the following screen and enable/disable 
expansion of Option Rom BIOS on the PCI bus. 

 

Phoenix BIOS Setup Utility

  
 
On Board SCSI:

 
[Enable

 
On Board LAN 1: 
On Board LAN 2:
PCI Slot 1: 
PCI Slot 2: 
PCI Slot 3: 

  

Disables/enables the 
mapping of the on-board 

IOSSCSI B .

OM
 

i

Item Specific HelpOption R

d]
[Enabled]
[Enabled]
[Enabled]
[Enabled]
[Enabled]

 

F1   Help -/+      Change Values F9  Setup Defaults
F10 Save Changes & ExitSub-MenuEnter Select Esc Ex t

Select Item
enuSelect M

Advanced
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See the table below for setup options on the screen. 

Option Parameter Description Your Setting 
On Board SCSI Disabled 

[Enabled] 
Enable or disable expansion of SCSI 
BIOS on the motherboard. 

 

On Board LAN 1, 2 Disabled 
[Enabled] 

LAN1: Enable or disable 10/100BASE 
LAN controller on the 
motherboard. 

LAN2: Enable or disable 1000BASE 
LAN controller on the 
motherboard. 

 

PCI Slot 1 - PCI Slot 3 Disabled 
[Enabled] 

Enable or disable BIOS on a device 
(board) connected to the PCI bus.   
Select "Enabled" for the graphic 
accelerator board. 
Select "Disabled" for Option ROM of 
PCI LAN device when the network 
boot feature is not used. 

#1: 
#2: 
#3: 
 

  [   ]: Factory-set 
 

IMPORTANT:  
For the slot which a graphical accelerator board is installed, do not specify “Disabled”.   
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Keyboard Features 
Select "Keyboard Features" on the Advanced menu to display the following screen. The NumLock 
submenu allows you to make keyboard settings. 

 
 

NumLock: 
Key Click: 
Keyboard Auto-repeat Rate: 
Keyboard Auto-repeat Delay:

Selects Power-on state 
for Numlock.

Item Specific HelpKeyboard Features
 
 

[Auto] 
[Disabled] 
[10/sec] 
[1 sec]

Phoenix BIOS Setup Utility

Advanced

F1   Help -/+      Change Values F9  Setup Defaults
F10 Save Changes & ExitSub-MenuEnter SelectEsc Exit

Select Item
Select Menu  

See the table below for setup options on the screen. 

Option Parameter Description Your Setting 
NumLock [Auto] 

On 
Off 

Enable or disable the NumLock 
feature at system start-up. If "Auto" is 
selected, the NumLock feature will be 
enabled when an entry with the 
keypad is detected. 

 

Key Click [Disabled] 
Enabled 

Enable or disable the key click sound.  

Keyboard 
Auto-repeat Rate 

2/sec 
6/sec 
[10/sec] 

Select the number of characters 
repeatedly output in one second when 
a key is pressed. 

 

Keyboard 
Auto-repeat Delay 

0.25 sec 
0.5 sec 
0.75 sec 
[1 sec] 

Select a period before a key character 
starts repeated. 

 

  [   ]: Factory-set 
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Security 

Move the cursor onto "Security" to display the Security menu. 

 

Phoenix BIOS Setup Utility

ExitBootSystem HardwareritySecuAdvancedMain

Item Specific Help
Clear Supervisor Passwo d is r

User Password is  
Set Supervisor Password 
Set User Password  
Password on boot:  

Clear 
[Enter] Supervisor Password  

 
setup utility.
controls access to the  Enter 

[Disabled]

  [Unmasked] 
[Unmasked] 

 Power Switch Mask:  
Option ROM Menu Mask: 

F1   Help -/+      Change Values 
Enter SelectEsc Exit

Select Item
nuSelect Me Sub-Menu

F9  Setup Defaults
F10 Save Changes & Exit

Select "Set Supervisor Password" or "Set User Password" and press Enter to display the following 
pop-up screen. 

The screen below shows when "Set Supervisor Password" is selected. 

 Phoenix BIOS Setup Utility

Supervisor Password is 
User Password is 
Set Supervisor Password 
Set User Password 
Password on boot: 

 
Power Switch Mask: 
Option ROM Menu Mask: 

Supervisor Password 
controls access to the 
setup utility.

Item Specific Help 
Clear 
Clear 
[Enter] 
Enter 
[Disabled] 

  [Unmasked] 
[Unmasked] 
[Disabled]

[                     ] 
[                     ]

Set Supervisor Password

Enter new password: 
Confirm new Password:

Main Advanced Security System Hardware Boot Exit 

F1   Help -/+      Change Values F9  Setup Defaults
F10 Save Changes & Exit Sub-MenuEnter SelectEsc Exit

Select Item 
Select Menu  

Set a password on this pop-up screen. Enter a password of up to seven alphanumeric characters and 
symbols from the keyboard. 
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IMPORTANT:  

� User password setup is not available before Supervisor password setup. 

� Do not set any password before installing the OS. 

See the table below for setup options on the screen. 

Option Parameter Description Your Setting 
Supervisor 
Password is 

[Clear] 
Set 

Indicates Supervisor password setup status (view 
only). 

 

User Password 
is 

[Clear] 
Set 

Indicates User password setup status (view only).  

Set Supervisor 
Password 

Up to 7 
alphanumeric 
characters 

Press Enter to display the supervisor password 
entry screen. With the supervisor password, all 
SETUP menus are available for access. This 
option is available only when you log into the 
SETUP utility with the supervisor password. 

 

Set User 
Password 

Up to 7 
alphanumeric 
characters 

Press Enter to display the user password entry 
screen. With a user password, accessing the 
SETUP menus is restricted. This option is 
available only if the Supervisor Password is 
specified. 

 

Password on 
boot 

Enabled 
[Disabled] 

Specify whether to request a password entry at 
boot-up. Supervisor password setup is required 
beforehand. When the supervisor password is 
specified and this option is disabled, the BIOS 
assumes that a system boot attempt is made by a 
user. 

 

Power Switch 
Mask 

[Unmasked] 
Masked 

Enable or disable the POWER switch on the 
server. If "Masked" is selected, power-off with the 
POWER switch becomes unavailable after OS 
boot-up. (Forced shut down also becomes 
unavailable. Forced shut down is a feature to shut 
down by pressing the POWER switch for over 
four seconds.) 

 

Option ROM 
Menu Mask 

[Unmasked] 
Masked 

Enable or disable key entries during optional 
ROM expansion. 

 

  [   ]: Factory-set 
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System Hardware 

Move the cursor onto "System Hardware" to display the System Hardware menu. 

 

To make a selection for "Thermal Sensor", "Wake On Event", and "Console Redirection", first 
select a desired option and press Enter to display its submenu. 
See the table below for setup options on the screen. 

Option Parameter Description Your Setting 
AC LINK Stay Off 

[Last State] 
Power On 

Specify the AC LINK feature by selecting the 
status of the power supply unit of the server 
when the AC power supply restarts. (See the 
table on the next page for details.) Do not 
select the parameters other than "Stay Off" 
when "Enabled" is selected for "Wake On 
Lan." 

 

Waiting time 
for AC-LINK 

[0], 10~3600 Set maximum waiting time in second for 
AC-LINK. If either of ACs is not supplied in 
time, the system will be turned on as simplex 
config. Value 0 means the system waits 
eternally. 
Range [0 or 10-3600sec.] 

 

Error Log 
Initialization 

Enter Press Enter to initialize the error log. The 
message "Error Log Cleared" appears upon 
successful completion. If failed, the message 
"Error Log Not Cleared!" appears. 

 

  [   ]: Factory-set 
 

IMPORTANT: It is recommended that “Waiting time for AC-LINK” be 3600 when you use 
UPSs in the redundant configuration.   
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The table below lists how selections for "AC LINK" determine the power status of the server when 
the power supply to the server restarts. 

Parameter State before powered off Stay Off Last State Power On 
In service Off On On 
Out of service (DC power: Off) Off Off On 
Forced shutdown * Off Off On 

* Pressing the POWER switch for over four seconds shuts down the power to the server. 

 

Thermal Sensor 

Select "Thermal Sensor" on the System Hardware menu and press Enter to display the following 
screen. 

 

Phoenix BIOS Setup Utility

  
 
Thermal S

 
 

ensor: 

 Upper Limit: 
Lower Limit:

Determines if BIOS will 
disable boot, if the
temperature is not 
within safe range.

Item Specific HelpThermal S
 

ensor

 
[Enabled]

 [48] 
[5]

System Hardware

it F10 Save Changes & Exit
F9  Setup Defaults-/+      Change Values 

Enter Select 
Select Item

enuSelect M Sub-Menu
F1   Help 
Esc Ex

See the table below for setup options on the screen. 

Option Parameter Description Your Setting 
Thermal 
Sensor 

[Enabled] 
Disabled 

Enable or disable the thermal sensor 
monitoring feature. 

 

Upper Limit 7 - [48] - 80 Specify the upper limit temperature for 
boot-up restriction in Celsius. Use + and/or - 
keys to specify a value by adding a number 
greater than 7 to the value specified for 
Lower Limit. 

 

Lower Limit 0 - [5] - 73 Specify the lower limit temperature for 
boot-up restriction in Celsius. Do not specify 
4 degrees or lower. Use + and/or - keys to 
specify a value by deducting a number 
greater than 7 to the value specified for 
Upper Limit. 

 

[   ]: Factory-set 
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Wake On Events 

Select "Wake On Events" on the System Hardware menu and press Enter to display the following 
screen. 

 
 

Wake On LAN: 
 

Enables Wake On LAN 
support.

Item Specific HelpWake On Events
 
 

[Enabled]

System HardwareSystem Hardware

Phoenix BIOS Setup Utility

F1   Help -/+      Change Values F9  Setup Defaults
F10 Save Changes & ExitSub-MenuEnter SelectEsc Exit

Select Item
Select Menu  

See the table below for setup options on the screen. 

Option Parameter Description Your Setting 
Wake On LAN Disabled 

[Enabled] 
Enable or disable the remote power-on 
feature via the network. 
When "Enable" is selected, change the 
"AC-LINK" setting in the "System Hardware" 
to "Stay Off". 

 

  [   ]: Factory-set 
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Console Redirection 

Select "Console Redirection" on the System Hardware menu and press Enter to display the 
following screen. 

 
 

Serial Port Address: 
 
Baud Rate: 
Flow Control: 
Console Connection:

If enabled, the console 
will be redirected to 
this port.

Item Specific HelpConsole Redirection
 
 

[Disabled] 
 
[19.2K] 
[XON/XOFF] 
[Direct]

System Hardware

Phoenix BIOS Setup Utility

F1   Help -/+      Change Values F9  Setup Defaults
F10 Save Changes & ExitSub-MenuEnter SelectEsc Exit

Select Item
Select Menu  

See the table below for setup options on the screen. 

Option Parameter Description Your Setting 
Serial Port 
Address 

[Disabled] 
On-board COM B 

Select a serial port to connect the HW 
console.   
Selecting "On-board COM B" changes 
"Boot-time Diagnostic Screen" to 
"Enabled".  

 

Baud Rate [19.2K] 
57.6K 

Select a baud rate for communications 
with the connected HW console. 

 

Flow Control [None] 
XON/XOFF 

Select a flow control method.  

Console 
Connection 

[Direct] 
Via modem 

Select a connection with the HW console.  

  [   ]: Factory-set 
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ft Memory 

Select "ft Memory" on the System Hardware menu and press Enter to display the following screen. 

 
See the table below for setup options on the screen. 

Option Parameter Description Your Setting 
Size [0] Size of ft Memory is specified (MB)  
Start Address - Shows the start address of ft Memory (view 

only) 
 

[   ]: Factory-set 

IMPORTANT:  

� Unless you use ft Memory, do not change the factory setting. 

� To use ft Memory, you need to prepare an “ft Memory RAM Disk.” 

� If you specify/change the size of ft Memory on the ft Memory RAM Disk (not this menu), the 
changes will take effect automatically. 

� For details, see manuals included with the ft Memory RAM Disk. 
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Boot 

Move the cursor onto "Boot" to display the Boot menu. 

    ATAPI CD-ROM Drive 
+  Removable Device 
+  Hard Drive 
    Intel(R) Boot Agent Version 4.0.1.7

Item Specific Help

Main Advanced Security System Hardware Boot

Phoenix BIOS Setup Utility

Exit

F1   Help -/+      Change Values F9  Setup Defaults
F10 Save Changes & ExitSub-MenuEnter SelectEsc Exit

Select Item
Select Menu

Use <
select a device, then  
press <+> to move it up 
the list, or <
move it down the list. 
Press <Esc> to exit  
this menu.

>or< >to

>to

 
The server searches for the boot device according to the order specified in this menu and use the 
software to boot the system if found. 

You can change the boot device order using ↑ or ↓ and + or –. Move the cursor to select the device 
by ↑ or ↓, and then change the priority using + or –. 

IMPORTANT: Specify the device boot order as shown above to start the NEC 
EXPRESSBUILDER. 
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Exit 

Move the cursor onto "Exit" to display the Exit menu. 

Save Changes & Exit 
Exit Without Saving Changes 
Get Default Value 
Load Previous Value 
Save Changes

Exit System Setup and 
save your changes to  
CMOS.

Item Specific Help

Main Advanced Security System Hardware Boot

Phoenix BIOS Setup Utility

Exit

F1   Help -/+      Change Values F9  Setup Defaults
F10 Save Changes & ExitSub-MenuEnter SelectEsc Exit

Select Item
Select Menu  

The following describes each option on the Exit menu: 

� Save Changes & Exit 

Select this option to save the current configuration data into the CMOS (non-volatile 
memory) and exit the SETUP utility. 

The following screen appears: 

Save configuration changes and exit now? 
 

[Yes]                  [No]

Setup Confirmation!

 
Select "Yes" to save the current configuration data into the CMOS (non-volatile memory) 
and exit the SETUP utility. The server will automatically restart the system. 

� Exit Without Saving Changes 

Select this option to discard the current configuration data and exit the SETUP utility. 

Configuration has not been saved! 
Save before exiting? 

 

[Yes]                  [No]

Setup Warning!

 
Select "No" to discard the current configuration data and exit the SETUP utility. Select 
"Yes" to save the current configuration data into the CMOS, to exit the SETUP utility, and 
to restart the server automatically. 
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� Get Default Value 

Select this option to restore all default values (factory-set values) of the SETUP utility. 

The following screen appears: 

Load default configuration now? 
 

[Yes]                  [No]

Setup Confirmation!

 
Select "Yes" to restore default values. Select "No" to return to the Exit menu screen. 

IMPORTANT: The default value slightly differs from the factory-set value. Check all 
setting values before restoring the default value. 

� Load Previous Values 

Select this option to discard the current configuration data and restore the previous 
configuration data.  

The following screen appears: 

Load previous configuration now? 
 

[Yes]                  [No]

Setup Confirmation!

 
Select "Yes" to discard the current configuration data and restore the previous one. 

� Save Changes 

Select this option to save the current configuration data into the CMOS (non-volatile 
memory) and stay on the SETUP utility. 

The following screen appears: 

Save configuration changes now? 
 

[Yes]                  [No]

Setup Confirmation!

 
Select "Yes" to save the current configuration data into the CMOS (non-volatile memory). 
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SCSI BIOS ∼ FAST!UTIL ∼ 

For several settings of the SCSI controller on the motherboard, the SCSI BIOS utility "Fast!UTIL" 
is used. 

The SCSI BIOS utility can be started by simple keystrokes during execution of POST without use 
of a special start disk. 

The SCSI BIOS built in the server is set to the optimum at the shipment. Accordingly, the SCSI 
BIOS may not be changed by using this utility. 

IMPORTANT:  
� Leave the settings for the SCSI controller to which built-in hard disks are connected as they 

are at shipment. If any of the settings are changed, see the description in this document to 
return to the settings at shipment. The controllers installed in each module must be configured 
individually. 

� Fast!UTIL of the latest version is installed in the NEC Express5800/ft series. Accordingly, the 
setting screen may be different from that described in this document. See the online help or 
contact your sales agent for the setting items different from those in this document. 

Start 

The procedure of starting Fast!UTIL is described below. 

 
Notes 

Note the following before starting Fast!UTIL. 

� Settings for built-in hard disk 

Leave the settings for the built-in hard disk as they are at shipment. The built-in host 
adapter is specified as QLA12160 Ultra3 2000 in the Select Host Adapter dialog box. 

� Settings of built-in SCSI controller installed in each group 

− Mount only the PCI module which has the built-in SCSI controller that you want to 
check the settings and start Fast!UTIL. Remove the other PCI module from the system.    

− Do not change the factory settings of the built-in SCSI controller.  

− Although there may be descriptions that the SCSI BIOS of the host adapter needs to be 
configured in manuals for tape devices, etc., this server does not require modifications 
to the settings. Do not change the settings.   
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Start Procedure 

Start Fast!UTIL in the procedure below: 

1. Turn on the power of the server. 

The start message appears on a screen in the middle of POST.  

2. Press Q and Ctrl together. 

Fast!UTIL is started. 

IMPORTANT: Press these keys before message "QLogic Adapter using IRQ number 
x" or later appears. 

<Example> 
QLogic Corporation
QLA 1216x PCI SCSI ROM BIOS Version X.XX
Copyright (C) QLogic Corporation 1993-2001 All rights reserved.
www.qlogic.com

Press <CTRL-Q> for Fast!UTIL

ISP12160 Firmware Version xx.xx.xx
QLogic Adapter using IRQ number X

Device Device Adapter SCSI SCSI Vendor Product Product
Number Type Number ID LUN ID ID Revision

81 Disk 0 0 0 SEAGATE ST32550 7394

 
 

3. Highlight "Select Host Adapter" using the cursor keys and press Enter. 

Configuration Settings
Scan SCSI Bus
SCSI Disk Utility
Select Host Adapter
Exit Fast!UTIL

Fast!UTIL Options
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4. Select the proper adapter. 

IMPORTANT: The adapter "QLA12160 Ultra3 2000" is used for built-in hard disk. 
Do not select it. 

Highlight the displayed item with the cursor keys and press Enter. 

 
 
QLA12160 Ultra3 2000 
xxxxxxxxxxxxxxxxxxxxxxxx xxxx 
xxxxxxxxxxxxxxxxxxxxxxxx xxxx 

Select Host Adapter 

Adapter Type I/O Address 

 
The display returns to "Fast!UTIL Options." The name of the selected host adapter 
appears at the upper left corner of the screen. 

Configuration Settings
Scan SCSI Bus
SCSI Disk Utility
Select Host Adapter
Exit Fast!UTIL

Fast!UTIL Options
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Configuration Settings 

If you select "Configuration Settings" from the "Fast!UTIL Options" menu, the screen for setting 
the configuration appears. 

Host Adapter Settings
SCSI Device Settings
SCSI Bus Settings
Autoconfigure SCSI Device
Selectable Boot Settings
Restore Default Adapter Settings
Raw Nvram Data

Configuration Settings

 
 

Host Adapter Settings 

If you put the cursor on "Host Adapter Settings" with keyboard cursors (↓ and ↑) in the 
"Configuration Settings" menu and press Enter, the screen for setting the information on the host 
adapter appears. 

The table below shows the parameters of the setting items and their factory settings. 

Submenu item Parameter Description 
BIOS Address - View only 
BIOS Revision - View only 
Adapter Serial Number - View only 
Interrupt level - View only 
Host Adapter BIOS [Enabled] 

Disabled 
Specify whether the BIOS extension of the host 
adapter is enabled or disabled. 

PCI Bus DMA Burst [Enabled] 
Disabled 

Specify whether the DMA burst transfer on the PCI 
bus is enabled or disabled. 

CDROM Boot Enabled 
[Disabled] 

Specify whether the start from CD-ROM is enabled or 
disabled. 

Adapter Configuration [Auto] 
Manual 
Safe 

Specify whether the adapter configuration is set 
automatically by BIOS, manually, or safely. 

Drivers Load RISC [Enabled] 
Disabled 

Specify whether the load of RISC codes is enabled or 
disabled. 

>4GByte Addressing Enabled 
[Disabled] 

Specify whether hard disks of 4 GB or larger is used 
or not. 

Fast Command Porting [Enabled] 
Disabled 

Do not change the factory setting. 

  [  ]: Factory-set 
 



System Configuration  4-33 

SCSI Device Settings 

If you put the cursor on "SCSI Device Settings" with keyboard cursors (↓ and ↑) in the 
"Configuration Settings" menu and press Enter, the screen for setting the information on the device 
connected to the host adapter appears. 

The table below shows the parameters of the setting items and their factory settings. 

IMPORTANT: The settings can be made for each SCSI bus. 

Parameter Submenu item 
SCSI Bus0 SCSI Bus1 

Description 

Disconnects OK [Yes] 
No* 

[Yes] 
No 

Specify whether the disconnection of 
SCSI devices from the SCSI bus is 
enabled or disabled. 
* On Bus0, select "No" for ID8. 

Check Parity [Yes] 
No 

[Yes] 
No 

Specify whether the parity check is 
provided or not. 

Enable LUNs [Yes] 
No 

[Yes] 
No 

Specify whether more than one LUN 
numbers are given to SCSI ID. 

Enable PPR [Yes] 
No 

[Yes] 
No 

Do not change the factory setting. 

Enable Device [Yes] 
No 

[Yes] 
No 

Do not change the factory setting. 

Negotiate Wide [Yes] 
No 

[Yes] 
No 

Specify whether the wide (32 bits) 
transfer is enabled or disabled. 

Negotiate 
Synchronous 

[Yes] 
No 

[Yes] 
No 

Specify whether the synchronous 
transfer is enabled or disabled. 

Tagged Queuing [Yes] 
No 

[Yes] 
No 

Do not change the factory setting. 

Sync Offset 00, 02, 04, 06, 08, 
10, 12, 14, 16, 18, 
20, 22, [24] 

00, 02, 04, 06, [08], 
10, 12, 14, 16, 18, 
20, 22, 24 

Select the proper offset value in 
synchronous transfer. 

 Transfer Rate 
(Mbytes/sec) 

 Transfer Rate 
(Mbytes/sec) 

[9] 160 (Ultra3 
SCSI) 

9 160 (Ultra3 
SCSI) 

10 80 (Ultra2 
SCSI) 

[10] 80 (Ultra2 
SCSI) 

12 40 (Ultra 
SCSI) 

12 40 (Ultra 
SCSI) 

25 20 (Fast 
SCSI) 

25 20 (Fast 
SCSI) 

Sync Period 

40 12.5 40 12.5 

Select the proper speed in 
synchronous transfer. 

Exec Throttle 1, 4, 8, [16], 32, 
64, 128, 255 

1, 4, 8, [16], 32, 64, 
128, 255 

Do not change the factory setting. 

  [  ]: Factory-set 
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SCSI Bus Settings 

If you put the cursor on "SCSI Bus Settings" with keyboard cursors (↓ and ↑) in the "Configuration 
Settings" menu and press Enter, the screen for setting the information on the SCSI bus of the host 
adapter appears. 

The table below shows the parameters of the setting items and their factory settings. 

IMPORTANT: The settings can be made for each SCSI bus.  

Parameter Submenu item 
SCSI Bus0 SCSI Bus1 

Description 

SCSI Bus SCSI ID 0, 1, 2, 3, 4, 5, 6, 
[7], 8, 9, 10, 11, 
12, 13, 14, 15 

0, 1, 2, 3, 4, 5, 6, 
[7], 8, 9, 10, 11, 
12, 13, 14, 15 

Select the SCSI ID given to SCSI 
bus. 

SCSI Bus Reset [Enabled]  
Disabled 

[Enabled]  
Disabled 

Make the reset valid or invalid in 
SCSI buses. 

SCSI Bus Reset 
Delay 

0, 1, 2, 3, 4, [5], 
6, 7, 8, 9, 10, 11, 
12, 13, 14, 15 

0, 1, 2, 3, 4, [5], 
6, 7, 8, 9, 10, 11, 
12, 13, 14, 15 

Leave this item as factory-set. 

SCSI Bus 
Termination 

Auto 
High only 
Disabled 
[Enabled] 

[Auto] 
High only 
Disabled 
Enabled 

Set the termination resistance of 
SCSI bus. 

  [  ]: Factory-set 
 
Autoconfigure SCSI Device 

If you put the cursor on "Autoconfigure SCSI Device" with keyboard cursors (↓ and ↑) in the 
"Configuration Settings" menu and press Enter, the screen for setting the information on the device 
connected to the host adapter appears. 

The parameters of the setting items and their factory settings are the same as those shown in the 
table for "SCSI Device Settings." 

IMPORTANT:  
� The settings can be made for each SCSI bus and SCSI ID. Check the SCSI ID of the target 

device before changing the settings. 

� The factory settings are the same for both SCSI bus 0 and SCSI bus 1. 

� The following items can be changed by setting "Adapter Configuration" in "Host Adapter 
Settings" to "Manual." 

 – Enable Device 
 – Enable LUNs 
 – Negotiate Wide 
 – Negotiate Sync 
 – Tagged Queuing 
 – Sync Offset 
 – Sync Period 
 – Exec Throttle 
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Selectable Boot Settings 

If you put the cursor on "Selectable Boot Settings" with keyboard cursors (↓ and ↑) in the 
"Configuration Settings" menu and press Enter, the screen for setting the information on the start 
from the device connected to the host adapter appears. 

Submenu item Parameter Description 
Selectable 
SCSI Boot 

Enabled 
[Disabled] 

Specify whether the boot from SCSI device can be 
selected or not. 

SCSI Bus [0] 
1 

Select the bus to which the started SCSI device is 
connected. 

SCSI Boot ID [0], 1, 2, 3, 4, 5, 6, 7, 
8, 9, 10, 11, 12, 13, 
14, 15 

Set the SCSI ID of the started SCSI device. 

SCSI Boot Lun [0], 1, 2, 3, 4, 5, 6, 7, 
8, 9, 10, 11, 12, 13, 
14, 15 

Select the number of the LUN to which the started 
SCSI device is bound. 

  [  ]: Factory-set 
 

Restore Default Settings 

If you put the cursor on "Restore Default Settings" with keyboard cursors (↓ and ↑) in the 
"Configuration Settings" menu and press Enter, the display changes to the screen for returning the 
setting values to the default values. 

IMPORTANT: The default values can be restored for each SCSI bus. 

Raw Nvram Data 

If you put the cursor on "Raw Nvram Data" with keyboard cursors (↓ and ↑) in the "Configuration 
Settings" menu and press Enter, the information on NvRAM installed in the host adapter is 
displayed in the hexadecimal format. 

This function is provided to solve problems. The information cannot be edited. 
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Scan SCSI Bus 

If you select "Scan SCSI Bus" from the "Fast!UTIL Options" menu, the list of devices connected to 
each SCSI bus is displayed in the order of SCSI IDs. The information to be displayed includes the 
device manufacturer, product name and firmware revision. 

 

SCSI Disk Utility 

If you select "SCSI Disk Utility" from the "Fast!UTIL Options" menu, the utility menu which is 
used to format or verify the connected SCSI devices appears. 

IMPORTANT:  
� Devices can be processed in each SCSI bus and SCSI ID. Be careful not to forget the 

selected bus and ID.  

� When performing low-level format, select [Advanced]-[Monitoring Configuration]-[Option 
ROM Scan Monitoring] and choose “Disabled” in BIOS setup utility. See “SYSTEM BIOS ~ 
SETUP ~” (page 4-2) for details of the setting. 

� The selection of "Continue With Format" in "Low- Level Format" causes all data in disks to 
be lost. 

� Low-Level Format 

Formats the device selected in "Continue With Format" physically. (The BIOS settings 
need to be changed before formatting. See “IMPORTANT” above.) If you select "Do Not 
Format Disk", the previous menu appears again. 

� Verify Disk Media 

Verifies the device selected in "Continue With Verify." If you select "Do Not Verify 
Media," the previous menu appears again. 

� Select Different Disk 

Selects another SCSI device on the same SCSI bus. 

 

Select Host Adapter 

If you select "Select Host Adapter" from the "Fast!UTIL Options" menu, the list of the host adapters 
installed in the main system is displayed. Select an adapter to change its settings. 

IMPORTANT: The adapter "QLA12160 Ultra3 2000" is used for built-in hard disk. Do not 
select it. 

The utility menu, which is used to format or verify the connected SCSI devices, appears. 
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Exit Fast!UTIL ∼ Termination and Storage of Fast!UTIL ∼ 

After changing the settings, press Esc several times to display the "Fast!UTIL Options" menu. If 
you select "Exit Fast!UTIL" from the menu, the screen for terminating Fast!UTIL appears. 

However, if the settings are different from those before the start, the screen prompting you to save 
the settings appears before the display of the termination screen. 

Save Changes
Do not save changes

Configuration settings modified

 

Select either "Save changes" or "Do not save changes" by using keyboard cursors (↓ and ↑) and 
press Enter. 

Pressing Enter causes the screen for terminating Fast!UTIL to appear. 

Reboot System
Return to Fast!UTIL

Exit Fast!UTIL

 

Select either "Reboot System" or "Return to Fast!UTIL" and press Enter. 

 

 

Setting List for Optional SCSI Device 

If you add an optional SCSI device, do not change the factory settings of built-in SCSI controller. 
For information on optimal SCSI devices for NEC Express5800/ft series, contact your sales agent.  
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FORCED SHUTDOWN AND CLEAR 
Read this section if your server does not operate as expected, or if you want to return all setup 
values to those made at shipment. 

 

Forced Shutdown 

Use this function when an OS command does not shut down the server, the POWER switch does not 
turn off the server, or resetting does not work. 

Press and hold the POWER switch on the server for over four seconds. The power is forcibly turned 
off. To turn on the power back again, wait approximately 30 seconds after turning off the power 
(forced shutdown). 

 
 

 

IMPORTANT: If the remote power-on feature is used, power on the server and start the OS, and 
turn off the power in the normal way. 

Press it for over 4 seconds. 

<Rack-mount model> 
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Clear CMOS / Password (Configuring Motherboard Jumpers) 

With the pre-installed SETUP utility, you can set desired passwords to protect data stored on the 
server from unauthorized user access. If you forget the passwords, you can clear them by following 
the procedure described in this section.   

You can also use the same procedure to clear the CMOS data in the server. 

IMPORTANT:  

� Clearing the CMOS data restores the factory settings. 

� To clear passwords or CMOS data, power off the server. 

To clear passwords or the CMOS data, use the jumper switch on the PCI module board of the server. 
The following figure illustrates the jumper switch location. 

IMPORTANT: Do not change any other jumper switch settings. Any improper change may 
cause the server to fail or malfunction. 

 

 

Use clips on  
pins 11 and 12 

Pins for protecting/clearing 
passwords 

Pins for protecting/clearing 
CMOS data 
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� Pins for protecting/clearing the passwords 

Place the clip on the two pins to clear the passwords. 

Remove the clip from these pins to protect the passwords (factory-set). 

� Pins for protecting/clearing the CMOS data 

Place the clip on the two pins to clear the CMOS data. 

Remove the clip from these pins to protect the CMOS data (factory-set). 

The following describe the clearing procedure. 

WARNING  
  

Observe the following instructions to use the server safely. There are risks of 
death or serious personal injury. See PRECAUTIONS FOR SAFETY in Chapter 
1. 
 

 

 
 � Do not disassemble, repair, or alter the server. 
  

 

How to Clear CMOS 

1. Power off the NEC Express5800/ft series and unplug the both power cords. 

2. Remove the both PCI modules (#1 and #2) from the NEC Express5800/ft series (see 
“Removing PCI Module” on page 8-29). 

3. Open the top cover of the PCI Module #1.   

4. Make setting of jumper switch for clearing CMOS. 

Remove the clips from the jumper pins 11-12 and place them on the jumper pins 1-2 on 
the PCI Module #1.  

5. Mount only the PCI Module #1 to the NEC Express5800/ft series (see “Installing PCI 
Module” on page 8-31). 

6. Plug the both power cords and when the POWER Switch LED turns on, press it to power 
on the server. 

7. When the following message appears after startup, press [CONTINUE]. 
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TIPS:  
A message informing you of the completion of CMOS clear and prompting you to 
clear CMOS will appear for 10 seconds. Note that even if you do not do anything, 
the process goes on and the server will be rebooted automatically.   

8. If the message [Non volatile memory cleared] appears after rebooting and during POST, 
turn off the power by pressing the POWER switch and unplug the both power cords. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

IMPORTANT:  
If the message [Non volatile memory cleared] appears at normal startup, the jumper 
switch is set for clearing CMOS. Change back the jumper switch setting.  

Non volatile memory cleared: 
 
This message indicates that CMOS is cleared properly. 

9. Remove the PCI Module #1 from NEC Express5800/ft series (see “Removing PCI 
Module” on page 8-29). 

10. Reset the jumper switch setting. 

Remove the clips from the jumper pins 1-2 and place them on the jumper pins 11-12 on 
the PCI Module #1. 

TIPS: If you place clips on other pins, the server may malfunction. 

11. Mount the PCI Module #1 again to NEC Express5800/ft series (see “Installing PCI 
Module” on page 8-31) and plug the power cord to the AC inlet B (for Group1). 

12. Likewise, mount the PCI Module #2 to NEC Express5800/ft series and plug the power 
cord to the AC inlet A (for Group2). 
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13. Shortly after you connect the both power cords, the BMC status LED of PCI Module #2 
will start to blink.  

When the BMC status LED goes off, the clear information of the PCI Module #1 is 
reflected to the PCI Module #2.  

CHECK:  

The BMC status LED blinks to show that synchronous processing is being 
performed between the two modules. When this process is complete, CMOS has 
also been cleared on PCI Module #2 

 

TIPS: 
� For the location of the AC inlet A, the AC inlet B, see “NAMES AND FUNCTIONS 

OF COMPONENTS” in Chapter 2. 

� For the location of the BMC status LED, see “NAMES AND FUNCTIONS OF 
COMPONENTS” in Chapter 2. 

� For description of the BMC status LED, see “LEDs” in Chapter 2. 
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How to Clear Passwords 

1. Power off NEC Express5800/ft series and unplug the both power cords. 

2. Remove the both PCI modules (#1 and #2) from the NEC Express5800/ft series (see page 
8-29 “Removing PCI Module”). 

3. Open the top cover of the PCI Module #1.  

4. Make setting of jumper switch for clearing the password. 

Remove the clips from the jumper pins 11-12 and place them on the jumper pins 3-4 on 
the PCI Module #1.  

5. Mount the PCI Module #1 to NEC Express5800/ft series (see page 8-31 “Installing PCI 
Module”). 

6. Plug the both power cords and when the POWER Switch LED turns on, press it to power 
on NEC Express5800/ft series. 

7. When the following POST screen appears after the startup, press the POWER Switch to 
turn off the power. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

8. Unplug the both power cords. 

9. Remove PCI Module #1 from NEC Express5800/ft series (see page 8-29 “Removing PCI 
Module”). 

10. Reset the jumper switch setting. 

Remove the clips from the jumper pins 3-4 and place them on the jumper pins 11-12 on 
the PCI Module #1. 

TIPS: If you place it on other pins, the server may malfunction. 
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11. Mount the PCI Module #1 again to the NEC Express5800/ft series (see page 8-31 
“Installing PCI Module”) and plug the power cord to the AC inlet B (for Group1). (The 
POWER Switch LED will be turned on.) 

12. Likewise, mount the PCI Module #2 to the NEC Express5800/ft series and plug the power 
cord to the AC inlet A (for Group2). 

13. Shortly after you connect the both power cords, the BMC status LED on PCI Module #2 
will start to blink. 

When Password clear is completed, the BMC status LED will go off.  

CHECK:  

The BMC status LED blinks to show that synchronous processing is being performed 
between the two modules. When this process is complete, Password has also been 
cleared on PCI Module #2. 

 

TIPS: 
� For the location of the AC inlet A, the AC inlet B, see “NAMES AND FUNCTIONS 

OF COMPONENTS” in Chapter 2. 

� For the location of the BMC status LED, see “NAMES AND FUNCTIONS OF 
COMPONENTS” in Chapter 2. 

� For description of the BMC status LED, see “LEDs” in Chapter 2. 
 

 



 

Chapter 5 

Installing and Using Utilities 

This section describes how to use the NEC EXPRESSBUILDER CD-ROM that comes with your 
server and to install the utilities stored on the NEC EXPRESSBUILDER. 
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NEC EXPRESSBUILDER 
The NEC EXPRESSBUILDER, integrated setup software, can automatically detect the hardware 
connected to an NEC Express5800/ft series machine to advance the processing. The hardware 
subject to setup with the NEC EXPRESSBUILDER should have the same configuration as that for 
operation. 

 

Start Menu 

The NEC EXPRESSBUILDER provides three procedures to start the server as described below. The 
menus and items appearing on the screen vary depending on the procedures. 

� Booting (starting) the server from NEC EXPRESSBUILDER CD-ROM 

For the procedure, insert the NEC 
EXPRESSBUILDER CD-ROM into the 
CD-ROM drive of the NEC Express5800/ft series 
and start the NEC Express5800/ft series from the 
system in the NEC EXPRESSBUILDER. When 
the NEC Express5800/ft series is started by using 
this procedure, the NEC EXPRESSBUILDER top 
menu shown on the right appears. 

Perform the NEC Express5800/ft series setup from 
this menu. 

IMPORTANT:  

 

� Do not use this CD-ROM on computers other than NEC Express5800/ft series with which it 
is packaged (including other NEC Express5800 models). Otherwise, a breakdown may 
result. 

� The execution of "Setup" of the menu causes the OS installed previously to be erased. OS 
must also be reinstalled. 

See "NEC EXPRESSBUILDER Top Menu" for details. 

 

� Booting (starting) the server from NEC 
EXPRESSBUILDER CD-ROM in the 
consoleless state 

If the NEC EXPRESSBUILDER is 
started from the CD-ROM drive in the 
server with the keyboard, mouse, and/or 
display unit not connected to the server, 
the NEC EXPRESSBUILDER Tools 
Menu shown on the right appears on the 
screen of the management computer (PC) 
connected to the server through LAN or 
COM (serial port).  
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Then operate the server remotely from the management PC by using the items in the menu. 

IMPORTANT:  
� Do not use this CD-ROM on computers other than NEC Express5800/ft series with which it 

is packaged (including other NEC Express5800 models). Otherwise, a breakdown may 
result. 

� To use the consoleless feature, make sure that keyboard is not connected to the server. When 
a keyboard is connected, the consoleless feature is disabled because the NEC 
EXPRESSBUILDER determines that the server has a console. (The menu will not be 
displayed on the management PC.) 

See "Consoleless Menu" described later for details. 

� Inserting NEC EXPRESSBUILDER CD-ROM after Windows startup 

The "Master Control Menu" (see figure below) starts automatically after you place the "NEC 
EXPRESSBUILDER" in the CD-ROM drive. A dialog box called “Master Control Menu” will 
appear. 

For this dialog, see “Master Control Menu” described later. 
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NEC EXPRESSBUILDER Top Menu 

The NEC EXPRESSBUILDER top menu is used for the setup of hardware and the setup and 
installation of OS. 

 
Start 

Start the NEC EXPRESSBUILDER top menu following the procedure below: 

1. Turn on the powers of peripherals and the power of the server in this order. 

2. Insert the NEC EXPRESSBUILDER CD-ROM into the CD-ROM drive of the server. 

3. After the CD-ROM is inserted, reset the system (by pressing Ctrl + Alt + Delete) or turn 
off the power and then on again to restart the server. 

The system is activated from the CD-ROM to start the NEC EXPRESSBUILDER. 

After the NEC EXPRESSBUILDER is started, the NEC EXPRESSBUILDER top menu shown 
below appears.  

 

  

A 1 

C

B

D

A Setup 
 Performs various automatic setup operations including settings of internal parameters and 

states of hardware and installations of Windows Server 2003, Enterprise Edition and 
several utilities. Select this setup procedure if hard disks are used in a partition different 
from that defined at the purchase, or if OS is reinstalled. 

B Tools 
 Starts each of the utilities stored in the NEC EXPRESSBUILDER individually to allow the 

operator to provide setup. Enables the setup without influence of installed OS. 
C Help 
 Describes the NEC EXPRESSBUILDER. We recommend you to read through the help 

before the setup. 
D Exit 
 The NEC EXPRESSBUILDER termination screen appears. 
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Setup 

The setup program is exclusively used for your server to perform automatic setup operations within 
the range from the settings of internal parameters and states of hardware to the installation of 
Windows Server 2003, Enterprise Edition and several utilities. 

Use the setup program if hard disks are used with a partition different from that at purchase, or if 
OS is reinstalled. This feature carries out the complicated setup. 

IMPORTANT:  
� To install Windows Server 2003, Enterprise Edition in your server, use the setup program 

(excluding the case of performing the setup for the first time after the purchase). Any other 
methods cannot install Windows Server 2003, Enterprise Edition in the server. 

� Because the setup is started from its first stage, the execution of the setup causes the data in 
the hard disk to be erased. 
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Tools 

The Tools Menu is used to start each of the several utilities stored in the NEC EXPRESSBUILDER 
CD-ROM individually for manual setup by operator. Use the Tools Menu to provide settings that the 
setup program cannot do automatically or detailed settings. Also use the Tools Menu when system 
diagnosis is performed or a support disk is created. The items in the Tools Menu are described 
below. 

NEC Express5800 NEC EXPRESSBUILDER Ver3. xxxx-x Copyright (C) NEC Corporation 2005 
   

Tools Menu 
 

  

Off-line Maintenance Utility                         

System Diagnostics 
 

RAID Board: None 
Maint Part: None 

Create Support Disk 
 

 
BIOS/FW/etc. Update 

 

 
System Management 

 

 
Help 

 

 
Return to the Top Menu 

 

 
 
� Off-line Maintenance Utility 

Off-line Maintenance Utility is an OS-independent maintenance program that performs 
preventive maintenance and error analysis for your server. See Chapter 6 or the online help for 
details. 

� System Diagnostics 

Executes several tests on the main system to examine the features of the system and the 
connections between the system and extension boards. If the system diagnosis is executed, the 
system check program is started depending on the system status. See the description in Chapter 
6 to manipulate the system check program  

� Create Support Disk 

In the support disk creation procedure, the starting support disk for starting a utility within the 
NEC EXPRESSBUILDER from a floppy disk and the support disk required in the installation 
of the operating system can be created. If you write down the titles appearing on the screen on 
the floppy disk labels, they can be easily managed later. 

The customer should prepare the floppy disks for creating the support disks. 

− Windows Server 2003 OEM-DISK for NEC EXPRESSBUILDER 
Creates a support disk required for recovering the system.  

− ROM- DOS Startup FD 
The support disk for starting the ROM -DOS system is created. 

− Off-line Maintenance Utility FD 
Creates a support disk for activating the Off-line Maintenance Utility.   

− System Diagnostics Utility FD 
The support disk for starting the system check program is created. 

− System Management Function FD 
The support disk for system management functions is created. 
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� BIOS/FW/etc. Update 

The program which is necessary for the update work is transferred to the floppy disk which the 
various update modules of BIOS/FW were stored in. After the reboot, an update program is 
started automatically from the floppy disk, and various BIOS/FW's are updated. 

IMPORTANT: During the execution of the update program, do not turn off the power of the 
system. If the update is interrupted halfway, the system will not be able to be started. 

� System Management functions 

Allow you to make settings of BMC (Baseboard Management Controller) to use its report 
functions and remote control from the management PC.  

� Help 

Indicates the descriptions on several features of the NEC EXPRESSBUILDER. 

� Return to the Top Menu 

Indicates the NEC EXPRESSBUILDER top menu. 
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Consoleless Menu 

The NEC EXPRESSBUILDER contains the "consoleless" feature that enables configuration of the 
server by remote operation from the management PC, even if a console device such as keyboard is 
not connected to the server.  

IMPORTANT:  
� Do not use this CD-ROM on computers other than NEC Express5800/ft series with which it is 

packaged (including other NEC Express5800 models). Otherwise, a breakdown may result. 

� To use the consoleless feature, make sure that keyboard is not connected to the server. When a 
keyboard is connected, the consoleless feature is disabled because the NEC 
EXPRESSBUILDER determines that the server has a console. (The menu will not be 
displayed on the management PC.) 

Starting 

Depending on the connection between the management PC and the main unit, there are two ways 
for startup: 

� Startup from the management PC connected to LAN 

� Startup from the management PC directly connected (serial port B) 

For startup procedures, see “Remote Management Configuration for the Server without Console” 
described later in this chapter. 

IMPORTANT:  
� Do not change the boot device order in the BOOT menu of BIOS SETUP. The consoleless 

feature cannot be used if the CD-ROM drive is not the first device to launch the system. 

� For LAN connection, you can only use LAN port 1. 

� For direct connection, you can only use Serial port B. 

� For consoleless remote operation of the NEC Express5800/ft series, you need to save 
configuration information to a floppy disk. Prepare a formatted floppy disk. 

 

TIPS: BIOS will be set as follows: 

� RomPilot Support: [Enabled] 
� Serial Port B:  [2F8, IRQ3] 
� Serial Port Address: [On-board COM B] 
� Baud Rate:  [19.2K] 
� Flow Control:  [None] 
� Console Connection: [Direct] 
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Menu Items 

Only the menu items available in consoleless operation are extracted from the NEC 
EXPRESSBUILDER Top Menu. See the NEC EXPRESSBUILDER Top Menu described earlier for 
each function. 

1

2

3  
1 See the "NEC EXPRESSBUILDER Top Menu". 
2 Shows detailed explanation of each function. 
3 Terminate the NEC EXPRESSBUILDER. 

 

IMPORTANT:  
� The following functions differ from the Tools Menu in the NEC EXPRESSBUILDER Top 

Menu. 

 – Contents and operations of System Diagnostics (see "SYSTEM DIAGNOSTICS" in Chapter 
6 for details.) 

 – Disk type created in "Created Support Disk". 

� System Diagnostics Utility 
When no keyboard is connected to the server, the System Diagnostic window is not displayed 
on the local console. Make sure to connect the keyboard to the server if you work on this utility 
from the local console. 
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Master Control Menu 

The Master Control Menu is used to: 

• Read documentation, 

• Install the management software, and 

• Install the viewer application (Adobe Acrobat Reader). 

TIPS: 
� Master Control Menu requires Microsoft Windows 95 (or later) or Windows NT 4.0 (or later). 
� To read documentation (HTML and PDF files) in the NEC EXPRESSBUILDER CD-ROM, 

the HTML browser (Microsoft Internet Explorer Version 5.0 (or later) or Netscape 
Communicator Version 4.0 (or later)), and Adobe Acrobat Reader Version 4.05 (or later) are 
required in your system. 

 

 

 

 

 

 

 

 

 

Put the NEC EXPRESSBUILDER CD-ROM in the CD-ROM drive. Master Control Menu 
automatically appears on the screen. If the Autorun feature is invalid in your system, run the 
\MC\1ST.EXE file in the CD-ROM directly. Some items are grayed-out when the logon user does 
not have the authority of the Administrator or the system does not meet the requirements to install 
the application. 

 

To use Master Control Menu: 

• Click [Online Document], [Setup] or [Quit], or 

• Right-click Master Control Menu window. 
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NEC ESMPRO Agent and Manager 
NEC Express5800/ft series system management applications "NEC ESMPRO Manager" and "NEC 
ESMPRO Agent" are bundled to accessory CD-ROM "NEC EXPRESSBUILDER."  

This manual describes the functions and features provided by NEC ESMPRO Manager and NEC 
ESMPRO Agent and the notes on their operations. 

These applications are necessary for continuous operation of NEC Express5800/ft series. 

Overview 

NEC ESMPRO Manager and NEC ESMPRO Agent are the server management software provided 
for the stable operation of a server system and effective system operations. They can manage the 
configuration information and operating status of server resources to prevent server faults from 
occurring. If a server fault occurs, they detect the fault to notify the system Administrator of the 
occurrence. This enables the system Administrator to take appropriate action against faults. 

� Importance of server management 

“Constantly stable operation” and “less management workload” are keywords in server 
management. 

− Stable operation of server 

Shutdown of a server immediately leads the customer to lose business opportunities 
and profits. This requires servers to always operate in their perfect state. If a fault 
occurs in a server, it is necessary to detect the occurrence as soon as possible, make 
clear the cause, and take appropriate action. The shorter the time taken from the 
occurrence of a fault to the recovery from the fault is, the smaller the loss of profits 
(and/or costs) is.  

− Load reduction of server management 

The server management requires many jobs. In particular, if the system becomes large 
or remote servers are used, required jobs increase further. The reduction of the load of 
the server management brings the decrease in costs (and thus customer's benefit). 

� What are NEC ESMPRO Manager and NEC ESMPRO Agent? 

NEC ESMPRO Manager and NEC ESMPRO Agent are server management software used 
to manage and monitor NEC Express5800 series systems on the network. The installation 
of NEC ESMPRO Manager and NEC ESMPRO Agent enables the server configuration, 
performance, and fault information to be acquired, managed, and monitored realtime and 
also the occurrence of a fault to be detected immediately by the alert report function.  
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� Effects of using NEC ESMPRO Manager and Agent 

NEC ESMPRO Manager and NEC ESMPRO Agent have sufficient effects on a variety of 
needs in versatile and complicated system environments. 

− Detection of server fault 

NEC ESMPRO Agent collects a variety of fault information on NEC Express5800 
series systems to identify the states of the systems. If a server detects a fault, the 
server provides NEC ESMPRO Manager with the proper alert report. 

− Prevention of server fault 

NEC ESMPRO Agent includes the preventive maintenance function predicting the 
occurrence of a fault in advance as countermeasures for preventing faults from 
occurring. It can previously detect the increase in the chassis temperature and the 
empty capacity in a file system. 

− Management of server operation status 

NEC ESMPRO Agent can acquire the detailed hardware configuration and 
performance information on NEC Express5800 series systems. The acquired 
information can be viewed at any point through NEC ESMPRO Manager. 

− Collective management of distributed servers 

NEC ESMPRO Manager provides the GUI interface that allows servers distributed 
on the network to be managed efficiently. 

 



Installing and Using Utilities  5-13 

Detection of Server Fault 

NEC ESMPRO Manager and NEC ESMPRO Agent detect errors causing faults to occur at an early 
stage and notify Administrators of fault information real-time. 

� Early detection of error 

If a fault occurs, NEC ESMPRO Agent detects the fault and reports the occurrence of the 
fault to NEC ESMPRO Manager (alert report). NEC ESMPRO Manager displays the 
received alert in the alert viewer and also changes the status colors of the server and server 
component in which the fault occurs. This allows you to identify the fault at a glance. 
Further, checking the content of the fault and the countermeasures, you can take 
appropriate action for the fault as soon as possible. 

� Types of reported faults 

The table below lists the typical faults reported by NEC ESMPRO Agent. 

Component Reported information 
CPU • CPU load is over the threshold 

• CPU degrading, etc. 
Memory ECC 1-bit error detection, etc. 
Power supply • Voltage lowering 

• Power failure, etc. 
Temperature Temperature increase in chassis, etc. 
Fan Fan failure (decrease in the number of revolutions), etc. 

Storage File system usage rate, etc. 
LAN • Line fault threshold over 

• Send retry or send abort threshold over, etc. 
 
Prevention of Server Fault 

NEC ESMPRO Agent includes the preventive maintenance function forecasting the occurrence of a 
fault as countermeasures for preventing faults from occurring. 

NEC ESMPRO Manager and NEC ESMPRO Agent can set the threshold for each source in the 
server. If the value of a source exceeds the threshold, NEC ESMPRO Agent reports the alert to NEC 
ESMPRO Manager. 

The preventive maintenance function can be set for a variety of monitoring items including chassis 
temperature, and CPU usage rate. 
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Management of Server Operation Status 

NEC ESMPRO Agent manages and monitors a variety of components installed in the server. You 
can view the information managed and monitored by NEC ESMPRO Agent on the data viewer of 
NEC ESMPRO Manager. 

NEC ESMPRO Agent also manages and monitors all the components and conditions required to 
keep the server reliability at a high level such as hard disks, CPU, memory, fans, power supply, and 
temperature. 
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Monitoring (Management) of NEC Express5800/ft series 

NEC Express5800/ft series is a fault tolerant system. It can continue the operation even if a major 
component fails. NEC Express5800/ft series improves the system availability with the hardware, 
NEC ESMPRO, and system software functions. 

If a major component fails, the NEC ESMPRO fault report function can notify the system 
Administrator of the occurrence of the fault. In addition, the data viewer of NEC ESMPRO 
Manager can monitor the system status and also identify the failed component. 

NEC ESMPRO provides several maintenance functions such as the update of F/W and BIOS in the 
NEC Express5800/ft series in the online state (in which the system continues the operation but the 
components used to update F/W or BIOS is suspended) and the suspension of a specific component. 

The table below lists the NEC Express5800/ft series management tasks using NEC ESMPRO and 
system functions. 

NEC Express5800/ft series 
management task 

NEC ESMPRO function or tool 
(on managed NEC 
Express5800/ft series)* 

NEC ESMPRO function or tool 
(on management manager) 

Monitoring of major 
component states 

– NEC ESMPRO Manager 
data viewer 

Diagnosis and start/stop of 
major components and F/W 
update 

NEC ESMPRO Agent 
ft server utility 

NEC ESMPRO Manager 
data viewer 

BMC F/W update NEC ESMPRO Agent 
BMC F/W update utility 

NEC ESMPRO Manager 
BMC F/W update utility 

Confirmation of alert or 
confirmation of fault 
occurrence event 
information 

Event Viewer NEC ESMPRO Manager 
Alert Viewer 

Confirmation of H/W error 
log 

NEC ESMPRO Agent NEC ESMPRO Manager 

 

* When the administration manager is also the managed NEC Express5800/ft series (or NEC 
ESMPRO Manager is installed on the managed NEC Express5800/ft series), all functions of the 
administration manager can be used on the managed NEC Express5800/ft series. 

 
The report of a fault occurrence in the NEC Express5800/ft series (alert) is immediately sent to the 
NEC ESMPRO Manager. When the NEC ESMPRO Manager receives the alert, a popup message 
appears.  

The alert contains the detailed information of the fault and the proper countermeasures. You can 
take the appropriate action for the alert. 
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.  
 
 
 

 

 
 

Collective Management of Distributed Servers 

The excellent GUI provided by NEC ESMPRO Manager allows servers on a network to be 
managed collectively. The management screen is designed in the Explorer format to indicate the 
components in a server hierarchically for effective server management. 

NEC ESMPRO Manager manages servers by using the following three types of GUIs. 

� Operation Window 

The operation window is used to create the 
map of servers connected to network to 
manage them. The map can be multi-layered 
depending on the installation areas, 
organizations, and objects. 
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� Data Viewer 

The data viewer indicates the server source configuration information in the Explorer format. In 
addition, it changes the status color of the failed server component. This enables you to identify 
the failed portion. 

 
� Alert Viewer  

The Alert Viewer manages fault reports sent from servers together. A fault occurred in a server 
is immediately reported to the Alert Viewer. 

The Administrator can recognize all faults on the network instantly. 
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NEC ESMPRO Agent 

Device ID in Alert Report 

Some NEC Express5800/ft series reports use unique device IDs which correspond to the devices 
listed in the table below as the device identification information. 

Device name Device ID 
CPU module 1 
DIMM1 on CPU module 1 
DIMM2 on CPU module 1 
DIMM3 on CPU module 1 
DIMM4 on CPU module 1 
DIMM5 on CPU module 1 
DIMM6 on CPU module 1 
CPU1 on CPU module 1 
CPU2 on CPU module 1 
Power supply unit on CPU module 1 

0 
0/0 
0/1 
0/2 
0/3 
0/4 
0/5 
0/20 
0/23 
0/100 

CPU module 3 
DIMM1 on CPU module 3 
DIMM2 on CPU module 3 
DIMM3 on CPU module 3 
DIMM4 on CPU module 3 
DIMM5 on CPU module 3 
DIMM6 on CPU module 3 
CPU1 on CPU module 3 
CPU2 on CPU module 3  
Power supply unit on CPU module 3 

2 
2/0 
2/1 
2/2 
2/3 
2/4 
2/5 
2/20 
2/23 
2/100 

PCI module 1 
PCI slot 1 on PCI module 1 
PCI slot 2 on PCI module 1 
PCI slot 3 on PCI module 1 
SCSI adapter 1 on PCI module 1 
SCSI bus 1 of SCSI adapter 1 on PCI module 1 
SCSI bus 2 of SCSI adapter 1 on PCI module 1 
Ethernet Board 1 on PCI module 1(1000BASE) 
Ethernet Board 2 on PCI module 1(100BASE) 
Power supply unit on PCI module 1 

10 
10/0 
10/1 
10/2 
10/5 
10/5/0 
10/5/1 
10/3 
10/6 
10/100 

PCI module 2 
PCI slot 1 on PCI module 2 
PCI slot 2 on PCI module 2 
PCI slot 3 on PCI module 2 
SCSI adapter 1 on PCI module 2 
SCSI bus 1 of SCSI adapter 1 on PCI module 2 
SCSI bus 2 of SCSI adapter 1 on PCI module 2 
Ethernet Board 1 on PCI module 2(1000BASE) 
Ethernet Board 2 on PCI module 2(100BASE) 
Power supply unit on PCI module 2 

11 
11/0 
11/1 
11/2 
11/5 
11/5/0 
11/5/1 
11/3 
11/6 
11/100 

SCSI enclosure 1 
SCSI slot 1 on SCSI enclosure 1 
SCSI slot 2 on SCSI enclosure 1 
SCSI slot 3 on SCSI enclosure 1 
Electronics 1 on SCSI enclosure 1 
Power supply unit on SCSI enclosure 1 

10/40 
10/40/1 
10/40/2 
10/40/3 
10/40/120 
10/40/100 
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Device name Device ID 
SCSI enclosure 2 
SCSI slot 1 on SCSI enclosure 2 
SCSI slot 2 on SCSI enclosure 2 
SCSI slot 3 on SCSI enclosure 2 
Electronics 1 on SCSI enclosure 2 
Power supply unit on SCSI enclosure 2 

11/40 
11/40/1 
11/40/2 
11/40/3 
11/40/120 
11/40/100 

 

The figure below shows the actual locations of the device names displayed on the NEC ESMPRO 
screen. In the case of the tower model, modules are mounted vertically instead of horizontally. 

 

 

 

PCI module2 
SCSI enclosure2 (SCSI 1 –
SCSI 3 from left to right) 

PCI module1 
SCSI enclosure1 (SCSI 1 –
SCSI 3 from left to right) 

CPU module1 

CPU module3 
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Supplement 

Note the following when using NEC ESMPRO Agent. 
 
Application log registered when system starting 

· About the event of “Source: Perflib” 
When system is starting, Perflib log may be registered to the application log. 
The detailed information about an event log is described on Microsoft Product 
Support Services. Please check the contents. 

- [INFO] Events for Performance Monitor Extensions 
http://support.microsoft.com/default.aspx?scid=kb;en-us;226494 

 
- Application Log Events Generated When You Start Performance Counter Query 

http://support.microsoft.com/default.aspx?scid=kb;en-us;296187 
  

- Event ID 2003 Warning Message Logged When Loading Performance Counters 
http://support.microsoft.com/default.aspx?scid=kb;en-us;267831 

Visit the Microsoft Help and Support on regular basis where you can find other information than the 
above at http://support.microsoft.com/default.aspx?LN=en-us. 
 
Dual registration of event logs 

At some types of errors, two event logs may be registered for a single occurrence. (However, in the 
case of NEC ESMPRO Manager, one log is reported for one occurrence.) Such errors are as 
follows: 

- Temperature error 

- Voltage error 

- Thermal trip 

 
Maintenance-related Functions 

When you want to use maintenance-related functions of the NEC Express5800/ft series, contact 
your maintenance personnel. 

 
CPU Information 

If you select [CPU Module]–[CPU] in the FTServer tree of the data viewer, unknown or incorrect 
information appears in some information items. 

The CPU information can be viewed by selecting [System]–[CPU] in the [ESMPRO] tree. 
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Change of Installation States of CPU and PCI Modules 

If you dynamically change the configuration of the CPU or PCI module in the relevant system 
during review of the server information by using the data viewer, the message prompting you to 
reconstruct the tree of the data viewer will appear. If you click the [Yes] button, the tree is 
reconstructed in the data viewer to reflect the change of the system configuration on the data viewer. 
Clicking the [No] button does not cause the tree to be reconstructed in the data viewer. If so, the 
information in the data viewer may be different from the current system information because the 
change of the system configuration is not reflected on the data viewer. 

 
SCSI Slot Information 

When the PCI module is detached and you select [SCSI Slot] → [General Information], the 
displayed “Hardware LED” information may not be correct. 

To check the status of SCSI slots, see the string information in the “Status” column. 

 
Impact When Module Status Changes 

PCI modules, SCSI adapters, SCSI buses, and modules under the SCSI enclosure have impact on 
each other. For example, when the “Status” item of a module changes to “fault,” it may be caused 
by another module’s error. Therefore, you need to check the status of the other modules based on 
alert information. 

 
Status Color after Mounting a Hard Disk 

When creating a new mirror, the status of the hard disk and its upper component, SCSI enclosure, 
will continue to change frequently after you mount a hard disk until the mirror is completed. During 
this process, the status color may turn to abnormal, but when the mirror is created successfully, it 
will return normal. 

 
LAN Monitoring Report 

The LAN monitoring function defines the line status depending on the number of transmission 
packets and the number of packet errors within a certain period. Thus, the LAN monitoring function 
may report a line fault or high line load only in a temporary high line impedance state. If a normal 
state recovery is reported immediately, temporal high line impedance may have occurred thus there 
is not any problem.  

 
LAN Monitoring Threshold 

Because the NEC Express5800/ft series detects hardware faults on the network in the driver level, 
NEC ESMPRO Agent does not monitor line faults. Thus, the value set for "Line fault occurrence 
rate" of a [LAN] tab of [NEC ESMPRO Agent properties] in the control panel is not used. 

 
Status during CPU Module Diagnosis 

While diagnosing a stopped CPU module, the CPU is no longer in the duplex mode and the CPU 



5-22  Installing and Using Utilities 

and the memory cannot be used. However, the status of [CPU] and [DIMM] displayed under [CPU 
module] in the FTServer tree on a Data Viewer becomes “Online” and the status color becomes 
green. 

 

Hard Disk Drives Mirrored By the Rapid Disk Resync (RDR) Function 

The Data Viewer’s [Mirror Disk] tree of [FTSever] shows a pair of hard disk drives constructing 
mirroring as one mirror.  

Therefore the status of a volume (such as span volume and striping volume) over multiple hard disk 
drives created by the RDR function may not be displayed correctly. Use the RDR Utility for 
checking the state of mirrored hard disk drives created by the RDR function.  

 
Community Authority 

Depending on your OS type or its version, settings for community, SNMP service’s security 
function, are not made, or default settings of authority are different   

To enable the remote shutdown and threshold change functions via NEC ESMPRO Manager, make 
settings of community and set its authority to "READ CREATE" or "READ WRITE." 

 
Monitoring with NEC ESMPRO Manager Ver.4.0 or Earlier 

Some items cannot be monitored with NEC ESMPRO Manager of version 4.0 or earlier.  

NEC ESMPRO Manager Ver.4.1 is registered in NEC EXPRESSBUILDER CD-ROM. Use the 
NEC ESMPRO Manager Ver.4.1. 

 
Coexistence with the Oracle products  

The installation of the Oracle products may change Startup Type of SNMP Service into “Manual”. If 
so, change the setting back to “Automatic” and set up correctly according to the description of the 
Oracle product. 
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Change of SNMP Community 

If the security setting of the SNMP Service of a system, where the NEC ESMPRO Agent is installed, 
is changed from the default “public” to a community name, change the community settings of the 
NEC ESMPRO Agent, too.  

1. Double-click the [NEC ESMPRO Agent] icon in [Control Panel]. 

2. Select a desired community name from the [SNMP Community] list box in [SNMP 
Setting] of the [General] sheet. 

The community names to receive SNMP packets from are listed in the [SNMP 
Community] list box. 

3. Click the [OK] button to terminate the operation. 

 

Disk Maintenance While NEC ESMPRO Agent is Running 

The following works to disks (hard disk drive or magneto optical) are not allowed while NEC 
ESMPRO Agent is running; 

· To format or delete a partition by Disk Administrator or by other means. 

· To request programmatically to remove media from removable disks such as MO, Zip and PD. 

1. Connect the machine using Web UI. 

2. Click the [Maintenance]. 

3. Click the [Terminal Service] 

4. Log on as an administrator 

5. Select the [Start] – [Settings] – [Control Panel] 

6. Open the [Service] 

7. Select a service named “ESMCommonService”, and click the [Stop]. 

8. Confirm that “ESMCommonService” stopped, and close the [Service]. 

9. Do the disk-related works. 

10. Open the [Service] again, select “ESMCommonService” and click the [Start]. 

11. Confirm that “ESMCommonService” is active and close the [Service] and [Control 
Panel]. 
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About the warning event of CPU load Monitoring 

If NEC ESMPRO Agent cannot get performance information from the OS due to a temporary 
resource shortage or high load ratio on the system, it will record the following event log. However, 
there is no real problem on operation. (In the description, Y and X represent alphanumeric 
characters.) 

Source: ESMCpuPerf 

Event ID: 9005 

Description: Cannot get system performance information now (YYYY Code=xxxx). 

If NEC ESMPRO Agent cannot get information, it will treat the load ratio as 0%. So, if NEC 
ESMPRO Agent cannot get information continuously, the CPU load ratio may appear lower than the 
actual value. 

 
Connection with Hard Disk Drive 

The preventive hard disk drive maintenance function may not work properly when a hard disk drive 
which was used in a system where NEC ESMPRO Agent is installed is connected to other systems. 
Make sure not to connect such hard disk drives. 

 
Change Settings of File System Monitoring Function 

New settings in thresholds of monitoring interval and free space monitoring are not reflected 
immediately after they are changed. They are reflected at the next monitoring interval of monitoring 
service.   

 
CPU Load Ratio of SNMP Service (snmp.exe) 

While monitoring the server from NEC ESMPRO Manager, the CPU load ratio of SNMP Service 
on the NEC ESMPRO Agent side may increase at every monitoring interval (default: 1 minute). 

NEC ESMPRO Manager and NEC ESMPRO Agent exchange information through SNMP Service. 
If the server status monitoring by NEC ESMPRO Manager is on (default: ON), NEC ESMPRO 
Manager regularly issues a request to NEC ESMPRO Agent to get the current status of the server. In 
response, NEC ESMPRO Agent checks the status of the server. As a result, the CPU load ratio of 
SNMP Service increases temporarily. 

If you have trouble of terminating a movie player application, turn off the server status monitoring 
by NEC ESMPRO Manager or extend the monitoring interval.   
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Current Status of Temperature, Voltage and Fan Sensors 

Some modes are equipped with temperature/voltage/fan sensors that do not have information on 
status, current values, rpm, threshold etc. Therefore, if you view such a sensor on NEC ESMPRO 
Manager, it may be displayed as follows: 

� The status becomes “Unknown” (grayed out) on the data viewer. 

� The current value or rpm becomes “Unknown” on data viewer. 

� The status is grayed out on the Web component data viewer. 

� The current value or rpm becomes blank on the Web component data viewer. 

 
Even if the sensor is displayed like stated above, it is monitoring the server. 

 
Actions to Take When Temperature/Voltage Error Occurs on CPU/PCI Modules 

At the time when a temperature or voltage error occurs on CPU/PCI module, necessary actions will 
differ depending on their status as shown below. You can check the status of each module from the 
data viewer of NEC ESMPRO Manager or ft server utility. 

Status Actions 
Duplex Stop the failed CPU/PCI module. 
Simplex Shut down the system. 
Other than duplex or simplex No action is required. 

TIPS:  
� If the status is “Empty,” the module is not mounted. Sensor monitoring is not conducted. 

� If disks are mounted on PCI modules, the status of both modules is “Simplex” while the disks 
are mirrored. Temperature or voltage error occurring during disk mirroring will result in the 
system to shut down. 

 
Total Status of the PCI Module 

When each module’s status is simplex, the total status of the PCI module displayed on the Data 
Viewer is yellow (warning) and the status will be reflected to the server status. The ft control 
software 3.0 or later does not display the information on Ethernet or SCSI adapter on the tree of the 
Data Viewer. If an error occurs on an Ethernet or SCSI adapter, view the alert reports.  
 
CPU Information 

In [CPU Information] of Data Viewer’s system tree, the external clock is listed as “Unknown.” 
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When [ft Server] Tree Appears on Date Viewer in an Incorrect Manner 

If you open a Data Viewer immediately after the system starts up, the tree or the state of a Data 
Viewer may not be displayed correctly due to high load of the system. In about 20 minutes after the 
system startup, when a pop-up message (below) which prompt you to reconstruct a Data Viewer 
appears, click [OK]. The Data Viewer will be reconstructed and the tree and the status will be 
displayed correctly.  

Data Viewer 

The system configuration of the host may have been changed. Do you wish to reconstruct the 
tree? 

 
Floppy Disk Drive Name 

After unplugging and plugging the PCI module of the primary side, the floppy disk drive name of 
[I/O Device] on Data Viewer may be different from the name that is recognized by the OS. 

(Example: drive name on Data Viewer: “A” 

 drive name recognized by the OS: “B”) 

Check the floppy disk drive name on Explorer. 

 
Floppy Disk Drive Information 

If you add or delete floppy disk drive connected with USB while the system is running, the drive 
information under the [I/O Device] in the data viewer will be updated at the next system startup.   
 
Information of the keyboard/mouse connected with USB 

When the keyboard or mouse is connected with USB, the keyboard or mouse information under the 
[I/O Device] in the data viewer is listed as “Unknown.” 
 
Ethernet Adapters You Do Not Use 

If an Ethernet adapter is not used (not connected to cable), set it to “Disable” in [Network 
Connections] from Control Panel. If an Ethernet adapter you are about to disable has dual LAN 
settings (AFT function), remove the dual LAN settings before disable it.  

 
Monitoring in Sleep State 

NEC ESMPRO Manager cannot monitor the NEC ESMPRO Agent machine in the sleep state 
(system standby or system halt state).  

While NEC ESMPRO Manager monitors server shutdown, the relevant NEC ESMPRO Agent 
machine may be entered into the sleep state. If so, the report "server access disabled" is issued and 
the status color of the server icon becomes gray. This cannot indicate whether the NEC ESMPRO 
Agent machine is shut down or entered into the sleep state. Keep these in mind when operating the 
system where systems to be monitored may enter the sleep state. 
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Printer Information’s Available Time: 

When you add a new printer, install its driver and make its settings, if you do not make settings for 
the available time from Add Printer Wizard, the printer’s available time (From and To) in [Printers 
and Faxes] are [00:00], on the other hand, Manager’s time are [9:00]. To display them properly, 
make the settings of printer from [Printers and Faxes]. The procedures are as follows; 

1. Start [Printers and Faxes], and open the printer properties you want to make settings 
for. (Select the [Printers and Faxes], right-click and select [Properties].) 

2. Select the [Advanced] tab. 

3. Enter values in the available time (From and To), and click [OK] in the [Advanced] 
and [Properties] dialog boxes.  

Now, you can see the correct information from Manager, too.  

 
Hang of SNMP Service 

SNMP Service has a module called “SNMP Extended Agent.” This module may be registered when 
you install some software that uses SNMP Service. 

If you start SNMP Service, SNMP Extended Agent is also loaded at the initialization. However, if 
the initialization is not completed within a specified period, SNMP Service will hang. 

It may take time to complete the initialization due to temporary high load on the system. In this case, 
wait for the system load become low enough before restarting SNMP Service. 

 
Model Name of CPU/PCI module 

If you select [CPU/PCI Module]-[Each CPU/PCI Module]-[General Information/Update 
Information] in [FT Server] tree of the data viewer, the displayed “Model Name” information is not 
correct. 

To check the “Model Name”, refer to the Part Number of Board Information displayed by selecting 
[Hardware]-[Field Replaceable Unit]-[Each CPU/PCI Module] in [ESMPRO] tree of the data 
viewer. 
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NEC ESMPRO Manager 

To monitor and manage a computer, on which NEC ESMPRO Agent is installed, with a 
management PC online, use NEC ESMPRO Manager that is bundled with the product. 

For detailed procedures of installation and setting, see online documents or NEC ESMPRO Online 
Help. 

TIPS: Online documents provide cautions and information for using NEC ESMPRO Manager. 
See NEC ESMPRO Manager User’s Guide in the NEC EXPRESSBUILDER CD-ROM. 

 
Monitoring by Use of Data Viewer 

To monitor the state of the NEC Express5800/ft series on a management computer with installation 
of NEC ESMPRO Manager, the data viewer is used. If you click each of the modules and items to 
be checked sequentially on the tree view in the Windows Explorer format, the data viewer indicates 
their states on the right side of the screen. 

You can manage the status on a Web browser using Web component functions of NEC ESMPRO 
Manager. For details, see Help on Web Component. 

This section describes the tree structure and displayed screens in the data viewer. 

To make the data viewer indicate the state of each module and those of the components on it, select 
the server to be monitored from NEC ESMPRO Manager to start the data viewer (in the following 
description, the start procedure of the data viewer is omitted). 
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Monitoring CPU Module 

To monitor the CPU modules and the components on the CPU module, see the [CPU Module] tree. 
To see the information on the [CPU Module] tree, select the target CPU module from [CPU 
Module] in the [FTServer] tree. 

You can see the following information on the modules and the components on the CPU modules in 
the [CPU Module] tree. 

� General 

Allows the configuration and other information on the CPU modules to be viewed. 

 
� Maintenance 

Allows the start/stop, MTBF information clear, dump acquisition, and diagnosis of the CPU 
modules to be provided. See "Maintenance of NEC Express5800/ft series" described later for 
the start/stop and MTBF information clear of the CPU modules. 
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� Update 

Allows the device identification information of the CPU modules to be viewed and BIOS of the 
CPU modules to be updated. See "Maintenance of NEC Express5800/ft series" described later 
for the update of BIOS of the CPU modules. The detailed device identification information can 
be checked by selecting [ESMPRO] tree→[Hardware] tree→[Field Replaceable Unit] tree. 

 
� CPU 

Allows the information of the CPU on the CPU modules to be viewed. 

 

 

� DIMM 

Allows the information of DIMM on the CPU modules to be viewed. 
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Monitoring PCI Module 

To monitor the PCI modules and the components on the PCI modules, refer to the [PCI Module] 
tree. To see the information on the [PCI Module] tree, select the target PCI module from [PCI 
Module] in the [FTServer] tree. 

You can see the following information on the PCI modules and the components on the PCI modules 
of the [PCI Module] tree. 

(This section describes the general information screens of the PCI modules. The components on the 
PCI modules are described later.) 

� General 

Allows the configuration and other information of the PCI modules to be viewed. 

 
� Maintenance 

Allows the start/stop, MTBF information clear, and diagnosis of the PCI modules to be 
provided. See "Maintenance of NEC Express5800/ft series" described later for the start/stop and 
MTBF information clear of the CPU modules. 

 
� Update 

Allows the device identification information of the PCI modules to be viewed. The detailed 
device identification information can be checked by selecting [ESMPRO] tree→[Hardware] 
tree→[Field Replaceable Unit] tree. 
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Monitoring PCI Slots and Devices on PCI Module 

To monitor the PCI slots and devices on the PCI modules, see the [PCI slot] tree. To see the 
information on the [PCI slot] tree, select [PCI Module]→[PCI module (containing PCI slot to be 
seen)]→[PCI slot] of the [FTServer] tree. 

You can see the following information on the PCI slot and the devices on the PCI slot in the [PCI 
slot] tree. 

� General 

Allows the PCI slot configuration information to be viewed. 

 
� Maintenance 

Allows a device on the PCI slot to be started. This function is not supported in the current 
version. 

 
� PCI Device – General 

Allows the information of devices on the PCI slot to be viewed. 
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� PCI Device – Detailed information 

Allows the detailed information of a device on the PCI slot to be viewed. 

 
� PCI Bridge – General 

Allows the information of bridges on the PCI bus to be viewed  

PCI Bridge – Bus information 

Allows the bus information of a bridge on the PCI bus to be viewed. 

 

 

 

 

 

� PCI Bridge – Detailed information 

Allows the detailed information of a bridge on the PCI bus to be viewed. 

 



5-34  Installing and Using Utilities 

Monitoring BMC on PCI Module 

To monitor the base management controller (BMC), controller for system management, on the PCI 
modules, see the [BMC] tree. To see the information on the [BMC] tree, select [PCI Module] [PCI 
module (containing BMC to be seen)] [BMC] of the [FTServer] tree. 

You can see the BMC F/W version and other information in the [BMC] tree. 
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Monitoring SCSI Enclosure 

To monitor the SCSI enclosure, see the [SCSI enclosure] tree. To see the information on the [SCSI 
enclosure] tree, select [SCSI enclosure] of the [FTServer] tree. 

You can see the following information of the SCSI enclosure from the [SCSI enclosure] tree. 

� General 

Allows the configuration and other information of the SCSI enclosure to be viewed.  

IMPORTANT: You need to be aware that PCI modules, SCSI adapters, SCSI buses, and 
modules under the SCSI enclosure have impact on each other. For details, see “Impact When 
Module Status Changes” described above. 

 
� Maintenance 

Allows the MTBF information of the SCSI adapter to be viewed or cleared. 

See "Maintenance of NEC Express5800/ft series" described later for clearing the MTBF 
information on the SCSI enclosure. 

 
� Update 

Allows the firmware of the SCSI enclosure to be updated. 

However, this function is not supported in the current version. 
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� Electronics – General 

Allows the configuration and other information of the SCSI enclosure electronics to be viewed. 

 
� Electronics – Maintenance 

Allows the MTBF information of the SCSI enclosure electronics to be viewed or cleared. 

See "Maintenance of NEC Express5800/ft series" described later for clearing the MTBF 
information on the SCSI electronics enclosure. 

 
� SCSI Slot – General 

Allows the configuration and other information of the SCSI slot to be viewed. 

 

IMPORTANT: You need to be aware of the status of hard disk during the mirror creation. For 
details, see “Status Color after Mounting a Hard Disk” in “Supplement”.  
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� SCSI Slot – Maintenance 

Allows the MTBF information of the SCSI slot to be viewed or cleared. 

See "Maintenance of NEC Express5800/ft series" described later for clearing the MTBF 
information on the SCSI slot. 

 
 

Monitoring Mirror Disk 

To monitor the mirror disk components, see the [Mirror Disk] tree. To view information on [Mirror 
Disk] tree, select [Mirror Disk] under [FTServer] tree. 

You can see the redundancy status of the mirrors and the device IDs of the SCSI slots into which 
these hard disk components are connected. 

 
[Mirror Disk] 
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Monitoring Hard Disk 

To monitor the hard disks and detect disk failures at an early stage, use the NEC ESMPRO Manager 
and Agent. You can see configurations and information of hard disk in the Data Viewer. 

 

Monitoring Operations 

This section describes how to maintain hard disks. 

1. Confirmation of hard disk failure 

If NEC ESMPRO Agent detects some problem with a hard disk, it will report an alert of 
the problem to NEC ESMPRO Manager. Please check the alert viewer in the manager  
regularly. 

Ex. If a hard disk in SCSI Slot (10/40/1) is broken, agent reports the following alert. 

Device 10/40/1 is now BROKEN. 
 

And manager displays the problem information of the hard disk in the [SCSI enclosure] 
→ [SCSI Slot] → [General] of the data viewer. 

 
[SCSI Slot] → [General] 
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2. Confirmation of mirror status 

To check the redundancy status of the failed mirror disk, open [Mirror Disk] screen under 
[FTServer]. On this screen, you can check the redundancy status of the mirror and the 
status of the mirrored hard disks.  

 
[Mirror Disk] 

IMPORTANT:  
The mirroring redundancy status will change depending on the status of the two hard disks 
that make up a mirror as follows: 

Status of hard disk 1 Status of hard disk 2 Status of mirror volume 
Duplex Normal 

Simplex - 

Duplex 

Others Warning 

Duplex - 

Simplex Normal 

Simplex 

Others Warning 

Duplex Warning 

Simplex Warning 

Others 

Others - 

“-”: No status is shown. 

TIPS: Unless the hard disks make up a mirror, the Mirror Disk screen does not show any 
information. 
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IMPORTANT:  
The Mirror Disk screen shows a pair of two hard disks as a mirror. Disk pairs are shown in 
the same manner even if a few volumes are created within a single disk or one volume spans 
a few disks (span volume).  

 

z A few volumes are created within a single disk: 

 
The screen shows information on a pair of hard disks that make up a mirror. It does not show 
information based on volumes (ex. Volume A, Volume B). 

Mirror Mirror Mirror

Boot volume 

Boot volume 

Volume A

Volume B

Volume C

Volume D

Volume A

Volume B

Volume C

Volume D
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IMPORTANT: 
z A volume that spans a few hard disks is mirrored (mirror volume, span volume) 

 
Even if a volume consists of a few hard disks, the screen shows information on each pair of 
hard disks that make up a mirror. In the above example, Volume A is shown in Mirror 2 
(10/40/2, 11/40/2) and Mirror 3 (10/40/3, 11/40/3), separately. When a hard disk fails, that 
status will be reflected in both mirrors. 

Boot volume 

Mirror

Boot volume 

Volume A

Volume A
Volume A

Mirror Mirror

Volume A
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3. Recovery from a hard disk failure 

If a hard disk breaks, the broken disk must be replaced immediately. This section 
describes alert reports and status shown by the Data Viewer while disks are replaced to 
restore mirroring. 

(1) Detecting problem of a hard disk 

See [1. Confirm of hard disk failure] above. 

(2) Removing the hard disk 

Disconnect the hard disk with the problem. At this time, NEC ESMPRO Agent reports 
the following alert to manager. And icons related to the hard disk with problem change 
the state of warning in the data viewer. 

Since the hard disk has been removed, the status of the SCSI slot will be “EMPTY.” 

 

TIPS: You can identify the new hard disk by DevicePathID (ex. 10/40/1). 

When one hard disk with problem was disconnected, SCSI slot changes the status to 
"Warning". 

 
[SCSI Slot] → [General] 

IMPORTANT: The status color of the SCSI slot differs depending on the 
connection of mirrored hard disks: 

� If one of the mirrored disks was removed: Warning 

� If both of the mirrored disks were removed: Gray 



Installing and Using Utilities  5-43 

Also, at this time, the redundant status of mirrored disks is changed to "Warning". 

 
[Mirror Disk] 

(3) Connect a new hard disk 

Next, connect a new hard disk to the same SCSI Slot. At this time, NEC ESMPRO 
Agent reports the following alert to manager. And icons related to the hard disk are 
changed to the state of normal in the data viewer. 

When the hard disk is connected, SCSI Slot changes the status to "ONLINE". 

 
[Alert report] 

TIPS: You can identify the new hard disk by DevicePathID (ex. 10/40/1). 
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When the hard disk is connected, SCSI Slot changes the status to "Normal". 

 
[SCSI Slot] → [General] 

Also, at this time, the state of the mirrored disks changes to "Normal". 

 
[Mirror Disk] 
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Maintenance of NEC Express5800/ft series 

NEC Express5800/ft series maintenance can be done in two ways; one is to use NEC ESMPRO 
Manager for remote maintenance and the other is to use the NEC ESMPRO Agent ft server utility 
on the NEC Express5800/ft series for local maintenance. 

TIPS: To start the NEC ESMPRO Agent ft server utility installed in the NEC Express5800/ft 
series, select the items as follows: 

Start Menu→[Programs]→[NEC ESMPRO Agent]→[ft server utility] 

The maintenance functions that can be executed from NEC ESMPRO include three types, those 
common to all components, those specific to particular components, and general system settings. 

The maintenance functions common to all components are operated in the same way basically (the 
operation procedure and typical examples of screen images are described below). 

The table below lists the maintenance functions common to all components. 

Start Stop MTBF 
clear 

Diag- 
nosis 

F/W 
update Component 

R L R L R L R L R L 
CPU module √ √ √ √ √ √ √ √ √ √ 
PCI module √ √ √ √ √ √ √ √ – – 
PCI slot – – – – – – – – – – 
Ethernet adapter – – – – – √ – – – – 
SCSI adapter – – – – – – – – – – 
SCSI enclosure – – – – √ √ – – – – 
SCSI electronics – – – – √ √ – – – – 
SCSI slot – – – – √ √ – – – – 
R: Remote. Executable from remote management PC by using NEC ESMPRO Manager 
L: Local. Executable on local server by using ft server utility 
√: Support 
–: Not support 

 

Note: The MTBF clear of Ethernet cannot be performed to built-in devices. 
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The table below shows the component-specific maintenance functions executable from NEC 
ESMPRO. 

Dump 
acquisition 

Dump acquisition 
during system 

operation 
Board switch Component 

R L R L R L 
CPU module – √ √ √ √ √ 

 
R: Remote. Executable from remote management PC by using NEC ESMPRO Manager 
L: Local. Executable on local server by using ft server utility 
√: Support 
–: Not support 

 
Bus reset Change of primary SCSI bus Component 

R L R L 
SCSI bus – √ – – 

 
R: Remote. Executable from remote management PC by using NEC ESMPRO Manager 
L: Local. Executable on local server by using ft server utility 
√: Support 
–: Not support 

 
BMC firmware update Component 

R L 
BMC √ √ 

 
R: Remote. Executable from remote management PC by using NEC ESMPRO Manager 
L: Local. Executable on local server by using ft server utility 
√: Support 
–: Not support 

 
The table below shows the support of the whole system setup functions. 

Quick dump Auto firmware update Auto module start Component 
R L R L R L 

Whole system – √ – √ – √ 
 

R: Remote. Executable from remote management PC by using NEC ESMPRO Manager 
L: Local. Executable on local server by using ft server utility 
√: Support 
–: Not support 

 
The table below shows the support of the preventive disk maintenance (S.M.A.R.T.) setup function. 

Preventive disk maintenance (S.M.A.R.T.) setup Component 
R L 

SCSI disk – – 
 

R: Remote. Executable from remote management PC by using NEC ESMPRO Manager 
L: Local. Executable on local server by using ft server utility 
√: Support 
–: Not support 
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Start and Stop of Components 

To start or stop a component with NEC ESMPRO Manager, use the [Maintenance] tree of the 
component in the [FTServer] tree of the data viewer. Open the tree of the component to be started or 
stopped and select the [Maintenance] tree. 

To start or stop a component with the ft server utility, use the utility screen of the component. 

The table below shows the potential cases in which a component is to be started or stopped. 

Start Stop Compo- 
nent Remote Local Remote Local 
CPU 
Module 

When the cause of 
down is reviewed 
and the system is 
restarted in module 
down state. 

Executable in any of 
the following module 
states (this can be 
viewed on manager 
screen): 
• Removed 
• Broken 
• Shot 
• Firmware Update 

Complete 
• Diagnostics 

Passed 
 

When the cause of 
down is reviewed 
and the system is 
restarted in module 
down state. 

Executable in the 
following module 
state: 
• When the status 

LED 1 is red and 
the status LED 2 is 
off 

Only the status LED 
1 illuminates red 
when the module is 
in one of the 
following states: 
• Removed 
• Broken 
• Shot 
• Firmware Update 

Complete 
• Diagnostics 

Passed 
 

When system is 
stopped forcibly 
due to replacement 
or malfunction of 
module. 

Executable in the 
following module 
state (this can be 
viewed on manager 
screen): 
• Duplex 

When system is 
stopped forcibly 
due to replacement 
or malfunction of 
module. 
Executable in the 
following module 
state: 
• Only the green 

LED is on and in 
redundant 
configuration 
state 

The both green 
LEDs are on when 
the module is in the 
following state: 

• Duplex 

 

PCI Module Same as above Same as above Same as above Same as above 
SCSI Slot – – – – 
 
Remote: Executable from remote management PC by using NEC ESMPRO Manager 
Local: Executable on local server by using ft server utility 
–: Not support 
 

IMPORTANT: PCI modules, SCSI adapters, SCSI buses, and modules under the SCSI enclosure 
have impact on each other. You need to be aware of this, for example, when you replace a PCI 
module. For details, see “Impact When Module Status Changes” described above. 
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Procedure in NEC ESMPRO Manager 

Start 

1. Select the target component in the [FTServer] tree. 

2. Check the current state with the "Status" display on the target component screen. 

3. Click the [Bring Up] button in the [Maintenance] screen for the target component. 

A certain time is required for the start. 

The start result can be confirmed by "State" on the target component screen. The result of 
the start operation is reported by the NEC Express5800/ft series as an alert. 

Stop 

Perform the procedure below before replacing a component. 

1. Select the target component in the [FTServer] tree. 

2. Check the current state with the "State" display on the target component screen. 

3. Click the [Bring Down] button in the [Maintenance] screen for the target component. 

A certain time is required for the stop. 

The stop result can be confirmed by "State" on the target component screen. The result of 
the stop operation is reported by the NEC Express5800/ft series as an alert. 

 

Sample screen of NEC ESMPRO Manager 1 

 
[Maintenance] screen of PCI module 

[PCI Module] – [PCI Module] – [Maintenance] 
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Sample screen of NEC ESMPRO Manager 2 

 
[Maintenance] screen of CPU module 

[CPU Module] – [CPU Module] – [Maintenance] 
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Procedure in the ft server utility 

Start 

1. Select the target component by using the ft server utility. 

2. Check the current state of the target component with the LEDs. 

3. Click the [Up] button of the target component. 

A certain time is required for the start. 

The start result can be confirmed by the LEDs on the target component. The result of the 
start operation is registered in the event log. 

Stop 

Stop before replacing components. 

1. Select the target component by using the ft server utility. 

2. Check the current state of the target component with the LEDs. 

3. Click the [Down] button of the target component. 

A certain time is required for the start. 

The start result can be confirmed by the LEDs on the target component. The result of the 
start operation is registered in the event log. 

 
Sample screen of ft server utility 
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Check and Clear of MTBF Information 

The MTBF information of a component can be viewed or cleared (initialized). 

NEC Express5800/ft series manages the MTBF (mean time between failure) of each component. If 
a fault occurs in a component, the NEC Express5800/ft series calculates the MTBF of the 
component again. If the calculated value is lower than the pre-defined threshold, the NEC 
Express5800/ft series disables the component to be used. 
Contact your maintenance personnel if such a symptom as above occurs. 

IMPORTANT: A disabled component with the MTBF lower than the threshold can be forcibly 
enabled by clearing the MTBF. However, contact your maintenance personnel for the forced use of 
such a component. 

To clear the MTBF information of a component with NEC ESMPRO Manager, use the 
[Maintenance] tree of the component of the [FTServer] tree of the data viewer. Open the tree of the 
component whose MTBF information is to be cleared and select the [Maintenance] tree. 

To clear the MTBF information of a component with the ft server utility, use the utility screen of the 
component. The table below shows the potential cases in which the MTBF information of a 
component is to be cleared. Contact your maintenance personnel for clearing MTBF information. 

MTBF clear Component 
Remote Local 

CPU Module To start the module forcibly after 
replacing a module or if MTBF became 
lower than the threshold due to 
malfunction and disabled the module. 

Executable in the following module 
state (this can be viewed on manager 
screen): 

• Broken 
MTBF is lower than the threshold. 

To start the module forcibly after replacing 
a module or if MTBF became lower than 
the threshold due to malfunction and 
disabled the module. 

Executable in the following module state: 

• Only the red LED is on and the event 
indicating that MTBF is lower than the 
threshold is registered in the event log. 

PCI Module Same as above Same as above 

Ethernet 
Adapter 

To start the module/component forcibly 
after replacing a module or if MTBF 
became lower than the threshold due 
to malfunction and disabled the 
module/component. 

Executable in the following module 
state (this can be viewed on manager 
screen): 

• Broken 
MTBF is lower than the threshold. 

To start the module/component forcibly 
after replacing a module or if MTBF 
became lower than the threshold due to 
malfunction and disabled the 
module/component. 

Executable in the following module state 
(this can be viewed on manager screen): 

• Only the red LED is on and the event 
indicating that MTBF is lower than the 
threshold is registered in the event log. 

 

IMPORTANT: You can also clear MTBF information for the PCI module, Ethernet Adapter and 
SCSI Adapter by unplugging and plugging the live wire of the PCI module. 
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MTBF clear Component 

Remote Local 
SCSI 
Enclosure 

To start the module/component forcibly 
after replacing a module or if MTBF 
became lower than the threshold due 
to malfunction and disabled the 
module/component. 

Executable in the following module 
state (this can be viewed on manager 
screen): 

Broken 
MTBF is lower than the threshold. 

To start the module/component forcibly 
after replacing a module or if MTBF 
became lower than the threshold due to 
malfunction and disabled the 
module/component. 

Executable in the following module state 
(this can be viewed on manager screen): 

Only the red LED is on and the event 
indicating that MTBF is lower than the 
threshold is registered in the event log. 

SCSI 
Electronics 

Same as above Same as above 

SCSI Slot Same as above Same as above 

Remote: Executable from remote management PC by using NEC ESMPRO Manager 
Local: Executable on local server by using ft server utility 
–: Not support 

 
Procedure in NEC ESMPRO Manager 

Perform the procedure below before replacement of a component. 

1. Select the target component in the [FTServer] tree. 

2. Check the current state with the "State" display on the target component screen. 

3. Click the [Clear] button in the [MTBF Clear] of the target component. 

The MTBF clearing result can be confirmed by "State" on the target component screen. 
The result of the MTBF clearing operation is reported by the NEC Express5800/ft series 
as an alert. 

4. Start the component. 

Sample screen of NEC ESMPRO Manager 

 
[Maintenance] screen of SCSI enclosure 

[SCSI Enclosure] – [Maintenance] 
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Procedure in the ft server utility 

Perform the procedure below before replacement of a component. 

1. Select the target component by using the ft server utility. 

2. Check the current state of the target component with the LEDs and event log. 

3. Click the [Clear] button in [MTBF Clear] of the target component. 

The MTBF clearing result can be confirmed by the LEDs on the target component. The 
result of the MTBF clearing operation is registered in the event log. 

4. Start the component. 

Sample screen of ft server utility 

 
[PCI Module] 
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Diagnostics 

The NEC Express5800/ft series provides the self-check diagnosis function for some components. If 
a fault occurs in a component, the NEC Express5800/ft series can diagnose the component to detect 
the fault. 

To diagnose a component with the NEC ESMPRO Manager, use the [Maintenance] tree of the 
component in the data viewer. Open the tree of the component to be diagnosed and select the 
[Maintenance] tree. 

To diagnose of a component with the ft server utility, use the utility screen of the component. 

The table below shows the potential cases in which a component is to be diagnosed. 

Diagnosis Component 
Remote Local 

CPU Module When a phenomenon causing the 
module to be down occurs or a 
phenomenon supposed to be a 
malfunction occurs. 

Executable in any of the following 
module states (this can be viewed on 
manager screen): 

• Removed 
• Broken 
• Shot 
• Firmware Update Complete 

To diagnose the module under 
operation, bring down the module 
before the diagnosis. 
 

When a phenomenon causing the 
module to be down occurs or a 
phenomenon supposed to be a 
malfunction occurs. 

Executable in any of the following 
module states: 

• When the status LED 1 is red and 
the status LED 2 is off 

Only the status LED 1 illuminates red 
when the module is in one of the 
following states: 
• Removed 
• Broken 
• Shot 
• Firmware Update Complete 

(no fault found by diagnosis) 

To diagnose the module under 
operation, bring down the module 
before the diagnosis. 
 

PCI Module Same as above Same as above 

 
Remote: Executable from remote management PC by using NEC ESMPRO Manager 
Local: Executable on local server by using ft server utility 
–: Not support 
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Procedure in NEC ESMPRO Manager 

1. Select the target component in the [FTServer] tree. 

2. Check the current state with the "State" display on the target component screen. If the 
component is operating, stop the component. 

3. Click the [Diagnostics] button in the [Maintenance] screen for the target component. 

The diagnosis result can be confirmed by "Result" of the diagnosis on the target 
component screen. The result of the diagnosis is reported by the NEC Express5800/ft 
series as an alert. 

The result of diagnosis executed last is displayed in the [Diagnosis Information] column. 
In addition, if a fault is detected by the result of the diagnosis, the state of the [General 
Information] tree of the component is changed. 

Sample screen of NEC ESMPRO Manager 

 
 [Maintenance] screen of PCI module 

[PCI Module] – [Maintenance] 
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Procedure in the ft server utility 

1. Select the target component by using the ft server utility. 

2. Check the current state of the target component with the LEDs. If the component is 
operating, stop the component. 

3. Click the [Diagnostics] button in the [Diagnosis Information] on the target component. 

The diagnosis result can be confirmed by the LEDs on the target component. The result of 
the diagnosis is registered in the event log. 

4. Start the component. 

Sample screen of ft server utility 

 
[PCI Module] 
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Firmware Update 

NEC Express5800/ft series can update firmware (including BIOS) if some hardware components 
operate in the online state (in which the system continues the operation but the component trying to 
update firmware or BIOS is stopped).  

To update firmware with NEC ESMPRO Manager, use the [Update] tree of the component in the 
data viewer. Open the tree of the component for which firmware is updated and select the [Update] 
tree. 

To update the firmware of a component with the ft server utility, use the utility screen of the 
component. 

To update the firmware of a component, the firmware image file of the firmware for update must 
previously be stored in the managed server. On the firmware update screen, specify the path to the 
firmware image file for update. 

The table below shows the potential cases in which the firmware of a component is to be updated. 

Firmware update Component 
Remote Local 

CPU Module When BIOS must be updated to 
new one. 
Executable in any of the 
following module states (this can 
be viewed on manager screen): 

• Removed 
• Broken or forced stop 
• No fault found by diagnosis 

To update the module under 
operation, bring down the 
module before the update. 
 

When BIOS must be updated to new 
one. 
Executable in the following module 
state: 

• When the status LED 1 is red and the 
status LED 2 is off 

Only the status LED 1 illuminates red 
when the module is in one of the 
following states: 
• Removed 
• Broken or forced stop 
• No fault found by diagnosis 

(Firmware Update Complete) 

To update the module under operation, 
bring down the module before the 
update. 

 
Remote: Executable from remote management PC by using NEC ESMPRO Manager 
Local: Executable on local server by using ft server utility 
–: Not support 
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Procedure in NEC ESMPRO Manager 

1. Save the image data of the update firmware in an arbitrary directory of the NEC 
Express5800/ft series. 

Save the image data in any way. Write down the path to the directory in which the image 
data is saved. 

2. Select the target component in the [FTServer] tree. 

3. Check the current state with the "State" display on the target component screen. If the 
component is operating, stop the component. 

4. Click the [Firmware Update] button in the [Update] screen for the target component. 

Sample screen of NEC ESMPRO Manager 

 
 [Update] screen of CPU module 

[CPU Module] – [Update] 
 

5. Select [Specify the file path to update], enter the 
directory in which the updated firmware specified in the 
input box in step 1 is saved, and click the [Execute] 
button. 

Perform the firmware update. 

The update result can be confirmed by the state on the 
target component screen (indication of "Firmware 
update completed"). The result of the update processing 
is reported by the NEC Express5800/ft series as an alert. 

6. After the BIOS for a single CPU module is completed, click the [Jump Switch] button. 
The module completely updated is started and the active module is stopped. 
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7. Start the other module stopped. 

Starting the module causes the firmware to be updated automatically. However, if the 
[Enable automatic firmware update] property is invalid, update the module in the 
procedure as follows: 

(1) Check the current state with the "State" display on the target component screen. If the 
component is operating, stop the component. 

(2) Click the [Firmware Update] button in the 
[Update] screen for the target component. 

(3) Select the update method in the [Firmware 
Update] dialog box and click the [Execute] 
button. 

(4) Start the module. 

 

Even if you do not have the image data of firmware for update, the firmware can be copied from the 
other module. 

By starting the module, the firmware will be updated automatically. However, when the [Enable 
automatic firmware update] property is disabled, follow the steps below to update the firmware: 

 
1. Start the system using the module of the firmware copy source. 

See the current status by the “Status” indication on the target component screen of the copy 
destination and confirm that it is stopped. 

2. On the [Update] screen of the target component, click [Firmware update]. 
3. When a firmware updating dialog appears, check [Copy online BIOS image to Offline.] and 

execute it. 
Firmware is updated by copying the firmware on the online side to the offline side. 

4. Start the stopped module. 
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Procedure in ft server utility 

1. Save the image data of the update firmware in a desired directory of the NEC 
Express5800/ft series. 

Save the image data in some manner. Write down the path to the directory in which the 
image data is saved. 

2. Select the target component with the ft server utility. 

3. Check the current state of the target component with the LEDs. If the component is 
operating, stop the component. 

4. Click the [Firmware...] button for the target component. 

Sample screen of ft server utility 

 
[CPU Module] 

 
5. Select [Specify new firmware for update], enter the 

directory in which the updated firmware specified 
in the input box in step 1 is saved, and click the 
[Activate] button. 

Perform the firmware update. 

 

6. Check the update result with the event log. 
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7. After the BIOS for a single CPU module is completed, click the [Jump Switch] button. 

The module completely updated is started and the module under operation is stopped. 

8. Start the other inactive module. 

Starting the module causes the firmware to be updated automatically. However, if the 
[Enable automatic firmware update] property is disabled, update the module in the 
procedure as follows: 

(1) Check the current state with the "State" 
display on the target component screen. If 
the component is operating, stop the 
component. 

 

(2) Click the [Firmware...] button in the 
[Update] screen for the target component. 

(3) Select the update method in the [Firmware 
Update] dialog box and click the [Run] 
button. 

 (4) Start the module. 

 

Even if you do not have the image data of firmware for update, the firmware can be copied from the 
other module.   

By starting the module, the firmware will be updated automatically. However, when the [Enable 
automatic firmware update] property is disabled, follow the steps below to update the firmware: 

 
1. Start the system using the module of the firmware copy source.   

See the current status by the “Status” indication on the target component screen of the copy 
destination and confirm that it is stopped.   

2. On the [Update] screen of the target component, click [Firmware...]. 
3. When a firmware updating dialog appears, check [Copy firmware from Online module to Offline 

one.] and execute it.    
Firmware is updated by copying the firmware on the online side to the offline side.   

4. Start the stopped module.   
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Dump Collection 

To collect the dump file with NEC ESMPRO Manager, use [CPU Module] →[Maintenance] tree in 
the data viewer. 

To collect the dump with the ft server utility, use the utility screen of the component. 

IMPORTANT: Acquire the dump only for the examination of a fault. 

The dump can be collected in two ways. In each way, the dump file is collected with the same path 
and file name "%SystemDrive%\NECDump\MEMORY.DMP" as the dump file of the OS standard. 

� Collecting dump of inactive module 

The dump is acquired from the inactive CPU module (due to the occurrence of a fault or 
forced stop). 

� Collecting dump under system operation 

Either of the CPU modules is entered into the offline state and the dump is collected 
during system operation. After the acquisition, the CPU module is returned to the online 
state again. This can be done only in the duplex system. 

The table below shows the potential cases in which the dump is acquired. 

Saving dump of stopped module Saving dump of component under system 
operation Component 

Remote Local Remote Local 
CPU Module – When a fault or malfunction 

occurs in the system. 
Save the dump if requested 
by maintenance personnel. 
Executable in the following 
module state: 
• Only the red LED is on 
However, this function 
operates only in a fault 
state. An execution error 
occurs in any other cases. 
Only the red LED is on when 
the module is in one of the 
following states: 
• Removed 
• Broken 
• Shot 
• Firmware 
Completion of update 
• No fault found by 

diagnosis 
 

When a fault or 
malfunction occurs 
in the system. 
Save the dump if 
requested by 
maintenance 
personnel. 
Executable in the 
following module 
state (this can be 
viewed on manager 
screen): 
• Duplex 
 

When a fault or 
malfunction occurs in 
the system. 
Save the dump if 
requested by 
maintenance 
personnel 
Executable in the 
following module 
state: 
• When only the 
green LED is on and 
the module is in  
redundant 
configuration state 
Only the green LED is 
on when the module is 
in the following state: 
• Duplex 
 

 
Remote: Executable from remote management PC by using NEC ESMPRO Manager 
Local: Executable on local server by using ft server utility 
–: Not support 
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Procedure in NEC ESMPRO Manager 

The [Dump] button of NEC ESMPRO Manager performs the function of "saving dump during 
system operation." 

1. Select [CPU Module] in the [FTServer] tree. 

2. Check the current state with the "State" display on the target component screen. 

3. Click the [Dump] button in the [Maintenance] screen for the target component. 

A certain time is required for the dump saving. 

The dump is stored as %SystemDrive%\NECDump\MEMORY.DMP on the managed 
server. 

The result of the dump saving is reported by the NEC Express5800/ft series as an alert. 

Sample screen of NEC ESMPRO Manager 

 
 [Maintenance] screen of CPU module 

[CPU Module] – [Maintenance] 
 



5-64  Installing and Using Utilities 

Procedure in ft server utility 

1. Select the target CPU module by using the ft server utility. 

2. Check the current state of the target CPU module with the LEDs. 

3. Select the dump acquisition method with [Dump] of the target CPU module and click the 
[Harvest] button. 

A certain time is required for the dump acquisition. 

The dump is stored as %SystemDrive%\NECDump\MEMORY.DMP on the server. 

The result of the dump acquisition can be confirmed in the event log. 

Sample screen of ft server utility 

 
[CPU Module] 
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SCSI Bus Reset 

The SCSI bus can be reset. 

Select [FTServer] tree→[PCI Module]→[SCSI adapter]→[SCSI bus] screens with the ft server 
utility. Open the tree of the component for which the SCSI bus is to be reset and select the [SCSI 
bus] tree. 

The table below shows the potential cases in which the SCSI bus is reset. 

Bus reset Component 
Remote Local 

SCSI Bus – When a malfunction occurs in the SCSI bus to require the 
bus reset.  
Provide the bus reset if requested by maintenance 
personnel. 
 
Executable in the following module state: 
• Only the green LED is on 
 
Only the green LED is on when the module is in the 
following state: 
• Duplex 
 

 
Remote: Executable from remote management PC by using NEC ESMPRO Manager 
Local: Executable on local server by using ft server utility 
–: Not support 
 
Reset the SCSI bus with the ft server utility in the following procedure. NEC ESMPRO Manager 
cannot reset the SCSI bus. However, because the ft server utility cannot check the setup of the SCSI 
bus, check the bus state with NEC ESMPRO Manager in advance. 

1. Select the target SCSI Bus in the [FTServer] tree. 

2. Click the [Reset] button for [Bus Reset] in the SCSI bus screen. 

The modification result can be checked in the event log. 

Sample screen of ft server utility 

 
[PCI Module] – [SCSI Adapter] – [SCSI Bus] 
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Setup of Preventive Disk Maintenance 

In this section, the preventive disk maintenance (S.M.A.R.T.) is configured. 

If the preventive disk maintenance (S.M.A.R.T.) is enabled (by checking Enable on the setting 
screen), the disk fault monitoring function is enabled to detect possible disk faults. Disabling the 
preventive disk maintenance disables the disk fault monitoring function. 

The table below shows the potential cases in which the setup of the preventive disk maintenance is 
modified. 

IMPORTANT: The disk failure prediction (S.M.A.R.T.) feature is not supported in this server. 
Use ft server utility to disable this feature. 

When a disk is replaced, be sure to change the setting described below. 

(Contact your maintenance personnel for changing the setup of the preventive disk maintenance in 
any case other than above.) 

Setup of preventive disk maintenance (S.M.A.R.T.) Component 
Remote Local 

SCSI disk – Executable if the system is operating. 
Use this function at disk replacement 
Change the setting to "Disable" before removing 
disk. 
Insert a new disk and, after termination of disk 
replacement, change the setting to "Enable." 

Remote: Executable from remote management PC by using NEC ESMPRO Manager 
Local: Executable on local server by using ft server utility 
–: Not support 
 
Change the setup of the preventive disk maintenance with the ft server utility in the following 
procedure. NEC ESMPRO Manager cannot set the preventive disk maintenance. 

1. Select [Disk Failure Prediction] in the [FTServer] tree. 

2. Check the check box of [Enable disk failure prediction [SMART]] (or cancel the check). 

3. Click the [Apply] button. 

Sample screen of ft server utility 

 
[Preventive Disk Maintenance] 
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Setup of System Operation 

The following properties can be set as the operation setup of the whole system. 

� Quick dump 

If this property is enabled (by checking "Enable" on the setup screen), the dump is 
acquired in parallel with the system startup if a fault occurs in the system. If this property 
is disabled, the dump is acquired by the dump function normally provided by OS. 

The initial setup value is "Enable." 

� Auto firmware update 

If a new CPU module containing BIOS different from that of the existing CPU module in 
version with this property being enabled (by checking "Enable" on the setup screen), the 
BIOS of the new CPU module is updated to the BIOS of the existing CPU module to 
match with each other. If this property is disabled, the BIOS of the new CPU module is 
not updated automatically. 

The initial setup value is "Enable." 

� Auto module start 

If this property is enabled (by checking "Enable" on the setup screen), the CPU or PCI 
module newly inserted is automatically started to be operable. If this property is disabled, 
the module is not started automatically. 

The initial setup value is "Enable." 

IMPORTANT: In the NEC Express5800/ft series with ft control software 3.0 or later, 
this property must be "Enable." Never specify "Disable." 

The system operation can be set on [FTServer] tree→[General] screen of the ft server utility. 

The table below shows the potential cases in which the system operation setup is changed. Contact 
your maintenance personnel for the change of the system operation setup. Setting change will take 
effect after system reboot. However, the utility does not indicate that reboot is required.  

Quick dump Auto firmware update Auto module start Component 
Remote Local Remote Local Remote Local 

Whole 
system 

– Executable if 
the system is 
operating. 

When dump is 
acquired by 
using the dump 
function 
normally 
installed in OS 
at occurrence of 
system fault. 

– Executable if the 
system is 
operating. 

When firmware is 
updated manually 
at insertion of 
new CPU module

– Executable if the 
system is 
operating. 

When firmware is 
updated manually 
at insertion of new 
CPU/PCI module 

 
Remote: Executable from remote management PC by using NEC ESMPRO Manager 
Local: Executable on local server by using ft server utility 
–: Not support 
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Configure the system settings using the ft server utility in the following procedure. The system 
cannot be configured using the NEC ESMPRO Manager. 

1. Select [General] in the [FTServer] tree. 

2. Check the property of carrying out the modification with [System Settings] (or cancel the 
check). 

3. Click the [Apply] button. 

Sample screen of ft server utility 
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BMC Firmware Update 

The firmware of the BMC on the PCI module can be updated. 

The base management controller (BMC) is the processor exclusively used for monitoring the 
system’s operating environment faults and controlling of the system. 

The BMC firmware can be updated by using the BMC firmware update utility. 

Both NEC ESMPRO Manager and the ft server utility can start the BMC firmware update utility. 

To update the BMC firmware, the firmware image file must be updated on the managed server in 
advance. On the BMC firmware update screen, specify the path of the image file of the firmware to 
be updated. 

The table below shows the potential cases in which the BMC firmware is to be updated. 

IMPORTANT: Contact your maintenance personnel for the update of the BMC firmware. 

BMC firmware update Component 
Remote Local 

BMC When an update to new firmware is 
required. 
Executable in the following module 
state (this can be viewed on 
manager screen): 
• Duplex 
 

When an update to new firmware is 
required. 
Executable in the following module state 
• Only the green LEDs on all PCI modules 

are on 
 
Executable in the following state when only 
the green LEDs on all PCI modules are on:  
• Duplex 

 
Remote: Executable from remote management PC by using NEC ESMPRO Manager 
Local: Executable on local server by using ft server utility 
–: Not support 
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Procedure of Update from NEC ESMPRO Manager Menu 

Update firmware in the procedure as follows: 

1. Select [Tools]→[BMC FW Update Utility] from the Operation Window’s menu. 

The [BMC FW Update] dialog box appears. 

 
2. Enter the device name and click [OK]. 

The [Execution Check] dialog box appears. 

 
3. Store the firmware in the directory specified by [Location]. 

The storage area may be modified. See "Change of Update 
Data Storage Destination " described later. 

 
4. Click [OK]. 

Run firmware update. 

The advance of the update appears during 
update. 

At the termination of update, the update 
result is displayed. 

 
5. Click [OK]. 
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Procedure of Update from ft server utility 

Update the firmware in the procedure as follows: 

1. Click the [Firmware] button in the [Firmware] tree. 

The [BMC FW Update] dialog box appears. 

 

 

 

 

 

 

2. Enter the device name and click [OK]. 

The [Execution Check] dialog box appears. 

 

 

3. Store the firmware in the directory shown in [Location]. 

The storage area may be changed. See "Change of Update 
Data Storage Destination" described later. 

 

4. Click [OK]. 

Execute the firmware update. 

The progress of the update appears during the 
update. 

The update result appears after the update is 
terminated. 

 

5. Click [OK]. 
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Change of Update Data Storage Destination 

Perform the firmware update by using the ft server utility in the procedure below: 

1. Click the [Property...] button in [BMC Firmware Update Service]. 

The [BMC FW Update Service Properties] dialog box appears. 

 
2. Enter the storage destination in [Storage directory for update data:] and click [Register]. 
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Refresh of View based on State Change Alert Setting 

A new function is supported so that NEC ESMPRO Manager window will be updated on a system 
state change basis (in other words, whenever necessary). This function is OFF by default. See the 
[Setting] below about how to turn it ON. 

NEC ESMPRO Manager window is updated by one minute-interval polling by default. Therefore, 
there is some time-lag for NEC ESMPRO Manager to recognize changes in NEC Agent. By using 
this function, the time-lag can be reduced. However, it may consume a little bit more network band 
width since each state change will be notified to NEC ESMPRO Manager as some kind of alert. 

[Setting] 

1. Select [All Programs] → [Esmpro] from the start menu and click [Manager Settings]. 

 
[Manager Settings] dialog box 

2. Check [Enable the State Change Alert Setting]. 

3. Click the [Agent Setting...] button. 

 
[State Change Alert Setting] dialog box 

4. Check the name of servers sending the state change alert to the Manager when the Agent 
recognizes changes in the state. 

Click the [Execute] button for the setting change to take effect. 
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Change of Device State Color on DataViewer 

From Manager Ver3.88 and Agent Ver3.8a, some change has been made to the color of device state 
in order to improve intuitive recognition at an abnormality or a system trouble occurrence. 

Device State Old color New color 
CPU Module Empty Gray Yellow 
CPU Module Removed Gray Yellow 
CPU Module Simplex Yellow Green 
PCI Module Empty Gray Yellow 
PCI Module Removed Gray Yellow 
PCI Module Simplex Yellow Green 
SCSI Slot Empty (in case of mirroring) Gray Yellow 

 
As shown above, the device state color of troubled components (components that is “Empty” or 
“Removed”) affecting the FT system’s redundancy has been changed to yellow (Warning) in order 
to make it easier to determine problems. However, for the device state color of modules operating 
without hardware trouble, the color indicating the simplex state has been changed from yellow 
(Warning) to green (Normal).  

(Example of old window) 

 
 
(Example of new window) 
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NEC MWA ∼ MANAGEMENT WORKSTATION APPLICATION ∼ 

NEC MWA is an application that enables the remote management of the server through a 
management PC over the network. (A management PC is a computer running NEC ESMPRO 
Manager.)   

Refer to “MWA First Step Guide” in the following directory of NEC EXPRESSBUILDER 
CD-ROM for details of its functions and operation. 

 CD-ROM drive: \mwa\doc\mwa_fsg.pdf 

TIPS: How to install NEC MWA is described in online documents. See “MWA Installation 
Guide” for details. 

 

Servers to be remotely managed by NEC MWA 

The server with RomPilot or BMC can be managed by NEC MWA. 

This product has both RomPilot and BMC (IPMI1.0).  

PRECAUTIONS: 
“MWA First Step Guide” is common to all the managed servers. The following denotes notes and 
restrictions for this product.   

� The Console Redirection feature with WAN or direct connection cannot be used when the server 
is operated remotely from the other management PC by using the RomPilot feature via LAN. To 
use Console Redirection with WAN or direct connection, set “RomPilot Support” in 
“Advanced” menu of BIOS setup utility to “Disabled”. See Chapter 4 “SYSTEM BIOS 
~SETUP~” for details. 

� ESCD information is not collected by NEC MWA. If you attempt to collect it from NEC MWA, 
“ESCD data read error server report: Plug and Play call error” is generated. 

� NO NEC MWA Agent is available on this product. Use the “BMC configuration tool” to 
configure this product on Windows. 

 
Remote Management Configuration for the Server without Console 

If the main unit does not have a console such as keyboard, you can operate tools on the server 
remotely using NEC MWA’s remote console functions and NEC EXPRESSBUILDER’s consoleless 
functions. 

 

There are two ways of remote console connection depending on the condition of connection 
between the management PC and the main unit: 

� Connect from the management PC linked to the main unit through LAN. 

� Connect from the management PC directly linked (through Serial port B) to the main unit. 
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Connect from the Management PC Linked through LAN 

On the management PC that is linked through LAN, perform the steps below: 

1. Start the management PC where NEC MWA is installed. From the Start menu, select 
[Program] → [NEC MWA] → [MWA]. 

When NEC MWA starts, the initial screen “Remote Control Manager” will appear. 

 
2. Insert a formatted 1.44MB floppy disk into the drive. 

3. From NEC MWA’s [File] menu, select [Configuration] command to open [Configuration] 
dialog box. 

4. Select [New] to display the [Select a model] dialog box. 

5. Check [Write to FD] and select an applicable model to open [Configuration for ft Server] 
dialog box. 

Ex) The model name is printed on the front cover like “NEC Express5800/320Lc,” or 
“NEC Express5800/320Lc-R.” 

6. On the [Configuration for ft Server] dialog box, specify/register configuration information 
including the names of computers to be managed, and then write the information to FD as 
the following filename: 

<Filename> 

CSL_LESS.CFG 

The setting items of the server are as follows:  

Computer Name (The managed server name. Arbitrary) 

IP address 

Subnet mask 

Default gateway 

Primary contact (Management PC’s IP address) 

7. Right-click the server name to open the pop-up menu, from which select [Property] 
command to open [Property] dialog box. 

8. When the [Property] dialog box appears, specify the items as follows: 

<[ID] page> 

Connection mode: LAN 

<[Alert notification] page> 

Uncheck [Use Default Settings] and check [Reset] of [Activate]. 
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9. Right-click the server name to 
open the pop-up menu and 
select [Open Remote Console] 
to open [MWA Remote 
Console]. 

 

 

 

 

 

  
10. Select the [Action at Remote Console Connect] command from the popup menu displayed 

by right-clicking the server window to display the [Action at Remote Console Connect] 
dialog box. Then select [Go MWA mode]. 

 

11. Insert NEC EXPRESSBUILDER CD-ROM into the drive of the computer to be managed 
and insert floppy disk storing the configuration information (CSL_LESS.CFG) into the 
FDD drive. 

12. Hook up the management PC to LAN. 

13. Power off and on the main unit to reboot the system. 

After one reboot, the main menu will appear on the management PC’s screen, on which you 
can perform hardware setup and run utilities. 

TIPS: If the configuration information (CSL_LESS.CFG) in the FD has already been 
loaded, the main menu will appear without a reboot. 

14. When the main menu appears on the management PC’s screen, eject the floppy disk. 

15. If you use other tools, exit NEC EXPRESSBUILDER and power off/on the main unit. 

IMPORTANT: After completing the procedure for remote console connection, uncheck 
[Reset] of [Activate] in [Property] dialog box. 

 



5-78  Installing and Using Utilities 

Connect from the Management PC Directly Linked (through Serial port B) 

On the management PC that is linked directly to Serial port B of the main unit, perform the steps 
below: 
 

1. Start the management PC where NEC MWA is installed. From the Start menu, select 
[Program] → [NEC MWA] → [MWA]. 

When NEC MWA starts, the initial screen “Remote Control Manager” will appear. 

2. Select [Environment] – [Direct Connection Setting] from the [File] menu of NEC MWA 
to display the [Direct Connection] dialog box. Configure the following settings: 

<Direct Connection> 
Port No.: COM port on the management PC to be connected 
Baud Rate: 19200 
Flow Control: None 

3. From MWA’s [File] menu, select [Configuration] command to open [Configuration] 
dialog box. 

4. Select [New] to display [Select a model] dialog box. 

5. Check [Write to FD] and select an applicable model to open [Configuration for ft Server] 
dialog box. 

Ex) The model name is printed on the front cover like “NEC Express5800/320Lc,” or 
“NEC Express5800/320Lc-R.” 

6. On the [Configuration for ft Server] dialog box, specify/register configuration information 
including the names of computers to be managed, and then write the information to FD as 
the following filename: 

<Filename> 
CSL_LESS.CFG 

7. Right-click the server name to open the pop-up menu and select [Property] command to 
open [Property] dialog box. 

8. When the [Property] dialog box appears, specify the items as follows: 

<[ID] page> 
Connection mode: COM 
COM:  Direct (cross cable) 

9. Right-click the server name to open the pop-up menu and select [Open Remote Console] 
to open [MWA Remote Console]. 

After checking to see if the server window is open on [MWA Remote Console], click the 
[Connect] button. 

10. Hook up the management PC directly to Serial port B of the computer to be managed. 

11. Insert NEC EXPRESSBUILDER CD-ROM into the drive of the managed computer and 
insert the floppy disk storing the configuration information (CSL_LESS.CFG) into the 
FDD drive. 
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12. Power off and on the main unit to reboot the system. 

After one reboot, the main menu will appear on the management PC’s screen, on which you 
can perform hardware setup and run utilities. 

TIPS: If the configuration information (CSL_LESS.CFG) in the FD has already been 
loaded, the main menu will appear without a reboot. 

 
IMPORTANT: For setting up MWA using Console Redirection (via WAN or direct), 
specify “Onboard COM B” to [SerialPort Address] from BIOS setup utility’s [System 
Hardware]→[Console Redirection] menu. For details, see “SYSTEM BIOS ~SETUP~” 
in Chapter 4.   

 

13. If you use other tools, exit NEC EXPRESSBUILDER and power off/on the main unit. 

IMPORTANT: After completing the procedure for remote console connection, click 
[Disconnect] on the [MWA Remote Console] window. 
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Chapter 6 

Maintenance 

This chapter describes the daily maintenance of NEC Express5800/ft series and precautions when 
relocating or storing the server. 
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DAILY MAINTENANCE 
To use your NEC Express5800/ft series in best condition, check and maintain regularly as described 
below. If an error is found on your NEC Express5800/ft series, consult your sales agent. 

 

Checking Alert 

Monitor the failure occurrence by NEC ESMPRO during the system operation. 

Always check whether any alert is reported to NEC ESMPRO Manager on the management PC. 
Check whether any alert is reported on the Operation Window, Data Viewer, or Alert Viewer of 
NEC ESMPRO Manager. 

Viewers of NEC ESMPRO 

 

 
Operation Window  Alert Viewer 

 

 

 

 Data Viewer  
 

 

 

Checking STATUS LEDs and LCD Display 

Check the LED indication on the front of the NEC Express5800/ft series, on hard disks installed in 
3.5-inch hard disk drive bay or on LCD display when the server is powered on or powered off by 
the shut down operation. The functions and indications of LEDs are described in Chapter 2. If any 
indication that shows an error, contact your sales agent. 
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Making Backup Copies 

NEC recommends you make backup copies of your valuable data stored in hard disks of the server 
on a regular basis. For backup storage devices suitable for the server and backup tools, consult with 
your sales agent. 

When you have changed the hardware configuration or BIOS configuration, select "System 
Information Management" and then "Save" of the Off-line Maintenance Utility to make a backup 
copy of the system information. 

 

Cleaning 

Clean the server on a regular basis to keep the server in a good shape. 

WARNING  
  

 
Observe the following instructions to use the server safely. There are risks of 
death or serious personal injury. See PRECAUTIONS FOR SAFETY in 
Chapter 1. 
 

 

 • Do not disassemble, repair, or alter the server. 
• Do not look into the CD-ROM drive. 
• Disconnect the power plug before cleaning the server. 

  
 
Cleaning the NEC Express5800/ft series 

For daily cleaning, wipe the external surfaces of the server with a dry soft cloth. Follow the 
procedure below if stains remain on the surfaces: 

IMPORTANT:  
� To avoid altering the material and color of the server, do not use volatile solvents such as thinner 

or benzene to clean the server. 

� The power receptacle, the cables, the connectors on the rear panel of server, and the inside of 
the server must be kept dry. Do not moisten them with water. 

1. Make sure that the server is powered off. 

2. Unplug the power cord of the server from a power outlet. 

3. Wipe off dust from the power cord plug with a dry cloth. 

4. Soak a soft cloth in neutral detergent that is diluted with cold or warm water, and squeeze 
it firmly. 

5. Rub off stains on the server with the cloth prepared in Step 4. 

6. Soak a soft cloth in water, squeeze it firmly and wipe the server with it once again. 
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7. Wipe the server with a dry cloth. 

8. Wipe off dust from the fan exhaust opening on the rear of the server with a dry cloth. 

 

Cleaning the Keyboard and Mouse 

IMPORTANT: A keyboard and a mouse use USB interface. Therefore it is not necessary to 
power off the server when connecting or disconnecting them. 

Disconnect the keyboard from the server while the devices in the system (the server and the 
peripheral devices) remain turned on. Wipe the keyboard surface with a dry cloth. Then connect the 
keyboard to the server. 

The mouse operation depends on the degree of smoothness of the internal ball rotation. To keep the 
mouse ball clean, use the mouse in a place with little dust. Follow the steps below to clean the 
mouse regularly: 

1. Disconnect the mouse from the USB hub of the keyboard while the server remains 
powered on. 

2. Turn the mouse upside down, and rotate the mouse ball 
cover counterclockwise to remove it. Take out the ball 
from the mouse. 

Bottom

3. Wipe the mouse ball with a dry soft cloth. 

If stains remain, use a soft cloth to wipe them off. 
Soak the soft cloth in neutral detergent that is 
diluted with water or warm water, and squeeze it 
firmly. 

ball 

4. Wipe three small rollers inside the mouse with 
cotton swab. 

Use the cotton swab soaked with alcohol if stains 
remain. 

5. Put the mouse ball back into the mouse. 

If the mouse or rollers are wet in steps 3 and 4, put 
it back after fully dried. 

6. Place the mouse ball cover, and rotate it clockwise 
until it is locked.  Ro

7. Connect the mouse to the server (the USB hub of the 
keyboard). 

 

 

Mouse 
Mouse 
Mouse cover 

llers 
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Cleaning the Floppy Disk Drive 

A read/write error may occur due to stains on the read/write head of the floppy disk drive. 

Use the cleaner dedicated for floppy disk drive to clean the read/write head. It is recommended to 
clean the head on regular basis. 

 

Cleaning CD-ROM 

A dusty CD-ROM or dust-accumulated tray causes the device to fail to read data correctly. 

Follow the procedure below to clean the tray and CD-ROM regularly: 

1. Make sure that the server is powered on. 

2. Press the Eject button on the front of the CD-ROM drive. 
The tray comes out. 

3. Hold the CD-ROM lightly and take it out from the tray. 

IMPORTANT: Do not touch the signal side of the CD-ROM with your hand. 

4. Wipe the tray with a dry soft cloth. 

IMPORTANT: Do not wipe the lens of the CD-ROM drive. Doing so may damage the 
lens and may cause a malfunction of the drive. 

5. Gently push on the tray front to close the tray. 

6. Wipe the signal side of the CD-ROM with a dry soft cloth. 

IMPORTANT: Wipe CD-ROMs from the center to the outside. Use only CD-ROM 
cleaner if necessary. Cleaning a CD-ROM with record spray/cleaner, benzene, or thinner 
causes damage to the CD-ROM contents. At worst, inserting the CD-ROM into the server 
may cause failure. 

 



6-6  Maintenance 

Cleaning Tape Drive 

Dirt on the tape head may be a cause of unsuccessful backup and damage to tape cartridge. Clean 
the tape head regularly using a cleaning tape. For procedure and interval of cleaning as well as 
lifetime of a tape cartridge to use, see instructions included with the tape drive. 
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SYSTEM DIAGNOSTICS 
The System Diagnostics runs several tests on the server. 

Select [Tools] → [System Diagnostics] in the NEC EXPRESSBUILDER to diagnose the server. 

 

Test Items 

The following items are tested in system diagnostics. 

� Memory 

� CPU cache memory 

� Hard disk used as a system 

IMPORTANT: When executing the system diagnostics, make sure to remove the LAN cable. 
Executing the system diagnostics with the LAN cable connected, the network may be influenced. 
 

TIPS: On checking the hard disk, no data is written into the disk. 

 

Startup and Exit of System Diagnosis 

Procedures to start the diagnostic program are as follows: 

1. Shutdown the OS, and power off the server. Then, unplug the power cord. 

2. Disconnect all the LAN cables from the server. 

3. Plug the power cord and power on the server. 

4. Use the NEC EXPRESSBUILDER CD-ROM to reboot the server. 

The following menu appears when the server is started using the NEC 
EXPRESSBUILDER.   

5. Select [Tools]. 
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6. Select [System Diagnostics]. 

CURSOR: Select Window   ENTER: View Window    P: Log Out    Q: Quit

Target scope

Test window

System bar Title bar

The system diagnosis starts and will be 
completed in approximately three 
minutes. 
 
When the diagnosis is completed, the 
following appears on the screen of the 
display unit. 

 
 

System bar: Shows information including time of progress during the diagnostics. Upon 
completion of the diagnostics, descriptions on key operations to navigate 
the window are shown. 

Title bar: Shows items for diagnosis. If an error is detected, the bar is indicated in 
red. 

Test window: Shows the progress or result of diagnostics. 

Target scope: A cursor to select the test window. Use the cursor keys on the keyboard to 
move it to another test window. (Move the target scope to a desired 
window and press Enter. Now you can view detailed information on the 
selected window. To return to the previous window, press Enter once 
again.) Some system configurations do not display the target scope but 
change the color of test window’s frame. 

If an error is detected during the system diagnostics, the title bar turns in red, and error 
information is displayed in red characters. Note down the error message and contact your 
sales agent. 

7. Press Q and select [Reboot] from the menu. 

The server restarts and the system is started from the NEC EXPRESSBUILDER. 

8. Exit the NEC EXPRESSBUILDER, and remove the CD-ROM from the CD-ROM drive. 

9. Power off the server and unplug the power cord from the receptacle. 

10. Reconnect all the LAN cables to the server. 

11. Plug the power cord. 

This completes the system diagnostics. 
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OFF-LINE MAINTENANCE UTILITY 
The Off-line Maintenance Utility is an OS-independent maintenance program. When you are unable 
to start the OS-dependent NEC ESMPRO to troubleshoot a problem, the Off-line Maintenance 
Utility can be used. 

IMPORTANT:  
� The Off-line Maintenance Utility is intended for use of your sales agent. The NEC 

EXPRESSBUILDER CD-ROM and the Off-line Maintenance Utility Bootable FD you have 
created contain a file that describes operation of the utility, but do not attempt to use the utility 
by yourself. Contact your sales agent and follow instructions. 

� Starting the Off-line Maintenance Utility disables any access from a client to the server. 

Starting the Off-line Maintenance Utility 

The Off-line Maintenance Utility may be started in the following ways. 

NEC Express5800/ft series does not support the feature to start the Off-line Maintenance Utility 
from the maintenance partition. 

� From the CD-ROM 

Set the NEC EXPRESSBUILDER CD-ROM in the CD-ROM drive and reboot the system. 
After the menu is displayed on the screen, select [Tools] → [Off-line Maintenance Utility]. 
The Off-line Maintenance Utility program starts from the CD-ROM. 

� From the floppy disk 

Set the Off-line Maintenance Utility Bootable FD in the floppy disk drive and reboot the 
system. The Off-line Maintenance Utility program starts from the boot disk. The Off-line 
Maintenance Utility Bootable FD is created by selecting [Tools] → [Create Support FD] 
on the NEC EXPRESSBUILDER. 

 

Features of Off-line Maintenance Utility 

The Off-line Maintenance Utility provides the following features.  

� IPMI Information Viewer 

Provides the functions to view the system event log (SEL), sensor data record (SDR), and 
field replaceable unit (FRU) in IPMI (Intelligent Platform Management Interface) and to 
make a backup copy of them. 

Using this feature, you can find system errors and events to determine a maintenance part. 

� BIOS Setup Viewer 

Provides the functions to export the current configuration data defined with the SETUP utility 
to a text file. 
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� System Information Viewer 

Provides the functions to view information on the processor (CPU) and the BIOS and export it 
to a text file. 

� System Information Management 

Provides the function to make a back-up copy of your data. Without the backup data, the 
system-specific information and/or configuration may not be restored. 

TIPS: For information on making backup copy of system information, see the separate 
volume “User’s Guide (Setup).” Only the authorized personnel are allowed to restore the 
backup data. 
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RELOCATING/STORING THE NEC Express5800/ft series 
Follow the procedure below to relocate or store the server. (Users should not attempt to remove the 
rack-mountable server from the rack assembly.) 

WARNING  
  

Do not attempt to remove the server. 
 

 

 

To avoid the risk of personal injury, users should not attempt to remove the 
server from the rack assembly. Removal of the server from the rack assembly 
should be performed by suitably trained maintenance personnel. 

  
 

CAUTION  
  

Observe the following instructions to use the server safely. There are risks of a 
fire, personal injury, or property damage. See PRECAUTIONS FOR SAFETY in 
Chapter 1 for details. 
  
• Never attempt to lift the server only by yourself. 
• Do not install the server in any place other than specified. 
• Do not connect/disconnect any interface cable with the power cord of the 

server plugged to a power source. 
  

 

IMPORTANT:
� If the server needs to be relocated/stored due to a change in the floor layout to a great extent, 

contact the sales agent. 
� Make sure to make a backup copy of your valuable data in the hard disk, if any. 
� When moving the server with hard disks, make sure not to give a shock to the hard disks. 
� When storing the server, keep it under storing environment conditions (temperature: -10 to 

55°C, humidity: 20 to 80%, non-condensing). 

1. Detach the front bezel (or open it in the case of a tower model). 

2. Take a floppy disk and a CD-ROM out of the server, if any. 

3. Power off the server. 

4. Unplug the power cord of the server from a power outlet. 

5. Remove all the cables from the server. 

6. Remove all the mounted modules. 

7. If the server is a rack-mount model, remove the backplane and the rails from the rack 
cabinet. 
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8. Carry the backplane, rails and modules separately. 

IMPORTANT: If the server is a tower model, do not hold the front bezel to lift it. The 
front bezel may get detached and fall off from the server, causing damage to the server. 

9. Protect the server with the shock-absorbing materials, and pack it securely. 

IMPORTANT: 
Check and adjust the system clock before operating the server again after relocating or 
storing it.  
If the server and the built-in optional devices are moved from a cold place to a warm place in 
a short time, condensation will occur and cause malfunctions and breakdown when these are 
used in such state. When you start operating these equipments again after the transportation 
or the storage, make sure to wait for a sufficient period of time to use them in the operating 
environment. 
If the system clock goes out of alignment remarkably as time goes by, though the system 
clock adjustment is performed, contact your sales agent. 

 

 



 

Chapter 7 

Troubleshooting 

If the product does not work properly, see this chapter before deciding that it is a breakdown. 
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TO LOCATE THE ERRORS 
Use NEC ESMPRO to monitor the occurrence of fault during the system operation. 

Especially take note on whether any alert is reported to NEC ESMPRO Manager on the 
management PC. Check whether any alert is reported on the Operation Window, Data Viewer, or 
Alert Viewer of NEC ESMPRO Manager. 

[Example] 
 

NEC ESMPRO Manager

 
Determine type and location of
server/workstation trouble. 
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ERROR MESSAGES 
If the NEC Express5800/ft series enters the abnormal state, the error is posted by various means. 
This section explains the types of error messages. 

 

Error Messages by LED Indication 

The LEDs on the front and rear panels of the NEC Express5800/ft series and near the handles of 
hard disks inform the user of the various server statuses by the colors and the patterns of going on, 
going off, and flashing. If trouble seems to have occurred, check the LED indication. For the LED 
indication and meanings, see Chapter 2. 

 

Error Messages on the Liquid Crystal Display (LCD) 

The LCD on the front panel of the NEC Express5800/ft series displays the NEC Express5800/ft 
series status all the time. If an error occurs, the LCD displays the error message. 

The following tables show the messages that are to be displayed on the LCD, and explain the 
meanings and procedures: 

IMPORTANT: Although NEC Express5800/320Lc(-R) does not have an LCD on its front, you 
can check error messages from NEC MWA or NEC ESMPRO Manager as follows: 

� NEC MWA: On a desired server, select [Start BMC dialog] from the Server menu. BMC dialog 
box will show the LCD status as well as server power status and LED status. 

� NEC ESMPRO Manager: On Operation Window, select a desired server and start Data Viewer. 
You can check the messages on Data Viewer. 
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STATUS LEDIndication 
Color State

Suspected 
module Explanation Procedure 

= A =      
AmbientTempAlm
00 

Amber Blink CPU module Temperature alarm (lower 
limit) 

AmbientTempAlm
02 

Amber Lit CPU module Fatal temperature alarm 
(lower limit) 

AmbientTempAlm
07 

Amber Blink CPU module Temperature alarm (upper 
limit) 

AmbientTempAlm
09 

Amber Lit CPU module Fatal temperature alarm 
(upper limit) 

Contact your sales agent. 

= B =      
BMC Unsync - - PCI module #1 The BMC cannot be 

synchronized. 
Contact your sales agent. 

BMC0 Not Ready Green Blink PCI module #1 
BMC1 Not Ready Green Blink PCI module #2 

PCI module’s BMC is 
disconnected 

If disconnection continues 
for a while, contact your 
sales agent. 

= C =      
Cor0 +12vAlm 00 Amber Blink PCI module #1 12-V power voltage alarm 

(lower limit) 
Cor0 +12vAlm 02 Amber Lit PCI module #1 Fatal 12-V power voltage 

alarm (lower limit) 
Cor0 +12vAlm 07 Amber Blink PCI module #1 12-V power voltage alarm 

(upper limit) 
Cor0 +12vAlm 09 Amber Lit PCI module #1 Fatal 12-V power voltage 

alarm (upper limit) 
Cor0 +2.5vAlm 
00 

Amber Blink PCI module #1 2.5-V power voltage alarm 
(lower limit) 

Cor0 +2.5vAlm 
02 

Amber Lit PCI module #1 Fatal 2.5-V power voltage 
alarm (lower limit) 

Cor0 +2.5vAlm 
07 

Amber Blink PCI module #1 2.5-V power voltage alarm 
(upper limit) 

Cor0 +2.5vAlm 
09 

Amber Lit PCI module #1 Fatal 2.5-V power voltage 
alarm (upper limit) 

Cor0 +3.3vAlm 
00 

Amber Blink PCI module #1 3.3-V power voltage alarm 
(lower limit) 

Cor0 +3.3vAlm 
02 

Amber Lit PCI module #1 Fatal 3.3-V power voltage 
alarm (lower limit) 

Cor0 +3.3vAlm 
07 

Amber Blink PCI module #1 3.3-V power voltage alarm 
(upper limit) 

Cor0 +3.3vAlm 
09 

Amber Lit PCI module #1 Fatal 3.3-V power voltage 
alarm (upper limit) 

Cor0 +3.3vsAlm 
00 

Amber Blink PCI module #1 3.3-V power voltage alarm 
(lower limit) 

Cor0 +3.3vsAlm 
02 

Amber Lit PCI module #1 Fatal 3.3-V power voltage 
alarm (lower limit) 

Cor0 +3.3vsAlm 
07 

Amber Blink PCI module #1 3.3-V power voltage alarm 
(upper limit) 

Cor0 +3.3vsAlm 
09 

Amber Lit PCI module #1 Fatal 3.3-V power voltage 
alarm (upper limit) 

Cor0 +5.0vAlm 
00 

Amber Blink PCI module #1 5-V power voltage alarm 
(lower limit) 

Cor0 +5.0vAlm 
02 

Amber Lit PCI module #1 Fatal 5-V power voltage alarm 
(lower limit) 

Cor0 +5.0vAlm 
07 

Amber Blink PCI module #1 5-V power voltage alarm 
(upper limit) 

Contact your sales agent. 
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STATUS LED Indication 
Color State 

Suspected 
module Explanation Procedure 

Cor0 +5.0vAlm 
09 

Amber Lit PCI module #1 Fatal 5-V power voltage alarm 
(upper limit) 

Cor0 +5.0vsAlm 
00 

Amber Blink PCI module #1 5-V power voltage alarm 
(lower limit) 

Cor0 +5.0vsAlm 
02 

Amber Lit  PCI module #1 Fatal 5-V power voltage alarm 
(lower limit) 

Cor0 +5.0vsAlm 
07 

Amber Blink PCI module #1 5-V power voltage alarm 
(upper limit) 

Cor0 +5.0vsAlm 
09 

Amber Lit PCI module #1 Fatal 5-V power voltage alarm 
(upper limit) 

Cor0 -12vAlm 00 Amber Blink PCI module #1 -12-V power voltage alarm 
(lower limit) 

Cor0 -12vAlm 02 Amber Lit PCI module #1 Fatal -12-V power voltage 
alarm (lower limit) 

Cor0 -12vAlm 07 Amber Blink PCI module #1 -12-V power voltage alarm 
(upper limit) 

Cor0 -12vAlm 09 Amber Lit PCI module #1 Fatal -12-V power voltage 
alarm (upper limit) 

Cor0 Bus PERR 
01 

Green Blink PCI module #1 PCI bus parity error 

Cor0 Bus SERR 
01 

Green Blink PCI module #1 Fatal PCI bus error 

Cor0 CLK Alm 00 Amber Blink CLOCK board Clock alarm (lower limit) 
Cor0 CLK Alm 02 Amber Lit CLOCK board Fatal Clock alarm (lower 

limit) 
Cor0 CLK Alm 07 Amber Blink CLOCK board Clock alarm (upper limit) 
Cor0 CLK Alm 09 Amber Lit CLOCK board Fatal Clock alarm (upper 

limit) 

Contact your sales agent. 
 

Cor0 FAN Alm 01 Amber Blink PCI module #1 Cooling fan1 alarm 
Cor0 FAN Alm 02 Amber Blink PCI module #1 Cooling fan2 alarm 
Cor0 FAN Alm 03 Amber Blink PCI module #1 Cooling fan3 alarm 
Cor0 FAN Alm 04 Amber Blink PCI module #1 Cooling fan4 alarm 
Cor0 FAN Alm 05 Amber Blink PCI module #1 Cooling fan5 alarm 

Check to see if dust is 
accumulated on the 
internal fans. Check also if 
the fan cables are 
connected securely. If not 
solved by the above, 
contact your sales agent.  

Cor0 offline Green Blink PCI module #1 PCI module logically isolated Start the PCI module by ft 
sever utility or dismount 
and remount that module. 
If not solved by the above, 
contact your sales agent. 

Cor0 removed Green Blink PCI module #1 PCI module detached Dismount and remount the 
PCI module. If not solved 
by the above, contact your 
sales agent. 

Cor0 Temp Alm 
00 

Amber Blink PCI module #1 Temperature alarm (lower 
limit) 

Cor0 Temp Alm 
02 

Amber Lit PCI module #1 Fatal temperature alarm 
(lower limit) 

Cor0 Temp Alm 
07 

Amber Blink PCI module #1 Temperature alarm (upper 
limit) 

Cor0 Temp Alm 
09 

Amber Lit PCI module #1 Fatal temperature alarm 
(upper limit) 

Check to see if dust is 
accumulated on the 
internal fans. Check also if 
the fan cables are 
connected securely. If not 
solved by the above, 
contact your sales agent. 
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STATUS LEDIndication 
Color State

Suspected 
module Explanation Procedure 

Cor1 +12vAlm 00 Amber Blink PCI module #2 12-V power voltage alarm 
(lower limit) 

Cor1 +12vAlm 02 Amber Lit PCI module #2 Fatal 12-V power voltage 
alarm (lower limit) 

Cor1 +12vAlm 07 Amber Blink PCI module #2 12-V power voltage alarm 
(upper limit) 

Cor1 +12vAlm 09 Amber Lit PCI module #2 Fatal 12-V power voltage 
alarm (upper limit) 

Cor1 +2.5vAlm 
00 

Amber Blink PCI module #2 2.5-V power voltage alarm 
(lower limit) 

Cor1 +2.5vAlm 
02 

Amber Lit PCI module #2 Fatal 2.5-V power voltage 
alarm (lower limit) 

Cor1 +2.5vAlm 
07 

Amber Blink PCI module #2 2.5-V power voltage alarm 
(upper limit) 

Cor1 +2.5vAlm 
09 

Amber Lit PCI module #2 Fatal 2.5-V power voltage 
alarm (upper limit) 

Cor1 +3.3vAlm 
00 

Amber Blink PCI module #2 3.3-V power voltage alarm 
(lower limit) 

Cor1 +3.3vAlm 
02 

Amber Lit PCI module #2 Fatal 3.3-V power voltage 
alarm (lower limit) 

Cor1 +3.3vAlm 
07 

Amber Blink PCI module #2 3.3-V power voltage alarm 
(upper limit) 

Cor1 +3.3vAlm 
09 

Amber Lit PCI module #2 Fatal 3.3-V power voltage 
alarm (upper limit) 

Cor1 +3.3vsAlm 
00 

Amber Blink PCI module #2 3.3-V power voltage alarm 
(lower limit) 

Cor1 +3.3vsAlm 
02 

Amber Lit PCI module #2 Fatal 3.3-V power voltage 
alarm (lower limit) 

Cor1 +3.3vsAlm 
07 

Amber Blink PCI module #2 3.3-V power voltage alarm 
(upper limit) 

Cor1 +3.3vsAlm 
09 

Amber Lit PCI module #2 Fatal 3.3-V power voltage 
alarm (upper limit) 

Cor1 +5.0vAlm 
00 

Amber Blink PCI module #2 5-V power voltage alarm 
(lower limit) 

Cor1 +5.0vAlm 
02 

Amber Lit PCI module #2 Fatal 5-V power voltage alarm 
(lower limit) 

Cor1 +5.0vAlm 
07 

Amber Blink PCI module #2 5-V power voltage alarm 
(upper limit) 

Cor1 +5.0vAlm 
09 

Amber Lit PCI module #2 Fatal 5-V power voltage alarm 
(upper limit) 

Cor1 +5.0vsAlm 
00 

Amber Blink PCI module #2 5-V power voltage alarm 
(lower limit) 

Cor1 +5.0vsAlm 
02 

Amber
 

Lit PCI module #2 
 

Fatal 5-V power voltage alarm 
(lower limit) 

Cor1 +5.0vsAlm 
07 

Amber Blink PCI module #2 5-V power voltage alarm 
(upper limit) 

Cor1 +5.0vsAlm 
09 

Amber Lit PCI module #2 Fatal 5-V power voltage alarm 
(upper limit) 

Cor1 -12vAlm 00 Amber Blink PCI module #2 -12-V power voltage alarm 
(lower limit) 

Cor1 -12vAlm 02 Amber Lit PCI module #2 Fatal -12-V power voltage 
alarm (lower limit) 

Contact your sales agent. 
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STATUS LED Indication 
Color State 

Suspected 
module Explanation Procedure 

Cor1 -12vAlm 07 Amber Blink PCI module #2 -12-V power voltage alarm 
(upper limit) 

Cor1 -12vAlm 09 Amber Lit PCI module #2 Fatal -12-V power voltage 
alarm (upper limit) 

Cor1 Bus PERR 
01 

Green Blink PCI module #2 PCI bus parity error 

Cor1 Bus SERR 
01 

Green Blink PCI module #2 Fatal PCI bus error 

Cor1 CLK Alm 00 Amber Blink CLOCK board Clock alarm (lower limit) 
Cor1 CLK Alm 02 Amber Lit CLOCK board Fatal Clock alarm (lower 

limit) 
Cor1 CLK Alm 07 Amber Blink CLOCK board Clock alarm (upper limit) 
Cor1 CLK Alm 09 Amber Lit CLOCK board Fatal Clock alarm (upper 

limit) 

Contact your sales agent. 
 

Cor1 FAN Alm 01 Amber Blink PCI module #2 Cooling fan1 alarm 
Cor1 FAN Alm 02 Amber Blink PCI module #2 Cooling fan2 alarm 
Cor1 FAN Alm 03 Amber Blink PCI module #2 Cooling fan3 alarm 
Cor1 FAN Alm 04 Amber Blink PCI module #2 Cooling fan4 alarm 
Cor1 FAN Alm 05 Amber Blink PCI module #2 Cooling fan5 alarm 

Check to see if dust is 
accumulated on the 
internal fans. Check also if 
the fan cables are 
connected securely. If not 
solved by the above, 
contact your sales agent. 

Cor1 offline Green Blink PCI module #2 PCI module logically isolated Start the PCI module by ft 
sever utility or dismount 
and remount that module. 
If not solved by the above, 
contact your sales agent. 

Cor1 removed Green Blink PCI module #2 PCI module detached Dismount and remount the 
PCI module. If not solved 
by the above, contact your 
sales agent. 

Cor1 Temp Alm 
00 

Amber Blink PCI module #2 Temperature alarm (lower 
limit) 

Cor1 Temp Alm 
02 

Amber Lit PCI module #2 Fatal temperature alarm 
(lower limit) 

Cor1 Temp Alm 
07 

Amber Blink PCI module #2 Temperature alarm (upper 
limit) 

Cor1 Temp Alm 
09 

Amber Lit PCI module #2 Fatal temperature alarm 
(upper limit) 

Check to see if dust is 
accumulated on the 
internal fans. Check also if 
the fan cables are 
connected securely. If not 
solved by the above, 
contact your sales agent. 

CPU IERR 00 Green Blink CPU module #1 CPU#1 internal error 
CPU IERR 01 Green Blink CPU module #1 CPU#2 internal error 
CPU IERR 20 Green Blink CPU module #2 CPU#1 internal error 
CPU IERR 21 Green Blink CPU module #2 CPU#2 internal error 
CPU T-Trip 00 Green Blink CPU module #1 CPU#1 thermal change error 

(upper limit) 
CPU T-Trip 01 Green Blink CPU module #1 CPU#2 thermal change error 

(upper limit) 
CPU T-Trip 20 Green Blink CPU module #2 CPU#1 thermal change error 

(upper limit) 
CPU T-Trip 21 Green Blink CPU module #2 CPU#2 thermal change error 

(upper limit) 
CPU0 +12ss Alm 
00 

Amber Blink CPU module #1 +12-V power voltage alarm 
(lower limit) 

CPU0 +12ss Alm 
02 

Amber Lit CPU module #1 Fatal +12-V power voltage 
alarm (lower limit) 

Contact your sales agent. 
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STATUS LEDIndication 
Color State

Suspected 
module Explanation Procedure 

CPU0 +12ss Alm 
07 

Amber Blink CPU module #1 +12-V power voltage alarm 
(upper limit) 

CPU0 +12ss Alm 
09 

Amber Lit CPU module #1 Fatal +12-V power voltage 
alarm (upper limit) 

CPU0 +12v Alm 
00 

Amber Blink CPU module #1 12-V power voltage alarm 
(lower limit) 

CPU0 +12v Alm 
02 

Amber Lit CPU module #1 Fatal 12-V power voltage 
alarm (lower limit) 

CPU0 +12v Alm 
07 

Amber Blink CPU module #1 12-V power voltage alarm 
(upper limit) 

CPU0 +12v Alm 
09 

Amber Lit CPU module #1 Fatal 12-V power voltage 
alarm (upper limit) 

CPU0 +1.5v Alm 
00 

Amber Blink CPU module #1 1.5-V power voltage alarm 
(lower limit) 

CPU0 +1.5v Alm 
02 

Amber Lit CPU module #1 Fatal 1.5-V power voltage 
alarm (lower limit) 

CPU0 +1.5v Alm 
07 

Amber Blink CPU module #1 1.5-V power voltage alarm 
(upper limit) 

CPU0 +1.5v Alm 
09 

Amber Lit CPU module #1 Fatal 1.5-V power voltage 
alarm (upper limit) 

CPU0 +2.5vAlm 
00 

Amber Blink CPU module #1 2.5-V power voltage alarm 
(lower limit) 

CPU0 +2.5vAlm 
02 

Amber Lit CPU module #1 Fatal 2.5-V power voltage 
alarm (lower limit) 

CPU0 +2.5vAlm 
07 

Amber Blink CPU module #1 2.5-V power voltage alarm 
(upper limit) 

CPU0 +2.5vAlm 
09 

Amber Lit CPU module #1 Fatal 2.5-V power voltage 
alarm (upper limit) 

CPU0 +2.5VcAlm 
00 

Amber Blink CPU module #1 2.5-V power voltage alarm 
(lower limit) 

CPU0 +2.5VcAlm 
02 

Amber Lit CPU module #1 Fatal 2.5-V power voltage 
alarm (lower limit) 

CPU0 +2.5VcAlm 
07 

Amber Blink CPU module #1 2.5-V power voltage alarm 
(upper limit) 

CPU0 +2.5VcAlm 
09 

Amber Lit CPU module #1 Fatal 2.5-V power voltage 
alarm (upper limit) 

CPU0 +3.3vAlm 
00 

Amber Blink CPU module #1 3.3-V power voltage alarm 
(lower limit) 

CPU0 +3.3vAlm 
02 

Amber Lit CPU module #1 Fatal 3.3-V power voltage 
alarm (lower limit) 

CPU0 +3.3vAlm 
07 

Amber Blink CPU module #1 3.3-V power voltage alarm 
(upper limit) 

CPU0 +3.3vAlm 
09 

Amber Lit CPU module #1 Fatal 3.3-V power voltage 
alarm (upper limit) 

CPU0 +3.3vsAlm 
00 

Amber Blink CPU module #1 3.3-V power voltage alarm 
(lower limit) 

CPU0 +3.3vsAlm 
02 

Amber Lit CPU module #1 Fatal 3.3-V power voltage 
alarm (lower limit) 

CPU0 +3.3vsAlm 
07 

Amber Blink CPU module #1 3.3-V power voltage alarm 
(upper limit) 

CPU0 +3.3vsAlm 
09 

Amber Lit CPU module #1 Fatal 3.3-V power voltage 
alarm (upper limit) 

CPU0 +5.0vAlm 
00 

Amber Blink CPU module #1 5-V power voltage alarm 
(lower limit) 

CPU0 +5.0vAlm 
02 

Amber Lit CPU module #1 Fatal 5-V power voltage alarm 
(lower limit) 

Contact your sales agent. 
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STATUS LED Indication 
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CPU0 +5.0vAlm 
07 

Amber Blink CPU module #1 5-V power voltage alarm 
(upper limit) 

CPU0 +5.0vAlm 
09 

Amber Lit CPU module #1 Fatal 5-V power voltage alarm 
(upper limit) 

CPU0 +5.0vsAlm 
00 

Amber Blink CPU module #1 5-V power voltage alarm 
(lower limit) 

CPU0 +5.0vsAlm 
02 

Amber Lit CPU module #1 Fatal 5-V power voltage alarm 
(lower limit) 

CPU0 +5.0vsAlm 
07 

Amber Blink CPU module #1 5-V power voltage alarm 
(upper limit) 

CPU0 +5.0vsAlm 
09 

Amber Lit CPU module #1 Fatal 5-V power voltage alarm 
(upper limit) 

CPU0 broken Green Blink CPU module #1 CPU module breakdown 

Contact your sales agent. 

CPU0 FAN Alm 01 Amber Blink CPU module #1 Cooling fan1 alarm 
CPU0 FAN Alm 03 Amber Blink CPU module #1 Cooling fan2 alarm 
CPU0 FAN Alm 04 Amber Blink CPU module #1 Cooling fan3 alarm 

Check to see if dust is 
accumulated on the 
internal fans. Check also if 
the fan cables are 
connected securely. If not 
solved by the above, 
contact your sales agent. 

CPU0 offline Green Blink CPU module #1 PCI module logically isolated Start the PCI module by ft 
sever utility or dismount 
and remount that module. 
If not solved by the above, 
contact your sales agent. 

CPU0 removed Green Blink CPU module #1 PCI module detached Dismount and remount the 
PCI module. If not solved 
by the above, contact your 
sales agent. 

CPU0 Temp Alm 00 Amber Blink CPU module #1 Temperature alarm (lower 
limit) 

CPU0 Temp Alm 02 Amber Lit CPU module #1 Fatal temperature alarm 
(lower limit) 

CPU0 Temp Alm 07 Amber Blink CPU module #1 Temperature alarm (upper 
limit) 

CPU0 Temp Alm 09 Amber Lit CPU module #1 Fatal temperature alarm 
(upper limit) 

Check to see if dust is 
accumulated on the 
internal fans. Check also if 
the fan cables are 
connected securely. If not 
solved by the above, 
contact your sales agent. 

CPU0 VccpAlm 00 Amber Blink CPU module #1 CPU operating voltage alarm 
(lower limit) (VCCP) 

CPU0 VccpAlm 02 Amber Lit CPU module #1 Fatal CPU operating voltage 
alarm (lower limit) (VCCP) 

CPU0 VccpAlm 07 Amber Blink CPU module #1 CPU operating voltage alarm 
(upper limit) (VCCP) 

CPU0 VccpAlm 09 Amber Lit CPU module #1 Fatal CPU operating voltage 
alarm (upper limit) (VCCP) 

CPU0 Vtt Alm 00 Amber Blink CPU module #1 1.25-V power voltage alarm 
(lower limit) 

CPU0 Vtt Alm 02 Amber Lit CPU module #1 Fatal 1.25-V power voltage 
alarm (lower limit) 

CPU0 Vtt Alm 07 Amber Blink CPU module #1 1.25-V power voltage alarm 
(upper limit) 

CPU0 Vtt Alm 09 Amber Lit CPU module #1 Fatal 1.25-V power voltage 
alarm (upper limit) 

Contact your sales agent. 
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CPU00 Temp Alm 
00 

Amber Blink CPU module #1 CPU#1 temperature alarm 
(lower limit) 

CPU00 Temp Alm 
02 

Amber Lit CPU module #1 CPU#1 fatal temperature 
alarm (lower limit) 

CPU00 Temp Alm 
07 

Amber Blink CPU module #1 CPU#1 temperature alarm 
(upper limit) 

CPU00 Temp Alm 
09 

Amber Lit CPU module #1 CPU#1 fatal temperature 
alarm (upper limit) 

CPU01 Temp Alm 
00 

Amber Blink CPU module #2 CPU#2 temperature alarm 
(lower limit) 

CPU01 Temp Alm 
02 

Amber Lit CPU module #2 CPU#2 fatal temperature 
alarm (lower limit) 

CPU01 Temp Alm 
07 

Amber Blink CPU module #2 CPU#2 temperature alarm 
(upper limit) 

CPU01 Temp Alm 
09 

Amber Lit CPU module #2 CPU#2 fatal temperature 
alarm (upper limit) 

Check to see if dust is 
accumulated on the 
internal fans. Check also 
if the fan cables are 
connected securely. If 
not solved by the above, 
contact your sales agent. 

CPU2 +12ss Alm 
00 

Amber Blink CPU module #2 12-V power voltage alarm 
(lower limit) 

CPU2 +12ss Alm 
02 

Amber Lit CPU module #2 Fatal 12-V power voltage 
alarm (lower limit) 

CPU2 +12ss Alm 
07 

Amber Blink CPU module #2 12-V power voltage alarm 
(upper limit) 

CPU2 +12ss Alm 
09 

Amber Lit CPU module #2 Fatal 12-V power voltage 
alarm (upper limit) 

CPU2 +12v Alm 
00 

Amber Blink CPU module #2 12-V power voltage alarm 
(lower limit) 

CPU2 +12v Alm 
02 

Amber Lit CPU module #2 Fatal 12-V power voltage 
alarm (lower limit) 

CPU2 +12v Alm 
07 

Amber Blink CPU module #2 12-V power voltage alarm 
(upper limit) 

CPU2 +12v Alm 
09 

Amber Lit CPU module #2 Fatal 12-V power voltage 
alarm (upper limit) 

CPU2 +1.5vAlm 
00 

Amber Blink CPU module #2 1.5-V power voltage alarm 
(lower limit) 

CPU2 +1.5vAlm 
02 

Amber Lit CPU module #2 Fatal 1.5-V power voltage 
alarm (lower limit) 

CPU2 +1.5vAlm 
07 

Amber Blink CPU module #2 1.5-V power voltage alarm 
(upper limit) 

CPU2 +1.5vAlm 
09 

Amber Lit CPU module #2 Fatal 1.5-V power voltage 
alarm (upper limit) 

CPU2 +2.5vAlm 
00 

Amber Blink CPU module #2 2.5-V power voltage alarm 
(lower limit) 

CPU2 +2.5vAlm 
02 

Amber Lit CPU module #2 Fatal 2.5-V power voltage 
alarm (lower limit) 

CPU2 +2.5vAlm 
07 

Amber Blink CPU module #2 2.5-V power voltage alarm 
(upper limit) 

CPU2 +2.5vAlm 
09 

Amber Lit CPU module #2 Fatal 2.5-V power voltage 
alarm (upper limit) 

Contact your sales 
agent. 
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CPU2 +2.5VcAlm 
00 

Amber Blink CPU module #2 2.5-V power voltage alarm 
(lower limit) 

CPU2 +2.5VcAlm 
02 

Amber Lit CPU module #2 Fatal 2.5-V power voltage 
alarm (lower limit) 

CPU2 +2.5VcAlm 
07 

Amber Blink CPU module #2 2.5-V power voltage alarm 
(upper limit) 

CPU2 +2.5VcAlm 
09 

Amber Lit CPU module #2 Fatal 2.5-V power voltage 
alarm (upper limit) 

CPU2 +3.3vAlm 
00 

Amber Blink CPU module #2 3.3-V power voltage alarm 
(lower limit) 

CPU2 +3.3vAlm 
02 

Amber Lit CPU module #2 Fatal 3.3-V power voltage 
alarm (lower limit) 

CPU2 +3.3vAlm 
07 

Amber Blink CPU module #2 3.3-V power voltage alarm 
(upper limit) 

CPU2 +3.3vAlm 
09 

Amber Lit CPU module #2 Fatal 3.3-V power voltage 
alarm (upper limit) 

CPU2 +3.3vsAlm 
00 

Amber Blink CPU module #2 3.3-V power voltage alarm 
(lower limit) 

CPU2 +3.3vsAlm 
02 

Amber Lit  CPU module #2 Fatal 3.3-V power voltage 
alarm (lower limit) 

CPU2 +3.3vsAlm 
07 

Amber Blink CPU module #2 3.3-V power voltage alarm 
(upper limit) 

CPU2 +3.3vsAlm 
09 

Amber Lit CPU module #2 Fatal 3.3-V power voltage 
alarm (upper limit) 

CPU2 +5.0vAlm 
00 

Amber Blink CPU module #2 5-V power voltage alarm 
(lower limit) 

CPU2 +5.0vAlm 
02 

Amber Lit CPU module #2 Fatal 5-V power voltage alarm 
(lower limit) 

CPU2 +5.0vAlm 
07 

Amber Blink CPU module #2 5-V power voltage alarm 
(upper limit) 

CPU2 +5.0vAlm 
09 

Amber Lit CPU module #2 Fatal 5-V power voltage alarm 
(upper limit) 

CPU2 
+5.0vsAlm00 

Amber Blink CPU module #2 5-V power voltage alarm 
(lower limit) 

CPU2 
+5.0vsAlm02 

Amber Lit CPU module #2 Fatal 5-V power voltage alarm 
(lower limit) 

CPU2 
+5.0vsAlm07 

Amber Blink CPU module #2 5-V power voltage alarm 
(upper limit) 

CPU2 
+5.0vsAlm09 

Amber Lit CPU module #2 Fatal 5-V power voltage alarm 
(upper limit) 

CPU2 broken Green Blink CPU module #2 CPU module breakdown 

Contact your sales 
agent. 

CPU2 FAN Alm 01 Amber Blink CPU module #2 Cooling fan 1 alarm 
CPU2 FAN Alm 03 Amber Blink CPU module #2 Cooling fan 2 alarm 
CPU2 FAN Alm 04 Amber Blink CPU module #2 Cooling fan 3 alarm 

Check to see if dust is 
accumulated on the 
internal fans. Check also 
if the fan cables are 
connected securely. If 
not solved by the above, 
contact your sales agent. 

CPU2 offline Green Blink CPU module #2 The CPU module has been 
logically disconnected. 

Start the PCI module by 
ft sever utility or 
dismount and remount 
that module. If not 
solved by the above, 
contact your sales 
agent. 
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CPU2 removed Green Blink CPU module #2 The CPU module has come 
off. 

Dismount and remount 
the PCI module. If not 
solved by the above, 
contact your sales 
agent. 

CPU2 Temp Alm 
00 

Amber Blink CPU module #2 Temperature alarm (lower 
limit) 

CPU2 Temp Alm 
02 

Amber Lit CPU module #2 Fatal temperature alarm (lower
limit) 

CPU2 Temp Alm 
07 

Amber Blink CPU module #2 Temperature alarm (upper 
limit) 

CPU2 Temp Alm 
09 

Amber Lit CPU module #2 Fatal temperature alarm 
(upper limit) 
 

Check to see if dust is 
accumulated on the 
internal fans. Check also 
if the fan cables are 
connected securely. If 
not solved by the above, 
contact your sales 
agent. 
 

CPU2 VccpAlm 00 Amber Blink CPU module #2 CPU operating voltage alarm 
(lower limit) (VCCP) 

CPU2 VccpAlm 02 Amber Lit CPU module #2 Fatal CPU operating voltage 
alarm (lower limit) (VCCP) 

CPU2 VccpAlm 07 Amber Blink CPU module #2 CPU operating voltage alarm 
(upper limit) (VCCP) 

CPU2 VccpAlm 09 Amber Lit CPU module #2 Fatal CPU operating voltage 
alarm (upper limit) (VCCP) 

CPU2 VttAlm 00 Amber Blink CPU module #2 1.25-V power voltage alarm 
(lower limit) 

CPU2 VttAlm 02 Amber Lit CPU module #2 Fatal 1.25-V power voltage 
alarm (lower limit) 

CPU2 VttAlm 07 Amber Blink CPU module #2 1.25-V power voltage alarm 
(upper limit) 

CPU2 VttAlm 09 Amber Lit CPU module #2 Fatal 1.25-V power voltage 
alarm (upper limit) 

Contact your sales 
agent.  

CPU20 TempAlm 
00 

Amber Blink CPU module #1 CPU#1 temperature alarm 
(lower limit) 

CPU20 TempAlm 
02 

Amber Lit CPU module #1 Fatal CPU#1 temperature 
alarm (lower limit) 

CPU20 TempAlm 
07 

Amber Blink CPU module #1 CPU#1 temperature alarm 
(upper limit) 

CPU20 TempAlm 
09 

Amber Lit CPU module #1 Fatal CPU#1 temperature 
alarm (upper limit) 

CPU21 TempAlm 
00 

Amber Blink CPU module #2 CPU#2 temperature alarm 
(lower limit) 

CPU21 TempAlm 
02 

Amber Lit CPU module #2 Fatal CPU#2 temperature 
alarm (lower limit) 

CPU21 TempAlm 
07 

Amber Blink CPU module #2 CPU#2 temperature alarm 
(upper limit) 

CPU21 TempAlm 
09 

Amber Lit CPU module #2 Fatal CPU#2 temperature 
alarm (upper limit) 

Check to see if dust is 
accumulated on the 
internal fans. Check also 
if the fan cables are 
connected securely. If 
not solved by the above, 
contact your sales 
agent. 

= D =      
DUMP Request! Off  - DUMP switch request Contact your sales 

agent. 
= F =      
FRB Processing Off  - During POST execution or OS 

start processing 
The server is operating 
normally. 
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STATUS LED Indication 
Color State 

Suspected 
module Explanation Procedure 

= M =      
Memory U-Err 01 Green Blink CPU module #1 DIMM#1 2-bit error 
Memory U-Err 02 Green Blink CPU module #1 DIMM#2 2-bit error 
Memory U-Err 03 Green Blink CPU module #1 DIMM#3 2-bit error 
Memory U-Err 04 Green Blink CPU module #1 DIMM#4 2-bit error 
Memory U-Err 05 Green Blink CPU module #1 DIMM#5 2-bit error 
Memory U-Err 06 Green Blink CPU module #1 DIMM#6 2-bit error 
Memory U-Err 21 Green Blink CPU module #2 DIMM#1 2-bit error 
Memory U-Err 22 Green Blink CPU module #2 DIMM#2 2-bit error 
Memory U-Err 23 Green Blink CPU module #2 DIMM#3 2-bit error 
Memory U-Err 24 Green Blink CPU module #2 DIMM#4 2-bit error 
Memory U-Err 25 Green Blink CPU module #2 DIMM#5 2-bit error 
Memory U-Err 26 Green Blink CPU module #2 DIMM#6 2-bit error 

The DIMM must be 
replaced. Contact a 
maintenance service 
company. 

= O =      
OS shutdown Alm Off  - Shutdown due to a timeout 

error of the watch dog timer 
(fatal error) 

Contact your sales agent. 

= P =      
Power-off Off  - The DC power is turned off. - 
= S =      
SSR Processing Off  - Reboot processing for 

recovery 
DUMP is being collected. 

= W =      
WDT timeout Off  - Timeout error of the watch dog 

timer (fatal error) 
Contact your sales agent. 
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POST Error Messages 

Powering on the server automatically starts the self-diagnostic program, POST (Power On 
Self-Test). When POST detects any error, it displays an error message and its measure on the 
display unit. Follow the table below to troubleshoot such errors. 

Phoenix BIOS 4.0 Release 6.0.XXXX
:

CPU=Pentium III XXX MHz
0640K System RAM Passed
0127M Extended RAM Passed
WARNING:
02B0: Diskette drive A error.

:
press <F1> to resume, <F2> to SETUP

Message indicating a floppy disk drive error  
 

TIPS: For error messages on optional PCI board, refer to the manual provided with those options. 

On-screen error message Cause Action 
0200 Failure Fixed Disk • Configuration error in Setup 

menu.  
• Hard disk is faulty. 
• CPU module board is faulty. 
• PCI module board is faulty. 

• Check configuration in Setup 
menu. 

• Replace the hard disk. 
• Replace the CPU module 

board.  
• Replace the PCI module 

board. 
0210 Stuck Key Keyboard connection error • Disconnect the keyboard 

and connect it back again. 
• Replace the keyboard. 
• Replace the PCI module 

board. 
0211 Keyboard error Keyboard is faulty. 
0212 Keyboard Controller 

Failed 
Keyboard controller is faulty. 

• Check the keyboard 
connection. 

• Restart the server. 
• Replace the PCI module 

board. 
0213 Keyboard locked - 

Unlock key switch 
Keyboard is locked. Unlock the key switch. 

0220 Monitor type does not 
match CMOS - Run 
SETUP 

Illegal monitor type is 
specified. 

• Select "Get Default Value" 
from the Setup menu. 

• Clear the CMOS data. 
0230 System RAM Failed at 

offset 
DIMM is faulty. • Replace DIMM. 

• Replace the CPU module 
board. 

0231 Shadow RAM Failed at 
offset 

DIMM is faulty. • Replace DIMM. 
• Replace the CPU module 

board. 
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On-screen error message Cause Action 
0232 Extend RAM Failed at 

address line 
DIMM is faulty. • Replace DIMM. 

• Replace the CPU module 
board. 

0233 Memory type mixing 
detected 

DIMMs of the different types 
are installed. 

Replace DIMM with 
appropriate one. 

0234 Single - bit ECC error DIMM is faulty. • Replace DIMM. 
• Replace the CPU module 

board. 
0235 Multiple - bit ECC error DIMM is faulty. • Replace DIMM. 

• Replace the CPU module 
board. 

0250 System battery is dead 
-Replace and run 
SETUP 

NvRAM battery is dead. Replace the PCI module 
board. 

0251 System CMOS 
checksum bad-Default 
configuration used 

NvRAM is faulty. • Re-configure using the 
Setup menu.  

• Replace the PCI module 
board. 

0252 Password checksum bad 
-Password cleared 

NvRAM is faulty. • Re-set the password in the 
Setup menu. 

• Replace the PCI module 
board. 

0260 System timer error PCI module board is faulty. Replace the PCI module 
board. 

0270 Real time clock error RTC is faulty. Replace the PCI module 
board. 

0271 Check date and time 
setting 

Date and time of RTC are 
incorrectly set. 

• Set the correct date and time 
in Setup menu. 

• Replace the PCI module 
board. 

0280 Previous boot incomplete 
-Default configuration 
used 

Configuration error in Setup 
menu. 

Check configuration in Setup 
menu. 

02B0 Diskette drive A error Floppy drive A is faulty. Replace the floppy disk drive 
A. 

02B2 Incorrect Drive A type - 
run SETUP 

Configuration error in Setup 
menu. 

Specify the correct drive type 
in Setup menu. 

02D0 System cache error - 
Cache disabled 

• CPU is faulty.  
• CPU module board is faulty. 

• Replace the CPU. 
• Replace the CPU module 

board. 
0B1B PCI System Error on 

Bus/Device/Function 
PCI device is faulty. 

0B1C PCI Parity Error on 
Bus/Device/Function 

PCI device is faulty. 

• Replace the PCI board. 
• Re-install the PCI board. 
• Re-configure the PCI board. 
• Replace the PCI module 

board. 
0B22 CPUs are installed out of 

order 
CPU is faulty. Replace the CPU. 

0B28 Unsupported Processor 
detected on Processor 1 

The processor (CPU) not 
supported by this server is 
installed in Processor 1. 

Install the CPU appropriate to 
the server. 
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On-screen error message Cause Action 
0B29 Unsupported Processor 

detected on Processor 2 
The processor (CPU) not 
supported by this server is 
installed in Processor 2. 

Install the CPU appropriate to 
the server. 

0B30 CPU FAN #1 Alarm 
occurred 

0B31 CPU FAN #2 Alarm 
occurred 

• Dusts are clogged in fan. 
• Fan is faulty. 
• CPU module board is faulty. 

• Replace the fan. 
• Replace the CPU module 

board. 
• Connect fan cable properly. 

0B32 CPU FAN #3 Alarm 
occurred 

• Dusts are clogged in fan. 
• Fan is faulty. 
• CPU module board is faulty. 

• Replace the fan. 
• Replace the CPU module 

board. 
• Connect fan cable properly. 

0B40 Invalid System 
Configuration Data 

• Configuration error in 
SETUP. 

• CPU/PCI module board is 
faulty. 

 

• Reset the setting by 
selecting [Yes] at [Reset 
Configuration Data] 

• Replace the CPU/PCI 
module board. 

0B41 System Configuration 
Data Read error 

• Configuration error in 
SETUP. 

• CPU/PCI module board is 
faulty. 

• Reset the setting by 
selecting [Yes] at [Reset 
Configuration Data] 

• Replace the CPU/PCI 
module board. 

0B42 Resource Conflict Configuration error in SETUP. Correct device configuration in 
SETUP 

0B43 Warning: IRQ not 
configured 

Configuration error in SETUP. Correct settings in SETUP 

0B44 Expansion Rom not 
initialized 

Configuration error in SETUP. In SETUP, disable 
decompression of expansion 
ROM on unnecessary optional 
PCI cards. 

0B45 System Configuration 
Data Write error 

• Configuration error in 
SETUP. 

• CPU/PCI module board is 
faulty. 

 

• Reset the setting by 
selecting [Yes] at [Reset 
Configuration Data] 

• Replace the CPU/PCI 
module board. 

0B47 Missing date and time 
synchronization 

The date and time are 
incorrect due to a 
communication error between 
BMCs. 

• Restart the system. 
• Re-set the date and time in 

SETUP. 
If the error persists, replace the 
PCI module board. 

0B49 BMC Issued Reset 
Command, but failed 
System Reset 

• System cannot be reset by 
BMC’s reset command. 

Replace PCI module board. 

0B6E DIMMs are installed out 
of order 

• DIMM is faulty. Replace DIMM. 

0B70 The error occurred 
during temperature 
sensor reading 

• SMBus device is faulty. 
• SMBus is faulty. 

Replace the CPU/PCI module 
or back panel board. 
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On-screen error message Cause Action 
0B71 System temperature out 

of Range 
• Ambient temperature is out 

of range. 
• Fan is faulty.  
• CPU/PCI module board is 

faulty. 

• Check the setting in SETUP 
• Clean the fan. 
• Replace the fan. 
• Replace the CPU/PCI 

module board. 
0B80 BMC Memory Test Failed 
0B81 BMC Firmware Code 

Area CRC check failed 
0B82 BMC core Hardware 

failure 
0B83 BMC IBF or OBF check 

failed 
0B90 BMC Platform 

Information Area 
corrupted 

0B91 BMC update firmware 
corrupted 

BMC is faulty. Replace the PCI module 
board. 

0B92 Internal Use Area of 
BMC FRU corrupted 

• SROM is faulty.  
• BMC is faulty. 

• Replace the back panel 
board. 

• Replace the PCI module 
board. 

0B93 BMC SDR Repository 
empty 

0B94 IPMB signal lines do not 
respond 

0B95 BMC FRU device failure 
0B96 BMC SDR Repository 

failure 
0B97 BMC SEL device failure 

BMC is faulty. Replace the PCI module 
board. 

0B98 BMC SEL Overflow SEL (System Event Log) 
overflowed. 

Erase the unnecessary SEL. 

0BB0 SMBIOS - SROM data 
read error 

0BB1 SMBIOS - SROM data 
checksum bad 

• SROM is faulty.  
• Back panel board is faulty. 

Replace the back panel board. 

0BD0 1st SMBus device 
address not 
acknowledged 

0BD1 1st SMBus device Error 
detected 

0BD2 1st SMBus timeout 

PCI module board #1 is faulty. 

0BD3 2nd SMBus device 
address not 
acknowledged 

0BD4 2nd SMBus device Error 
detected 

0BD5 2nd SMBus timeout 

CPU module board #1 is faulty. 

• Check cable connection. 
• Replace the board. 
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On-screen error message Cause Action 
0BD6 3rd SMBus device 

address not 
acknowledged 

0BD7 3rd SMBus device Error 
detected 

0BD8 3rd SMBus timeout 

- 
(3rd SMBus does not exist) 

0BD9 4th SMBus device 
address not 
acknowledged 

0BDA 4th SMBus device Error 
Detected 

0BDB 4th SMBus device 
timeout 

CPU module board #2 is faulty. 

0BDC 5th SMBus device 
address not 
acknowledged 

0BDD 5th SMBus device Error 
detected 

0BDE 5th SMBus timeout 

- 
(5th SMBus does not exist) 

0BDF 6th SMBus device 
address not 
acknowledged 

0BE0 6th SMBus device Error 
detected 

0BE1 6th SMBus timeout 

- 
(6th SMBus does not exist) 

0BE2 7th SMBus device 
address not 
acknowledged 

0BE3 7th SMBus device Error 
detected 

0BE4 7th SMBus timeout 

Back panel board is faulty. 

0BE5 8th SMBus device 
address not 
acknowledged 

0BE6 8th SMBus device Error 
detected 

0BE7 8th SMBus timeout 

PCI module board #2 is faulty. 

• Check cable connection. 
• Replace the board. 

0BF0 Vendor ID cannot be 
retrieved from BP 
IDPROM 

0BF1 System Structure cannot 
be retrieved from BP 
IDPROM 

Back panel board is faulty. Replace the back panel board. 

0C00 Rompilot reports error 
number xx 

• Configuration error in 
SETUP.  

• CPU/PCI module board is 
faulty. 

• Re-configure Rompilot. 
• Replace the CPU/PCI 

module board. 

8600 No working DQS value 
found 

• DIMM is faulty 
• DIMM is not supported 

• Replace DIMM 
• Replace DIMM with 

appropriate one. 
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On-screen error message Cause Action 
8610 MAC Address update 

failed – CoreI/O#0 
10/100Mbit Ethernet 
Controller 

FRB2 timeout occurred when 
setting MAC address, and 
rewrite was unsuccessful. 

• Replace the back panel 
board. 

• Replace the PCI module 
board 1. 

8611 MAC Address update 
failed – CoreI/O#0 Gbit 
Ethernet Controller 

FRB2 timeout occurred when 
setting MAC address, and 
rewrite was unsuccessful. 

• Replace the back panel 
board. 

• Replace the PCI module 
board 1. 

8612 MAC Address update 
failed – CoreI/O#1 
10/100 Mbit Ethernet 
Controller 

FRB2 timeout occurred when 
setting MAC address, and 
rewrite was unsuccessful. 

• Replace the back panel 
board. 

• Replace the PCI module 
board 2. 

8613 MAC Address update 
failed – CoreI/O#1 Gbit 
Ethernet Controller 

FRB2 timeout occurred when 
setting MAC address, and 
rewrite was unsuccessful. 

• Replace the back panel 
board. 

• Replace the PCI module 
board 2. 
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Error Notification by BEEP 

An error message may not be displayed on the display unit even though the POST detected an error. 
In such a case, the beep sounds notifies you an error. The error contents are indicated by the 
combination of beep sound patterns. For example, beep sounds once, consecutively three times, 
once, and then once (beep code: 1-3-1-1) indicates DRAM refresh test error. 

The following table lists the meaning of beep codes and measures against them. 

Beep code Meaning Action 
1-2-2-3 ROM checksum 

error 
Contact your sales agent to replace the CPU module 
board. 

1-1-2-4 ROMEXEC code 
error 

1-3-1-1 DRAM refresh test 
error 

Check the installation of DIMM board. 
If the error persists, contact your sales agent to replace 
the DIMM or CPU module board.  

1-3-1-3 Keyboard controller 
error 

Disconnect the keyboard and connect it back on. If the 
error persists, request your sales agent to replace the 
CPU module board. 

1-3-3-1 Failed to detect 
memory. 
Or, DIMM board 
type is incorrect. 

1-3-3-2 Initial setting error of 
the POST memory 
manager 

1-3-4-1 RAM address error 
1-3-4-3 RAM low byte data 

error 
1-4-1-1 RAM high byte data 

error 

Check the installation of DIMM board. 
If the error persists, contact your sales agent to replace 
the DIMM or CPU module board.  

2-2-3-1 Illegal interrupt test 
error 

2-1-2-3 Copyright check 
error 

Contact your sales agent. 

Failed to initialize 
the video BIOS 
 
Failed to initialize 
the option ROM 

1-2 

Failed to expand the 
option ROM 

Check the motherboard installation if nothing is 
displayed on the display unit. If the error persists, 
contact your sales agent to replace the CPU module 
board. 
Check the PCI board installation if the Option ROM of 
the added PCI board is not displayed. If the error 
persists, contact your sales agent to replace the CPU 
module board, PCI module board or added PCI board 
with new one. 
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Windows Server 2003, Enterprise Edition Error Messages 

If a fatal error (e.g., a STOP or system error) occurs after Windows Server 2003, Enterprise Edition 
starts, the screen of the display unit turns blue and displays detailed error messages. 

STOP: C0 0 0 0 2 1 A (FATAL SYSTEM ERROR)

Th e  Windows  lo gon  pro c es s ..  Sys te m  proc es s  te rm in ate d.

Une xpec te dly  with  a s tatus  o f 0 x0 0 0 0 0 0 0 1
(0 x0 0 0 0 0 0 0 0  0 x0 0 0 0 0 0 0 0 ).

Th e  sys te m  h as  bee n sh utdown.

c rash dum p : in it ializ in g m in iport  drive r

c rash dum p : dum pin g phys ic al m e m ory to  dis k

The screen
background is "blue".

 
 
Take notes of the messages displayed on the screen, and call your sales agent. 

If a fatal error occurs, the server automatically executes memory dump processing and saves the 
memory dump data in an arbitrary directory. (See the end of this chapter) The maintenance 
personnel of your sales agent may ask you to provide this data. Thus, copy the file into a medium 
(e.g., DAT) to be ready to pass it to the maintenance personnel. 

IMPORTANT: A message may appear indicating that virtual memory is insufficient when you 
restart the system after a STOP or system error has occurred. Ignore the message and start the 
system. 
 

TIPS: Before copying the file into a medium, start the Event Viewer to confirm that the Save 
Dump event log is included in the system event logs and the memory dump has been saved. 

The following message may be displayed during usage. 

"Your system is low on virtual memory. To ensure that Windows runs properly, increase the 
size of your virtual memory paging file. For more information, see Help." 

When this message is displayed, extend a physical memory following the procedure below. 

1. Add a physical memory 

2. Change the configuration of the paging file (Change more than < physical memory 
capacity × 1.5 >) 

The system also displays a warning message if an internal device or peripheral equipment (e.g., disk, 
network, or printer) encounters an error. Take notes of the message, and call your sales agent. 
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Server Management Application Error Message 

If the server management tool such as NEC ESMPRO 
Agent, NEC ESMPRO Manager, or GAMServer has 
been installed in the NEC Express5800/ft series or 
management PC, you can obtain the error information 
from the display unit of the server or management PC. 

See Chapter 5 or online documentation for details of 
such application programs. 
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SOLVING PROBLEMS 
When the server fails to operate as expected, see the following to find out your problem and follow 
the given instruction before asking for repair. 

If the server still fails to operate successfully after solving your problem, take a note on the 
on-screen message and contact your sales agent. 

 

Problems with NEC Express5800/ft series 

Fail to power on the server: 

� Is the server properly supplied with power? 

→ Check if the power cord is connected to a power outlet (or UPS) that meets the 
power specifications for the server. 

→ Check if the two pieces of the provided power cord are connected to the main unit 
properly. 

→ Make sure to use the power cord provided with the server. Check the power cord 
for broken shield or bent plugs. 

→ Make sure the power breaker for the connected power outlet is on. 

→ If the power cord is plugged to a UPS, make sure the UPS is powered and it 
supplies power. See the manual that comes with the UPS for details. 

Power supply to the server may be linked with the connected UPS using the BIOS 
setup utility of the server. 

<Menu to check:  [System Hardware] → [AC-LINK] → [Power On]> 

→ Make sure the POWER switch on the power unit is on. 

� Did you press the POWER switch? 

→ Press the POWER switch on the front of the NEC Express5800/ft series to turn on 
the power (the POWER LED lights). 

� Did you install the CPU/PCI module properly? 

→ Check if the CPU/PCI module is properly installed in the server. Secure the 
module with screw located on the module handle. 
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The screen turns blue during OS boot: 

→ Wait for the period of time you set at BIOS [Boot Monitoring]; after the boot pair is 
automatically swapped, the server will be rebooted and the OS will start up. 

→ Start the OS from the other PCI module’s hard disk. 

 

Fail to power off the server: 

� Is the POWER switch enabled? 

→ Restart the server and start the BIOS setup utility. 

<Menu to check:  [Security] → [Power Switch Mask] → [Unmasked]> 

 

POST fails to complete: 

� Is the DIMM installed? 

→ At least one DIMM is required for operation. 

� Is the memory size large? 

→ The memory check may take a time if the memory size is large. Wait for a while. 

� Did you perform any keyboard or mouse operation immediately after you started the 
server? 

→ If you perform any keyboard or mouse operation immediately after start-up, POST 
may accidentally detect a keyboard controller error and stops proceeding. In such 
a case, restart the server once again. Do not perform any keyboard or mouse 
operation until the BIOS start-up message appears when you restart the server. 

� Does the server have appropriate memory boards or PCI card? 

→ Operation of the server with unauthorized devices is not guaranteed. 
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Fail to access to internal or external devices: 
� Are cables properly connected? 

→ Make sure that the interface cables and power cord are properly connected. Also 
make sure that the cables are connected in the correct order. 

� Is that device compliant with NEC Express5800/ft series? 

→ Operation of the server with unauthorized devices is not guaranteed. 

� Is the power-on order correct? 

→ When the server has any external devices connected, power on the external 
devices first, then the server. 

� Did you install drivers for connected optional devices? 

→ Some optional devices require specific device drivers. Refer to the manual that 
comes with the device to install its driver. 

→ Some optional devices connected to the serial port require settings for I/O port 
address and operation mode. Refer to the manual that comes with the device to 
configure the device. 

<Menu to check:  [Advanced] → [Peripheral Configuration]> 

� Is SCSI controller (including options) configuration correct?  

→ If the sever has an optional SCSI controller board and SCSI devices are hooked up 
to the server, make correct settings by the SCSI controller board’s SCSI BIOS 
utility. For details, see manuals included with the SCSI controller board. 

� Is SCSI device configuration correct? 

→ If external SCSI devices are connected to the server, you need to make settings of 
SCSI ID and terminal resistance. For details, see manuals included with the SCSI 
device. 

 

CPU not in Dual mode: 

→ Check if the memory configuration is correct. 

→ Check if third-party CPUs or memory (DIMM) are used. 

 

Disk not in Dual mode: 

→ Unless you perform mirroring (including reconfiguration after failed disks are 
replaced) in correct order, the mirror may not be [re]configured. Check if the steps 
were correct. 
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The keyboard or mouse fails to operate: 
� Is the cable properly connected? 

→ Make sure that the cable is connected to the correct connector on the rear of the 
server. 

� Are the keyboard and mouse are compliant with NEC Express5800/ft series? 

→ Operation of the server with unauthorized devices is not guaranteed. 

� Is BIOS configuration correct? 

→ The keyboard and mouse may be disabled with the BIOS setup utility of the server. 
Check the settings with the BIOS setup utility. 

<Menu to check:  [Advanced] → [Keyboard Features]> 

� Does the server have drivers installed? 

→ Refer to the manual that comes with your OS to check that the keyboard and 
mouse drivers are installed. (These drivers are installed along with the OS.) Some 
OS's allow you to change the keyboard and mouse settings. Refer to manual that 
comes with your OS to check that the keyboard and mouse settings are correct. 

� Are you using a PS2-USB conversion connector? 

→ The PS2-USB conversion connector is not supported. Use the keyboard and 
mouse that are specified by NEC. 

 

Screen freezes, keyboard and mouse do not work: 

→ If the amount of memory is large, it takes time to copy the memory in dual mode 
and the system stops working during the copying. It is not system trouble. 

 

Message “New Hardware Found” appears: 

→ Such a message may appear at the system startup or when a PCI module is 
replaced and incorporated into the system. This is due to the server’s operating 
specifications and does not pose any problem. 

 
Fail to access (read or write) to the floppy disk: 

� Does the floppy disk drive contain a floppy disk? 

→ Insert a floppy disk into the floppy disk drive until it clicks. 

� Is the floppy disk write-protected? 

→ Place the write-protect switch on the floppy disk to the "Write-enabled" position. 

� Is the floppy disk formatted? 

→ Use a formatted floppy disk or format the floppy disk in the floppy disk drive. 
Refer to the manual that comes with the OS for formatting a floppy disk. 
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Fail to access to the CD-ROM: 
� Is the CD-ROM properly set in the CD-ROM drive tray? 

→ The tray is provided with a holder to secure the CD-ROM. Make sure that the 
CD-ROM is placed properly in the holder. 

� Is the CD-ROM applicable to the server? 

→ The CD-ROM for Macintosh is not available for use. 

� Is the CD-ROM on the PCI module whose POWER switch is on (primary module)? 

→ Although there are two CD-ROM drives, you can only use the one located on the 
primary module whose POWER switch is on. 

 

Fail to access the hard disk: 
� Is the hard disk applicable to the server? 

→ Operation of any device that is not authorized by NEC is not guaranteed. 

� Is the hard disk properly installed? 

→ Make sure to lock the hard disk with the lever on its handle. The hard disk is not 
connected to the internal connector when it is not completely installed (see Chapter 
8). When the hard disk is properly installed, the drive power LED for the hard disk 
is lit while the server is powered. 

 
The “An Error occurred while creating partition.” error message appears when 
installing an OS: 

� If the following message appears when installing an OS using NEC 
EXPRESSBUILDER, you need to perform Low-Level Format again due to reasons 
including stoppage.  
Referring to “SYSTEM BIOS” in Chapter 4, change the status of [Option ROM 
Scan Monitoring] to “Disabled” and then perform Low-Level Format. 
After performing Low-Level Format, change the status of [Option ROM Scan 
Monitoring] back to “Enabled”.  
 
“An Error occurred while creating partition. Press CTRL-C to terminate 
installation.” 
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An error message appears while expanding BIOS of SCSI controller (ISP12160) 
when starting system after performing Low-Level Format and the system cannot be 
started:  

If the following message appears, you need to perform Low-Level Format again due to reasons 
including stoppage.  
Referring to “SYSTEM BIOS” in Chapter 4, change the status of [Option ROM Scan Monitoring] 
to “Disabled” and then perform Low-Level Format. 
After performing Low-Level Format, change the status of [Option ROM Scan Monitoring] back to 
“Enabled”.  
 
“ERROR! Cannot configure SCSI device. Check SCSI bus termination and check adapter 
termination settings by pressing ALT-Q to enter Fast!UTIL.” 
 

Fail to start the OS: 
� Is a floppy disk in the floppy disk drive? 

→ Take out the floppy disk and restart the server. 

� Is the NEC EXPRESSBUILDER CD-ROM (or the other bootable CD-ROM) in the 
CD-ROM drive? 

→ Take out the CD-ROM and restart the server. 

� Is the OS damaged? 

→ Use the recovery process of the OS to attempt to recover the damaged OS. 
 
OS behavior is unstable: 

� Have you updated your system? 

→ If you install a network driver after installing the OS, the OS may become 
unstable. For update procedure, see the separate volume “User’s Guide (Setup).” 

 

The system does not operate according to the configured settings of "Automatic 
Restart" at the occurrence of error: 

→ The system may or may not restart automatically even if the "Automatic Restart" 
settings are made at occurrence of an error is set. If the system does not restart 
automatically, restart it in manual mode. 

 
The power cannot be turned off while the blue screen of Windows Server 2003, 
Enterprise Edition is displayed: 

→ The forced power-off (forced shutdown) procedure is necessary to turn off the power 
with the blue screen displayed. Keep pressing the POWER switch for 4 seconds. 
Pressing the POWER switch only once does not turn off the power in this case. 
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The server is not found on the network: 
� Is the LAN cable connected? 

→ Make sure to connect the LAN cable to the network port on the rear of the server. 
Also make sure to use the LAN cable that conforms to the network interface 
standard. 

� Is BIOS configuration correct? 

→ The internal LAN controller may be disabled with the BIOS setup utility of the 
server. Check the setting with the BIOS setup utility. 

<Menu to check:  [Advanced] → [Option Rom] → [On Board LAN]> 

� Have the protocol and service already configured? 

→ Install the distinctive network driver for the server. Make sure that the protocol, such 
as TCP/IP, and services are properly specified. 

� Is the transfer speed correct? 

→ Open the [Network Property] dialog box in Control Panel to specify the “Link Speed 
& Duplex” value the same as the value specified for HUB. 

Transfer speed can be fixed by PROSet II. 
Select an adapter to modify the setting from the tree on the left, for 100Base adapter, 
click the [Advanced] tab and make settings at “Link Speed & Duplex”. 
For 1000Base-T adapter click the [Link Config] tab. 
Select [Enabled] "Auto Negotiation" and specify the transfer speed at  
"Negotiable Speed and Duplexes". 
(Only check the transfer speed to use.) 
 

Icon of drive A is changed to that of removal disk: 

→ Does not cause any problem. 

 
WMI log is recorded in the application event log: 

When you view the Application Event Viewer log on your computer, one or more of the following 
events may be logged. This has no effect on the functionality of VERITAS Volume Manager.  

Source: WinMgmt 
ID: 41 
Description: WMI ADAP was unable to create object index 2902 for Performance 

Library vxio because no value was found in the 009 subkey. 
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Failure in CPU module duplication: 

→ If the simultaneous replacement of the CPU and PCI modules causes the CPU and 
PCI modules to control duplication, the CPU module duplication may fail with the 
following message saved in the system event log. If so, the system can be 
recovered from the failure starting the CPU module with ft server utility or by 
reinserting the CPU module. 

Source: srabid 
ID: 16474 
Description: Diagnostics failure of 2: ‘CPU Get Chipset Info’ (0xf026,0x0,0x0). 

 

Disk information is not correct on VERITAS Enterprise Administrator after system 
starts: 

→ If the primary PCI cannot access the FC disk, the disk information may not be 
displayed correctly. In this case, run “Action/Update” or “Action/Rescan.” 

 If the information is not displayed correctly even after the above step, check the 
connection between the module and disk. 

 

“Stratus Fault Tolerant Virtual 69000 Video” is displayed on “Remove Hardware” 
dialog box: 

→ If you double-click an icon “Remove Hardware” on the system tray, two “Stratus 
Fault Tolerant Virtual 69000 Videos” will appear. Do not remove them. Otherwise, 
the connected PCI modules will be disconnected forcefully and the system may 
operate normally.  

 

Machine repeats rebooting at startup: 
 

� Is CHKDSK executed at machine startup?   

→ Open the utility of the BIOS setup at rebooting and change the following settings:   
 
(Change BIOS settings) 

Change [Advanced] - [Monitoring Configuration] - [Boot Monitoring] to [Disable]. 
(For details, see page 4-15 “Monitoring Configuration”.) 

 
* After completion of CHKDSK, restart the machine and change the above setting 

back to [Enable] and continue the operation.  
 

CHKDSK is executed in the following conditions:  
(1) CHKDSK is scheduled to be executed at next system startup 
(2) Corruption of file system is detected since the previous startup until shutdown  
(3) Inconsistency (corruption) of file system is detected while mouting at system 

startup  
 
� Is the value of [Boot Monitoring Time-out Period] in the BIOS setting appropriate? 
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→ Change the value of [Boot Monitoring Time-out Period] to suit your environment. 

(For details, see page 4-15 “Monitoring Configuration”.) 
 

Mouse Does Not Move Smoothly, And Drawing Graphics Takes Time: 
� Is the hardware acceleration set to Full?   

→ Set it to “None”.   

Make sure to set the hardware acceleration to None in NEC Express5800/ft series 
(Default: None). 

 
(How to check and change the hardware acceleration setting) 

Select the [Start] - [Control Panel] - [Display] – [Settings] tab – [Advanced].  
“Plug&Play Monitor and Stratus Virtual Video Properties” is displayed.  Select the 
[Troubleshoot] tab and check the hardware acceleration setting. 

 
CPU load ratio of SNMP Service (snmp.exe) increases: 

→ While monitoring the server from NEC ESMPRO Manager, the CPU load ratio of 
SNMP Service on the NEC ESMPRO Agent side may increase at every 
monitoring interval (default: 1 minute). 

NEC ESMPRO Manager and NEC ESMPRO Agent exchange information 
through SNMP Service. 
If the server status monitoring by NEC ESMPRO Manager is on (default: ON), 
NEC ESMPRO Manager regularly issues a request to NEC ESMPRO Agent to get 
the current status of the server. In response, NEC ESMPRO Agent checks the 
status of the server. As a result, the CPU load ratio of SNMP Service increases 
temporarily. 
If you have trouble of terminating a movie player application, turn off the server 
status monitoring by NEC ESMPRO Manager or extend the monitoring interval. 

 
Hang of SNMP Service occurs: 

→ SNMP Service has a module called "SNMP Extended Agent." This module may 
be registered when you install some software that uses SNMP Service. 

If you start SNMP Service, SNMP Extended Agent is also loaded at the 
initialization. However, if the initialization is not completed within a specified 
period, SNMP Service will hang. 
It may take time to complete the initialization due to temporary high load on the 
system. In this case, wait for the system load become low enough before restarting 
SNMP Service. 

 
A CPU/PCI module cannot be integrated: 

→ When a component fails and is reintegrated, the following message may be 
recorded to the system event log and the process is stopped. Such event indicates 
that the component’s MTBF is below the threshold and it is judged that repair is 
necessary. Thus the reintegration process cannot be completed. Generally 
replacement of the component will be required, so contact your sales 
representative. If reintegrating the component without repair is required for some 
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reason, consult your sales agent. It is possible to perform reintegration forcefully.  

Source: srabid 
ID: 16395 
Description: x is now STATE_BROKEN / REASON_BELLOW_MTBF (“x” 

is a device number.) 
 
 
An unavailable disk is displayed on Disk Management: 

→ Follow the instructions on the table below:  

Disk status Description Action 

 

[Foreign] appears when 
loading a dynamic disk 
which has been used in a 
different system. 

[To use the disk’s data] 
Referring to Chapter 3 “Windows 
Setup and Operation”, import the disk.  
 
[To change the disk to an available 
disk] 
To use this disk, it needs to be 
initialized. It will become available 
after initialization.  
<Note> 
Initialization erases all data on the disk. 
If there is important data, back up data 
before initialization. 

 

[Missing] appears when a 
dynamic disk is damaged or 
removed.  

If there is a volume on the missing 
disk, break the mirror on that disk. 
Then right-click the [Missing] disk and 
perform [Remove disk]. 

 

[Not Initialized] appears 
when the disk is not signed. 

Right-click the disk and perform 
[Initialize Disk]. The disk will become 
available.  

 
 
Primary PCI module’s status LED2 and DISK ACCESS LED illuminate amber after 
startup: 

� Is the mirroring of the hard disks broken? 

→ See [Disk Management] and if the mirror is broken, reconfigure it.  
For mirroring configuration, see “DISK OPERATIONS” in Chapter 3 “Windows 
Setup Operation.”  
 
Other than disk failure, the mirror may be removed at startup after the following 
operations: 

• Started the server after shutdown with the PCI module in simplex mode 
• Started NEC Express5800/ft series when the BMC status LED was blinking 

The duplication process of Baseboard Management Controller (BMC) is executed 



Troubleshooting  7-33 

immediately after turning on the AC power, or mounting a PCI module. The mirror of 
a disk may be removed if you turn on the power and start the server before or during 
the duplication process. Make sure to start the server after the duplication process of 
BMC is completed.  
You can check the status of the duplication process from BMC status LED of  PCI 
module on mounted side. 

• Illuminating red: Yet to be duplicated 
• Blinking in red: In the process of duplication 
• Off: Duplication is completed 

See “LEDs” in Chapter 2 “General Description” for details of the BMC status 
LED. 

 
Memory dump (debug information) cannot be collected at a failure occurrence: 

� Is there any available space at the memory dump storage location? 

→ Specify a drive in which there is an available storage space of greater than a memory 
size on the server plus 12 MB (more than 2048 + 12MB if a memory size is more than 
2GB ). 
For details, see “Set Memory Dump (Debug Information)” of “Step 12:  Set up 
Failure Management” in Chapter 4 “Windows Setup” in the separate User’s Guide for 
setup.  

� Is [Initial size] of the paging file of the OS partition smaller than [Recommended]? 

→ If a value smaller than the [Recommended] value is set for [Initial Size] of the paging 
file, accurate memory dump (debug information) may not be collected. Be sure to 
create the file in the above size in the OS partition. 
For details, see “Set Memory Dump (Debug Information)” of “Step 12:  Set up 
Failure Management” in Chapter 4 “Windows Setup” in the separate User’s Guide for 
setup.  
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Event Log 

Perflib-related logs are recorded in the application event log when system starting: 
 

→ When system is starting, Perflib log may be registered to the application log. 

The detailed information about an event log is described on Microsoft Product 
Support Services. Please check the contents. 
• [INFO] Events for Performance Monitor Extensions 

http://support.microsoft.com/default.aspx?scid=kb;en-us;226494 
• Application Log Events Generated When You Start Performance Counter 

Query 
http://support.microsoft.com/default.aspx?scid=kb;en-us;296187 

• Event ID 2003 Warning Message Logged When Loading Performance 
Counters 
http://support.microsoft.com/default.aspx?scid=kb;en-us;267831 

Visit the Microsoft Help and Support on regular basis where you can find other 
information than the above at: 
http://support.microsoft.com/default.aspx?LN=en-us. 

 
"The NMS Service terminated unexpectedly." is recorded in the system event log: 

→ Although the following log may be recorded in the system event log when starting 
the system, or after exchanging PCI modules, there is no real problem on 
operation. Change of a setup with PROSet II will become invalid if NMS service 
stops, but you can change a setup normally because NMS service will be 
automatically started when PROSet II is started. 

“Source:  Service Control Manager 
Event ID: 7031 
Description: The NMS service terminated unexpectedly. This has occurred 1 

time(s). The following corrective action will be taken in 0 
milliseconds: No action.” 

 
iANSMiniport-related logs are recorded in the system event log: 

→ Although the following log may be recorded in the system event log when starting 
the system, there is no real problem on operation (In the description, “X” 
represents a number). 

“Source:  iANSMiniport 
Event ID: 35 
Description: Initializing Team #X missing adapters. Check the configuration to 

verify that all the adapters are present and functioning.” 

→ The logs of the source “iANSMiniport” are the logs about the duplex of the 
network. The following logs may be recorded in the system event log when 
starting the system (In the description, “X” represents a number). 

“Source:  iANSMiniport 
Event ID: 11 
Description: Adapter link down: Stratus emb-82544GC Copper Gigabit Adapter.” 

http://support.microsoft.com/default.aspx?LN=en-us
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“Source:  iANSMiniport 
Event ID: 11 
Description: Adapter link down: Stratus emb-82544GC Copper Gigabit Adapter 

#2.” 

“Source:  iANSMiniport 
Event ID: 13 
Description: Secondary Adapter is deactivated from the Team: Stratus 

emb-82544GC Copper Gigabit Adapter #2.” 

“Source:  iANSMiniport 
Event ID: 16 
Description: Team #X: The last adapter has lost link. Network connection has 

been lost.” 

“Source:  iANSMiniport 
Event ID: 35 
Description: Initializing Team #X missing adapters. Check the configuration to 

verify that all the adapters are present and functioning.” 

If the following logs are recorded after the above logs are recorded, there is no real 
problem on operation by the above errors or warnings. When the following logs are 
not recorded, if the log of the source “sragbe” is not recorded, there is no real problem 
on operation by the above errors or warnings. 

“Source:  iANSMiniport 
Event ID: 14 
Description: Secondary Adapter has rejoined the Team: Stratus emb-82544GC 

Copper Gigabit Adapter.” 

“Source:  iANSMiniport 
Event ID: 15 
Description: Adapter link up: Stratus emb-82544GC Copper Gigabit Adapter.” 

“Source:  iANSMiniport 
Event ID: 17 
Description: Team #X: An adapter has re-established link. Network connection 

has been restored.” 
 
ESMCpuPerf-related logs are recorded in the system event log: 

→ If NEC ESMPRO Agent cannot get performance information from the OS due to a 
temporary resource shortage or high load ratio on the system, it will record the 
following event log. However, there is no real problem on operation (In the 
description, Y and Xrepresent alphanumeric characters). 

Source:  ESMCpuPerf 
Event ID: 9005 
Description: Cannot get system performance information now (YYYY 

Code=xxxx). 

If NEC ESMPRO Agent cannot get information, it will treat the load ratio as 0%. 
So, if NEC ESMPRO Agent cannot get information continuously, the CPU load 
ratio may appear lower than the actual value. 
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EvntAgnt log is recorded in the application event log: 

→ This event does not have any influence on the system, not on SNMP services. 
Thus no measurement is required.  

Source: EvntAgnt 
ID: 1003 
Description: TraceFileName parameter not located in registry; Default trace file 

used is . 

Source: EvntAgnt 
ID: 1015 
Description: TraceLevel parameter not located in registry; Default trace level 

used is 32. 
 
SCSI control error appears in the system event log:   

→ There is sometimes a case that SCSI control error that has a source of sraq160 
appears in the system event log. This symptom occurs when the processing speed 
of HDDs is slower than the request from the operating system, and the process 
will be continued properly by the retry function. Since this does not affect any 
operations, check the detailed data as described below and ignore that log if the 
data is either “f0030004” or “f0030015”.   

However, if the SCSI control error in the detailed data above repeatedly shows 
either “f0030004” or “f0030015” (more than 10 times a week as an indication), 
the HDD failure can be occurring. Contact your maintenance service company.   

 
The srabid error log is recorded in the system event log at system startup:  

→ The following log may be recorded in the system event log at system startup, but 
there is no problem for operation.  

Source: srabid 
Type: Error 
ID: 300 
Description: CPU board dump harvest failed. 

Status from Common Code: ErrDumpDoesntExist  (0x8123). 

Source: srabid 
Type: Error 
ID: 300 
Description: CPU board dump harvest failed. 

Status from Common Code: ErrMagic  (0x8188). 
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Problems with NEC EXPRESSBUILDER 

When the server is not booted from the NEC EXPRESSBUILDER CD-ROM, check the following: 

� Did you set the NEC EXPRESSBUILDER CD-ROM during POST and restart the 
server? 

→ If you do not set the NEC EXPRESSBUILDER CD-ROM during POST and 
restart the server, an error message will appear or the OS will boot. 

� Is BIOS configuration correct? 

→ The boot device order may be specified with the BIOS setup utility of the server. 
Use the BIOS setup utility to change the boot device order to boot the system from 
the CD-ROM drive first. 

<Menu to check:  [Boot]> 

When an error occurs while the NEC EXPRESSBUILDER is in progress, the following message 
appears. After this message appears, check the error and take the appropriate corrective action 
according to the error codes listed in the table below. 

Message Cause and Remedy 
This machine is not supported. This NEC EXPRESSBUILDER version is 

not designed for this server. Execute the 
NEC EXPRESSBUILDER on the compliant 
server. 

NvRAM access error An access to the nonvolatile memory 
(NvRAM) is not acceptable. 

Hard disk access error The hard disk is not connected or it is 
failed. 
Check whether the hard disk is correctly 
connected. 

 

An error message will also be displayed when an error was detected during system 
diagnosis. Take a note or print the error message displayed, and contact your sales agent. 
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Problems with Master Control Menu 

Failed to read online documentation: 
� Is HTML browser installed properly? 

→ Online documentation is an HTML-format file. Install the HTML browser 
(Internet Explorer 5.x or later) in your operating system. 

� Is HTML file properly associated to the browser software? 

→ Online documentation accesses the local files in CD-ROM. 

If the extension of HTML file (.htm or .html) is not associated to your browser 
correctly, the local HTML file may not be browsed from Internet Explorer or the 
other applications. Initialize your browser and set the association of extension (.htm 
or .html) correctly. 

� Is Adobe Acrobat Reader installed properly?   

→ A part of online documentation is supplied in PDF file format. Install the Adobe 
Acrobat Reader (Version 4.05 or later) in your operating system. You can also 
install the Adobe Acrobat Reader using the NEC EXPRESSBUILDER CD-ROM. 
Launch the Master Control Menu and select [Setup] → [Adobe Acrobat Reader].  

 

Image of online documentation is not clear: 

� Is your display unit set to display 256 colors or more? 

→ Set the display unit to display 256 colors or more. 

 

The master control menu fails to appear: 

� Is your system Windows NT 4.0 or later, or Windows 95 or later? 

→ The CD-ROM Autorun feature is supported by Windows NT 4.0 and Windows 95. 
The older versions do not automatically start from the CD-ROM. 

� Is Shift pressed? 

→ Setting the CD-ROM with Shift pressed down cancels the Autorun feature. 

� Is the system in the proper state? 

→ The menu may not appear depending on the system registry setting or the timing 
to set the CD-ROM. In such a case, start the Internet Explorer and run 
\MC\1ST.EXE in the CD-ROM. 
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Problems with NEC ESMPRO 

NEC ESMPRO Manager 

→ See Chapter 5. See also online document in NEC EXPRESSBUILDER CD-ROM 
for troubleshooting and other supplementary information. 

 

NEC ESMPRO Agent 

→ See Chapter 5. 
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COLLECTION OF TROUBLE LOGS 
In the event of trouble, you can get information in the procedures described below: 

IMPORTANT:  
� You can perform the procedures described below only when you are asked by your maintenance 

personnel to get trouble logs. 

� When the system restarts after the trouble, it may show a message that there is a shortage of 
virtual memory. However, continue the system startup. If you reset and restart the system, you 
cannot get correct information. 

 

Collection of Event Logs 

Collect the logs of various events that have occurred in the NEC Express5800/ft series. 

IMPORTANT: If a STOP error or system error has occurred or the system has stalled, restart the 
system, and then start collecting event logs. 

1. Click [Start] → [Settings] → [Control Panel] → [Administrative Tools] → [Event 
Viewer]. 

2. Select the type of the log to be collected. 

[Application Log] contains events related to the applications that were active at 
occurrence of the events. [Security Log] contains security-related events. [System Log] 
contains events that occurred in system components of Windows Server 2003, Enterprise 
Edition. 

3. Click [Save Log File As...] in the [Action] menu. 

 
4. Enter the name of the target archive log file in the [File name] box. 

5. Select the format of the target log file from the [Save as type] list box, and click [OK]. 
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Collection of Configuration Information 

Collect information such as the hardware configuration and internal setting information of the NEC 
Express5800/ft series. 

IMPORTANT: If a STOP error or system error has occurred or the system has stalled, restart the 
system, and then start the work. 

1. Click [Start] → [All Programs] → [Accessories] → [System Tools] → [System 
Information]. 

2. Select the [Save…] from the File menu. 

 
3. Enter the name of the target file in the [File name] box. 

4. Click [Save]. 

 

Collection of Diagnostic Information by Dr. Watson 

Collect diagnostic information related to application errors by using Dr. Watson. 

You can designate any destination to save diagnostic information. 

For details, see help information. Click [Start] → [Run...], execute "drwtsn32.exe," and click [Help] 
in the [Dr. Watson for Windows] dialog box. 
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COLLECTION OF THE MEMORY DUMP 
If a failure occurs, the memory data should be dumped to acquire the required information. If you 
stored the dump data in a DAT, label it so as to indicate the software (e.g. NTBackup) you used for 
storing it. You may save the diagnosis data to a desired destination. 

IMPORTANT:  
� Consult with your sales agent before dumping the memory. Executing memory dumping while 

the server is in the normal operation may affect the system operation. 

� Restarting the system due to an error may display a message indicating insufficient virtual 
memory. Ignore this message and proceed. Restarting the system again may result in dumping 
improper data. 

Preparing for Memory Dump 

Memory dumping with the DUMP switch may disable the server to restart. In such a case, it is 
required to force the server to shut down. This forced shutdown, however, is not available if 
"Masked" is selected for "Power Switch Mask" on the Security menu of the BIOS setup utility, 
SETUP, because this setting disables POWER switch operation. 

Follow the procedure below to change the setting to enable the forced shutdown and restart of the 
server. 

1. Power on the server and start the BIOS setup utility, SETUP. 

2. Select "Unmasked" for "Power Switch Mask" in the Security menu. 

3. Save the configuration data and exit the SETUP. 

 

Saving Dump Files 

Press the DUMP switch to save the dump file when an error 
occurs. Insert a metal pin (a straightened large paper clip will 
make a substitute) into the switch hole to press the DUMP 
switch. 

Pressing the DUMP switch saves the dump file in the 
specified directory. (Memory dumping may not be available 
when the CPU stalls.) 

IMPORTANT: Do not use a toothpick or plastic 
stick that is easy to break. 

 
Dump switches 

 



 

Chapter 8 

System Upgrade 

This chapter describes procedures to add options and replace failed components. 

IMPORTANT:  

� Optional devices described in this chapter may be installed or removed by the user. However, 
NEC does not assume any liability for damage to optional devices or the server or malfunctions 
of the server resulted from installation by the user. NEC recommends you ask your sales agent 
to install or remove any optional devices. 

� Be sure to use only optional devices and cables designated by NEC. Repair of the server due to 
malfunctions, failures, or damage resulted from installing such devices or cables will be 
charged. 



8-2  System Upgrade 

SAFETY PRECAUTIONS 
Observe the following notes to install or remove optional devices safely and properly. 

WARNING  
  

Observe the following instructions to use the server safely. There are risks of 
death or serious personal injury. See PRECAUTIONS FOR SAFETY in 
Chapter 1 for details. 
 

 

 

 
• Do not disassemble, repair, or alter the server. 
• Do not look into the CD-ROM drive. 
• Do not remove the lithium battery. 
• Disconnect the power plug before working with the server. 

  
 

CAUTION  
  

Observe the following instructions to use the server safely. There are risks of 
fire, personal injury, or property damage. See PRECAUTIONS FOR SAFETY 
in Chapter 1 for details. 
 

 

 
• Do not install or remove components by a single person. 
• Do not install the server leaving the cover removed. 
• Make sure to complete component installation. 
• Do not pinch your finger(s). 
• High temperature 
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ANTI-STATIC MEASURES 
The server contains electronic components sensitive to static electricity. Avoid failures caused by 
static electricity when installing or removing any optional devices. 

� Wear wrist straps (arm belts or anti-static gloves). 

Wear wrist straps on your wrists. If no wrist strap is available, touch an unpainted metal 
part of the cabinet before touching a component to discharge static electricity from your 
body. 

Touch the metal part regularly when working with components to discharge static 
electricity. 

� Select a suitable workspace. 

– Work with the server on the anti-static or concrete floor. 

– When you work with the server on a carpet where static electricity is likely to be 
generated, make sure take anti-static measures beforehand. 

� Use a worktable. 

Place the server on an anti-static mat to work with it. 

� Clothes 

– Do not wear a wool or synthetic cloth to work with the server. 

– Wear anti-static shoes to work with the server. 

– Take off any metal accessories you wear (ring, bracelet, or wristwatch) before 
working with the server. 

� Handling of components 

– Keep any component in an anti-static bag until you actually install it to the server. 

– Hold a component by its edge to avoid touching any terminals or parts. 

– To store or carry any component, place it in an anti-static bag. 
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PREPARING YOUR SYSTEM FOR UPGRADE 
Note the following, when installing or replacing devices, to improve the performance of NEC 
Express5800/ft series. 

� With the NEC Express5800/ft series, devices can be replaced during the continuous operation. 
Take extreme care for electric shock and damage to the component due to short-circuit. 

� Optional devices cannot be installed or removed during continuous operation. Normally, 
shutdown Windows Server 2003, Enterprise Edition, check that the server is powered off, 
disconnect all power cords and interface cables from the server before installing or removing 
the optional devices. 

� To remove the CPU or PCI module during the continuous operation, disable the intended 
module (place the module off-line) by using the ft server utility of the NEC ESMPRO Agent 
or the NEC ESMPRO Manager from the management PC on the network. After a new module 
is installed to the server, enable the module using the ft server utility or the NEC ESMPRO 
Manager. 

TIPS: The system is defaulted to automatically boot the module, once installed. For more 
information, see Chapter 5. 

� Make sure to provide the same hardware configuration on both groups. 

� Use the same slots and sockets on both groups. 

� Do not install those devices having different specifications, performance, or features. 

� Before removing the setscrews from the CPU and PCI modules, place the desired module 
off-line using the ft server utility or the NEC ESMPRO Manager. 

� When connecting a SCSI device such as a tape drive to the SCSI connector at the back of a 
PCI module, the server needs to be powered off. 
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3.5-INCH HARD DISK DRIVE 
The 3.5-inch hard disk drive bay in front of the server contains six slots in which hard disks with the 
SCA2 interface are installed. 

The figures used in this section show the rack-mount model. The orientation is the only difference 
from the tower model. 

IMPORTANT:  

� Do not use any hard disks that are not authorized by NEC. Installing a third-party hard disk may 
cause a failure of the server as well as the hard disk. Purchase hard disks of the same model in 
pair. Contact your sales agent for hard disk drives optimum for your server. 

� The OS starts from the hard disk that is mounted in Slot 1 of the primary module (whose 
POWER LED is on). 
A SCSI controller error having sraql160 as its source may sometimes be recorded in the system 
event log. This error is likely to be issued when the hard disk drive processing cannot keep up in 
time with requests of the OS, but the processing is carried on normally thanks to the retry 
function. So, this does not affect the operation at all. In case such an error is issued, check the 
detailed data indicated below, and if it is "f0030004" or "f0030015," just ignore that log.  
If, however, a SCSI controller error whose detailed data is "f0030004" or "f0030015" is recorded 
repeatedly (ten times or more in a week time as a rough guide), a hard disk drive failure is 
suspected. Contact the maintenance personnel in such a case. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Description:  
The driver detected a controller 
error on \Device\Scsi\sraql160x 
[x is a numeral as 1 or 2 for 
example.] 

In the case where the detailed 
data of the above event 
properties is represented in 
words, the error represents no 
trouble if the value from 0034: is 
“f0030004” or “f0030015”. 

TIPS: 
� POWER LED is on to indicate that it is the primary module. 

� The module that you plug in first will be the primary module (see Chapter 3). 
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You can install hard disks, each of which is about 25.4 mm (1 inch) in thickness, to the three slots of 
each PCI module. Each slot has a label describing the slot number. 

Disks of the same slot number are mirrored between the groups. The figure below shows the groups 
and mirroring slots. 

 
Slots 1 Slots 2 Slots 3 

 

Group 1 

Group 2 

Slots used in mirroring  

 

Empty slots in the 3.5-inch hard disk drive bay contain dummy trays. The dummy trays are inserted 
to improve the cooling effect within the device. Always insert the dummy trays in the slots in which 
hard disks are not installed. 

Attach an HDD ID label indicating the slot number of installed hard disk to the handle of the hard 
disk. 
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Installing 3.5-inch Hard Disk Drive 

Follow the procedure below to install the hard disk. A hard disk may be installed in another slot in 
the same procedure. 

IMPORTANT: Make sure to read "Anti-static Measures" and "Preparing Your System for 
Upgrade" before starting installing or removing options. 

 

1. Click [Start] - [Administrative Tools] - [Computer Management]. The [Computer 
Management] window appears. 

2. Click [Disk Management] under [Storage] in the console tree. 

3. <Tower model> 

Unlock the front bezel with the security key and open it. 

<Rack-mount model > 

Unlock the front bezel with the security key and detach it. 

4. Identify the slot to which you want to install the hard disk. 

Install a hard disk in an empty slot in the group, starting from the left slot. 

5. Unlock the lever of the dummy trays and 
remove the trays by pulling the handles 
(handles need to be brought forward to be 
pulled). 

All the slots except Slot 1 have a dummy 
tray. 

IMPORTANT: Carefully keep the 
removed dummy tray. 

 

 

6. Unlock the hard disk to be added. 
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7. Firmly hold the handle of the hard disk to install and insert the hard disk into the slot. 

 TIPS:  

� Insert the disk until the lever hook touches 
the server frame. 

� Check the orientation of lever. Insert the hard 
disk with the lever unlocked. 

8. Slowly close the lever. 

When the lever is locked, you will hear a click 
sound. 

IMPORTANT: Be careful not to pinch your finger(s) between the lever and handle. 
 

TIPS: Check the hook of the lever is engaged with the frame. 

9. <Tower model> 

Close the front bezel and lock it with the security key. 

<Rack-mount model> 

Install the front bezel and lock it with the security key. 

10. Set the dual disk configuration (see Chapter 3). 
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Removing 3.5-inch Hard Disk Drive 

Follow the procedure below to remove the hard disk. 

IMPORTANT: Make sure to read "Anti-static Measures" and "Preparing Your System for 
Upgrade" before starting installing or removing options. 

1. Shutdown Windows Server 2003, Enterprise Edition. 

The system turns off automatically. 

2. Disconnect all the power cords from the power outlet. 

3. <Tower model> 

Unlock the front bezel with the security key and open it. 

<Rack-mount model> 

Unlock the front bezel with the security key and detach it. 

4. Push the lever of the hard disk to unlock the 
handle. 

5. Hold the handle and hard disk to pull them off. 

6. Install the dummy tray in an empty slot according 
to procedures described in "Installation". 

Make sure to install the dummy tray in the empty 
slot to improve the cooling effect within the device. 
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Replacing 3.5-inch Hard Disk Drive 

Follow the procedure below to remove the failed hard disk. If the hard disk fails, it should be 
replaced with new device with the server powered-on. 

IMPORTANT: Make sure to read "Anti-static Measures" and "Preparing Your System for 
Upgrade" before starting installing or removing options. You can replace disks during continuous 
operation. 

Replacing the Hard Disk Drive 

1. Locate the failed hard disk.  

When a hard disk fails, the DISK LED on the hard disk drive’s handle illuminates green, 
while the other mirrored disk illuminates amber.  

The DISK Access LED of the amber lit disk also illuminates amber.  

TIPS: Even if a hard disk fails, the DISK LEDs may not illuminate as described above. 
See “How to Locate Failed Disks” in Chapter 3 to identify failed disks. 

2. Referring to the steps in "Removing the hard disk", remove the failed hard disk. 

No need to shutdown Windows Server 2003, Enterprise Edition.  

3. Refer to the steps in "Installing the hard disk" to install a new hard disk. 

TIPS:  
� The hard disk to be installed for replacement must have the same specifications as its 

mirroring hard disk. 

� Use an unsigned hard disk to replace the failed one. If you use a signed disk, you need 
to restore the redundant configuration in the procedure of “How to Restore Redundant 
Configuration Manually” below.  

 

4. Restore the redundant configuration (see Chapter 3). 
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CPU MODULE 
Concerning the CPU module, you can add or replace the following components, or CRU 
(customer-replaceable units): 

� CPU (processor) 

� DIMM (memory) 

Remove the CPU module to install or remove these devices. The figures used in this section show 
the rack-mount model. The orientation is the only difference from the tower model. 

IMPORTANT:  
� Ask your sales agent to replace the CPU module and components of the CPU module. 

� Make sure to read "Anti-static Measures" and "Preparing Your System for Upgrade" before 
installing or removing options. 

� To install or remove CPU or DIMM, first power off the server before removing the CPU module. 
The procedures described below are for replacement of DIMMs. 

� Removing the module being operating may cause unexpected trouble. Use the management 
software (e.g., ft server utility or NEC ESMPRO Manager) to identify the module to be 
removed so that the module is removed when it is stopped, without fail  
Then remove the relevant module after verifying the status LED on the CPU module. For 
information on the status LEDs, see “LEDs” in Chapter 2. 

� Handle the module fixing screw with your hand, not by using any tool. 

� If you have replaced the module, attach an HDD ID label indicating the replaced module 
number to the upper part of the fixing screw of the module. 

� When replacing a PCI module and a CPU module, replace one module and wait until dual 
configuration is established to replace the other module. If you replace the both modules 
simultaneously, dual configuration of either CPU modules or PCI modules may fail. (See 
Chapter 7 “Troubleshooting.”) 
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Removing CPU Module 

Follow the procedure below to remove the CPU module. 

1. Stop the CPU module you want to remove. 

To this end, use the ft server utility of the NEC ESMPRO Agent installed to your server or 
the Data Viewer of the NEC ESMPRO Manager. 

For the detailed procedure, see "NEC ESMPRO Agent and Manager" - "Maintenance of 
NEC Express5800/ft series" in Chapter 5. 

  

NEC ESMPRO Manager 
Select [FTServer] → [CPU Module] → [CPU 
Module (to be removed)] → [Maintenance] → 
[Bring Up/Bring Down] → [Bring Down]. 

ft server utility 
Select [FTServer] → [CPU Module] → [CPU 
Module (to be removed)] → [Bring Up/Bring Down] 
→ [Down]. 

 
After the CPU module enters into off-line status, the status LED will change as follows. 

Fail LED: Red 

State LED:  Off 

2. <Tower model> 

Unlock the front bezel with the security key and open it. 

<Rack-mount model> 

Unlock the front bezel with the security key and detach it. 

3. Loosen the setscrews that secure the CPU module’s release levers. 

4. Hold the release levers of the CPU module and pull it off. 

The CPU module is slightly pulled out toward you. 
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5. Pull off the module halfway slowly. Pushing down the latch lever on the side to unlock it, 
pull the module off the rack. 

IMPORTANT: Carefully handle the CPU module so that you will not drop it or strike it 
against other server internal devices. 

 

 

Release lever

Release lever 

 Latch lever 

6. Carefully place the CPU module on the flat and sturdy table. 

Avoid the dusty or humid place. 

7. Remove the two setscrews on the front of the CPU module and one setscrew on the back. 

 
8. Slide the top cover a little to remove it. 

This allows you to access the devices in the CPU module. For more information on how to 
handle these devices, see the associated sections.  
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Installing CPU Module 

Follow the procedure below to install the CPU module:  

IMPORTANT: Make sure to read "Anti-static Measures" and "Preparing Your System for 
Upgrade" before starting installing or removing options. 

1. Install the top cover to the CPU module. 

TIPS: Check the left, right, and upper tabs on the top cover are certainly engaged with 
the CPU module. 

 
2. Secure the top cover to the CPU module with the three setscrews. 

3. Firmly hold the CPU module with both hands and insert it into the server.  

Hold the module in such a way that its back panel connector faces the back of the rack and 
engage the guides of the module and chassis to insert it slowly. 

Release lever 

Wrong 
(The hook is located 
before the frame)

Correct 
(The hook is located 
 behind the frame) 

4. Hold the release levers to push the module as far as it goes. 
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5. Close the release levers. 

The installed CPU module will start automatically. 

IMPORTANT: Unless the release levers are located inside the rack frame, the 
module will not be mounted correctly.  

6. Screw the release levers. 
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DIMM 
The DIMM (dual inline memory module) is installed to the DIMM socket in the CPU module on the 
NEC Express5800/ft series. 

The CPU module board is equipped with six sockets. Two standard 256MB DIMMs are mounted in 
DIMM#1 and #2 each. (The standard DIMM can be replaced with another DIMM.) 

DIMMs should be installed to these sockets, starting from the lowest socket number. 

TIPS:  
� The memory capacity can be increased up to 6 GB (six 1GB DIMMs). 

� In the error messages and logs in POST, NEC ESMPRO, or Off-line Maintenance 
Utility, the DIMM connector may be described as “group”. The number next to 
“group” corresponds to the connector numbers shown in the figure below. 

 

IMPORTANT:  
� Memory capacity can be up to 6 GB.  If installing greater than 4 GB of memory, the FT BIOS 

will recognize the full amount of physical RAM.  However, Windows Server 2003 will only 
recognize a portion of the RAM.  The “boot.ini” file in the root directory must be modified to 
include the Physical Address Extension (PAE) switch.  The switch needs to be added to the 
following line: 

 
BEFORE 
[operating systems] 
multi(0)disk(0)rdisk(0)partition(1)\WINDOWS=”Windows Server 2003, Enterprise” /fastdetect 
 
AFTER 
[operating system] 
multi(0)disk(0)rdisk(0)partition(1)\WINDOWS=”Windows Server 2003, Enterprise” /fastdetect 
/PAE             
Reboot the system, when completed. 

� The DIMM is extremely sensitive to static electricity. Make sure to touch the metal frame of 
the server to discharge static electricity from your body before handling the DIMM. Do not 
touch the DIMM terminals or on-board parts with a bare hand or place the DIMM directly on 
the desk. For static notes, see the preceding section "Anti-static Measures". 

� Make sure to use the DIMM authorized by NEC. Installing a third-party DIMM may cause a 
failure of the DIMM as well as the server. Repair of the server due to failures or damage 
resulted from installing such a board will be charged. 

� Before adding or removing DIMMs, power off the server and detach the CPU module. 

� Make sure to read "Anti-static Measures" and "Preparing Your System for Upgrade" before 
installing or removing options. 
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CPU module board 

 

Note the following to install or replace DIMM. 

� The DIMMs with the same number are linked among the groups. When a DIMM is added to 
one group, another identical DIMM should be installed to the socket with the same number in 
another group. This rule is applied to the case of removal. 

� The linked DIMMs should be of the same product with same performance. 

� DIMMs should be installed in sockets, starting from the lowest socket number. 
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Installing DIMM 

Follow the procedure below to install the DIMM. Make sure to power off the server before starting 
installation except when replacing DIMM. 

1. Shutdown OS. 

The system turns off automatically. 

2. Disconnect power cord from outlet. 

3. Remove the CPU module. 

4. Check to be sure in which socket you are mounting the DIMM. 

5. Remove the connector cover from the socket. 

A DIMM connector cover is installed to the open 
socket. When the levers on both ends of the 
connector are opened, the DIMM connector cover is 
unlocked and you can remove the cover. 

IMPORTANT: Carefully keep the removed DIMM 
connector cover. 

6. Insert a DIMM into the DIMM socket straight. 

TIPS: Pay attention to the orientation of the DIMM. 
The terminal of the DIMM has a cutout to prevent 
misinsertion. 

After the DIMM is completely inserted into the 
socket, the levers are automatically closed. 

7. Mount the CPU module. 

8. Connect the power cords. 

9. Press POWER switch to power on the module. 

10. Verify that POST displays no error messages. 

If POST displays an error message, take a note on the massage and see the POST error 
messages listed in Chapter 7. 

11. After starting the OS, set the paging file size to at least the recommended value (1.5 times 
the installed memory size). 
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Removing DIMM 

Follow the procedure below to remove the DIMM. Make sure to power off the server before 
installation except when replacing DIMM. 

TIPS: Unless at least two DIMMs are installed, the server does not work. 

1. Shutdown OS. 

The system turns off automatically. 

2. Disconnect power cord from outlet. 

3. Remove the CPU module. 

4. Open the levers on the target DIMM socket. The DIMM is unlocked and you can remove 
the device. 

5. Mount the CPU module. 

 
6. Connect the power cord. 

7. Press the POWER switch to power on the module. 

8. Verify that POST displays no error messages. 

If POST displays an error message, take a note on the massage and see the POST error 
messages listed in Chapter 7. 
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Replacing DIMM 

Follow the procedure below to replace the failed DIMM. 

1. Identify the failed DIMM using the Data Viewer of the NEC ESMPRO Manager. 

 
2. Remove the CPU module. 

3. Replace a DIMM 

4. Install the CPU module. 

The installed CPU module will start automatically. 
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PROCESSOR (CPU) 
In addition to the standard CPU (Intel® Xeon™ Processor), you can add one CPU to make a 
multi-processor system. 

IMPORTANT:  
� The CPU is extremely sensitive to static electricity. Make sure to touch the metal frame of the 

server to discharge static electricity from your body before handling the CPU. Do not touch the 
CPU terminals or on-board parts with a bare hand or place the CPU directly on the desk. For 
static notes, see the preceding section "Anti-static Measures". 

� Do not use the system before checking to see it works correctly. 

� Make sure to use the CPU authorized by NEC. Installing a third-party CPU may cause a failure 
of the CPU as well as the server. Repair of the server due to failures or damage resulted from 
installing such a board will be charged. 

� Before adding or removing CPU, power off the server and detach the CPU module. 

� Make sure to read "Anti-static Measures" and "Preparing Your System for Upgrade" before 
starting installing or removing options. 

 

 

CPU#2 
(additional)

CPU#1 
(standard)
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Installation 

Follow the steps below to mount a CPU: 

1. Shut down OS. 

The server will be powered off automatically. 

2. Unplug the power cord. 

3. Remove the CPU module. 

4. Detach the CPU air duct. 

 
5. Check to be sure of the location of the CPU socket. 

6. Remove the anti-dust sheet from the socket. 

IMPORTANT: Carefully keep the removed sheet. 

7. Lift the socket lever. 

IMPORTANT: Open the lever fully. It can be opened 120° or more. 
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8. Place the CPU carefully on the socket. 

TIPS: Pay attention to the orientation of the CPU. 

The CPU and socket have pin marks to prevent 
misinsertion.  

 

Pin marks 

9. After pressing the CPU softly against the socket, close 
the levers to fasten it. 

 

 

 

10. Remove the film of the cool sheet that is affixed on 
the heat sink. 

 

11. Place the heat sink on top of the CPU. 

 

 

 

 

12. Fasten the heat sink with its clip. 

Engage the clip holes with tabs on the sides of the retention: engage one hole first and 
engage the other holding the first hole. 
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13. Check to see if the heat sink is mounted parallel with the motherboard. 

IMPORTANT:  
� If the heat sink is not parallel to the motherboard, dismount and remount it. You 

cannot mount the heat sink correctly due to the following: 
- CPU is not mounted correctly 
- The heat sink clip is not engaged correctly. 

� Do not hold the fastened heat sink to move the CPU. 
 

14. Attach the CPU air duct. 

TIPS: Check to see if the air duct is attached securely with its projected parts inserted 
into the chassis.  

 
15. Install the CPU module. 

16. Connect the power cord. 

17. Press the POWER switch to power on the module. 

18. Verify that POST displays no error messages. 

If POST displays an error message, take a note on the massage and see the POST error 
messages listed in Chapter 7. 
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Removing CPU 

Follow the steps below to remove the CPU. Except when you replace the CPU with a new one, 
power off the server. 

IMPORTANT:  
� Do not remove the CPU unless it is faulty. 

� If a CPU is not mounted on CPU#2, cover it with an anti-dust sheet. 

� After operation, the cool sheet at the bottom of the heat sink may stick to the CPU because of 
heat. When you dismount the heat sink, turn it lightly to make sure that the heat sink is not 
sticking to the CPU. Otherwise, the CPU or socket may be damaged. 

1. Shut down OS. 

The server will be powered off automatically. 

2. Unplug the power cord. 

3. Remove the CPU module. 

4. Detach the CPU air duct. 

5. Dismount the heat sink using the dismount tool included with the additional CPU. 

 
6. Remove the CPU. 

 

7. Affix an anti-dust sheet on the CPU socket. 

Place the adhesive part on the opposite side of the lever. Any part of the sheet place off the 
socket. 

8. Install the CPU module. 

9. Connect the power cord. 

10. Press the POWER switch to power on the module. 
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11. Verify that POST displays no error messages. 

If POST displays an error message, take a note on the massage and see the POST error 
messages listed in Chapter 7. 

 

Replacing CPU 

Follow the steps below to replace a failed CPU: 

 
1. Use Data Viewer of NEC ESMPRO Manager to check the failed CPU. 

2. Remove the CPU module. 

3. Replace the CPU. 

4. Install the CPU module. 

The installed CPU module will start automatically.  
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PCI MODULE 
Three PCI boards can be installed to the PCI module. 

Up to two PCI boards can be added to each PCI module, therefore, the server can accommodate four 
additional PCI boards at a maximum (one video board has already been installed to each PCI 
module in standard configuration). 

Remove the PCI module when adding or replacing the PCI board. The figures used in this section 
show the rack-mount model. The orientation is the only difference from the tower model. 

IMPORTANT:  
� Ask your sales agent to replace the PCI module and its components. 

� Make sure to read "Anti-static Measures" and "Preparing Your System for Upgrade" before 
starting installing or removing options. 

� Handle the module fixing screw with your hand, not by using any tool. 

� If you have replaced the module, attach an HDD ID label indicating the module number to the 
upper part of the screw fixing the module. 

 

TIPS: The primary PCI module is the one whose POWER LED is on. 
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Precautions 

� If you remove a PCI module during operation, dual configuration of its internal hard disks will 
be cancelled. If you mount the module again, the dual configuration will be restored 
automatically. However, do not perform a system shutdown or remove any of the PCI modules 
before the dual configuration is completed. Otherwise, hard disk data could be corrupted. 

� Removing the primary (active) module will cause unexpected trouble. Be sure to remove the 
secondary (inactive) module. 

� When the secondary BMC is not in synchronous condition, removing the PCI module on the 
primary BMC will lose the SG data (system data). If one of the STATUS LEDs is blinking in 
red, do not remove the PCI module associated with another STATUS LED. 

When DC power is off: 

BMC#1 BMC#2 Status 
Off (Primary) Blinking in red 

(Secondary) 
(At 1-second intervals) 

Do not remove the PCI module on Primary 
BMC side.  
BMC Sync disabled. 

Off (Primary) Lit in red (Secondary) Do not remove either of the PCI modules. 
During BMC Sync. 

Off (Primary) Blinking in red 
(Secondary) 
(At 0.5-second intervals) 

Do not remove either of the PCI modules or 
control the AC/DC power before the LED 
stops blinking.  

 
When DC power is on: 

BMC#1 BMC#2 Status 
Lit in green 
(Primary) 

Blinking in red 
(Secondary) 
(At 1-second intervals) 

Do not remove the PCI module on Primary 
BMC side.  
BMC Sync disabled. 

Lit in green 
(Primary) 

Lit in red (Secondary) Do not remove either of the PCI modules. 
During BMC Sync. 

Lit in green 
(Primary) 

Blinking in red 
(Secondary) 
(At 0.5-second intervals) 

Do not remove either of the PCI modules or 
control the AC/DC power before the LED 
stops blinking.  

 
� When you remove a PCI module, the system will be powered off automatically. If there is a 

CD-ROM in the drive, eject it before removing the module. 

� When you insert a PCI module while the system is off, make sure that the newly inserted PCI 
module’s BMC status LED is off and then press the power switch.  

� When replacing a PCI module and a CPU module, replace one module and wait until dual 
configuration is established to replace the other module. If you replace the both modules 
simultaneously, dual configuration of either CPU modules or PCI modules may fail. (See 
Chapter 7 “Troubleshooting”.) 

� To add a backup module, stop the PCI module to connect and then connect the SCSI cable. 

� The MTBF value of PCI modules, Ethernet adaptor, and SCSI adaptor (including option 
boards) are cleared by inserting or removing live line of a PCI module. 
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Removing PCI Module 

Follow the procedure below to remove the PCI module.  

1. Stop the PCI module you want to remove. 

To this end, use the ft server utility of the NEC ESMPRO Agent installed to your server or 
the Data Viewer of the NEC ESMPRO Manager. 

For more information, see "NEC ESMPRO Agent and Manager" - "Maintenance of NEC 
Express5800/ft series" in Chapter 5. 

  
NEC ESMPRO Manager 

Select [FTServer] → [PCI Module] → [PCI Module 
(to be removed)] → [Maintenance] → [Bring 
Up/Bring Down] → [Bring Down]. 

ft server utility 
Select [FTServer] → [PCI Module] → [PCI Module 
(to be removed)] → [Bring Up/Bring Down] → 
[Down]. 

 

After the CPU enters into off-line status, the status LEDs of the PCI board and PCI 
module will change as follows.  

PCI board slot status LEDs (all of them): Off 

PCI module 

Status LED 1: Red 

Status LED 2: Off 
 

2. <Tower model> 

Unlock the front bezel with the security key and open it. 

<Rack-mount model> 

Unlock the front bezel with the security key and detach it. 

3. Disconnect the PCI module’s network cable and cables connected to the options. 

4. Loosen the setscrews securing the PCI module’s release levers. 
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5. Hold the release levers of the PCI module and pull it off. 

The PCI module is slightly pulled out toward you. 

IMPORTANT: Do not hold the other parts than the release levers to pull the module. 

6. Pull off the module halfway slowly. Pushing down the latch lever on the side to unlock it, 
pull the module off the rack. 

IMPORTANT: Carefully handle the PCI module so that you will not drop it or strike 
it against other server internal devices. 

 
Release lever Latch lever 

7. Carefully place the PCI module on the flat and sturdy table. 

Avoid the dusty or humid place. 

8. Remove the two setscrews on the front of the PCI module and one setscrew on the back.  

9. Slide the top cover a little to remove it. 

This allows you to access the devices in the PCI module. For more information on how to 
handle these devices, see the associated sections. 
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Installing PCI Module 

Follow the procedure below to install the PCI module: 

IMPORTANT: Make sure to read "Anti-static Measures" and "Preparing Your System for 
Upgrade" before starting installing or removing options. 

1. Install the top cover to the PCI module. 

TIPS: Check the left, right, and upper tabs on the top cover are certainly engaged with 
the PCI module. 

 
2. Secure the top cover to the PCI module with the three setscrews.  

3. Firmly hold the PCI module with both hands and insert it into the server. 

4. Hold the module in such a way that its back panel connector faces the back of the rack and 
engage the guides of the module and chassis to insert it slowly.  

5. Hold the release levers to push the module as far as it goes. 

Do not close the release levers yet. 

 

 

 

 

 

 

 

 

 

 

 
Release lever

6. Connect the network cable and option cables. 
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7. Close the release levers.  
The installed PCI module will start automatically. 

IMPORTANT: Unless the release levers are located inside the rack frame, the 
module will not be mounted correctly. 

8. Screw the release levers. 

 

 

 

 

 

 

 

 

 

 

 

 

Release lever

Wrong 
(The hook is located 
before the frame)

Correct 
(The hook is located 

behind the frame)
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PCI BOARD 
Up to three PCI boards can be installed to the PCI module (however, one video board is already 
installed in each module in standard configuration). 

IMPORTANT:  
� The PCI board is extremely sensitive to static electricity. Make sure to touch the metal frame of 

the server to discharge static electricity from your body before handling the PCI board. Do not 
touch the PCI board terminals or on-board parts by a bare hand or place the PCI board directly 
on the desk. For static notes, see the preceding section "Anti-static Measures". 

� Make sure to read "Anti-static Measures" and "Preparing Your System for Upgrade" before 
starting installing or removing options. 

� PCI#1 is a slot dedicated for video board, which is standard equipment. Do not replace this 
broad with any other board. 

 

TIPS: When a PCI board is installed or removed, or the slot is changed, use the BIOS setup 
utility "SETUP" to change the detailed settings such as interrupt line (IRQ), when necessary. See 
Appendix B for details. 

 

Video board 

PCI#2

PCI#3

 
Built-in riser card of PCI module 

Note the following to install or replace PCI board. 

� To add a PCI board, the system must be shut down. 

� To make a dual PCI board configuration, install the same type of board (i.e., having the same 
specifications and performance) to the same slot in another group. 

When a PCI board is installed to one group, another identical PCI board should be installed to 
the same slot in another group. This rule is applied to the case of removal. 

� Install the PCI boards, starting from the one with the smallest number. 
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Installing PCI Board 

Follow the procedure below to install the board to be connected to the PCI board slot. 

TIPS: To install the PCI board, make sure the shape of the board connector matches with the 
shape of the PCI board slot connector. 

1. Remove the PCI module. 

2. Remove the PCI module’s top cover. 

3. Identify the slot to which you want to install a PCI board and remove the connector cap. 

IMPORTANT: Carefully keep the removed connector cap. 

4. To install a long card, loosen the setscrew, slide the bracket, and secure it with the 
setscrew. 

 

Screw 

Bracket

5. Pull the PCI board retainer bracket from the inside. 

6. Unscrew the setscrew of the additional slot cover at the same position (level) as the target 
slot, and remove the slot cover. 

IMPORTANT: Carefully keep the removed additional slot cover. 

 

 

PCI board retainer
bracket 

Additional slot cover 
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7. Align the terminal segment of the board with the connection of the slot and insert the 
board slowly into the slot. 

 

 

TIPS: Check to see if the edge of the bracket (taper) is inserted into a slot of the chassis. 
In the case of a long board, check also to see if its other edge is inserted into the bracket 
guide. 

Slots for inserting  
bracket edges 

Guide 
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8. Align the PCI board with the guide rail groove and insert the board slowly. 

 

 

IMPORTANT: If the insertion is unsuccessful, remove the board once and retry 
installation. Note that if excessive force is applied to the board, it may be damaged. 

 

9. Attach the retainer bracket to fasten the PCI board. 
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10. In the case of a long board, slide the bracket to fasten the other edge of the board. 

 

Screw 

Bends for fastening
boards  

11. Install the top cover to the PCI module. 

12. Install the PCI module. 

Do not close the release levers yet. 

13. Connect the network cable and option cables. 

14. Close the release levers. 

The installed PCI module will start automatically. 

15. Secure the release levers with the setscrews. 

16. Check the PCI module status LED and PCI board status LED. 

For description of LED indications, see “LEDs” in Chapter 2 and “Setup of Optional PCI 
Board” later in this chapter. 
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17. Use cable ties to fasten the extra length of cables. 

 
Cable ties (included with cabinet) 
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Removing PCI Board 

Follow the procedure below to remove the PCI board.  

1. Remove the PCI module. 

2. Remove the PCI module’s top cover. 

3. Remove the PCI board retainer bracket to dismount the PCI board. 

In the case of a long board, unscrew the guide at the other edge and slide it to the front of 
the board. 

4. Install the additional slot cover to the open slot. 

5. Install the connector cover to the relevant slot. 

6. Attach the PCI board retainer bracket. 

7. Install the PCI module’s top cover. 

8. Install the PCI module. 

Do not close the release levers yet. 

9. Connect the network cable and option cables. 

10. Close the release levers. 

The installed PCI module will start automatically. 

11. Secure the release levers with the setscrews. 

12. Check the PCI module status LED and PCI board status LED. 

For description of LED indications, see “LEDs” in Chapter 2 and “Setup of Optional PCI 
Board” later in this chapter. 
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Replacing PCI Board 

Follow the procedure below to replace the failed PCI board.  

1. Check the PCI board LED and identify the failed PCI board. 

When the PCI board is failed or incorrectly installed, the two LEDs associated with the 
PCI board slot are being turned off. 

2. Remove the PCI module. 

3. Remove the PCI module’s top cover. 

4. Remove the PCI board retainer bracket to dismount the PCI board. 

In the case of a long board, unscrew the guide at the other edge and slide it to the front of 
the board. 

5. Replace the board and fasten it. 

6. Install the PCI module’s top cover. 

7. Install the PCI module. 

Do not close the release levers yet. 

8. Connect the network cable and option cables. 

9. Close the release levers. 

The installed PCI module will start automatically. 

10. Secure the release levers with the setscrews. 

11. Check the PCI module status LED and PCI board status LED. 

For description of LED indications, see “LEDs” in Chapter 2 and “Setup of Optional PCI 
Board” later in this chapter. 
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Setup of Optional PCI Board 

IMPORTANT:  

� To enable the fault-tolerant feature of the optional device, the identical devices must be installed 
to the same slots in groups 1 and 2, respectively. 

� A video board is already installed to slot #1 as standard configuration. This board may not be 
removed or replaced with any other board. 

� Change the BIOS settings. For some optional PCI boards you may need to start up the BIOS 
setup utility to change the [Boot Monitoring Time-out Period] configuration in [Advanced] – 
[Monitoring Configuration]. For more details, see page 4-15. 

 

N8804-001P1 100BASE-TX Adapter Set 

IMPORTANT: Note the following about this product: 

� For LAN cable’s connector, use the RJ-45 connector which is compliant with IEC8877 standard. 
Using a different connector may make it difficult to remove the connector.  

� Slots to install the board 

PCI slot 
Group 1 Group 2 N code Name 

#1 #2 #3 #1 #2 #3 
Remarks 

N8804-001P1 100BASE-TX Adapter set – √ √ – √ √  

√: Can be installed. –: Cannot be installed. 

� Installation of driver 

The NEC Express5800/ft series duplicates one or two pairs of 100BASE-TX adapter sets 
(N8804-001P1) before using. 

After installing Operating System, install the drivers in the following procedure and make 
dual settings of the PCI board. 

TIPS: To perform this procedure, you have to log on the system as an Administrator or a 
member of the Administrators group. 

After installing the OS, follow the steps below to install a driver and establish a dual 
configuration: 
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1. Mount the N8804-001P1 100BASE-TX adapter to the slot with the same number in PCI 
module #1 and #2, and then start Windows Server 2003, Enterprise Edition. 

After starting Windows Server 2003, Enterprise Edition, the drivers are installed 
automatically. 

IMPORTANT: If the [Digital Signature Not Found] dialog box appears, click the [Yes] 
button. 

2. Build a dual LAN configuration. (See "Setting Dual LAN Configuration" in the separate 
volume “User’s Guide (Setup).”) 

IMPORTANT:  

� You can also select [Load Balancing] in step 3 in "Setting Dual LAN Configuration". In 
this case, [Team #1:Adaptive Load Balancing Mode] is added to Network Component 
Tree. 

� Moreover, select [Stratus AA-U51500 10/100 Enet Adapter] instead of [Stratus 
emb-82559 10/100 Enet Adapter] in Steps 4 and 5. 

� If you build a dual configuration by using two pairs of adapters in Step 5, add an 
adapter in the same way. 

 
� PCI Board Status LED Indications 

 
LED 
indications Description Action 

Amber Duplex is specified, however, 
the server works in simplex 
mode. 

Specify duplex (AFT, ALB). 
Specify an appropriate driver. 

PCI board is properly installed 
and operates in non-duplex 
mode (AFT, ALB). (Does not 
depend on simplex or duplex.) 

In non-duplex mode, no special problem 
occurs. 

PCI board is installed to operate 
in the duplex mode. 

The system is operating normally in duplex 
mode. 

Off 

The PCI board is not installed 
yet, the PCI board is installed 
incorrectly, or the power is not 
supplied. 

Mount the PCI board correctly. 
If the PCI board was not mounted, there is no 
problem. 
Check the condition of power unit. 
Remount the PCI module. 

In the process of configuring or 
canceling the duplex mode. 

Wait for a while until the indication changes. If 
the indication unchanged, check the PCI board 
slot status using NEC ESMPRO Manager. 

Red 

Although the PCI board is 
mounted, it may be offline or not 
be working. 

Make the slot of the board installed from NEC 
ESMPRO Manager online. 
Mount the PCI board correctly. 
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N8803-031F Fibre Channel Controller 

� Slots to install the board 

PCI slot 
Group 1 Group 2 N code Name 

#1 #2 #3 #1 #2 #3 
Remarks 

N8803-031F Fibre Channel 
Controller 

– √ √ – √ √ Each PCI module can 
contain one board only. 
Only one of them can be 
mounted. (cannot be 
mounted together) 

√: Can be installed.   –: Cannot be installed. 

� Installation of driver 
1. When you start the system after 

installing N8803-031F Fibre 
Channel Controller, a wizard to 
detect new hardware will 
automatically start up. 

2. Select [Install from a list of 
specific location (Advanced)], and 
then click [Next]. 

 

 

 

 

3. Select [Don’t search. I will choose 
the driver to install.], and then click 
[Next]. 
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4. Select [SCSI and RAID controller], 
and then click [Next].  

 

 

 

 

 

 

 
 
5. Do not select a driver listed on the 

model list. Click [Have Disk…]. 

 

 

 

 

 

 

 

6. Insert NEC EXPRESSBUILDER into 
the CD-ROM drive, and click [Browse], 
specify the “CD-ROM 
drive:\WINNT\DRIVERS\QL2300” 
folder in the “Copy manufacture’s files 
from:” column, and then click [OK]. 

 

7. Select [Qlogic QLA23xx PCI Fibre 
Channel Adapter] on model list, 
and then click [Next]. 
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8. A warning message 
tells that you are about 
to update a driver. 
Click [Yes] to continue. 

 
The driver will be installed.  

* During the processing, the mouse 
cursor may not be moved for 10 
to 20 seconds. Please wait. 

 

 

 

 

 

 
9.  Click [Finish]. 

* This wizard will start up as many 
times as the installed Fibre 
Channel controllers. Repeat steps 
1 to 10. . 

 

 

 

 

 

10. Select [Control 
Panel] – 
[Administrative 
Tools]- [Computer 
Management] – 
[Device Manager], 
and confirm that 
there are as many 
[Qlogic QLA23xx 
PCI Fibre Channel 
Adapter]s as the 
installed Fibre 
Channel Controllers 
under [SCSI and 
RAID controller].  
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IMPORTANT:
� StoragePathSavior is required to connect NEC Storage using N8803-031F. 

� PortDuplexManager is required to connect FC DISK ARRAY (N8190-110F) using 
N8803-031F. 

� Insert Fibre Channel Controllers after the installation of OS is completed. Use 
Fibre Channel Controllers in pairs. Insert a Fibre Channel Controller into a slot in 
a PCI module and another Fibre Channel Controller into the slot at the same 
location in another PCI module. 

� How to confirm the status: 

Use StoragePathSavior (when NEC Storage is connected) or PortDuplexManager (when 
N8190-110F is connected) to check Fibre Channel Controller statuses, instead of viewing 
PCI board statuses. 
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N8104-84 1000BASE-SX Adapter 

Consult your sales personnel for details when purchasing this hardware. 

IMPORTANT: Note the following about this product: 

� It is advisable to add this product to such environment that each system is used for a different 
purpose (ex. system line, maintenance, monitoring) and multiple accesses do not occur 
simultaneously. 

� If there are multiple accesses, the processing power and transmission speed may be somewhat 
affected. 

� Slots to install the board 

PCI slot 
Group 1 Group 2 N code Name 

#1 #2 #3 #1 #2 #3 
Remarks 

N8104-84 1000BASE-SX Adapter – √ √ – √ √ Each PCI module 
can contain one 
board only. 

√: Can be installed.   –: Cannot be installed. 
� Installation of driver 

The NEC Express5800/ft series uses a pair of N8104-84 boards in duplex mode. 

After installing the drivers in the following procedure, perform a dual configuration setup. 

IMPORTANT: Please use the CD-ROM for NEC Express5800/ft series for installation. If 
you use the floppy disk provided with the network card, it will not operate properly. 
(PROSetII will not start.) 

 

TIPS: To perform this procedure, you have to log on the system as an Administrator or a 
member of the Administrators group. 

After installing the OS, follow the steps below to install a driver and establish a dual 
configuration: 

1. Mount the N8104-84 adapter to the slot with the same number in PCI module #1 and #2, 
and then start the Windows Server 2003, Enterprise Edition. 

After starting Windows Server 2003, Enterprise Edition, the drivers are installed 
automatically. 

IMPORTANT: If the [Digital Signature Not Found] dialog box appears, click the [Yes] 
button. 
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2. Build a dual LAN configuration. (See "Setting Dual LAN Configuration" in the separate 
volume “User’s Guide (Setup).”) 

IMPORTANT:  

� You can also select [Load Balancing] in step 3 in "Setting Dual LAN Configuration". In 
this case, [Team #1:Adaptive Load Balancing Mode] is added to Network Component 
Tree. 

� Moreover, select [Stratus AA-U5700 Fiber Gigabit Server Adapter] instead of [Stratus 
emb-82559 10/100 Enet Adapter] in Steps 4 and 5. 

� PCI Board Status LED Indications 

LED 
indications Description Action 

Amber Duplex is specified, 
however, the server works 
in simplex mode. 

Specify duplex (AFT, ALB). 
Specify an appropriate driver. 

PCI board is properly 
installed and operates in 
non-duplex mode (AFT, 
ALB). (Does not depend on 
simplex or duplex.) 

In non-duplex mode, no special problem 
occurs. 

PCI board is installed to 
operate in the duplex mode. 

The system is operating normally in duplex 
mode. 

Off 

The PCI board is not 
installed yet, the PCI board 
is installed incorrectly, or the 
power is not supplied. 

Mount the PCI board correctly. 
If the PCI board was not mounted, there is no 
problem. 
Check the condition of power unit. 
Remount the PCI module. 

In the process of configuring 
or canceling the duplex 
mode. 

Wait for a while until the indication changes. If 
the indication unchanged, check the PCI board 
slot status using NEC ESMPRO Manager. 

Red 

Although the PCI board is 
mounted, it may be offline 
or not be working. 

Make the slot of the board installed from NEC 
ESMPRO Manager online. 
Mount the PCI board correctly. 

 



System Upgrade  8-49 

N8104-103 1000BASE-T Adapter 

Consult your sales personnel for details when purchasing this hardware. 

IMPORTANT: Note the following about this product: 

� It is advisable to add this product to such environment that each system is used for a different 
purpose (ex. system line, maintenance, monitoring) and multiple accesses do not occur 
simultaneously. 

� If there are multiple accesses, the processing power and transmission speed may be somewhat 
affected. 

� For LAN cable’s connector, use the RJ-45 connector which is compliant with IEC8877 standard. 
Using a different connector may make it difficult to remove the connector.  

� Slots to install the board 

PCI slot 
Group 1 Group 2 N code Name 

#1 #2 #3 #1 #2 #3 
Remarks 

N8104-103 1000BASE-T Adapter – √ √ – √ √ Each PCI module 
can contain one 
board only. 

√: Can be installed.   –: Cannot be installed. 
 
� Installation of driver 

The NEC Express5800/ft series uses a pair of N8104-103 boards in duplex mode. 

After installing the drivers in the following procedure, perform a dual configuration setup. 

IMPORTANT: Please use the CD-ROM for NEC Express5800/ft series for installation. If 
you use the floppy disk provided with the network card, it will not operate properly. 
(PROSetII will not start.) 

 

TIPS: To perform this procedure, you have to log on the system as an Administrator or a 
member of the Administrators group. 

After installing the OS, follow the steps below to install a driver and establish a dual 
configuration: 

1. Mount the N8104-103 adapter to the slot with the same number in PCI module #1 and #2, 
and then start the Windows Server 2003, Enterprise Edition. 

After starting Windows Server 2003, Enterprise Edition, the drivers are installed 
automatically. 

IMPORTANT: If the [Digital Signature Not Found] dialog box appears, click the [Yes] 
button. 
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2. Build a dual LAN configuration. (See "Setting Dual LAN Configuration" in the separate 
volume “User’s Guide (Setup).”) 

IMPORTANT:  

� You can also select [Load Balancing] in step 3 in "Setting Dual LAN Configuration". In 
this case, [Team #1:Adaptive Load Balancing Mode] is added to Network Component 
Tree. 

� Moreover, select [NEC 8490XT Copper Gigabit Adapter] instead of [Stratus emb-82559 
10/100 Enet Adapter] in Steps 4 and 5. 

� PCI Board Status LED Indications 

LED 
indications Description Action 

Amber Duplex is specified, 
however, the server works 
in simplex mode. 

Specify duplex (AFT, ALB). 
Specify an appropriate driver. 

PCI board is properly 
installed and operates in 
non-duplex mode (AFT, 
ALB). (Does not depend on 
simplex or duplex.) 

In non-duplex mode, no special problem 
occurs. 

PCI board is installed to 
operate in the duplex mode. 

The system is operating normally in duplex 
mode. 

Off 

The PCI board is not 
installed yet, the PCI board 
is installed incorrectly, or the 
power is not supplied. 

Mount the PCI board correctly. 
If the PCI board was not mounted, there is no 
problem. 
Check the condition of power unit. 
Remount the PCI module. 

In the process of configuring 
or canceling the duplex 
mode 

Wait for a while until the indication changes. If 
the indication unchanged, check the PCI 
board slot status using NEC ESMPRO 
Manager. 

Red 

Although the PCI board is 
mounted, it may be offline 
or not be working. 

Make the slot of the board installed from NEC 
ESMPRO Manager online. 
Mount the PCI board correctly. 
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Supplement 

Before using backup devices: 

If any of following backup devices is used for internal SCSI connector of NEC Express5800/ft 
series, you may need to update your firmware for backup devices. 

If your backup device to be connected is any of the following models, refer to the manual_E.pdf in 
your attached NEC Express Builder (CD-ROM). That file describes detailed procedures to update 
your firmware. 

List of backup devices and firmware 

Model # NEC Model Name Latest Firmware Revision 
N8151-29F Built-In AIT Auto Loader L1nb 

N8151-34AF Built-In AIT 07n6 
N8151-36F Built-In AIT Auto Loader L7n7 
N8151-39F Built-In DAT Auto Loader L2n4 
N8151-45F Built-In DAT 02n9 
N8151-46F Built-In AIT 01nm 

N8151-41AF Built-In AIT 01nm 
All tape devices are needed to update the firmware if the firmware revision is older than 
above. 
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Appendix A 

Specifications 
NEC Express5800/320Lc NEC Express5800/320Lc-R 

Item 
N8800-063F N8800-064F 

Type Intel® Xeon™ Processor × 1 
Clock/second cache 2.8GHz/512KB 
Number of processors 1 processor (the number of processors installed per module) 

CPU 

MAX Up to 2 processors (the number of processors installed per 
module) 

Chipset Server Works Server Set III GC-LE 
512MB (256MB × 2*) Standard 
*Each module has two DIMMs in standard configuration. 

Maximum 6GB (The standard DIMM must be replaced.) 
Expansion unit 2 DIMMs (256MB × 2/ 512MB × 2/ 1GB × 2) 
Memory module DDR200 SDRAM DIMM (Registered Type) 

Memory 

Error check ECC 
Graphics (VRAM) CT69000 (VRAM 2MB) 

Floppy disk (standard) 3.5-inch drive × 1 (USB) 
Hard disk (standard) None 
Hard disk (maximum) 1800GB* (300GB × 6) 
 * The user area is reduced to a half of the physical capacity 

due to software mirroring. 

Auxiliary 
input 
device 

CD-ROM (standard) ATAPI interface × 1 (Load on tray type, x24 speed) 
A ready drive is indicated by POWER LED of that PCI module. 

5.25 inch  None File bay 
3.5 inch 6 slots 
PCI  6 slots Additional 

slot  (2 slots are used for graphics board.) 
LAN interface 1000BASE-T/100BASE-TX/10BASE-T (2 ports); 

100BASE-TX/10BASE-T (2 ports) 
USB 4-pin (2 ports) 2 ports are used by keyboard and external USB 

FDD. 
SCSI VHDCI 68-pin connector (2 ports) 
Serial D-sub 9-pin (2 ports) 

*For maintenance purpose only 
Network RJ-45 (4 ports) 

External 
interface 

Display MINI D-sub 15-pin (1 port) 
Cabinet design Deskside and mini-tower Rack-mount type 
External dimensions 222 (width)* × 560 (height) × 

795 (depth) mm 
*370mm if stabilizers included 

480 (width) × 177 (height) × 
790 (depth) mm  

Weight 68 kg (Max. 73kg) 56 kg (Max. 61kg) 
Power supply 100 to 120 VAC ±10%, 200 to 240 VAC ±10%, 50/60 Hz ±1 Hz 
Power consumption 880 VA, 870 W 

In operation Temperature  10 to 35°C 
Humidity  20 to 80% RH (non-condensing) 

Environmental 
requirements 

In storage Temperature  -10 to 55°C 
Humidity  20 to 80% RH (non-condensing) 
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I/O Port Addresses 

The factory-set I/O port addresses for the server are assigned as follows: 

Address Chip in Use 
00-1F 
20-21 
2E-2F 
40-43 

60 
61 
64 

70-71 
80-8F 
A0-A1 
C0-DF 
E0-E9 

F0 
F1-FF 

170-177 or BAR2 
1F0-1F7 or BAR0 

278-27F 
2F8-2FF 

BAR or 376 
370-377 
378-37F 
3B0-3BB 
3BC-3BE 
3C0-3DF 

3F6 or BAR1 
3F0-3F7 
3F8-3FF 

40B 
4D0 
4D1 
4D6 

580-58F 
C00 
C01 
C14 
C49 
C4A 
C52 
C6C 
C6F 

CA2-CA3 

8-bit DMA control register 
Master 8259 programming interface 
Configuration 
8254 programming interface 
Keyboard & mouse 
NMI status register 
Keyboard & mouse 
NMI enable register/real-time clock 
16-bit DMA control register 
Slave 8259 programming interface 
DMA controller page register 
Base address register 
Register IRQ13 
Logical device configuration 
EDMA2-compatible mode primary command block register 
EDMA2-compatible mode secondary command block register 
(Parallel port 3) 
Serial port B 
EDMA2-compatible mode secondary command block register 
(Floppy disk drive 2), IDE 2 
(Parallel port 2) 
VGA 
Parallel port 1 
VGA 
EDMA2-compatible mode primary command block register 
(Floppy disk drive 1), IDE 1 
Serial port A 
DMA1 expansion write mode register 
Master 8259 ELCR programming 
Slave 8259 ELCR programming 
DMA2 expansion write mode register 
SMBus control 
PCI IRQ mapping index register 
PCI IRQ mapping data register 
PCI error status register 
Address & status control 
Rise time counter control 
General register (GPMs) 
ISA wait register 
Other control registers 
IPMI (IMPI KCS interface) 
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Address Chip in Use 
CA4-CA5

CA6-CA-7
CD6
CD7

CF8, CFC
CF9

F50-F58h
BAR4+00-0F

IPMI (SMI interface) 
IPMI (SCI/SW1 interface) 
Power management index register 
Power management data register 
PCI configuration space 
Reset control 
General chipset 
EDMA2 PCI base address register 4 

* Expressed in hexadecimal digits. 
* I/O port addresses of PCI devices are specified based on the type and number of PCI devices. 
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